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Introduction

This chapter includes the following sections:

* Models, Key Features, and Capabilities

*  What Can You Do With a Wireless Controller?
* Licenses

e Maintenance and Support

Note: For more information about the topics covered in this manual, visit the
support website at netgear.com/support.

Note: Firmware updates with new features and bug fixes are made
available from time to time on downloadcenter.netgear.com. Some
products can regularly check the site and download new firmware, or
you can check for and download new firmware manually. If the
features or behavior of your product does not match what is
described in this guide, you might need to update your firmware.

Note: In this manual, the terms wireless and WiFi are interchangeable.
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ProSAFE Wireless Controller

Models, Key Features, and Capabilities

The NETGEAR ProSAFE® Wireless Controller is a high-capacity, secured wireless controller
intended for medium to large-sized businesses, higher education institutions, hospitals, and
hotels.

The wireless controller supports the IEEE 802.11a/b/g/n/ac protocols. With the wireless
controller, you can manage your wireless network from a central point, implement security
features centrally, support Layer 2 and Layer 3 fast roaming, configure a guest access
captive portal, and support voice over Wi-Fi (VoWi-Fi).

This user manual supports models WC7500, WC7600, WC7600v2, and WC9500. For a
comparison between the models, see Table 1 on page 13.

Note: Forinformation about the manuals for the legacy model WC7520, visit
downloadcenter.netgear.com/en/product/WC7520.

Model WC7500

One WC7500 wireless controller with the appropriate licenses can support up to 15 access
points (APs) with up to 400 users. Model WC7500 is an entry-level model: You cannot stack
the WC7500, nor is controller redundancy supported.

Model WC7500 provides four RJ-45 Gigabit Ethernet ports. However all four Gigabit Ethernet
ports provide equal performance and are bonded together in Linux active-backup mode. In
this mode, the ports effectively function as one port rather than four separate ports, with one
port active and three ports acting as backup if the active port fails. Therefore, only one port is
available to access the wireless controller for management or for data and control
communications between the wireless controller and the access points. For more
information, visit kb.netgear.com/app/answers/detail/a_id/30974/~/prosafe-wc7500.

Model WC7600

One WC7600 wireless controller with the appropriate licenses can support up to 50 access
points (APs) with up to 2,000 users. In a stacked configuration, a stack of three wireless
controllers can support up to 150 access points with up to 6,000 users.

Model WC7600 provides one RJ-45 Gigabit Ethernet port and two 10 Gigabit Ethernet
(10GDbE) slots with standard SFP+ form factor for optional 10GBASE or 1000BASE GBICs.
These ports are available to access the wireless controller for management and for data and
control communications between the wireless controller and the access points.

Introduction
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Model WC7600v2

One WC7600v2 wireless controller with the appropriate licenses can support up to 50 access
points (APs) with up to 2,000 users. In a stacked configuration, a stack of three wireless
controllers can support up to 150 access points with up to 6,000 users.

Model WC7600v2 provides four RJ-45 Gigabit Ethernet ports. These ports are available to
access the wireless controller for management and for data and control communications
between the wireless controller and the access points.

Model WC9500

One WC9500 standalone wireless controller with the appropriate licenses can support up to
300 access points with up to 9,000 clients. In a stacked configuration, one wireless controller
with the appropriate licenses can support up to 200 access points with up to 6,000 clients. A
stack can support three wireless controllers with up to 18,000 clients.

Model WC9500 provides one RJ-45 Gigabit Ethernet port and two 10 Gigabit Ethernet
(10GDbE) slots with standard SFP+ form factor for optional 10GBASE or 1000BASE GBICs.
These ports are available to access the wireless controller for management and for data and
control communications between the wireless controller and the access points.

Model Scalability and Feature Differences

The following table show the differences in scalability and features between the wireless
controller models.

Table 1. Model differences and scalable architecture

Feature WC7500 WC7600 WC7600v2 WC9500

License in AP increments 5 10, 50 10, 50 10, 50, 100, 200

Single controller
Max. number of APs 15 50 50 300
Max. number of users 400 2,000 2,000 9.000

Stack of three controllers

Max. number of APs Stacking is not 150 150 600

Max. number of users supported 6,000 6,000 18,000
Controller redundancy Not supported Supported Supported Supported
Link aggregation Not supported Supported Not supported Supported
Monitor blacklisted clients Not supported Supported Not supported Supported
1G ports 41 1 4 1
SFP slots None 2 None 2
USB ports 2 1 2 1

Introduction
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Table 1. Model differences and scalable architecture (continued)

Feature WC7500 WC7600 WC7600v2 WC9500

SD card slot 12 None 1 None

Optional extra power supply | Not supported Supported Not supported Supported
1. All four Gigabit Ethernet ports provide equal performance and are bonded together in Linux active-backup mode.

2. An

SD card will be supported in a future release.

Model Common Features and Capabilities

The wireless controller provides the following common key features and capabilities:
WiFi modes

Aut

802.11a

802.11b

802.11g

802.11n

802.11ac

odiscovery of access points

Autodiscovery of access points in the same Layer 2 domain.
Autodiscovery of access points across a Layer 3 domain.

Automatic download of wireless controller—based firmware to discovered access
points that are added to the managed access point list.

Centralized management

Single point of management for the entire WiFi network.
Automatic firmware upgrade to all managed access points.
DHCP server for IP address provisioning.

Configurable management VLAN.

Security

Identity-based security authentication with an external RADIUS or LDAP (Active
Directory) server, or with an internal authentication server.

Support for nine access point profile groups (one basic and eight advanced) on one
wireless controller.

Support for up to 8 profiles per access point profile group and 8 profiles per radio
(therefore, dual-band access points can support up to 16 profiles in one access point
profile group).

Support for up to 144 profiles on one wireless controller (8 profiles per access point
group and eight groups per radio). Each profile supports settings for SSID, network
authentication, data encryption, client separation, VLAN, MAC ACL, and WiFi QoS.

Rogue access point detection and classification.

Introduction
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- Guest access and captive portal access with cost and expiration accounting.

- Scheduled WiFi on/off times.

Wi-Fi Multimedia Quality of Service and advanced wireless features

- Wi-Fi Multimedia (WMM) support for video, audio, and voice over Wi-Fi (VoWi-Fi).
- WMM power save option.

- Automatic WLAN healing mechanism ensures seamless coverage for WiFi users.
Layer 2 and Layer 3 seamless roaming support.

Local Layer 2 traffic switching and Layer 3 traffic processing at access point level for
fast processing.

Wireless and Radio Frequency (RF) management

- Automatic control of access point transmit power and channel allocation to reduce
interference.

- Automatic load balancing of clients across access points.
- Rate limiting per profile.

- Multicast and broadcast rate limiting

- ARP suppression

Monitoring and reporting

- Monitoring of the status of the network, wireless controllers, WLANSs, and clients, and
network usage statistics.

- Specific health monitoring of access points.

- Logging and emailing of system events, RF events, load-balancing events, and
rate-limiting events.

For a list of all features and capabilities of the wireless controller, see the datasheets:

For the WC7500, visit netgear.com/support/product/WC7500.

For the WC7600, visit netgear.com/support/product/\WWC7600v1.
For the WC7600v2, visit netgear.com/support/product/\WWC7600v2.
For the WC9500, visit netgear.com/support/product/WC9500.

What Can You Do With a Wireless Controller?

You can perform the following tasks with a wireless controller:

Organize the Network

- Create access point profiles. Organize access points in profiles to differentiate
between SSIDs, client authentication, authentication settings, and WiFi QoS settings.

- Create access point profile groups. Organize access point profiles in access point
profile groups to differentiate between buildings, floors, businesses, business
divisions, and so on. Easily assign access points to profile groups or change
assignments.

For more information, see Chapter 7, Manage Security Profiles and Profile Groups.

Introduction
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« Discover Access Points in the Network and Provision IP Addresses and Firmware

- Discover access points in the network. The access points can be in factory default
state or functioning in standalone mode, but after discovery by the wireless controller
and addition to the managed access point list, the access points become dependent
(managed) access points.

- Provision IP addresses to the access points. Use the internal DHCP server to
provision IP addresses to all or selected managed access points in the network.

- Upgrade access point firmware. Update and synchronize new firmware versions to
all managed access points in the network.

For more information, see Chapter 8, Discover and Manage Access Points.

e Centrally Manage Security in the Network

- Manage secure access to the network and secure data transmission. Manage
client authentication, encryption, WiFi client security separation, and MAC
authentication in access point profiles.

- Manage authentication servers for the network. Manage all internal and external
authentication servers for the entire network or for access point profile groups.

- Manage MAC authentication. Specify trusted and untrusted MAC addresses for the
entire network.

- Manage rogue access points. Manage rogue access points and their associated
clients in the network.

- Manage guest access. Manage guest access and captive portal access to the
network.

For more information, see Chapter 10, Manage Rogue Access Points, Guest Network
Access, and Users.
e Centrally Manage the WiFi Settings for the Network

- Schedule the radios. Schedule the entire network to go offline, or schedule access
point profile groups to go offline.

- Manage WiFi settings and channel allocation. Manage the WiFi settings such as
wireless mode, data rate, and channel width for the entire network or for access point
profile groups, and manage channel allocation for the entire network.

- Manage QoS settings. Manage QoS queue settings for data, background, video,
and voice traffic for access point profile groups.

- Configure RF management settings. Configure WLAN healing for access point
profile groups.

For more information, see Chapter 9, Configure WiFi and QoS Settings.

e Manage Other Wireless Controllers in the Network

- Manage stacking. Specify the master and slave wireless controllers in a stack and
synchronize information between the wireless controller.1

For more information, see Chapter 12, Manage Stacking and Redundancy.

1. Model WC7500 does not support stacking.

Introduction
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e Monitor the Network and Its Components

- Monitor the status of all WiFi devices. View the status of the wireless controllers,
access points, clients, access point profiles, and the entire network, and view network
usage statistics.

- Monitor network health. See which access points are healthy and which ones are
down or compromised.

For more information, see Chapter 13, Monitor the WiFi Network and Its Components.

Licenses

By default, the wireless controller comes with a trial license for two access points. You must
purchase and register licenses for the access points in your network. Licenses are tied to the
serial number of the wireless controller.

Depending on the model, you can purchase licenses in 5—, 10—, 50—, 100—, or 200—access
point increments for support of multiple access points on a single wireless controller.

Table 2. Purchasable license increments

License increments | WC7500 WC7600 WC7600v2 WC9500

5APs WC5APL-10000S — —

10 APs — WC10APL-10000S |WC10APL-10000S |WC10APL-10000S
50 APs — WC50APL-10000S | WC50APL-10000S |WC50APL-10000S
100 APs — — — WC100APL-10000S
200 APs — — — WC200APL-10000S

For example, if you installed three WC9500 wireless controllers in a stack and want to
support the maximum number of 600 access points in a stacked configuration, you must
purchase three WC200APL licenses (or a combination of other licenses that add up to a total
of 600 access points).

For information about how to register and manage your licenses, see Register Your Licenses
on page 110 and Manage Licenses on page 274.

Maintenance and Support

NETGEAR offers technical support seven days a week, 24 hours a day. Information about
support is available on the NETGEAR ProSupport website at prosupport.netgear.com.

Introduction
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Package Contents

The product package contains the following items:

e One ProSAFE wireless controller appliance

e One AC power cable

* Rubber feet (four) with adhesive backing

*  One rack-mount kit

» Straight-through Category 5 Ethernet cable

* ProSAFE Wireless Controller Installation Guide

If any of the parts are incorrect, missing, or damaged, contact your NETGEAR dealer. We

recommend that you keep the carton, including the original packing materials, in case you
must return the product for repair.

Hardware Models WC7500 and WC7600v2

The front panel ports, slots, and LEDs, back panel components, and product label of models
WC7500 and WC7600v2 are described in the following sections.

WC7500 and WC7600v2 Front Panel Ports and Slots

The following figure shows the front panel of models WC7500 and WC7600v2. (The label on
the right states PROSAFE WC7500 but the front panel for the WC7600v2 is identical.)

Digital access point counter USB ports Console port

NETGEAR PROSAFE WC7500

LEDs (top to bottom): 10/100/1000M RJ-45 ports SD slot Reset button
Power, Status, and LEDs
Fan, Stack Maser

Figure 1. Front panel models WC7500 and WC7600v2

Hardware Descriptions
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The following figure shows a close-up of the left side of the front panel.

Digital access point counter USB ports

e e el =
Left LED - Green = 1000M Blink = ACT I I I I E
Right LED - Yellow = 10/100M Blink = ACT
1 2 3 4 USB

LEDs (top to bottom): 10/100/1000M RJ-45 ports
Power, Status, Fan, Stack Master and LEDs

Figure 2. Front panel close-up models WC7500 and WC7600v2

From left to right, the front panel of models WC7500 and WC7600v2 show the components
that are described in the following table.

Table 3. Front panel components models WC7500 and WC7600v2

Component Description
Digital counter Displays the number of connected access points that are in a healthy state.
System LEDs From top to bottom: Power LED, Status LED, Fan LED, and Stack Master LED.

These LEDs are described in Table 5 on page 25.

Ethernet ports and LEDs | Four 10/100/1000 Mbps LAN Ethernet port with an RJ-45 connector, left LED, and
right LED. The Ethernet port provides switched N-way, automatic speed negotiating,
auto MDI/MDIX technology.

USB ports Two USB 2.0 ports for external storage of floor heat maps, saving of the syslogs, and
backing up the configuration. The USB ports support FAT32 file systems.

SD card slot An SD card for saving of the system logs will be supported in a future release.

Console port RS232 port for connecting to an optional console terminal. The port provides a DB9
male connector. The default baud rate is 115200 bits/second.

Note: The console port is for debugging under guidance of NETGEAR technical
support only.

Reset button Using a sharp object, press and hold this button for about 10 seconds until the Status
LED blinks and the wireless controller returns to factory default settings.

If you reset the wireless controller, all configuration settings are lost and the default
password is restored.

Hardware Descriptions
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WC7500 and WC7600v2 Back Panel Components

The wireless controller comes with a single internal power supply and internal fans. The back
panel provides a Kensington™ lock slot and the AC power supply connector for the
100-240V, 3A, 50-60 Hz power supply.

Kensington lock slot Power supply connector

Figure 3. Back panel models WC7500 and WC7600v2

Attach the power cord to the power supply connector. (The wireless controller does not
provide an on/off power switch.)

WC7500 and WC7600v2 Product Labels

The product label on the bottom of the wireless controller’s enclosure displays the default IP
address, default user name, and default password, as well as regulatory compliance, input
power, and other information.

Model WC7500 and model WC7600v2 share the same product label. The actual model
number (WC16A for both the WC7500 and the WC7600v2) is stated in the MODEL field.

®
DEFAULT ACCESS

AR EE ML T http://19?.1d6q.o.2so
ProSAFE® Wjireless Controller HaE L2 HI2F :Z‘;‘Zﬁi’&e :asr:\:\?ord
Model No #5: WC16A

FE ® & C€ @

This device complies with part 15 of the FCC Rules and Canada ICES-003. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference,and (2) this device must accept any
interference received, including interference that may cause undesired operation. CAN ICES-3 (A)/NMB-3(A)
ik by AGER A FEAETEIAEE S, %7 ST RE IS ACE LT . TEXFMEBLT . ATRER A T
RIS AT A«

- D 5 fEEem O S m g

COREE S5 A RREHRETY, CORRERERATRATDL [E
BRHEEFNEE T ENHYEY. COBECEIEAENEN 23K
EFBTHLOBRENZLEDHVET, VCCI-A MISIP-REM-NGRWC16A

Designed by NETGEAR in California

Made in China A E #li&

Input/#i A:100-240VAC, 50-60Hz
~3-1.5A max/&A

usIs 272-12590-01

Figure 4. Product label model WC7500 and model WC7600v2

SERIAL JTF15
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Hardware Models WC7600 and WC9500

The front panel ports, slots, and LEDs, back panel components, and product label of models
WC7600 and WC9500 are described in the following sections.

WC7600 and WC9500 Front Panel Ports and Slots

The following figure shows the front panel of models WC7600 and WC9500. (The label on
the right states PROSAFE WC9500 but the front panel for the WC7600 is identical.)

Digital access point counter

SFP+ slots and LEDs

PROSAFE WC9500

USB port 10/100/1000M RJ-45 port Console port

and LEDs
Reset button

LEDs (top to bottom):
Power, Status,
Fan, Stack Maser

Figure 5. Front panel models WC7600 and WC9500

The following figure shows a close-up of the left side of the front panel.

Digital access point counter

SFP+ slots and LEDs

USB port
Reset button and LEDs

10/100/1000M RJ-45 port

LEDs (top to bottom):
Power, Status,
Fan, Stack Maser

Figure 6. Front panel close-up models WC7600 and WC9500
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From left to right, the front panel of models WC7600 and WC9500 show the components that
are described in the following table.

Table 4. Front panel components models WC7600 and WC9500

Component

Description

Digital counter

Displays the number of connected access points that are in a healthy state.

System LEDs

From top to bottom: Power LED, Status LED, Fan LED, and Stack Master LED.
These LEDs are described in Table 5 on page 25.

Reset button

Using a sharp object, press and hold this button for about 10 seconds until the Status
LED blinks and the wireless controller returns to factory default settings.

If you reset the wireless controller, all configuration settings are lost and the default
password is restored.

USB port

One USB 2.0 port for external storage of floor heat maps, saving of the syslogs, and
backing up the configuration. The USB port supports FAT32 file systems.

SFP+ slots and LEDs

Two SFP+ slots for optional 10GE SFP+ or 1G SFP gigabit interface converters
(GBICs), each slot with an LED.

Ethernet port and LEDs

One 10/100/1000 Mbps LAN Ethernet port with an RJ-45 connector, left LED, and
right LED. The Ethernet port provides switched N-way, automatic speed negotiating,
auto MDI/MDIX technology.

Console port

RS232 port for connecting to an optional console terminal. The port provides a DB9
male connector. The default baud rate is 9600 bits/second.

Note: The console port is for debugging under guidance of NETGEAR technical
support only.

WC7600 and WC9500 Back Panel Components

The wireless controller comes with a single internal power supply but supports an optional
second power supply for power redundancy. The power supplies are hot-swappable.

The following figure shows the back panel of the wireless controller with a single internal
power supply, the power supply connector, and two double fans.

oYy e "“VJ

‘ ‘k« k« :

Removable power supply Removable fans Slot for an optional

Power supply connector

second power supply

Figure 7. Back panel models WC7600 and WC9500
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From left to right, the back panel of models WC7600 and WC9500 provide the following

components:

* Power supply. 100-240V, 5A, 47-63 Hz power supply, which includes the following

external components:

- AC power socket. Attach the power cord to this socket. (The wireless controller does

not provide an on/off power switch.)

- Power supply with handle. The handle allows for easy removal and insertion of the

power supply.

- LED. The power supply LED is lit green when the power supply functions correctly. If
the LED is off, power is not supplied to the power supply, or a problem occurred.

* Fans. Two double fans, each of which can be easily exchanged.

e Slot for optional second power supply. The cover plate can be removed so you can
insert a second removable power supply for power redundancy.

WC7600 and WC9500 Product Labels

The product label on the bottom of the wireless controller’s enclosure displays the default IP
address, default user name, and default password, as well as regulatory compliance, input

power, and other information.

NETGEAR
ProSAFE® Wireless Controller WC7600

This device complies with part 15 of the FCC Rules and Canada CAN ICES-3 (A)/NMB-3(A). Operation
is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause undesired operation.

COKEF, VXA BREMKETY. COXKBERERRTHEAITSL
BREGEESI SRS ENDHYET. COBAICIIERE N EY 23 K
EHBTHLOBREINBZI LD HYET, VCCI-A

hip://192.168.0.250 c s usten 4103 C € &E
|

user name: admin ITE.E212778
password: password
Input Rating: AC 100-240V~ 47-63Hz, 5A max.

_ — _
(I-AN)

NETGEAR, INC. Made in China 272-12101-02

Figure 8. Product label model WC7600
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NETGEAR

and (2) this device must accept any interference received, including
cause undesired operation.

BRBEERER T IEPHYVET. ZDHFAICIHE
EHTHLOBRSINZENHYVET,

@) 0o
http://192.168.0.250
usgr name: admin [Ec q US LISTED [H[ wc

password: password TE. E212778

KCC-REM-NGR-WC9500

NETGEAR, INC. Made in China

ProSAFE® Wireless Controller WC9500

This device complies with part 15 of the FCC Rules and Canada ICES-003. Operation is
subject to the following two conditions: (1) this device may not cause harmful interference,

COKE[. XA FREMEKETY. CORKBZRERRETEAITDL

Input Rating: AC 100-240V~ , 47-63Hz, 5A max.

= _ SERIAL_
(LAN)

interference that may

RENEY 23R
VCCI-A

€EDE

272-11969-03

Figure 9. Product label WC9500

LED Functions (All Models)

The function of each LED is described in t
except where noted otherwise.

Table 5. LED functions for all models

he following table. These LEDS apply to all models

LED Status Description
Power LED Solid green The wireless controller is on.
Off The wireless controller is off.
If the power LED is not lit when the wireless controller is on,
check the connections and check to see if the power outlet is
controlled by a wall switch that is turned off (see Power LED Is
Not Lit on page 361).

Status LED Solid yellow The wireless controller is initializing. After approximately two
minutes, when the wireless controller completes its
initialization, the Status LED turns solid green. If the Status
LED remains solid yellow, the initialization failed (see Status
LED Never Turns Off on page 361).

Solid green The wireless controller completed its initialization successfully.
The Status LED is solid green during normal operation.
Off The wireless controller is not receiving power.
Blinking yellow Firmware is being upgraded.
Fan LED Solid green The fans are functioning correctly.
Solid yellow One or more fans are not functioning correctly.

Hardware Descriptions
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Table 5. LED functions for all models (continued)

LED Status Description

Stack Master LED | Solid green The wireless controller is functioning as the master controller in
a stack.

Note: Does not

apply to WC7500 | Solid yellow The wireless controller is functioning as a slave controller in a
stack.

SFP slot LEDs Solid green The slot is operating at 10G.

Note: Doesnot |Blinking green Data is being transmitted or received at 10G.

apply to WC7500

and WC7600v2 Solid yellow The slot is operating at 1G.

Blinking yellow Data is being transmitted or received at 1G.
Left Ethernet Off The port is not connected to a powered-on Ethernet device
port LED (see Ethernet Port LEDs Are Not Lit on page 361).

WC7500 Solid green The port is operating at 1000 Mbps.

and
WC7600v2 | Blinking green | Data is being transmitted or received at 1000 Mbps.

WC7600 Solid green The port is operating at 1000 Mbps.

and
WC9500 Solid yellow The port is operating at 100 Mbps or 10 Mbps.

Right Ethernet Off The port is not connected to a powered-on Ethernet device
port LED (see Ethernet Port LEDs Are Not Lit on page 361).

WC7500 Solid yellow The port is operating at 100 Mbps or 10 Mbps.

and
WC7600v2 | Blinking yellow | Data is being transmitted or received at 100 Mbps or 10 Mbps.

WC7600 Solid green The port is connected to a powered-on Ethernet device.

and
WC9500 Blinking green | Data is being transmitted or received.

Wireless Controller System Components

A wireless controller system consists of one or more wireless controllers and a collection of
access points that are organized into groups based on location or network access.

The wireless controller system can include a single wireless controller or a group of up to
three stacked wireless controllers that can function in a redundant configuration?.

The wireless controller system supports the following NETGEAR ProSAFE access point
models:

«  WAC740 ProSAFE 4x4 Dual-Band Wireless AC Access Point

«  WAC730 ProSAFE 3x3 Dual-Band Wireless AC Access Point
«  WAC720 ProSAFE 2x2 Dual-Band Wireless AC Access Point

1. Model WC7500 does not support stacking and redundancy.
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WN370 ProSAFE Wall Mount Wireless N Access Point

*  WND930 Outdoor Dual Band Wireless-N

*  WNDAP660 ProSAFE Premium 3x3 Dual Band Concurrent Wireless-N Access Point
«  WNDAP380R ProSAFE Dual Band Wireless-N Access Point with RFID support

«  WNDAP360 ProSAFE Dual Band Wireless-N Access Point

WNDAP350 ProSAFE Dual Band Wireless-N Access Point

¢ WNAP320 ProSAFE Wireless-N Access Point

«  WNAP210v2 ProSAFE Wireless-N Access Point

Supported NETGEAR Access Points

You can connect access points to the wireless controller either directly with an Ethernet cable
through a router or switch, or remotely through a VPN network. After you use the automatic
discovery process and add access points to the managed access point list on the wireless
controller, the wireless controller converts the standard access points to dependent access
points by pushing firmware to the access points. From then on, you can centrally manage
and monitor the access points.

The following table lists the minimum firmware versions that must run on the standalone
access points before you convert them to managed access points. If your access point runs a
firmware version that is earlier than the minimum firmware version, first upgrade the access
point to the minimum firmware version or a later version.

Table 6. Minimum firmware versions

Access Point Model |[Minimum Firmware Version on Standalone Access Point

WAC740 Model WAC740 cannot function as a standalone access point. This model can be
used only as a controller-managed access point.

WAC730 All firmware versions are supported.
WAC720 All firmware versions are supported.
WN370 Model WN370 cannot function as a standalone access point. This model can be used

only as a controller-managed access point.

WND930 2.0.4 or a newer version is supported.
WNDAP660 2.0.2 or a newer version is supported.
WNDAP380R All firmware versions are supported.

WNDAP360 2.1.6 or a newer version is supported.
WNDAP350 2.1.7 or a newer version is supported.
WNAP320 2.1.1 or a newer version is supported.
WNAP210v2 All firmware versions are supported.
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A wireless controller system supports the following access points:

«  WAC740 ProSAFE 4x4 Dual-Band Wireless AC Access Point

Supports concurrently 802.11a, 802.11b, 802.11g, 802.11n, and 802.11ac network
devices.

Operates concurrently in the 2.4 GHz and 5 GHz radio bands.
Supports 4x4 multi-user multiple input, multiple output (MU-MIMO).
Supports speeds of up to 1.7 Gbps for 802.11ac network devices.

Supports Power over Ethernet plus (PoE+) with a power consumption that complies
with the 802.3at standard.

Accepts optional antennas.

For product documentation and firmware, visit netgear.com/support/product/WAC740.

«  WAC730 ProSAFE 3x3 Dual-Band Wireless AC Access Point

Supports concurrently 802.11a, 802.11b, 802.11g, 802.11n, and 802.11ac network
devices.

Operates concurrently in the 2.4 GHz and 5 GHz radio bands.
Supports 3x3 multiple input, multiple output (MIMO).
Supports speeds of up to 1300 Mbps for 802.11ac network devices.

Supports Power over Ethernet (PoE) with a power consumption that complies with the
802.3af standard.

Accepts optional antennas.

For product documentation and firmware, visit netgear.com/support/product/WAC730.

« WAC720 ProSAFE 2x2 Dual-Band Wireless AC Access Point

Supports concurrently 802.11a, 802.11b, 802.11g, 802.11n, and 802.11ac network
devices.

Operates concurrently in the 2.4 GHz and 5 GHz radio bands.
Supports 2x2 multiple input, multiple output (MIMO).
Supports speeds of up to 867 Mbps for 802.11ac network devices

Supports Power over Ethernet (PoE) with a power consumption that complies with the
802.3af standard.

Accepts optional antennas.

For product documentation and firmware, visit netgear.com/support/product/WAC720.

*  WN370 ProSAFE Wall Mounted Wireless-N Access Point

Supports concurrently 802.11b, 802.11g, and 802.11n network devices.
Operates in the 2.4 GHz radio band.
Supports speeds of up to 300 Mbps for 802.11n network devices.

Supports Power over Ethernet (PoE) with a power consumption that complies with the
802.3af standard.
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For product documentation and firmware, visit netgear.com/support/product/WN370.

*  WND930 Outdoor Dual Band Wireless-N
- Supports 802.11a, 802.11b, 802.11g, and 802.11n network devices.
- Operates concurrently in the 2.4 GHz and 5 GHz radio bands.
- Supports speeds of up to 300 Mbps for 802.11n network devices.
- Supports Power over Ethernet (PoE) with a power consumption that complies with the
802.3af or 802.3at standards.
For product documentation and firmware, visit netgear.com/support/product/\WND930.

«  WNDAP660 ProSAFE Premium 3x3 Dual Band Concurrent Wireless-N Access Point
- Supports 802.11a, 802.11b, 802.11g, and 802.11n network devices.
- Operates concurrently in the 2.4 GHz and 5 GHz radio bands.
- Supports 3x3 multiple input, multiple output (MIMO).
- Supports speeds of up to 450 Mbps for 802.11n network devices.
- Supports Power over Ethernet (PoE) with a power consumption that complies with the
802.3at standard.

Note: If your network does not include a PoE device that can provide the
WNDAPG660 access point with POE power according to the 802.3at
standard, you can instead use two ports of a POE device that complies
with the 802.3af standard. (The WNDAP660 access point provides two
Ethernet ports that accept PoE.)

- Accepts optional antennas.

For product documentation and firmware, visit netgear.com/support/product/WNDAPG60.
«  WNDAP380R ProSAFE Dual Band Wireless-N Access Point with RFID support
Supports 802.11a, 802.11b, 802.11g, and 802.11n network devices.

Operates concurrently in the 2.4 GHz and 5 GHz radio bands.
Supports Power over Ethernet (PoE) with a power consumption of up to 10.51W.

Accepts an RFID module for support of RFID devices and tags.

For product documentation and firmware, visit
netgear.com/support/product/WNDAP380R.

e WNDAP360 ProSAFE Dual Band Wireless-N Access Point
- Supports 802.11a, 802.11h, 802.11g, and 802.11n network devices.
- Operates concurrently in the 2.4 GHz and 5 GHz radio bands.
- Supports Power over Ethernet (PoE) with a power consumption of up to 10.51W.
- Accepts optional antennas.

For product documentation and firmware, visit netgear.com/support/product/WNDAP360.
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WNDAP350 ProSAFE Dual Band Wireless-N Access Point

- Supports 802.11a, 802.11b, 802.11g, and 802.11n network devices.

- Operates concurrently in the 2.4 GHz and 5 GHz radio bands.

- Supports Power over Ethernet (PoE) with a power consumption of up to 10.75W.
- Accepts optional antennas.

For product documentation and firmware, visit netgear.com/support/product/\WNDAP350.

WNAP320 ProSAFE Wireless-N Access Point

- Supports 802.11b, 802.11g, and 802.11n network devices.

- Operates in the 2.4 GHz radio band.

- Supports Power over Ethernet (PoE) with a power consumption of up to 5.8W.
- Accepts optional antennas.

For product documentation and firmware, visit netgear.com/support/product/WWNAP320.

WNAP210v2 ProSAFE Wireless-N Access Point

Supports 802.11b, 802.11g, and 802.11n network devices.

Operates in the 2.4 GHz radio band.

Supports Power over Ethernet (PoE) with a power consumption of up to 5.8W.
Operates in the 2.4 GHz radio band.

For product documentation and firmware, visit
netgear.com/support/product/WNAP210v2.

Note: Model WNAP210v1 cannot function in a wireless controller system, but
model WNAP210v2 can.

Supported NETGEAR Antennas

A wireless controller system supports the following antennas:

ANT2409 ProSAFE Indoor/Outdoor 9 dBi Omni-directional Antenna
- 9 dBi omni-directional antenna for indoor or outdoor use

- WiFi signal 802.11g

- Frequency range 2400-2485 MHz

- Maximum range 11.5 km (7.2 miles)

- Polarization vertical

For product documentation and firmware, visit netgear.com/support/product/ANT2409v2.

ANT224D10 ProSAFE 10 dBi 2x2 Indoor/Outdoor Directional Antenna
- 10 dBi directional antenna for indoor or outdoor use
- WiFi signal 802.11n
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- Frequency range 2400-2500 MHz
- Maximum range 8.5 km (5.28 miles)
- Polarization linear; vertical

For product documentation and firmware, visit netgear.com/support/product/ANT224.
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System Planning and Deployment
Scenarios

This chapter includes the following sections:

Basic and Advanced Setting Concepts

Profile Group Concepts

System Planning Concepts

High-Level Configuration Examples
Management VLAN and Data VLAN Strategies
High-Level Deployment Scenarios
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Basic and Advanced Setting Concepts

You can deploy the wireless controller in a small WiFi network with 10 or 20 access points or
in a large WiFi network with up to 600 access points. Small networks require a basic
configuration, but large networks can become complex and require you to configure the
advanced features of the wireless controller.

Depending on your network configuration, use basic settings or advanced settings to
manage your access points:

e Basic settings for a typical network. The basic settings work with most common
network configurations. For example, all access points on the WLAN are for the same
organization or business and therefore adhere to the same policies and use a few service
set identifiers (SSIDs, or network names).

* Advanced settings for access point profile groups. In a large WiFi network, or if
separate networks share a single WLAN, use the advanced settings to set up multiple
access point profile groups with multiple security profiles (SSIDs with associated security
settings). For example, a shopping mall might need several access point profile groups if
several businesses share a WLAN but each business maintains its own network. Larger
networks could require multiple access point profile groups to allow different policies per
building or department. The access points could support different security profiles per

building and department, for example, one for guests, one for management, and one for
sales.

Note: Access point profile groups are also referred to as just profile groups.
Profiles, security profiles, and SSIDs (that is, SSIDs with associated
security settings) are terms that are interchangeable.

To accommodate all types of networks, almost all configuration menus of the web
management interface are divided into basic and advanced submenus. The following figure
shows an example of the Configuration > Security > Basic submenu on the left and the
Configuration > Security > Advanced submenu on the right:

Access Point Configuration fAccess Point Configuration

System | Wireless | Security |

Wireless

System | i Security i

Basic
* MAC ACL
» Authentication| » MAC ACL
Server » Authentication
Advanced Server

Figure 10. Basic and advanced submenus
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Before you start the configuration of your wireless controller, decide whether you can use a
basic configuration (that is, follow the Basic submenus) or must use an advanced
configuration (that is, follow the Advanced submenus). Once you make your choice,
configuring the wireless controller can be fairly easy if you consistently follow either the Basic
submenus or the Advanced submenus.

Profile Group Concepts

Each access point can support up to eight security profiles (16 for dual-band access points),
each with its own SSID, security settings, MAC ACL, rate-limiting settings, WMM, and so on.

The wireless controller follows the same architecture. A profile group on the wireless
controller includes all the features that you can configure for an individual access point: up to
8 profiles (16 for dual-band access points), each of which supports its own SSID, security,
MAC ACL, rate-limiting settings, WMM settings, and so on.

Basic Profile

The basic profile includes all the settings that are required to configure a fully functional
access point with up to eight security profiles (16 for dual-band access points).

After you use the automatic discovery process and add access points to the managed AP list
on the wireless controller, the access points are assigned by default to the basic profile

group.

If your network requires the wireless controller to manage multiple access points with
different configurations, use the advanced profile.

Advanced Profile

The advanced profile lets you configure up to eight access point profile groups. Each group
includes all the settings that are required to configure a fully functional access point with up to
eight security profiles (16 for dual-band access points).

For example, if your company site includes four buildings, each with a different WiFi network,
you simply create four profile groups. You then assign all access points in one building to one
profile group, all access points in another building to a second profile group, and so on.

For each profile group, you can create an individual radio on/off schedule, RF management
settings, MAC ACL authentication, and an authentication server. For each radio in a profile

group (2.4 GHz radio and 5 GHz radio), you can create individual WiFi settings, WMM, and
rate-limit settings.

The following figure shows the advanced profile group architecture. The structure that is
shown under Group-1 is implemented in all profile groups (that is, Group-2 through Group-8):
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Group-1| [ Group-2[|Group-3| |Group-4| |Group-5| |Group-6| |Group-7||Group-8

2.4 GHz 5 GHz
radio radio
1 2 31 4|5 6 7 |8 1|2 3 4 15 1|6 7 8
Security profiles Security profiles

Figure 11. Advanced profile group architecture

The following figure shows an example of three access point profile groups, in which the first
profile group (Group-1) supports five security profiles. For each profile in this profile group,
the profile name, radio mode, and authentication setting are shown. (Group-1 is the default
group in the advanced profile group configuration; you must create the other profiles groups.)

Access Point Configuration Maonitor Maintenance Stacking Plans Diagnostics
System | Wireless Security | Profile | WLAN Network | Captive Portal
Basic Profile Groups @
Group-1 Group-2 Group-3 +
= Rate Limit
| . .
» AP LED State Name | Authentication
Bld1l_Upper_Floor £02.11b/ba/ng  WPA-PSK & WPAZ-PSK
Bldi_Lower Floar 802.11b/ba/ng  WPA-PSK & WPAZ-PSK
Bldi_Library g02.11b/bafng  Open Systemn
Bldi_Upper_Floor_na 802.11a/na WPA-PSK & WPAZ-PSK
Bldi_Lower_Floor_na 802.11a'na WPA-PSK & WPAZ-PSK
CANCEL DELETE EDIT APPLY

Figure 12. Example of profile groups with security profiles
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System Planning Concepts

This section includes the following subsections:

* Preinstallation Planning
e Before You Configure a Wireless Controller

Preinstallation Planning

Before you install any wireless controllers, determine the following:

* Number of access points required to provide seamless coverage

*  Number of licenses required to cover all access points that must be managed
*  Number of wireless controllers required

e 802.11 frequency band and the channels that are optimal for WiFi usage

We recommend that you perform a site survey:

* To determine the current RF behavior and detect both 802.11 and non-802.11 noise, run
a spectrum analysis of the channels of the site.

e To determine the maximum throughput that is achievable on the client, run an access
point-to-client connectivity test.

e Identify potential RF obstructions and interference sources.
e Determine areas where denser coverage might be required because of heavier usage.

Before You Configure a Wireless Controller

These sections assume that you deployed at least one wireless controller in your network
and are ready to configure the wireless controller. For information about how to deploy the
wireless controller in your network, see your model’s installation guide, which you can
download by visiting downloads.netgear.com.

For many configurations, you can use the default WiFi settings. The IP address, VLAN,
DHCP server, client authentication, and data encryption settings are specific to your
environment. Following are short sections that describe these settings (except for IP address
settings, which are self-explanatory). For information about how to configure these settings,
see the relevant sections.

Management VLAN

The management VLAN is the dedicated VLAN for access to the wireless controller. All traffic
that is directed to the wireless controller, including HTTP, HTTPS, SNMP, and SSH traffic, is
carried over the management VLAN.

If the management VLAN is also configured as a tagged VLAN (the most common
configuration), the packets to and from the wireless controller carry the 802.1Q VLAN header
with the assigned VLAN number. If the management VLAN is marked as untagged, the
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packets that are sent from the wireless controller do not carry the 802.1Q header, and all
untagged packets that are sent to the wireless controller are treated as management VLAN
traffic.

Note: Use a tagged VLAN or change the tagged VLAN ID only if the hubs
and switches on your LAN support 802.1Q. If they do not, and you did
not configure a tagged VLAN with the same VLAN ID on the hubs and
switches in your network, IP connectivity might be lost.

The management VLAN must provide IP connectivity between the wireless controller and the
access points. If the wireless controller and the access points are on different management
VLANSs, external VLAN routing must allow IP connectivity between the wireless controller and
the access points.

For information about how to configure management VLANS, see Manage the IP, VLAN, and
Link Aggregation Settings on page 102.

Client VLANS

Each authenticated WiFi user is placed into a VLAN that determines the user’'s DHCP server,
IP address, and Layer 2 connection. Although you could place all authenticated WiFi users
into the single VLAN that is specified in the basic security profile, the wireless controller
allows you to group WiFi users into separate VLANs based on the WiFi SSID to differentiate
access to network resources. For example, you might place authorized employee users into
one VLAN, and itinerant users, such as contractors or guests, into a separate VLAN. To use
different VLANS, you must create different security profiles.

For information about how to configure regular VLANSs, see Manage the IP, VLAN, and Link
Aggregation Settings on page 102.

DHCP Server

The wireless controller can function as a DHCP server and assign IP addresses to both WiFi
and wired devices that are connected to it. You can add up to 64 DHCP server pools, each
assigned to a different VLAN.

Specifying an internal DHCP server on the wireless controller automatically enables DHCP
option 43 (vendor-specific information) with the IP address of the wireless controller. Whether
you must enable option 43 on an external DHCP server in a Layer 2 network depends on the
firmware version that the wireless controller is running:

e Firmware version 4.x and earlier versions. Option 43 must be enabled on an external
DHCP server in a Layer 2 network.

e Firmware version 5.x and later versions. Option 43 is not required on an external
DHCP server in a Layer 2 network.

For discovery across Layer 3 networks, you always must enable option 43 on an external
DHCP server.
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Client Authentication and Data Encryption

A user must authenticate to the WLAN to be able to access WLAN resources. The wireless
controller supports several types of security methods, including those methods that require
an external RADIUS or LDAP authentication server.

The encryption option that you can select depends upon the authentication method that you
selected. The following table lists the authentication methods available, with their
corresponding encryption options:

Table 7. Authentication and encryption options

Authentication Method Encryption Option Authentication Server

Open System 64-bit, 128-bit, or 152-bit WEP | None

Shared Key 64-bit, 128-bit, or 152-bit WEP | None

WPA-PSK TKIP or TKIP+AES None

WPA2-PSK AES or TKIP+AES None

WPA-PSK and WPA2-PSK TKIP+AES None

WPA TKIP or TKIP+AES One of the following authentication servers:

« External RADIUS server
* Internal authentication server
* External LDAP server

WPA2 AES or TKIP+AES One of the following authentication servers:
¢ External RADIUS server

e Internal authentication server

¢ External LDAP server

WPA and WPA2 TKIP+AES One of the following authentication servers:
¢ External RADIUS server

¢ Internal authentication server

e External LDAP server

For information about how to configure client authentication, data encryption, and
authentication servers, see Chapter 7, Manage Security Profiles and Profile Groups.
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High-Level Configuration Examples

This section includes the following subsections:

e Single Controller Configuration With Basic Profile Group

* Single Controller Configuration With Advanced Profile Groups
» Stacked Controller Configuration

Single Controller Configuration With Basic Profile Group

A basic configuration consists of a single wireless controller that controls a collection of
access points that are organized into the basic default group.

» To set up a single wireless controller system with a basic profile group:

Step |Configuration Web Management Interface Path
1. Configure the system and network settings of the wireless
controller:
1. Configure the country code of operation. Configuration > System > General
2. Configure the time settings. Configuration > System > Time
3. Configure the IP address of the wireless controller. Configuration > System > IP/VLAN
4. Verify that VLAN 1 is set as the management VLAN and is
marked as untagged.
By default, VLAN 1 an untagged management VLAN.
5. Ifno network DHCP server is accessible to the access points, | Configuration > System > DHCP
configure the wireless controller’s DHCP server. Server
2. Configure up to eight profiles, and for each profile, do at least the
following:
1. Configure an SSID for WiFi access. Configuration > Profile > Basic
2. Configure the network authentication and data encryption.
3. Assign the VLAN.
4. If necessary for the selected network authentication option, | Configuration > Security > Basic >
configure the authentication server. Authentication Server
3. Run the Discovery Wizard and add the access points to the Access Point > Discovery Wizard
managed access point list.

System Planning and Deployment Scenarios

39




ProSAFE Wireless Controller

Single Controller Configuration With Advanced Profile Groups

A more complex configuration consists of a single wireless controller that controls a collection
of access points that are organized in access point profile groups and might use several
profiles in each access point profile group.

» To set up asingle wireless controller system with advanced profile groups:

Step |Configuration Web Management Interface Path
1. Configure the system and network settings of the wireless
controller:
1. Configure the country code of operation. Configuration > System > General
2. Configure the time settings. Configuration > System > Time
3. Configure the IP address of the wireless controller. Configuration > System > IP/VLAN
4. Verify that VLAN 1 is set as the management VLAN and is
marked as untagged.
By default, VLAN 1 an untagged management VLAN.
5. If no network DHCP server is accessible to the access points, | Configuration > System > DHCP
configure the wireless controller's DHCP server. Server
2. Configure up to eight access point profile groups, and for each
access point profile in a group, do at least the following:
1. Configure an SSID for WiFi access. Configuration > Profile > Advanced
2. Configure the network authentication and data encryption.
3. Assign the VLAN.
4. If necessary for the selected network authentication option, | Configuration > Security >
configure the authentication server. Advanced > Authentication Server
3. Run the Discovery Wizard and add the access points to the Access Point > Discovery Wizard
managed access point list.
4. Assign the access points to the access point profile groups (also | Configuration > WLAN Network
referred to as WLAN groups).
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Stacked Controller Configuration

A stacked controller configuration can consist of up to three wireless controllers and up to
600 access points.

Note: If the stack members are on different floors or in different buildings, you

could configure a separate access point profile group for each building or

floor.

» To set up a stacked controller configuration:

Step |Configuration Web Management Interface Path
1. On each individual wireless controller that you intend to make a
stack member, configure the system and network settings of the
wireless controller:
1. Configure the country code of operation. Configuration > System > General
2. Configure the time settings. Configuration > System > Time
3. Configure the IP address of the wireless controller. Configuration > System > IP/VLAN
4. Verify that VLAN 1 is set as the management VLAN and is
marked as untagged.
By default, VLAN 1 an untagged management VLAN.
5. Ifno network DHCP server is accessible to the access points, | Configuration > System > DHCP
configure the wireless controller's DHCP server. Server
2. Configure the master wireless controller and deploy it in the
network.
Configure up to eight access point profile groups, and for each
access point profile in a group, do at least the following:
1. Configure an SSID for WiFi access. Configuration > Profile > Advanced
2. Configure the network authentication and data encryption.
3. Assign the VLAN.
4. If necessary for the selected network authentication option, | Configuration > Security >
configure the authentication server. Advanced > Authentication Server
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Step |Configuration Web Management Interface Path
3. Configure the slave wireless controllers and deploy them in the

network.

For each slave wireless controller, configure up to eight access

point profile groups, and for each access point profile in a group, do

at least the following:

1. Configure an SSID for WiFi access. Configuration > Profile > Advanced

2. Configure the network authentication and data encryption.

3. Assign the VLAN.

4. If necessary for the selected network authentication option, | Configuration > Security >

configure the authentication server. Advanced > Authentication Server

4. Interconnect the wireless controllers that you intend to make

members of the stack. The connection must be a wired

connection but does not need to be a direct connection, that is, a

switch or router can be located in between the wireless

controllers that are part of a stack.
5. Configure the stacking group on the wireless controller that you | Stacking > Stacking

intend as the master controller.
6. Synchronize all wireless controllers that are members of the

stack.

Management VLAN and Data VLAN Strategies

If your network includes 10 or more access points, we recommend that you set up at least
two VLAN groups: a management VLAN group and a data VLAN group. If your network is
large, we recommend that you create a number of data VLAN groups. Setting up data VLANs
for clients allows you to do the following:

e Segregate traffic by user category

e Create different policies such as access policies that are based on user category
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The following illustration shows a simplified view of how you can use VLANSs to segregate
traffic by user category.

Management VLAN 100 Ethernet traffic
— — = Finance VLAN 10 Ethernet traffic
— == Employee VLAN 20 Ethernet traffic

Internet

ﬁi; =]
" AT

. Backend L3 switch
Deploy the wireless controller or router

on atrunk port if you use the
internal DHCP server

Network pFinter / I //’

PoE switch

Access point
WNDAP360

Wireless controller

Finance ' Finance
computer computer

Employee Employee
computer computer

Figure 13. Example: Use VLANS to segregate traffic by user categories

The wireless controller uses the management VLAN to continually exchange packets with
the access points. For large networks, if all traffic uses a single VLAN, the client traffic could
potentially flood the network. If flooding occurs and the wireless controller is not able to
exchange packets with the access points, the network performance can slow down, and the
access points can lose their connectivity with the wireless controller.

If you use the internal DHCP server of the wireless controller, deploy the wireless controller
on a trunk port on your switch. The trunk port must provide access to all VLANSs.

To accommodate the traffic load of the trunk, use a high-speed port on your switch as the
trunk port. If you use an external DHCP server, you do not need to deploy the wireless
controller on a trunk port on your switch.
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High-Level Deployment Scenarios

This section provides three deployment scenarios to illustrate how the wireless controller can
function in various network configurations:

» Scenario Example 1: Network With Single VLAN
e Scenario Example 2: Advanced Network With VLANs and SSIDs
e Scenario Example 3: Advanced Network With Redundancy

Scenario Example 1: Network With Single VLAN

The following sample scenario consists of a simple network with a wireless controller, POE
switch, Layer 3 switch or router, and access points.

Management VLAN Ethernet traffic

— — = All client Ethernet traffic Internet (¥ :

. Backend L3 switch
Deploy the wireless controller or router

on atrunk port if you use the
internal DHCP server

Access point
WNDAP360

Finance Marketing
computer computer

Employee Employee
computer computer

Figure 14. Example: Basic network with a single VLAN
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The access points and wireless controller are connected in the same subnet and use the
same IP address range that is assigned for that subnet. The configuration does not include
any routers between the access points and the wireless controller. The access points are
connected to a PoE switch, which, in turn, is connected to the wireless controller. The uplink
of the PoE switch connects to a Layer 3 switch or router that provides Internet access.

» To provision the wireless controller:

Step |Configuration Web Management Interface Path
1. Configure the system and network settings of the wireless
controller:
1. Configure the country code of operation. Configuration > System > General
2. Configure the time settings. Configuration > System > Time
3. Configure the IP address of the wireless controller. Configuration > System > IP/VLAN

4. Verify that VLAN 1 is set as the management VLAN and is
marked as untagged.

By default, VLAN 1 an untagged management VLAN.

5. Ifno network DHCP server is accessible to the access points, | Configuration > System > DHCP

configure the wireless controller's DHCP server. Server
2. Configure up to eight profiles, and for each profile, do at least the
following:
1. Configure an SSID for WiFi access. Configuration > Profile > Basic

2. Configure the network authentication and data encryption.

3. Assign the VLAN.

4. If necessary for the selected network authentication option, | Configuration > Security > Basic >

configure the authentication server. Authentication Server
3. Use any port of the wireless controller to connect the WiFi PoE
switch.
4. Deploy the access points and connect them to the same WiFi
PoE switch.
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Step |Configuration Web Management Interface Path

When the access points are operating, open the Discovery Access Point > Discovery Wizard
Wizard to do the following:

1. Specify the state of the access points. The state can be either
factory default in a Layer 2 network or already installed and
functioning in standalone mode.

2. Run the Discovery Wizard.

3. Select the access points that you want the wireless controller to
manage and add them to the managed list.

Note: By default, all access points are added to the basic group
and all settings from the basic group (profile definition, client
authentication, authentication settings, and WiFi QoS) are applied
to the access points.

Scenario Example 2: Advanced Network With VLANs and SSIDs

The following sample scenario consists of an advanced network with a wireless controller,
PoE switch, Layer 3 switch or router, access points, and several VLANs and SSIDs. The
wireless controller system includes the following VLANS:

VLAN 1, the default untagged VLAN to access the wireless controller
VLAN 10, a tagged client VLAN

VLAN 20, another tagged client VLAN

VLAN 100, a tagged management VLAN

Management VLAN 100 Ethernet traffic
— — = Client VLAN 10 Ethernet traffic
— — — Client VLAN 20 Ethernet traffic gﬁgthLAN 10
_'- . e F
& E— "‘ '.f".' i ——‘-i"-]-' E — )
Wireless controller POE switch l WNDAP360
|
|
I
I
Backend L3 switch I
or router :
|
|
I J )
- L —_—— .
Internet .- WNDAP360
SSID 2
Client VLAN 20

Figure 15. Example: Advanced network with VLANs and SSIDs
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The access points and wireless controller are connected in the same subnet and same VLAN
and use the same IP address range that is assigned for that subnet. The configuration does
not include any routers between the access points and the wireless controller. The access
points are connected to a PoE switch, which, in turn, is connected to the Layer 3 switch or
router that provides Internet access.

This network configuration requires the following conditions:

VLANS 10, 20, and 100 are tagged VLANs and are configured on the wireless controller
and the PoE switch.

e The wireless controller is connected to the PoE switch through default VLAN 1. You
manage the wireless controller from a computer over VLAN 1 through the PoE switch.

e The DHCP server on the wireless controller is configured in management VLAN 100 to
enable the access points to receive an IP address through VLAN 100.

e The PoE switch port to which the wireless controller is connected is configured as a
tagged port to allow tagged traffic from VLAN 100.

> To provision the wireless controller:

Step |Configuration Web Management Interface Path
1. Configure the basic system settings:
1. Configure the country code of operation. Configuration > System > General
2. Configure the time settings. Configuration > System > Time
3. Configure the IP address of wireless controller. Configuration > System > IP/VLAN

4. For initial discovery and configuration of the access points,
temporarily configure management VLAN 100 as an
untagged management VLAN on the wireless controller.

5. Change default VLAN 1 to a tagged VLAN.

2. For initial discovery and configuration of the access points,
temporarily configure management VLAN 100 as an untagged
management on the PoE switch.

3. Configure either the network’s DHCP server or the wireless
controller's DHCP server to use VLAN 100.

If you use the wireless controller’'s DHCP server:

1. Configure the IP address range for VLAN 100. Configuration > System > DHCP
Server

2. Configure the other DHCP server fields, including the
gateway and DNS servers.
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Step |Configuration Web Management Interface Path
4. Configure the following profiles, and configure network
authentication and data encryption for these profiles:
1. A profile with SSID 1 and VLAN 10. Configuration > Profile > Basic
2. A profile with SSID 2 and VLAN 20.
3. If necessary for the selected network authentication options, | Configuration > Security > Basic >
configure one or more authentication servers. Authentication Server
5. Connect the wireless controller to the PoE switch.
6. Before you connect the access points to the PoE switch, verify
that the switch ports to which you intend to connect the access
points are configured as access ports in management VLAN 100.
7. Deploy the access points and connect them to the designated
PoE switch ports.
8. When the access points are operating, open the Discovery Access Point > Discovery Wizard
Wizard to do the following:
1. Specify the state of the access points, which is factory default
in a Layer 2 network.
2. Run the Discovery Wizard.
3. Select the access points that you want the wireless controller to
manage and add them to the managed list.
Note: By adding the access points to managed list, you enable
them to receive an IP address from the DHCP server over
management VLAN 100.
9. For each access point on the managed list, disable the untagged
VLAN and configure VLAN 100 as the management VLAN. Doing
S0 causes the access points to lose connectivity with the wireless
controller.
10. Restore connectivity between the access points and the wireless
controller by changing the PoE switch ports to which the access
points are connected to tagged ports.
During the discovery process, these switch ports were access
ports in management VLAN 100.

Scenario Example 3: Advanced Network With Redundancy

The following sample scenario consists of an advanced network with one wireless controller,
one redundant wireless controllerl, one core switch, two PoE switches in different buildings,
access points, and several VLANs and SSIDs. These are the components in the wireless

controller system:

*« One wireless controller

*  Fifty access points (managed by the wireless controller through management VLAN 1)

1. Model WC7500 does not support controller redundancy.
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* One redundant wireless controller
e Four VLANSs: VLAN 10, VLAN 20, VLAN 30, and VLAN 40
e Three SSIDs: SSID 1, SSID 2, and SSID 3

In this scenario, the VLANs and SSIDs are used to accommodate traffic for different user
groups in a school that is spread out over two buildings.

e Building 1:
- SSID 1in VLAN 10 for staff traffic
- SSID 2 in VLAN 20 for middle school students
- SSID 3in VLAN 30 for guests
* Building 2:
- SSID 1in VLAN 10 for staff traffic
- SSID 2 in VLAN 40 for high school students
- SSID 3in VLAN 30 for guests

Internet Building 1
SSID 1 Staff VLAN 10
SSID 2 Middle school VLAN 20
SSID 3 Guest VLAN 30 Q
— o~
/ABackend L3 switch ] o —~
or router : i :
-
11 ——
i 'Q
11 :
i ]
1
11 WNDAP660 ———
L --JI_!JI Q;%%é;
e =
) ! 111 —
R E lg“’ —=1_3 |” Building 2
o ——— 1
11| SSID 1 Staff VLAN 10
Redundant controller : I'1 [ SSID 2 High school VLAN 40
I : SSID 3 Guest VLAN 30 @
1
[
11! —
It
L

-—=Staff VLAN 10 Ethernet traffic
——=Middle school VLAN 20 Ethernet traffic
—==High school VLAN 40 Ethernet traffic
—==Guest VLAN 30 Ethernet traffic

WNDAP660

Figure 16. Example: Advanced network with redundancy

The access points and wireless controllers are connected in the same subnet and the same
VLAN and use the same IP address range that is assigned for that subnet. The core switch is
located between the wireless controllers and the PoE switches, to which the access points
are connected. The core switch provides Internet access.
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This network configuration requires the following conditions:

* VLAN 1 is configured on the wireless controllers, core switch, and PoE switches. This
VLAN is untagged.

 VLANSs 10, 20, and 30 are configured on the wireless controllers, core switch, and the
PoE switch in Building 1. These VLANS are tagged.

e VLANs 1, 10, 20, 30, and 40 are configured on the wireless controllers, core switch, and
PoE switches. Except for VLAN 1, these VLANS are tagged.

» To provision the wireless controller:

Step |Configuration Web Management Interface Path
1. Configure the basic system settings:
1. Configure the country code of operation. Configuration > System > General
2. Configure the time settings. Configuration > System > Time
3. Configure the IP address of wireless controller. Configuration > System > IP/VLAN

4. Verify that VLAN 1 is set as the management VLAN and is
marked as untagged.

By default, VLAN 1 an untagged management VLAN.

5. If no network DHCP server is accessible to the access points, | Configuration > System > DHCP
configure the wireless controller's DHCP server. Server

2. Configure the following profiles, and configure network
authentication and data encryption for these profiles:

1. A profile with SSID 1 and VLAN 10. Configuration > Profile > Basic

2. A profile with SSID 2 and VLAN 20.

. A profile with SSID 2 and VLAN 30.

3
4. A profile with SSID 3 and VLAN 40.

5. If necessary for the selected network authentication options, | Configuration > Security > Basic >
configure one or more authentication servers. Authentication Server

3. Configure the following profile groups:

1. A profile group with the name Building 1, to which you add the | Configuration > Profile > Advanced
following profiles:
- The profile with SSID 1 and VLAN 10
- The profile with SSID 2 and VLAN 20
- The profile with SSID 2 and VLAN 30

2. A profile group with the name Building 2, to which you add the
following profiles:
- The profile with SSID 1 and VLAN 10
- The profile with SSID 2 and VLAN 30
- The profile with SSID 3 and VLAN 40
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Step |Configuration Web Management Interface Path
4. Deploy the access points and connect them to PoE switches.
5. When the access points are operating, open the Discovery Access Point > Discovery Wizard

Wizard to do the following:

1. Specify the state of the access points, which is the factory
default state in a Layer 2 network.

2. Run the Discovery Wizard.

3. Select and add the access points that you want to be managed
by the wireless controller to the managed list.

Note: By default, all access points are added to the basic group.

6. Assign the access points to the access point profile groups (also | Configuration > WLAN Network
referred to as WLAN groups) Building 1 and Building 2.
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RF Planning and Deployment

This chapter includes the following sections:

Application, Browser, and Port Requirements for RF Planning

RF Planning Overview

Manage a Building and Floors for an RF Plan

Use the WiFi Auto Planning Advisor to Generate an RF Plan for a Floor
Manually Add and Manage Access Points on a Floor Map for an RF Plan
Manually Add and Manage Antennas on a Floor Map for an RF Plan
Display and Recalculate the WiFi Coverage for a Heat Map

Display or Change the WiFi Inventory for an RF Plan

Download a Report for an RF Plan

View the Heat Map for a Deployed Floor Plan
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Application, Browser, and Port Requirements for RF
Planning

For you to be able to access the RF planning pages in the web management interface, make
sure that your computer can run Adobe Flash Player and that Java is enabled in your
browser. If you get a Java security warning, add an exception.

To display the RF planning pages, you might need to refresh your browser’s cache. For most
browsers, to refresh the cache, press the F5 key.

For remote access (that is, access over a WAN interface) to the RF planning pages, specific
ports must be open your computer’s firewall:

e Forremote HTTPS access, make sure that ports 4430 and 8443 are open.

e Forremote HTTP access, make sure that ports 80 and 8080 are open.

RF Planning Overview

You can do the following with RF planning:

e Define WLAN coverage.

« Estimate the number of access points required based on signal quality and number of
clients per access point.

« Optimize the placement of access points for the best coverage.

e Monitor WLAN coverage, rogue access points, and blacklisted clients for a plan that is in
deployment.

e Identify weak signal spots and dead spots from a coverage hole and add additional
access points to mitigate the situation.

RF planning provides a view of each floor in a building, allowing you to specify how WiFi
coverage must be provided. RF planning then provides coverage maps and access point
placement locations.

For deployed RF plans, real-time calibration lets you visualize the indoor propagation of RF
signals to identify areas with a weak signal or dead spots and add additional access points in
the right location to mitigate the weak signal or dead spots.

Note: In a stacking configuration, RF planning is accessible only from the
master controller. The access points that are controlled by the slave
controllers are displayed in the web management interface of the master
controller. These access point are displayed in the default building
(Building-1) on the default floor (Floor-1) of the master controller.
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Note: In a redundancy group, after a failover occurs to a redundant controller,
RF planning is no longer accessible. Only after a switchback to the
primary controller occurs, RF planning becomes available again.

Planning Requirements

To expedite your planning efforts, collect the information that is listed in Table 8 and Table 9
before you use RF planning.

Use a worksheet similar to the following table to collect your building information.

Table 8. Building planning table

Item Your Information

Building length

Building width

Building height

Number of floors

Distance in height between floors

Use a worksheet similar to the following table to collect your information for each floor in the
building.

Table 9. Floor planning table

Item Your Information

Floor dimensions if different from building dimensions

Length

Width

Height

Define WiFi coverage and noncoverage areas

WiFi coverage areas

WiFi noncoverage areas

WiFi building obstacles

Dry walls

Wood walls

Plastic walls

Glass walls
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Table 9. Floor planning table (continued)

Item

Your Information

Brick walls

Concrete walls

Light doors

Metal doors

Heavy doors

Thin windows

Thick windows

Other obstacles

WiFi building obstruction areas

Cubicle office areas

Closed office areas

Elevator shafts

Warehouses with low-density stock

Warehouses with medium-density stock

Warehouses with high-density stock

WiFi client information

Total number of expected clients on floor

Expected number of clients per access point

WiFi radio band or bands

Access point protocol for each WiFi radio

band

2.4 GHz (802.11b/bg/ng)

5 GHz (802.11a/na/ac)

Access point transmission power (from fu

Il to minimum) for each WiFi radio band

2.4 GHz

5 GHz

WiFi coverage and signal strength

WiFi coverage percentage

Minimum required signal strength in dBm
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Recommended RF Planning Procedure for a Building

We recommend that you first set up your building and floors to scale and define the floor
plans. For more information, see Manage a Building and Floors for an RF Plan on page 56.

Then, for each floor, perform the following tasks:
e Use the WiFi Auto Planning Advisor

See Use the WiFi Auto Planning Advisor to Generate an RF Plan for a Floor on page 70.
e (Optional) Manually add and fine-tune access points on each floor.

See Manually Add and Manage Access Points on a Floor Map for an RF Plan on
page 76.

e (Optional) Manually add and fine-tune antennas.
See Manually Add and Manage Antennas on a Floor Map for an RF Plan on page 79.
e (Optional) Display the WiFi coverage.
See Display and Recalculate the WiFi Coverage for a Heat Map on page 83.
e (Optional) Display and fine-tune the WiFi inventory.
See Display or Change the WiFi Inventory for an RF Plan on page 84.
e (Optional) Download the report.
See Download a Report for an RF Plan on page 87.

After you install or move the physical access points and antennas according to the RF plan
for a floor, deploy the floor plan by placing the virtual access points at the virtual locations on
the floor map to match the actual physical locations of the physical access points on the floor
as closely as possible. Doing so enables you to generate a realistic heat map for the
deployed floor plan.

For more information, see View the Heat Map for a Deployed Floor Plan on page 88.

Manage a Building and Floors for an RF Plan

This section describes how you can define a building and floors and make modifications after
you define them.

Defining a floor includes the following main tasks:

e Uploading a custom floor map and setting dimensions (see Add a Building and Floors on
page 57)

e If you do not set dimensions, scaling the floor (see Scale a Floor on page 60)

e Adding WiFi coverage zones and WiFi noncoverage zones (see Add a WiFi Coverage or
WiFi Noncoverage Zone to a Floor on page 61)

e Adding WiFi building obstacles (see Add a WiFi Building Obstacle to a Floor on page 62)
* Adding WiFi obstruction areas (see Add a WiFi Obstruction Area on page 65)
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Add a Building and Floors

The wireless controller includes a default building and default floor with a default floor map.
You cannot remove the default building or default floor but you can replace the default floor
map with a custom floor map.

You can add up to 30 buildings, each of which can include up to 20 floors. However, the total
number of floors that the wireless controller can support is 128.
> To add and define a building and floors:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Plans > Planning.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

# [ Building-1(1/10)

5. To add a building, in the building tree on the left, click the Add Building icon.
The Add Building pop-up window displays.

6. Enter a name for the building and click the Confirm button.
7. In the building tree, click the + icon of the building that you added.
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The Floor-1 name displays. This default floor name was added automatically when you
added the building.

8. Click Floor-1.

The default floor map displays. This default floor map was added automatically when you
added the building.

9. To add a custom floor map, click the Add Floor icon.

E‘-E: Add Floor Map B

Floor Plan Information

Name:

Select a map from local machine(format *.png,*.jpg,*.gif):

Browse...

Floor Plan Dimensions:

O] None

() Width(X): = v

| Length(Y): = v

L hd

You can leave the Dimension blank, and use the scale map tool to set the
Dimension later!

v |28 Cancel |

10. Define the floor:
a. Enter a name for the floor.

b. Upload a custom floor map by clicking the Browse button, following the directions of
your browser to navigate to a floor map, and selecting the floor map.

You can upload a planin .png, - jpg, or .gif format.

c. To either specify the floor width or the floor length, do the following:

e To specify the floor width, click the Width(X) button, select Meter or Feet from the
menu, and enter the floor width.

» To specify the floor length, click the Length(Y) button, select Meter or Feet from
the menu, and enter the floor length.

Note: If you do not want to enter the length or width or the information is not
available, you can scale the floor later (see Scale a Floor on page 60).

d. Click the Confirm button.
The floor map is uploaded and displays onscreen.
11. Click the Save |®] icon.
Your settings are saved.

12. To add another floor and floor map, repeat Step 9 through Step 11.
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Add a Single Floor to a Building

You can add a single floor to an existing building.

To add a single floor to a building:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

4. Select Plans > Planning.
The page displays the Planning icons.

5. In the building tree on the left, click the name of the building to which you are adding a floor.

6. Click the Add Floor [ icon.

E{__ Add Floor Map B =X
Floor Plan Information
Name:
Select a map from local machine(format *.png,*.jpg,*.gif):
Browse...
Floor Plan Dimensions:
(=) None
() Width(X): = v
() Length(Y): = v
You can leave the Dimension blank, and use the scale map tool to set the
Dimension later!
v % concel |

7. Define the floor:
a. Enter a name for the floor.

b. Upload a custom floor map by clicking the Browse button, following the directions of
your browser to navigate to a floor map, and selecting the floor map.

You can upload a plan in .png, - jpg, or .gif format.

c. To either specify the floor width or the floor length, do the following:

» To specify the floor width, click the Width(X) button, select Meter or Feet from the
menu, and enter the floor width.
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« To specify the floor length, click the Length(Y) button, select Meter or Feet from
the menu, and enter the floor length.

Note: If you do not want to enter the length or width or the information is not
available, you can scale the floor later (see Scale a Floor on page 60).

d. Click the Confirm button.

The floor map is uploaded and displays onscreen.

8. Click the Save [¥] icon.

Your settings are saved.

Scale a Floor

If you did not specify the floor width or floor length while adding a new floor (see Add a
Building and Floors on page 57 or Add a Single Floor to a Building on page 59), you can do
so by scaling the floor. You must know the distance in meters or feet between two known
points on the floor.

To scale afloor:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Plans > Planning.
The page displays the Planning icons.
5. In the building tree on the left, click the + icon of the building that contains the floor.
The floor names display.
6. Click the floor name.

The floor map displays.

7. Click the Scale [_] icon.

Select a line between two points on the map by anchoring the line at one point and releasing
the line at the other point.

The points do not need to cover the entire length or width of the floor.

The Scale Map pop-up window opens.
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9. Select Meter or Feet from the menu and enter the distance between the two points.
10. Click the Confirm button.

The floor map is scaled.

11. Click the Save [H] icon.

Your settings are saved.

Add a WiFi Coverage or WiFi Noncoverage Zone to a Floor

A WiFi coverage zone on a floor is an area in which access points must provide WiFi
coverage. A WiFi noncoverage zone on a floor is an area in which access points do not need
to provide WiFi coverage, for example, a storage area.

Note: Before you add a WiFi coverage or WiFi noncoverage zone, first define
the floor dimensions (see Add a Single Floor to a Building on page 59)
or scale the floor (see Scale a Floor on page 60).
To add a WiFi coverage or WiFi noncoverage zone to a floor:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Plans > Planning.
The page displays the Planning icons.
5. In the building tree on the left, click the + icon of the building that contains the floor.
The floor names display.
6. Click the floor name.

The floor map displays.

7. Click the Zone |£] icon.
Click either the Coverage Zone icon or the Non-AP Zone icon.

9. Anchor a rectangle at one point on the floor map and define the WiFi coverage zone or the
zone in which you do not need WiFi coverage.

10. To remove the zone, click the Undo link, and repeat Step 7 though Step 9.
11. Click the Save |®| icon.
Your settings are saved.
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12. To add another zone, repeat Step 7 though Step 11.

Remove a WiFi Coverage or Noncoverage Zone From a Floor

After you add and save a WiFi coverage or noncoverage zone on a floor, you can remove it
from the floor.

To remove a WiFi coverage area or WiFi noncoverage zone from a floor:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
Click the Login button.
The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Plans > Planning.
The page displays the Planning icons.
5. In the building tree on the left, click the + icon of the building that contains the floor.
The floor names display.
6. Click the floor name.

The floor map displays.

Click the Zone [Z] icon.
Click the zone on the map.
9. Click the Delete link.
10. Click the Save |®] icon.
Your settings are saved.

11. To remove another zone, repeat Step 7 though Step 10.

Add a WiFi Building Obstacle to a Floor

WiFi building obstacles can be any of the following predefined obstacles with their predefined
attenuation factor (WiFi signal loss) in dB or a custom defined building obstacle:

Drywall (4 dB)

e Wood wall (4 dB)
e Plastic wall (4 dB)
* Glass wall (8 dB)

* Brick wall (8 dB)
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* Concrete wall (12 dB)
* Light door (4 dB)

* Metal door (11 dB)

e Heavy door (15 dB)

e Thin window (2 dB)

e Thick window 4 dB)

These obstacles contribute to the WLAN signal degradation based on their construction
materials and interferences.

Note: Before you add a building obstacle, first define the floor dimensions (see
Add a Single Floor to a Building on page 59) or scale the floor (see Scale
a Floor on page 60).

To add a WiFi building obstacle to a floor:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
Click the Login button.
The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Plans > Planning.
The page displays the Planning icons.
5. In the building tree on the left, click the + icon of the building that contains the floor.
The floor names display.
6. Click the floor name.
The floor map displays.

7. Click the Obstacle [£] icon.
Take one of the following actions:
e Select the icon for one of the predefined obstacles.
e Define a custom obstacle:
a. Click the Add Obstacle Type link.
The Add New Obstacle Type pop-up window opens.

Enter a name.

Enter the attenuation factor in dB.
Select a color.

Click the Confirm button.

® o o o
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f. Click the Obstacle |[£] icon.
g. Select the icon for the custom obstacle that you just added.

Select a line between two points on the map by anchoring the line at one point and releasing
the line at the other point.

To remove the obstacle, click the Undo link, and repeat Step 7 though Step 9.
Click the Save [8] icon.
Your settings are saved.

To add another obstacle repeat Step 7 though Step 11.

Remove a Building Obstacle From a Floor

After you add and save a WiFi building obstacle on a floor, you can remove it from the floor.

To remove a WiFi building obstacle from a floor:

1.

10.

11.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.

Select Plans > Planning.

The page displays the Planning icons.

In the building tree on the left, click the + icon of the building that contains the floor.

The floor names display.

Click the floor name.

The floor map displays.

Click the Obstacle [£] icon.

Click the obstacle on the map.
Click the Delete link.

Click the Save 9] icon.
Your settings are saved.

To remove another obstacle, repeat Step 7 though Step 10.
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Add a WiFi Obstruction Area

WiFi obstructions areas can be any of the following predefined areas:

Cubicle office area

Closed office area

Elevator shaft

Warehouse stock with low density
Warehouse stock with medium density
Warehouse stock with high density

These areas contribute to the WLAN signal degradation based on openness (or lack thereof)
and interferences.

Note: Before you add a WiFi obstruction area, first define the floor dimensions
(see Add a Single Floor to a Building on page 59) or scale the floor (see
Scale a Floor on page 60).

To add a WiFi obstruction area to a floor:

1.

10.

11.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

Select Plans > Planning.

The page displays the Planning icons.

In the building tree on the left, click the + icon of the building that contains the floor.

The floor names display.

Click the floor name.

The floor map displays.

Click the Area |"] icon.

Anchor a rectangle at one point on the floor map and define the WiFi obstruction area.
To remove the area, click the Undo link, and repeat Step 7 and Step 8.

Click the Save [H¥] icon.
Your settings are saved.

To add another area, repeat Step 7 though Step 10.
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Remove a WiFi Obstruction Area

After you add and save a WiFi obstruction area on a floor, you can remove it from the floor.

» To remove a WiFi obstruction area from a floor:

1.

10.

11.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Plans > Planning.

The page displays the Planning icons.

In the building tree on the left, click the + icon of the building that contains the floor.

The floor names display.

Click the floor name.

The floor map displays.

Click the Area | | icon.

Click the area on the map.
Click the Delete link.

Click the Save [8] icon.
Your settings are saved.

To remove another area, repeat Step 7 though Step 10.

Change the Name, Map, or Dimensions of a Floor

You can change the basic properties of a floor, including those for the default floor.

» To change the name, map, or dimensions of a floor:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.
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The wireless controller’'s web management interface opens and displays the Summary
page.

4. Select Plans > Planning.
The page displays the Planning icons.

5. In the building tree on the left, click the + icon of the building that contains the floor.
The floor names display.

6. Click the floor name.

The floor map displays.

7. Click the Edit [ icon.
A pop-up window opens and displays information about the floor plan.

8. Change the name or dimensions of the floor, upload another floor map, or perform a
combination of these actions.

For more information about the floor settings, see Add a Single Floor to a Building on
page 59.

9. Click the Confirm button.

Your settings are saved.

Change the Name of a Building

You can change only the name of a building, including the name of the default building. All
other building properties are defined through the floors and the floor plans.
To change the name of a building:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

4. Select Plans > Planning.

The page displays the Planning icons.
5. In the building tree on the left, click the building name.
6. Click the Edit [Ig icon.

A pop-up window opens.
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Change the name.
Click the Confirm button.

Your settings are saved.

Duplicate an Entire Building With All Floors

You can duplicate an entire building with all floors and floor plans, including all floor
definitions. For information about duplicating a single floor in a building, see Duplicate a
Single Floor on page 68.

To duplicate an entire building with all floors:
1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

Select Plans > Layout.

The page displays the Planning icons.

In the building tree on the left, click the building name.

Click the Duplicate [ icon.

A pop-up window opens.

Enter a name for the new building.

Click the Confirm button.

The new building and floor or floors are added in the building tree.

Duplicate a Single Floor

You can duplicate a single floor and floor plan, including the floor definition. For information
about duplicating an entire building with all floors, see Duplicate an Entire Building With Al
Floors on page 68.

» To duplicate a single floor:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
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The wireless controller’s login window opens.

Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Plans > Layout.

The page displays the Planning icons.

In the building tree on the left, click the + icon of the building that contains the floor.

The floor names display.

Click the floor name.

The floor map displays.

Click the Duplicate [ icon.

A pop-up window opens.

Specify a name for the floor and select a building:
a. Enter a name for the new floor.

b. From the Workspace tree, select the building to which you want to add the new floor.
c. Click the Confirm button.

The new floor is added to the building.

Remove a Single Floor

You can remove a single floor from a building. However, you cannot remove the default floor
of the default building.

To remove a single floor:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Plans > Layout.

The page displays the Planning icons.

In the building tree on the left, click the + icon of the building that contains the floor.
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The floor names display.
6. Click the floor name.

The floor map displays.
7. Click the Trashcan [g] icon.
8. Confirm the removal.

The floor is removed.

Remove an Entire Building With All Its Floors

You can remove an entire building with all its floors. However, you cannot remove the default
building.
» To remove an entire building:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Plans > Layout.
The page displays the Planning icons.
5. In the building tree on the left, click the building name.

6. Click the Trashcan fz§ icon.
7. Confirm the removal.

The building with all its floors is removed.

Use the WiFi Auto Planning Advisor to Generate an RF Plan
for a Floor

After you define a building and floors (see Manage a Building and Floors for an RF Plan on
page 56), you can run the WiFi auto planning advisor for a floor. This tool calculates the
number of access points and, optionally, antennas that you might need to provide WiFi
coverage for your environment and suggests the best locations on the floor for these access
points and antennas.
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The WiFi auto planning advisor bases its calculations on the building and floor definitions and
lets you enter the following parameters to determine the WiFi coverage for your environment:
* NETGEAR access point (see Supported NETGEAR Access Points on page 27)
e NETGEAR antenna (see Supported NETGEAR Antennas on page 30)
» For each WiFi band of a selected access point, the following parameters:
- 802.11 protocol (depending on the access point, 802.11b/g/n, 802.11a/n/ac, or both)
- Transmit power (from minimum power to full power)

Note: The antenna gain and maximum number of supported clients for a
selected access point are set automatically.

» Percentage of expected WiFi coverage (from 10 percent to 100 percent)

e The minimum required signal strength (from —95 dBm to —30 dBm)
The signal strength determines the automatic channel allocation and automatic
transmission power of the access points.

e The WiFi band (2.4 GHz or 5 GHz)

e The maximum number of clients that must be supported on the floor

For you to determine the expected financial investment, the WiFi auto planning advisor also

lets you enter a price for the selected access point and a price for the selected antenna.

Whether or not you enter a price, the WiFi auto planning advisor generates an inventory list.
For more information, see Display or Change the WiFi Inventory for an RF Plan on page 84.

The WiFi auto planning advisor creates a heat map for the 2.4 GHz band, the 5 GHz band, or
for both bands. To optimize the WLAN network coverage and throughput for your RF plan,
you can manually fine-tune the placement of access points and antennas on the floor map.

For more information about adding and managing access points and antennas on a floor
map, see the following sections:

e Manually Add and Manage Access Points on a Floor Map for an RF Plan on page 76
e Manually Add and Manage Antennas on a Floor Map for an RF Plan on page 79

A WARNING:

For each floor, you can save one floor map only. When you run the
WiFi auto planning advisor for a floor, the advisor removes all
previously placed access points and antennas from the floor map.
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> To run the WiFi auto planning advisor and generate an RF plan and heat map for a
floor:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

Select Plans > Planning.

The page displays the Planning icons.

In the building tree on the left, click the + icon of the building that contains the floor.

The floor names display.

Click the floor name.

The floor map displays.

Click the Advisor |®| icon.

Y Auto-placement for Assigned AP/Antenna

¢ The advisor will clear all APs and antennas on this Floor map and provide an auto planning advisory for you.

Select AP and External Antenna Models for Planning

AP Model WNDAPS60 Browse... Antenna Model Browse...
Price($) 0 L,:.,' L7} Price($) 0 l_:L' L7]
2.4G 5G
AP Protocol | 802.11b/g/n ¥
Transmit Power (dBm) | HALF(1/2) v L]
Antenna Gain (dBi) 5
Client Support 128

Criteria of Auto-placement
Wi-Fi Coverage Percentage (82%) 10 {1 100 Band | 2.4G v |
Minimum Signal Strength (-52dBm) 95 =——{lf— -30 Maximum Client Support

| o Start Calculation |
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8. Specify the WLAN requirements for the floor as described in the following table.

Setting

Description

Select AP and External Antenna for Planning

AP Model

Specify the access point that you intend to use for the floor:
1. Click the Browse button.
The access points that the wireless controller supports display in a pop-up window.
2. Click the access point.
All calculations are performed with the selected access point.
3. Click the Confirm button.
Your settings are saved and the pop-up window closes.

Price($)

As an option, enter the price of the access point.

2.4G

For the 2.4 GHz band, specify the transmission power in dBm for the access point.
From the Transmit Power (dBm) menu, select FULL, HALF(1/2), QUARTER(1/4),
EIGHT(1/8), or MINIMUM(1/16). The default setting is HALF(1/2).

Note: When you select an access point, the AP Protocol, Antenna Gain (dBi), and
Client Support fields are populated automatically.

5G

If the selected access point supports the 5 GHz band, specify the transmission power in
dBm for the access point.

From the Transmit Power (dBm) menu, select FULL, HALF(1/2), QUARTER(1/4),
EIGHT(1/8), or MINIMUM(1/16). The default setting is HALF(1/2).

Note: When you select an access point, the AP Protocol, Antenna Gain (dBi), and
Client Support fields are populated automatically.

Antenna Model

Specify the antenna that you intend to use for the floor:
1. Click the Browse button.

The antennas that the wireless controller supports for the selected access point
display in a pop-up window.

2. Click the antenna.

All calculations are performed with the selected antenna.
3. Click the Confirm button.

Your settings are saved and the pop-up window closes.

Price($)

As an option, enter the price of the antenna.
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Setting

Description

Criteria of Auto-p

lacement

Wi-Fi Coverage
Percentage

Move the slider to the required WiFi coverage. The minimum coverage is 10 percent;
The maximum coverage is 100 percent.

Base the WiFi coverage on the following components:

e The required bandwidth for each connection in the covered area
* The required aggregated throughput for the covered area

* The required aggregated bandwidth for the covered area

A small area allows you better coverage control than a large area. You might need to
set the WiFi coverage percentage for the 2.4 GHz and 5 GHz bands separately.

Note: To prevent packet loss and allow for seamless roaming between covered areas,
configure moderate overlap of the covered areas and make sure that access points in
overlapping areas do not use the same channels.

Minimum Signal

Move the slider to the minimum required signal strength. The maximum signal quality is

Strength —30 percent; The minimum signal quality is —95 percent.
The required signal strength for good coverage depends on the type of WiFi devices
and applications in the network. The edge of a coverage area for an access point is
based on the signal strength and signal-to-noise ratio (SNR), measured as a WiFi
device moves away from the access point.
Note: For voice applications, We recommend a minimum WiFi signal strength of
-67 dBm and a minimum SNR of 25 dB.

Band From the Band menu, select 2.4G or 5G.

If the selected access point does not support the 5 GHz band, the menu selection is
automatically set to 2.4G.

Maximum Clients
Supported

Enter the total number of clients that must be supported simultaneously on the floor.

9. Click the Start Calculation button.

The WiFi auto planning advisor starts its calculations, displays the progress in a pop-up
window, and generates a heat map.
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The WiFi auto planning advisor generates a heat map that suggests the required number
of access points (15 in the figure) and the locations on the floor map to achieve the
optimum WiFi coverage that is based on the WLAN requirements that you specified (see
Step 8).

To see the signal strength at a location on the floor map, point to the location (-44dBm at
the location in the figure).

To switch the heat map to the 2.4 GHz or 5 GHz band, on the right, click the Band | 8| icon.

The Band icon displays 2.4G if the heat map for the 2.4 GHz band is shown. The Band
icon displays 5G if the heat map for the 5 GHz band is shown.

To move an access point to another location on the floor map, drag the access point to a
location on the floor map.

Note: Moving an access point turns off the heat map.

To move an antenna to another location on the floor map, drag the antenna to a location on
the floor map.

Note: Moving an antenna turns off the heat map.

To regenerate the heat map, on the right, click the HeatMap icon.

The heat map is generated and displays. Use the color information on the right as
guidance for WiFi coverage.

To show the map with or without grid, on the right side, click the Grid icon.

To show the access points by model or without a label, on the right side, click the Label
icon and select your preference.
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By default, the access point name is shown. Because this section describes an RF plan
that is not yet deployed, the IP address and channel cannot be displayed on the map.

17. To save the floor map with its new configuration, click the Save |8 icon.

The settings are saved.

Manually Add and Manage Access Points on a Floor Map
for an RF Plan

You can add individual access points to a floor map for an RF plan. These access points do
not need to be of the same model. After adding access points, you can change their
properties, move them to another location on the floor map, or remove them from the floor
map.

Note: Before you add any access points to a floor plan, first define the floor
dimensions (see Add a Single Floor to a Building on page 59) or scale
the floor (see Scale a Floor on page 60) and define the WiFi coverage
zone (see Add a WiFi Coverage or WiFi Noncoverage Zone to a Floor
on page 61).

» To manually add and manage individual access points on a floor map for an RF plan:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Plans > Planning.
The page displays the Planning icons.

5. In the building tree on the left, click the + icon of the building that contains the floor.
The floor names display.

6. Click the floor name.

The floor map displays.

7. Click the AP [Z] icon.
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AP Name *

Price(s)

AP Type

2.4G 5G

Enable

Channel

Transmit Power (dBm)

AP-16 AP Model WNDAPEE0 Browse...
30 = @ IP Address
Concurrent Dual Band Description
(&) On () Off
Auto v | Protocol | 802.11b/g/n v
HALF(1/2) v| @& Antenna Gain (dBi) 5
| o Confirm | | ¥ Cancel |

Specify the access point settings as described in the following table.

Setting

Description

AP name

Enter a name for the access point.
By default, the access points are numbered, for example, AP-16.

AP Model

Specify the access point that you intend to use for the floor:
1. Click the Browse button.
The access points that the wireless controller supports display in a pop-up window.
2. Click the access point.
All calculations are performed with the selected access point.
3. Click the Confirm button.
Your settings are saved and the pop-up window closes.

Price($)

As an option, enter the price of the access point.

IP Address

As an option, enter the IP address of the access point.

Note: If your network uses a DHCP server and a deployed access point receives an IP
address automatically, you can enter any IP address. If you intend to assign a static IP
address to a deployed access point, enter the IP address that you want to set aside for
the access point.

AP Type

When you select an access point, this field is populated automatically.

Description

As an option, enter a description for the access point.
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Setting Description

2.4G Specify the settings for the 2.4 GHz band:

* Enable. By default, the On radio button is selected and the 2.4 GHz band is
enabled. To disable the 2.4 GHz band, select the Off radio button.

» Channel. Leave the default selection Auto to enable the access point to select a
channel automatically, or select a specific channel from the menu.

» Protocol. When you select an access point, this field is populated automatically.

e Transmission Power (dBm). From the menu, select FULL, HALF(1/2),
QUARTER(1/4), EIGHT(1/8), or MINIMUM(1/16). The default setting is HALF(1/2).

* Antenna Gain (dBi). When you select an access point, this field is populated
automatically.

5G If the selected access point supports the 5 GHz band, specify the settings for the 5 GHz

band:

« Enable. By default, the On radio button is selected and the 5 GHz band is enabled.
To disable the 5 GHz band, select the Off radio button.

« Channel. Leave the default selection Auto to enable the access point to select a
channel automatically, or select a specific channel from the menu.

» Protocol. When you select an access point, this field is populated automatically.

* Transmission Power (dBm). From the menu, select FULL, HALF(1/2),
QUARTER(1/4), EIGHT(1/8), or MINIMUM(1/16). The default setting is HALF(1/2).

e Antenna Gain (dBi). When you select an access point, this field is populated
automatically.

9. Click the Confirm button.
Your settings are saved and the pop-up window closes.
The new access point is placed at the top of the floor map.

10. Move the access point to the desired location on the floor map by dragging the access point
to a location on the floor map.

11. To change the properties for an access point, do the following:
a. Double-click the access point.

A pop-up menu displays.
b. From the pop-menu, select Edit Properties.

The Edit AP pop-up window opens. This window is identical to the Add AP pop-up
window.

c. Change the properties.
For information about the properties, see the previous table.
d. Click the Confirm button.
Your settings are saved and the pop-up window closes.
12. To remove an existing access point from the floor map, do the following:

a. Click the access point to select it.
b. Click the Delete link.
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13. To add another access point to the floor map, change the properties for another access
point, move another access point on the floor map, remove another access point from the
floor map, or perform a combination of these tasks, repeat Step 7 through Step 12.

14. To turn the heat map on or off, on the right, click the HeatMap icon.

If you turn on the heat map, the heat map is generated and displays. Use the color
information on the right as guidance for WiFi coverage.

Note: Adding or removing access points changes the heat map.

15. To switch the heat map to the 2.4 GHz or 5 GHz band, on the right, click the Band icon.

The Band icon displays 2.4G if the heat map for the 2.4 GHz band is shown. The Band
icon displays 5G if the heat map for the 5 GHz band is shown.

16. To show the map with or without grid, on the right side, click the Grid icon.

17. To show the access points by model or without a label, on the right side, click the Label
icon and select your preference.

By default, the access point name is shown. Because this section describes an RF plan
that is not yet deployed, the IP address and channel cannot be displayed on the map.

18. To save the floor map with its new configuration, click the Save ¥ icon.

The settings are saved.

Manually Add and Manage Antennas on a Floor Map for an
RF Plan

You can add individual antennas to a floor map for an RF plan. These antennas do not need
to be of the same model. After adding antennas, you can change their properties, move them
to another location on the floor map, or remove them from the floor map.

Note: Antennas are associated with access points. Therefore, before you
add antennas to a floor plan, first add access points to the floor plan.
For more information about adding access points to a floor plan, see
Use the WiFi Auto Planning Advisor to Generate an RF Plan for a
Floor on page 70 and Manually Add and Manage Access Points on a
Floor Map for an RF Plan on page 76.
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> To manually add and manage individual antennas on a floor map for an RF plan:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Plans > Planning.
The page displays the Planning icons.
5. In the building tree on the left, click the + icon of the building that contains the floor.
The floor names display.
6. Click the floor name.
The floor map displays.
7. Click an access point to select it.
8. Click the Antenna [] icon.

Note: The Antenna m icon is masked if you do not select an access point.

;) Add Antenna BE
Name * Antenna-1 Model ANT224D10 | Browse...
Type Directional | Angle(0) | Price($) 10 Ii’ 7]
Description
2.4G
Enable (s) On () OFf

Antenna Gain (dBi) 10

Antenna Pattern

e
r
- IR

Horizontal Vertical

L « Confirm | | # Cancel |
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9. Specify the antenna settings as described in the following table.

Setting Description

Name Enter a name for the antenna.
By default, the access points are numbered, for example, Antenna-1.

Model Specify the antenna that you intend to use for the floor:
1. Click the Browse button.
The antennas that the wireless controller supports display in a pop-up window.
2. Click the antenna.
All calculations are performed with the selected antenna.
3. Click the Confirm button.
Your settings are saved and the pop-up window closes.

AP Type When you select an antenna, this field is populated automatically.

Angle When you add a directional antenna, by default, the antenna points to the north. You
can set the antenna direction to a desired angle.

Specify the antenna angle:

1. Click the Browse button.
A degree clock displays in a pop-up window.

2. Click the degree at which you want to direct the antenna.
The yellow needle moves to the selected degree.

3. Click the Confirm button.
Your settings are saved and the pop-up window closes.

Price($) As an option, enter the price of the antenna.
Description As an option, enter a description for the access point.
2.4G Specify the settings for the 2.4 GHz band:

* Enable. By default, the On radio button is selected and the 2.4 GHz band is
enabled for the antenna. To disable the 2.4 GHz band for the antenna, select the
Off radio button.

* Antenna Gain (dBi). When you select an antenna, this field is populated
automatically.

* Antenna Pattern. When you select an antenna, this field is populated
automatically.

10. Click the Confirm button.
Your settings are saved and the pop-up window closes.

The new antenna is placed at the edge of the floor map and shows a connection with the
access point.

11. To move an antenna to another location on the floor map, drag the antenna to a location on
the floor map.

Note: Moving an antenna turns off the heat map.
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To change the properties for an antenna, do the following:
a. Double-click the antenna.

A pop-up menu displays.
b. From the pop-menu, select Edit Properties.

The Edit Antenna pop-up window opens. This window is identical to the Add Antenna
pop-up window.

c. Change the properties.

For information about the properties, see the previous table.
d. Click the Confirm button.

Your settings are saved and the pop-up window closes.

To remove an existing antenna from the floor map, do the following:
a. Click the antenna to select it.
b. Click the Delete link.

To add another antenna to the floor map, change the properties for another antenna, move
another antenna on the floor map, remove another antenna from the floor map, or perform a
combinations of these tasks, repeat Step 7 through Step 13.

To turn the heat map on or off, on the right, click the HeatMap icon.

If you turn on the heat map, the heat map is generated and displays. Use the color
information on the right as guidance for WiFi coverage.

Note: Adding or removing antennas changes the heat map.

To switch the heat map to the 2.4 GHz or 5 GHz band (for antennas that support dual
bands), on the right, click the Band icon.

The Band icon displays 2.4G if the heat map for the 2.4 GHz band is shown. The Band
icon displays 5G if the heat map for the 5 GHz band is shown.

To show the map with or without grid, on the right side, click the Grid icon.

To show the antennas by model or without a label, on the right side, click the Label icon
and select your preference.

By default, the antenna name is shown. The IP address and channel do not apply to an
antenna.

To save the floor map with its new configuration, click the Save |8 icon.

The settings are saved.
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Display and Recalculate the WiFi Coverage for a Heat Map

After you set up an RF plan and generate a heat map for a floor, you can display the WiFi
coverage and view how the WiFi coverage changes if you change the minimum signal
strength with the same number of access points and antennas.

The default minimum signal strength is —62 dBm. The WiFi coverage percentage is
calculated based on this value. You can change this value and recalculate the coverage
percentage. However, to change the minimum signal strength for an RF plan, you must run
the WiFi auto planning advisor again (see Use the WiFi Auto Planning Advisor to Generate
an RF Plan for a Floor on page 70).

Note: The WiFi coverage tool is for display and information only. However,
heat maps can function in realtime.

> To display and recalculate the WiFi coverage for an existing heat map:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Plans > Planning.
The page displays the Planning icons.
5. In the building tree on the left, click the + icon of the building that contains the floor.
The floor names display.
6. Click the floor name.

The floor map displays.

7. On the right, click the HeatMap icon.

The heat map for the 2.4 GHz band is generated and displays. Use the color information
on the right as guidance for WiFi coverage.

8. To generate the heat map for the 5 GHz band, on the right, click the Band icon.

The heat map for the 5 GHz band is generated and displays. Use the color information on
the right as guidance for WiFi coverage.

9. Click the Coverage [£] icon.
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Note: The Coverage icon is masked if you did not generate a heat map.

") Wi-Fi Coverage

Minimum Signal Strength (-62dBm) -95 1; -30
Total Number of AP 17

Total Number of Antenna 3

Wi-Fi Coverage Percentage (%) 100%

| & Re-Calculate | | « OK |

The Total Number of AP and Total Number of Antenna fields are based on the RF plan
and fixed. The Wi-Fi Coverage Percentage (%) field displays the WiFi coverage based
on the position of the Minimum Signal Strength slider at -62dBm.

10. Move the position of the Minimum Signal Strength slider to another dBm value.
11. Click the Re-Calculate button.

The Wi-Fi Coverage Percentage (%) field displays the WiFi coverage based on the new
dBm value.

12. Click the OK button.
The pop-up window closes.

If you want to change the actual minimum signal strength for an RF plan, run the WiFi
auto planning advisor again (see Use the WiFi Auto Planning Advisor to Generate an RF
Plan for a Floor on page 70).

Display or Change the WiFi Inventory for an RF Plan

The inventory for an RF plan of a floor displays all access points and antennas that you
added by running the WiFi auto planning advisor, the access points and antennas that you
added manually, or a combination of both.

> To display or change the access point and antenna inventory for an RF plan:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Plans > Planning.
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The page displays the Planning icons.

5. In the building tree on the left, click the + icon of the building that contains the floor.
The floor names display.

6. Click the floor name.
The floor map displays.

7. Click the Inventory [_] icon.

7 Inventory

[ig Edit Properties @ Delete Item
AP List Antenna List
I B T R R C T
AP-1 WNDAPSSD 246G 802.11b/g/n(2.4G) Auto(2.4G) £4495 =
5G 802.11a/n(5G) Auto(5G) [
2 | AP-10 WNDAPEEO 2.4G 802.11b/g/n(2.4G) Auto(2.4G) $405 |
5G 802.11a/n(5G) Auta(5G)
3 AP-11 WNDAPSE0 2.4G 802.11b/g/n(2.4G) Auto(2.4G) $495
5G 802.11a/n(5G) Auto(5G)
4 | AP-12 WNDAPS60 2.4G 802.11b/g/n(2.4G) Auto(2.4G) £495
5G 802.11a/n(5G) Auto(5G)
5 AP-13 WNDAPSE0 2.4G 802.11b/g/n(2.4G) Auto(2.4G) £495 lL
¥ OK |

By default, the AP List tab is selected and the access point inventory displays. The
inventory is based on the access points that you added by running the WiFi auto planning
advisor (see Use the WiFi Auto Planning Advisor to Generate an RF Plan for a Floor on
page 70), the access points that you added manually (see Manually Add and Manage
Access Points on a Floor Map for an RF Plan on page 76), or a combination of both.

8. To change the properties for an access point in the inventory, do the following:
a. Select the access point in the inventory table.
b. Click the Edit Properties button.

The Edit AP pop-up window opens.
c. Change the properties.

For more information about changing the properties, or for information about
removing an access point from the inventory, see Manually Add and Manage Access
Points on a Floor Map for an RF Plan on page 76.

d. Click the Confirm button.
Your settings are saved and the pop-up window closes.

9. On the Inventory pop-up window, click the Antenna List tab.
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) Inventory

[@ Edit Properties @ Delete Item
AP List Antenna List
m_m_m
Antenna-2 ANT224D10 © Directional 10dBi(2.4G) £290
2 Antenna-3 ANT2409 © omni-Directional 9dBi(2.4G) $155
3 | Antenna-4 ANT2409 © omni-Directional 9dBi(2.4G) $155

v ok

The inventory is based on the antennas that you added by running the WiFi auto planning
advisor (see Use the WiFi Auto Planning Advisor to Generate an RF Plan for a Floor on
page 70), the antennas that you added manually (see Manually Add and Manage
Antennas on a Floor Map for an RF Plan on page 79), or a combination of both.

10. To change the properties for an antenna in the inventory, do the following:
a. Select the antenna in the inventory table.
b. Click the Edit Properties button.

The Edit Antenna pop-up window opens.
c. Change the properties.

For more information about changing the properties, or for information about
removing an access point from the inventory, see Manually Add and Manage
Antennas on a Floor Map for an RF Plan on page 79.

d. Click the Confirm button.
Your settings are saved and the pop-up window closes.
11. On the Inventory pop-up window, click the OK button.

The Inventory pop-up window closes.

12. To save the inventory changes, click the Save |®] icon.

The settings are saved.
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Download a Report for an RF Plan

The report for an RF plan includes the following components:

Floor summary

Inventory summary that could serve as a purchase list

Detailed list of access points

Detailed list of antennas (if you added any manually)

Floor map with suggested locations of the access points and antennas
Heat map for the 2.4 GHz band

Heat map for the 5 GHz band

You can download the report as a PDF or a Microsoft Word file.

To generate and download a report for an RF plan:
1.

Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

Select Plans > Planning.

The page displays the Planning icons.

In the building tree on the left, click the + icon of the building that contains the floor.

The floor names display.

Click the floor name.

The floor map displays.
Click the PDF [£] icon or the Word [Z] icon.
The report downloads.

Follow the directions of your browser to save the report.
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View the Heat Map for a Deployed Floor Plan

For an RF plan, you can assign access points and antennas to a building and floor. However,
these access points and antennas are used only for the purpose of planning and are not
actual access points and antennas.

Access points display on the floor map of a deployed floor plan only if you assign them to the
building and floor. For information about assigning access point to a building and floor, see
Assign Access Points to Buildings, Floors, and Advanced Profile Groups on page 174.

A heat map lets you view in real time, by WiFi frequency band, the signal strength and WiFi
coverage for a floor of a building. The heat map shows the actual signal strengths that each
access point is detecting from neighbor access points.

IMPORTANT:

For the heat map to provide realistic information, do the following:

1. Scale the floor plan accurately.
2. Place the different types of obstacles accurately on the floor map.

3. Move each virtual access point to the virtual location on the floor
map that matches the actual physical location of the physical
access point on the floor as closely as possible.

The heat map displays the following information:
» Signal strength and WiFi coverage, including weak coverage areas and coverage holes,
indicated by color
* Access points that are managed by the wireless controller
e For each access point, the following real-time information:
- Status in relation to the wireless controller (for example, Connected)
- IP address
- MAC address
- For each WiFi band, the number of connected clients
- For each WiFi band, the active channel
- For each WiFi band, the transmission (output) power
» Information for each antenna
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» To move the access points and antennas to the correct locations on the floor map and
generate a realistic heat map for a deployed floor plan:

1.

7.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Plans > Heat Map.

The page displays the Planning icons.

In the building tree on the left, click the + icon of the building that contains the floor.

The floor names display.

Click the floor name.
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The first time that you view the heat map, move the access points manually on the floor
map to closely match their actual physical locations on the floor by dragging each access
point to the correct location on the floor map.

On the right, click the HeatMap icon.

The heat map for the 2.4 GHz band is generated and displays. Use the color information
on the right as guidance for WiFi coverage.
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9. To generate the heat map for the 5 GHz band, on the right, click the Band icon.

The heat map for the 5 GHz band is generated and displays. Use the color information on
the right as guidance for WiFi coverage.

10. To see the information about an individual access point or antenna, point to the location.

A pop-up field displays the information.
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11. To make adjustments to the WiFi coverage, drag the access points to new locations on the
floor map.

12. To regenerate the heat map, on the right, click the HeatMap icon.

The heat map is generated and displays. Use the color information on the right of the heat
map as guidance for WiFi coverage.

13. If you made changes to the WiFi coverage on the floor map in Step 11, move each physical
access point to the actual physical location on the floor that matches the virtual location of
the virtual access point on the floor map as closely as possible.

In other words, reverse the process that you accomplished in Step 7 and now make sure
that the actual placement on the floor matches the virtual placement on the floor map.
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Installation and Configuration
Overview

This chapter includes the following sections:

e Connect Your Computer to the Wireless Controller

e Log In to the Wireless Controller

e Roadmap for Initial Configuration

e Roadmap for Configuring Management of Your WiFi Network
* Choose a Location for the Wireless Controller

» Deploy the Wireless Controller
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Connect Your Computer to the Wireless Controller

To connect to the wireless controller for initial configuration, follow the steps in this section.
You can also download your model’s installation guide by visiting downloads.netgear.com.

» To connect your computer to the wireless controller:

1. Configure the computer with a static IP address of 192.168.0.210 and 255.255.255.0 as
the subnet mask.

2. Connect the wireless controller to the computer through the network or directly to the
wireless controller’'s Ethernet port.

3. Connect the power cord from the wireless controller to an AC power outlet.
4. Verify that the following LEDs on the front panel are lit:

LED Description

Power The green Power LED is lit. If the Power LED is not lit, check the connections and check to see
if the power outlet is controlled by a wall switch that is turned off.

Status The Status LED is lit yellow while the wireless controller is initializing. After approximately two
minutes, when the wireless controller completes its initialization, the Status LED turns green.

Fan The green Fan LED is lit, indicating that the fans are functioning correctly.

Ethernet | The right Ethernet port LED is lit green for a 1000 Mbps connection or yellow for a 100 Mbps or
10 Mbps connection. If it is not, make sure that the Ethernet cable is securely attached at both
ends.

Log In to the Wireless Controller

Before you log in to the wireless controller, make sure that you follow the steps in Connect
Your Computer to the Wireless Controller on page 92.

To log in to the wireless controller, you must use a web browser such as Microsoft Internet
Explorer, Mozilla Firefox, or Google Chrome with JavaScript, cookies, and SSL enabled.
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> To log in to the wireless controller:

1.

2.

3.

Open your browser and type http://192.168.0.250 in the browser’s address field.
NETGEAR WC9500

Connect with Innovation ™ i
ProSafe Wireless LAN Controller

lﬂ Help

Login

User Name
Password

LOGIMN

When prompted, enter admin for the user name and password for the password, both in
lowercase letters.

Click the Login button.

The first time that you log in, the Change Password Notification pop-up window opens.
Changing the password is optional.

Change Password Notification

Controller is using default ‘admin’ p d.

Do you want to change the password now?

NOW LATER

Click either the NOW button to change the password immediately or the LATER button to
change the password later.

Note: We recommend that you change the administrator password of the
wireless controller to a secure password. (For information about
changing the password later, see Change the Password of the Default
admin Account of the Wireless Controller on page 237). The
administrator password that you configure on the wireless controller is
also pushed to all managed access points.

If you click the LATER button, the following figure, Step 5, and Step 6 do not apply.
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Change Password

0ld Password .oo__ooooo
New Password

Confirm New Password

RESET APPLY

In the Old Password field, the old password is automatically entered.

5. In the New Password field, enter your new password and repeat it in the Confirm New
Password field.

Note: You cannot change the default user name (admin), but you can create
a new administrative account with a customized user name. For more
information, see Add a Management User on page 239.

6. Click the OK button.

The wireless controller’s web management interface opens and displays the Summary
page (the path is Monitor > Controller > Summary), which shows the network status
and related information:

NETGEAR WC9500
I PIDSG‘E Wilek” LAN cﬂnll’U"E'

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Controller | WLAN | Clients

Network Status 7 Wireless Clients 7 Controller Info

Usage
Access Point
Clients

Total | alarms Open | WEP | WPA | WPAZ Firmware Yersion 3.0.0.82_1116
I T I Controller Uptime S hours, 35 mins, 59 secs
Last Reboot Mon Apr & 11:29:00 2013

Device Up | Down | Critical 17 o o o

Access Points H o o L
MNeighboring Last Configuration Change Mon Apr & 16:52:10 2013

Clignt: 17 HA HA NA
Clients ante Last Channel Allocation Mon Apr & 15:33:00 2013

Heighbor AP Last Admin Login Mon Apr & 17:04:34 2013

Profiles
DHCP Le.
ase Most Active APs 3 Most Active Clients 7 Most Active SSIDs 3
Captive Portal :
osers | clients |l MAC | SSID | Usage(kaytes) [l ssio [Clients |

netgearB6ETAR  WHDAPSSO  Z0:de:7f:B6:eT:iald & Dok 17
9

REFRESH

For information about the network status and related information, see View the Wireless
Controller Summary Page on page 324.

Roadmap for Initial Configuration

After you connect and log in to the wireless controller, perform the initial configuration. If you
are not sure how you are going to deploy the wireless controller in your network, We
recommend that you read Chapter 3, System Planning and Deployment Scenarios.

This section is a roadmap for basic configuration only: It provides high-level configuration
steps with references to the sections or chapters that provide detailed configuration steps.
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> To perform the initial configuration of the wireless controller:

1.

10.

11.

12.

Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Configuration > System > General.
The General Settings page displays.

Enter a name for the wireless controller and select the country in which the wireless
controller is used.

Click the Apply button.

Your settings are saved.

Select Configuration > System > Time.
The Time Setting page displays.

Select the time zone in which the wireless controller is used. Optionally, configure the NTP
settings.

For more information, see Manage the Time Settings on page 101.
Click the Apply button.

Your settings are saved.

Select Configuration > System > IP/VLAN.

The IP Settings page displays.

Enter the IP settings for your network and the VLANS that you want to assign to the wireless
controller.

Note: A management VLAN is used for all SNMP and HTTP traffic to and
from the wireless controller and managed access points.

Note: Clearthe Untagged VLAN check box only if the hubs and switches in
your network support the VLAN (802.1Q) standard. Likewise, change
the untagged VLAN value only if the hubs and switches in your network
support the VLAN (802.1Q) standard.

For more information, see Manage the IP, VLAN, and Link Aggregation Settings on
page 102.

Click the Apply button.
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13.

14.

15.

16.
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Your settings are saved.

If your network does not include a DHCP server, configure the wireless controller's DHCP
server.

For more information, see Manage the DHCP Server on page 106.
Click the Apply button.
Your settings are saved.

The connection to the wireless controller is terminated because you changed its IP
address.

Reconfigure your computer with an IP address and subnet mask that is in the same
IP subnet as the new IP address of the wireless controller.

Log back in to the wireless controller using its new IP address.

Continue with the following section, Roadmap for Configuring Management of Your WiFi
Network.

Roadmap for Configuring Management of Your WiFi
Network

After you perform the initial configuration and change the IP address to an address that is
specific to your network (see Roadmap for Initial Configuration on page 94), you are ready to
configure the wireless controller for management of your WiFi network.

This section is a roadmap only: It provides high-level configuration steps with references to
the sections or chapters that provide detailed configuration steps.

1.

To configure the wireless controller for management of your WiFi network:

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.

Register the licenses.

For more information, see Register Your Licenses on page 110.

(Optional but recommended) Replace the default certificate with a custom certificate for
certificate-based authentication of the internal authentication server.

For more information, see Manage Certificates on page 113.
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10.

11.

12.
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(Optional but recommended) Configure logs, alerts, and alarms.

For more information, see Configure Syslog, Alarm Notification, and Email Settings on
page 114.

Configure security profiles:

a. Configure the security profiles for the basic profile group or for advanced profile
groups.

For detailed configuration steps, see:

e Manage Security Profiles for the Basic Profile Group on page 124.

e Manage Security Profiles for Advanced Profile Groups on page 129.
b. (Optional) Configure authentication servers.

For more information, see Manage Authentication Servers and Authentication Server
Groups on page 140.

c. (Optional) Configure MAC authentication.

For more information, see Manage MAC Authentication and MAC Authentication
Groups on page 146.

d. (Optional) Assign the authentication servers and MAC ACLs to the security profiles.
For more information, see:
* Manage Security Profiles for the Basic Profile Group on page 124.
e Manage Security Profiles for Advanced Profile Groups on page 129.

Configure the managed access point list:
a. Run the Discovery Wizard and add access points to the managed list.

For more information, see Discover Access Points With the Discovery Wizard on
page 159.

b. (Optional) Configure access points that are on the managed list.
For more information, see Manage the Managed AP List on page 167.
c. (Optional) Assign access points to advanced profile groups.

For more information, see Assign Access Points to Buildings, Floors, and Advanced
Profile Groups on page 174.

(Optional) Configure rogue access point detection.
For more information, see Manage Rogue Access Points on page 219.
(Optional) Configure a guest portal or captive portal.

For more information, see Manage Guest Network Access Through Guest Portals and
Captive Portals on page 223.

(Optional) Configure user accounts and portal accounts.
For more information, see Manage Users, Accounts, and Passwords on page 236.

(Optional) Configure WiFi and QoS settings.
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For more information, see Chapter 9, Configure WiFi and QoS Settings.

13. (Optional but recommended) Back up the configuration.

For more information, see Back Up the Configuration File on page 254.

Choose a Location for the Wireless Controller

The wireless controller is suitable for use in an office environment where it can be
freestanding on its runner feet or mounted into a standard 19-inch equipment rack.
Alternatively, you can rack-mount the wireless controller in a wiring closet or equipment room.
A mounting kit, containing two mounting brackets and screws, is provided in the wireless
controller package.

Consider the following when deciding where to position the wireless controller:

L]

The unit is accessible and cables can be connected easily.

Cabling is away from sources of electrical noise. These include lift shafts, microwave
ovens, and air-conditioning units.

Water or moisture cannot enter the case of the unit.

Airflow around the unit and through the vents in the side of the case is not restricted.
Provide a minimum of 25 mm or 1 inch of clearance.

The air is as free of dust as possible.

Temperature operating limits are not likely to be exceeded. Install the unit in a clean,
air-conditioned environment. For information about the recommended operating
temperatures for the wireless controller, see Appendix B, Factory Default Settings,
Technical Specifications, and Passwords Requirements.

Deploy the Wireless Controller

After you follow the steps in Roadmap for Initial Configuration on page 94 and Roadmap for
Configuring Management of Your WiFi Network on page 96, you are ready to deploy the
wireless controller in your network.

2.
3.
4

To deploy the wireless controller:
1.

Disconnect the wireless controller from the computer that you used for configuration.
(Optional) Reconfigure the computer back to its original TCP/IP settings.
Place the wireless controller where you intend to deploy it.

Connect an Ethernet cable from the wireless controller to a switch or router on your wired
network.

Connect the power cord to the wireless controller and plug the power cord into a power
outlet.

The Power, Status, and Ethernet LEDs light. If any of these do not light, see Troubleshoot
Basic Functioning on page 361.
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Configure the System and Network
Settings and Register the Licenses

This chapter includes the following sections:

Configure the General Settings

Manage the Time Settings

Manage the IP, VLAN, and Link Aggregation Settings
Manage the DHCP Server

Register Your Licenses

Manage Certificates

Configure Syslog, Alarm Notification, and Email Settings
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Configure the General Settings

Note: You must select the correct country or region of operation. It might not
be legal to operate the access points in a country or region not shown
here. If your location is not listed, check with your local government
agency or check the NETGEAR website for more information about
which channels to use.

The General Settings page lets you configure the basic settings of your wireless controller.

» To configure general settings:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Configuration > System > General.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal
General Settings @

Time Name WC9S00MainBld

IP/¥YLAN Country/Region United States v

DHCP Server Controller Location Code Rack4_b_14

Certificates

Alerts/Logs

CANCEL APPLY
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5. Configure the settings as described in the following table.

Setting

Description

Name

Enter a unique value as the wireless controller name. We recommend changing the
name as soon as possible after setting up.

The name must contain only alphabetical characters, numbers, and hyphens, and must
be 31 characters or less.

Country/Region

From the menu, select the region of operation for the wireless controller and the access
points that the wireless controller manages.

This setting is crucial for optimal performance of the wireless controller. The wireless
controller uses the country code to determine the best WiFi settings for the access
points. In the United States, the country is preset and cannot be changed on the access
points. If the country or region is not set up correctly, the wireless controller might not
be able to access the access points.

Note: To enable the wireless controller to transmit at a higher power level than the level
that might be specified for your country or region, select Rest of World from the
Country/Region menu.

Controller
Location Code

Enter a code to identify the physical location of the wireless controller.
If you use more than one wireless controller, a code is especially useful.

WARNING:

If you change the selection from the Country/Region menu and you
click the Apply button, the wireless controller reboots.

6. Click the Apply button.

Your settings are saved.

Manage the Time Settings

This page lets you configure the time-related settings of your wireless controller and
managed access points.

» To configure time settings:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP

address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary

page.
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4. Select Configuration > System > Time.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal
B General Time Settings @
Time Zone USA-Pacific v
IE/¥LAN Current Time Thu Feb 14 13:28:41 PST 2013
DHCP Server NTP Client ® enable O disable
S Use Custom NTP Server

Alerts/fL
» Alerts/Logs Hostname/IP Address 192.168.0.238

5. Configure the settings as described in the following table.

Setting Description

Time Zone From the menu, select the local time zone for your country or region.

Current Time This field is a nonconfigurable field that displays the current time at your
location.

NTP Client Select the Enable radio button to use a Network Time Protocol (NTP) server to

synchronize the clock of the wireless controller and managed access points.
Select the Disable radio button if you do not want to use an NTP server.

Use Custom NTP Server | Select the Use Custom NTP Server check box if you want to use an alternate
NTP server. By default, the NETGEAR NTP server is used.

Hostname/IP Address Enter the host name or IP address of the NTP server, if you are using a custom
NTP server.

6. Click the Apply button.

Your settings are saved.

Manage the IP, VLAN, and Link Aggregation Settings

You can manage the IP address, VLAN settings, and link aggregation (LAG) settings of the
wireless controller.

Management VLAN Concepts

Management VLANS are used for all SNMP and HTTP traffic to and from the wireless
controller and managed access points.

For large deployments, we recommend that the wireless controller and access points are in
separate VLANS to ensure uninterrupted connectivity between the wireless controller and the
access points.

Configure the System and Network Settings and Register the Licenses

102



ProSAFE Wireless Controller

The wireless controller and access points share heartbeat messages to keep synchronized
and share configurations and client key data to facilitate seamless roaming.

Untagged VLAN Concepts

When the Untagged VLAN check box is selected on the IP Settings page, one VLAN can be
configured as an untagged VLAN:

e When the wireless controller sends frames associated with the untagged VLAN to the
LAN (Ethernet) interface, those frames do not carry an 802.1Q VLAN header.

* When the wireless controller receives untagged traffic from the LAN (Ethernet) interface,
those frames are assigned to the untagged VLAN.

If you clear the Untagged VLAN check box, the wireless controller tags all outgoing LAN
(Ethernet) frames, and accepts only incoming frames that are tagged with known VLAN IDs.

Note: Clear the Untagged VLAN check box only if the hubs and switches
on your LAN support the VLAN (802.1Q) standard. Likewise, change
the untagged VLAN value only if the hubs and switches on your LAN
support the VLAN (802.1Q) standard.

Changing either of these values results in a loss of IP connectivity if the hubs and switches
on your network are not configured with the corresponding VLANS.

Controller Link Aggregation Concepts

Note: Link aggregation is not supported on model WC7500 and model
WC7600v2.

If you connect the two 10GE connections of the wireless controller to a switch or router, the
wireless controller supports dynamic link aggregation (802.3ad), which you can use either to
increase bandwidth or to support link redundancy.

You can enable the wireless controller to automatically create a single link aggregation group
(LAG) in which the two links share the same speed and duplex settings. The link selection for
egress traffic is based on the transmit hash policy.

You can also configure a standby link in which only one link in the LAG is active. The standby
link becomes active only if the active link fails. In such a situation, a failover occurs from the
failed active link to the standby link, which becomes the new active link.
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Configure the IP, VLAN, and Controller Link Aggregation
Settings

Note: Link aggregation is not supported on model WC7500 and model
WC7600v2.

You can configure the management IP address, VLAN settings, and link aggregation (LAG)
settings of the wireless controller.
To configure IP, VLAN, and controller LAG settings:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
3. Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > System > IP/VLAN.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal
General IP Settings @
{Time IP Address 192.168.0,251
IP Subnet Mask 255.255.255.0

DHCP Server Default Gateway 192.168.0.1

Certificates Primary DNS Server 192.168.0.1

Alerts/Logs Secondary DNS Server

WINS Server

Management YLAN Settings

Management YLAN 1
Untagged VLAN

10G Port Settings @
LAG O
Active Standby ®

CANCEL APPLY

5. Configure the settings as described in the following table.
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Setting

Description

IP Settings section

IP Address

Enter the IP address of the wireless controller.

The default IP address is 192.168.0.250. To change it, enter an available IP
address from the address range used on your LAN.

Note: If you assign a static IP address to the wireless controller and then use the
web management interface of a discovered access point to configure a static IP
address for the access point and enter the wireless controller’s static IP address,
the access point attempts to reach the wireless controller only at the provided static
IP address.

If the IP address of the wireless controller changes, the access point can no longer
reach the wireless controller. In such a situation, reset the access point to factory
default settings. Doing so removes the static IP address of the wireless controller
from the access point configuration.

IP Subnet Mask

Enter the subnet mask value used on your LAN.
The default value is 255.255.255.0.

Default Gateway

Enter the IP address of the gateway for your LAN.

Primary DNS Server

Enter the IP address of the primary Domain Name Server (DNS) that you want to
use.

Secondary DNS Server

Enter the IP address of the secondary DNS that you want to use.

WINS Server

Enter the IP address of the Windows Internet Name Service (WINS) that you want
to use.

Management VLAN Set

tings section

Management VLAN Enter the management VLAN.
For more information, see Management VLAN Concepts on page 102.
Untagged VLAN Select the Untagged VLAN check box if the configured VLAN is untagged.

For more information, see Untagged VLAN Concepts on page 103.

10G Port Settings secti

onl

LAG

Select the LAG radio button to enable the wireless controller to automatically
create a LAG in which both links are active.

The LAG radio button and Active Standby radio button are mutually exclusive.
For more information, see Controller Link Aggregation Concepts on page 103.

Active Standby

Select the Active Standby radio button to enable the wireless controller to
automatically create a LAG in which only one link is active and the other link
functions as a standby link.

The Active Standby radio button and LAG radio button are mutually exclusive.
For more information, see Controller Link Aggregation Concepts on page 103.

1. Link aggregation is not supported on model WC7500 and model WC7600v2.

Click the Apply button.

Your settings are saved.
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Manage the DHCP Server

Note: Make sure that a DHCP server is available; otherwise, the Discovery
Wizard does not function correctly. If your network already includes a
DHCP server, do not enable the DHCP server on the wireless controller.

The wireless controller can function as a DHCP server. You can add multiple DHCP server
pools for different VLANSs. By default, no DHCP server pool is configured on the wireless
controller but you can add one or more DHCP server pools.

Add a DHCP Server
The DHCP Server List page lets you add a DHCP server pool.

> To add a DHCP server and configure its settings:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > System > DHCP Server.

The DHCP Server List page displays. Because this page is wide, it is shown in the
following two figures.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile | WLAN Network | Captive Portal

DHCP Server List

General
[cdt/Remove | VLAN > 1P Ntwaric | Subnet sk | Defaul Gateway |
IP/VLAN Management 192.168.0.0 255.255.255.0 192.168.0.1

O 25 192,168.25.0 255.255.255.0 192.168.25.1
Certificates
AlertsfLogs
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@
I Start IP & m Primary DNS ¢ | Secondary DNS ¢ | WINS Server# m

192,168.0.130 192,168.0.249 192.168.0.1 Enabled

192,168,252 192,168,25,254 192.168.0,1 Enabled

ADD EDIT REMOVE CANCEL

The DHCP Server List shows the DHCP servers that are already configured on the
wireless controller.

5. Click the Add button.

Add DHCP Server

DHCP Settings

Enable

Use YLAN Interface

YLAN '

IP Network 192.168.0.0
Subnet Mask 255,255,255.0
Default Gateway 192.168.0.1
Start IP

End IP

Use Default DNS Server

Primary DNS Server 192.165.0.1

Secondary DNS Server
Use Default WINS Server
WINS Server

CANCEL CLEAR ADD

6. Configure the settings as described in the following table.

Setting Description

Enabled Select the Enabled check box to enable the DHCP server.
If the check box is cleared, the DHCP server is disabled.

Use VLAN Interface Select the Use VLAN Interface check box to allow the DHCP server to function
with multiple VLANS.

VLAN Enter the DHCP server VLAN ID.
The range is between 1 and 4094. The DHCP server services this VLAN.
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Setting Description

IP Network Enter the IP address for the wireless controller in the VLAN that you specified in
the VLAN field.

Note: If you do not select the Use VLAN Interface check box, the IP address
of the wireless controller's management VLAN is used.

Subnet Mask Enter the subnet mask that is assigned to the WiFi clients by the DHCP server.

Default Gateway Enter the IP address of the default network gateway for all traffic beyond the
local network.

Start IP Enter the start IP address of the range that the DHCP server can assign.

End IP Enter the end IP address of the range that the DHCP server can assign.

Use Default DNS Server | Select the Use Default DNS Server check box to allow the DHCP server to use
the wireless controller’s default DNS servers.

The Primary DNS Server and Secondary DNS Server fields are masked out.

Primary DNS Server Enter the IP address of the primary DNS server for the network.

Secondary DNS Server | Enter the IP address of the secondary DNS server for the network.

Use Default WINS Server | Select the Use Default WINS Server check box to allow the DHCP server to
use the wireless controller's default WINS server.

The WINS Server field is masked out.

WINS Server Enter the IP address of the WINS server for the network.

7. Click the Add button.
The new DHCP server is added to the DHCP Server List.

Change the Settings for a DHCP Server

You can change the settings for a DHCP server.

To change the settings for a DHCP server:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Configuration > System > DHCP Server.
The DHCP Server List page displays.
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5. Select the radio button in the Edit/Remove column that corresponds to the DHCP server for
which you want to change the settings.

6. Click the Edit button.

Edit DHCP Server

DHCP Settings

Enable
Use YLAN Interface O
YLAN

IP Network [192.168.0.0
Subnet Mask 255.255,255.0
Default Gateway |192.168.0.1
Start IP 1 192.166.0.130
End IP [ 192.168.0.249
Use Default DNS Server

Primary DNS Server 192.,168.0.1

Secondary DNS Server
Use Default WINS Server
WINS Server [

CANCEL CLEAR APPLY

7. Change the settings.
8. Click the Apply button.

Your settings are saved.

Remove a DHCP Server

You can remove a DHCP server.

To remove a DHCP server:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

4. Select Configuration > System > DHCP Server.
The DHCP Server List page displays.

5. Select the radio button in the Edi‘Remove column that corresponds to the DHCP server that
you want to remove.

6. Click the Remove button.
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Register Your Licenses

Make sure that your licenses cover the number of access points in your network. Before you

can register your licenses, you must configure the license server settings.

For more information about licenses, see Licenses on page 17 and Manage Licenses on
page 274.

Note: When you install your licenses, they replace the default trial license.

Configure the License Server Settings

Although you generally do not need to change the default license update server, you must

make sure that the wireless controller can reach the license update server.

» To configure the license server settings:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary

Select Maintenance > Licensing.
Click the Server Settings tab.

Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade : Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management : Logs & Alerts

License Settings 7

Inventory Server Settings Registration Advanced

Update From
@ Default Update Server @] Specify Update Server

Server Address updatel.eng netgear.co
[ usea Proxy Serwver to Connect to the Internet
Proxy Server
Prory Port 0
This Proxy Server Requires Authentication

User Name
Password

CANCEL APPLY
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6. Configure the settings as described in the following table.

Setting Description

Update From Select one of the following radio buttons to specify the license update server:
« Default Update Server. The default license update server is used.

e Specify Update Server. You must specify the license update server. Fill in
the Server Address field.

Server Address | Enter the IP address or FQDN of the server from which you
import your licenses.

By default, the FQDN of the NETGEAR license server is
updatel.eng.netgear.com.

Use a Proxy Serverto | Select the Use a Proxy Server to Connect to the Internet check box if you use
Connect to the Internet | a proxy server to connect to the Internet.

Proxy Server Enter the IP address or FQDN of the proxy server.

Proxy Port Enter the port that the proxy server uses.
This Proxy Server If the proxy server requires authentication, specify the user name and password.
Requires Authentication

User Name Enter the user name to access the proxy server.

Password Enter the password to access the proxy server.

7. Click the Apply button.

Your settings are saved.

Register Your Licenses With the License Server

You must purchase licenses before you can register them. For more information, see
Licenses on page 17)
To register your licenses:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Make sure that the wireless controller is connected to the Internet.

5. Select Maintenance > Licensing.

6. Click the Registration tab.
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The following figure shows some licenses already registered and installed. If you register
licenses for the first time, the page does not yet show any licenses.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade | Licensing | Backup/Restore | RebootfReset | Extended Storage | Remote Management | Logs & Alerts

License Settings @

Inventory Server Settings Registration Advanced

Registration Key

ADD DELETE

Key Type + | Key Status ¢

NGZFO6-50D6-CT65-D487-30AC-AA43-2867-B63A-3508  S0-AP Registered
NG2F0&-385D-F35F-9D9C-2766-BBET-CBDE-S806-BDFS S0-AP Registerad
MG2ZF04-950C-FO10-A130-8710-1552-2520-8707-0333  10-AP Registered
NG2F04-1030-7951-99DE-D18C-FOEA-B269-636B-582C 10-AP Registered
NGZFO04-4BCS5-5B12-3D6E-AATS-4BSF-E6ZF-C612-DEG3 10-AP Registerad
NG2F04-3639-1888-D2D3-6F7A-90F5-0AES-BF21-5FES 10-AP Registerad
MG2F04-49C3-EBERB-24A5-F7SD-0CIE-3DF9-269A-453F 10-AP Registered
NGZFO6-AF29-CABB-1A64-C195-90BF-CAIA-T346-0EDE S0-AR Registered

Customer Information
Company Name
First Name
Last name
Email Address
Fax Number
Phone Number
Address
Address2

Zip

City

State

Country

VAR Information
Company Name
First Name
Last name
Email Address
Fax Number
Phone Number
Address
Address2

Zip

City

State

Country

CAMCEL REFRESH APPLY

7. Complete the fields in the Customer Information section with the customer information that is
associated with the key that you want to add and register.

These fields are self-explanatory.

8. Complete the fields in the VAR Information section with the value-added reseller (VAR)
information that is associated with the key that you want to add and register.
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These fields are self-explanatory.

9. Inthe Registration Key field at the top of the page, enter the registration key for the license
that you want to add and register.

10. Click the Add button.

The license is added to the table. The key details in the table mean the same as the key
details that are shown on the Inventory page (see the Key Details section in the table in
View Your Licenses on page 274).

11. Click the Apply button.
Your license is registered.

12. To register another license, repeat these steps.

Manage Certificates

The internal authentication server for certificate-based authentication requires you to install a
certificate on the wireless controller. A default self-signed server certificate is installed on the
wireless controller. However, we strongly recommend that you replace this default certificate
with a custom certificate issued for your site or domain by a trusted certificate authority (CA).

To obtain a security certificate for the wireless controller, generate and submit a certificate
signing request (CSR) to the CA of your choice. Upon receiving the CA-signed server
certificate, install the certificate from your computer as described in this section. Certificates
must be in X.509 PEM format.

» To add certificates:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Configuration > System > Certificates.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal
General Add Certificates @
Time Password ssssssee
“:WLEN Controller Key ._
D_ “ Se.r\i'er Controller Certificate
AlertsfLogs CA Certificate [ .

CANCEL APPLY

5. Configure the settings as described in the following table.

Setting Description
Password Enter the password for wireless controller certificates.
Controller Key Click the Browse button, and select the controller key.

Controller Certificate |Click the Browse button, and select the controller certificate.

CA Certificate Click the Browse button, and select the CA certificate.

6. Click the Apply button.

Your settings are saved.

Configure Syslog, Alarm Notification, and Email Settings

From the Alerts/Logs menu, you can configure the syslog and the alarms, and specify the
email address from which alerts originate.

Configure the Syslog Settings for an Internal Syslog Location

You can configure the settings to connect to a syslog server with an internal location.

If you use an internal syslog location, make sure that you attach and mount an extended
storage device (see Manage Extended Storage on page 260).

Log files include the following:

* debug.log: Wireless controller applications log.
* kernel.log: Wireless controller kernel log.
* message: Wireless controller applications log and syslogs from AP.

e wnc_[hostname] [year]_[month]_[day] [hour] [min].log.tar.gz: Compressed file of
log messages when the total size exceeds 10 MB.
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» To configure the syslog settings for an internal location:

1.

5.

Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Configuration > System > Alerts/Logs > Logs/Syslog.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile | WLAN Network | Captive Portal

Syslog Settings @

General

Time Enable Syslog ¥
IP/VLAN Log Level LOG_LEVEL_CRIT [=]
DHCP Server syslog Location @ Internal ) External
Certificates Storage Device Not connected

Status Stopped
= Alarms
» Email Setup

CANCEL APPLY

In the Syslog Settings section of the page, configure the settings as described in the
following table.

Setting Description

Enable Syslog Enable the syslog settings using the Enable Syslog check box to forward
system wide logs to an external syslog server or to save to a storage device
such as a USB or SD card connected to the wireless controller. By default, the
syslog settings are disabled.

Log Level From the Log Level menu, select one of the following levels:

e LOG_LEVEL_CRIT. Critical errors only are logged.

¢ LOG_LEVEL_ERR. Noncritical errors and critical errors are logged.

e LOG_LEVEL_WARN. Warnings, noncritical errors, and critical errors are
logged.

e LOG_LEVEL_NOTICE. Natifications, warnings, noncritical errors, and
critical errors are logged.

e LOG_LEVEL_INFO. Informational messages, notifications, warnings,
noncritical errors, and critical errors are logged.

Syslog Location Select the Internal radio button if you have already mounted a storage device
(see Manage Extended Storage on page 260).
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Setting Description

Storage Device Displays the Storage Device status:

« Not connected. Device is not connected. Insert and mount a device.
« Not mounted. Device is not mounted.

e USBO. If a device is mounted in the USBO slot.

e USBI1. If a device is mounted in the USB 1 slot.*

¢ SDCARD. If a device is mounted in the SDCARD slot.*

* Applies to WC7500 and WC7600v2 controllers only.

Status Displays the status of the internal syslog service:

e Stopped. Logging has not started. Device may not be mounted or internal
syslog service has not been started.

e Logging. Syslogs are being saved in the mounted storage device.

Click the Apply button.

Your settings are saved.

Configure the Syslog Settings for an External Syslog Location

You can configure the settings to connect to an external syslog server if your network
includes one.

If you use an external syslog location, before you configure the IP address of the syslog
server on the wireless controller, make sure that you set up a syslog server (such as a
computer running a syslog service) and that the syslog server is available on the network.

> To configure the syslog settings for an external location:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
Select Configuration > System > Alerts/Logs > Logs/Syslog.
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Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile | WLAN Network | Captive Portal

General

Time

Enable Syslog o
IP/VLAN Log Level LOG_LEVEL_INFO_ ¥
DHCP Server Syslog Location Internal ® External
Certificatas Syslog Server IP Address

Server Port Number 514
= Alarms.
= Email Setup

K

Syslog Settings

CAMNCEL APPLY

Copvrioht & 1996-2016 Netaear &

In the Syslog Settings section of the page, configure the settings as described in the

following table.

Setting

Description

Enable Syslog

Enable the syslog settings using the Enable Syslog check box to forward
system wide logs to an external syslog server or to save to a storage device
such as a USB or SD card connected to the wireless controller. By default, the
syslog settings are disabled.

Log Level

From the Log Level menu, select one of the following levels:

e LOG_LEVEL_CRIT. Critical errors only are logged.

e LOG_LEVEL_ERR. Noncritical errors and critical errors are logged.

¢ LOG_LEVEL_WARN. Warnings, noncritical errors, and critical errors are
logged.

e LOG_LEVEL_NOTICE. Notifications, warnings, noncritical errors, and
critical errors are logged.

e LOG_LEVEL_INFO. Informational messages, notifications, warnings,
noncritical errors, and critical errors are logged.

Syslog Location

Select the External radio button if your network includes a syslog server.

Syslog Server IP Address

Enter the IP address to which the wireless controller and managed access
points send all syslogs, if the Enable Syslog check box is selected.

Note: Before you configure the IP address of the syslog server on the wireless
controller, make sure that you set up a syslog server (such as a computer running
a syslog service) and that the syslog server is available on the network.

Server Port Number

Enter the number of the port at which your syslog server is configured to listen to

requests.

Click the Apply button.

Your settings are saved.

Configure the System and Network Settings and Register the Licenses

117



ProSAFE Wireless Controller

Configure Alarm Notification Settings

You can classify certain events as critical, major, normal, or minor. Some events you can
classify only as critical or major.

To configure alarm actions:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
Select Configuration > System > Alerts/Logs > Alarms.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile | WLAN Network | Captive Portal

General Alarm Actions @
UL Severity t! Action ¢ | Email Address é
i Minor No Action v
DHCP Server :

Normal No Action v
Certificates

Major add To Syslog v
» Logs/SysLog Critical Add To Syslog v

» Ermail Setup

CAMCEL APPLY

For each alarm severity (Minor, Normal, Major, and Critical), select the desired action from
its corresponding Action menu.

« No Action. When the alarm occurs, no action is taken.

* Add To Syslog. When the alarm occurs, the wireless controller adds an entry to the
syslog.

e Send Email. When the alarm occurs, the wireless controller sends an email.

For each alarm severity for which you selected the Send Email option in the previous step,
enter an email address.

Click the Apply button.

Your settings are saved.
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Configure the Email Notification Server

The email notification server is the location from which the email alerts originate.

To configure email settings:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
Select Configuration > System > Alerts/Logs > Email Setup.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security ! Profile | WLAN Network | Captive Portal
General Email Configuration ®
1L Server Address
IP/YLAN Port 25
DHCP Server sender E-Mail Address
Certificates Authentication Required ]

User Name
» Logs/SysLog
* Alarms

Password

CANCEL APPLY

5. Configure the settings as described in the following table.

Setting Description
Server Address Enter the IP address of the server from which email naotifications are sent.
Port Enter the port number of the server from which email notifications are sent. The

default port is 25.

Sender Email Address Enter the email address from which email notifications are sent.

Authentication Required | Select the Authentication Required check box if the email server requires
authentication, and complete the User Name and Password fields.

User Name | Enter the user name that is associated with the email server.

Password Enter the password that is associated with the email server.

6. Click the Apply button.

Your settings are saved.
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Manage Security Profiles and
Profile Groups

This chapter includes the following sections:

WiFi Security Profile Concepts

Manage Security Profiles for the Basic Profile Group

Manage Security Profiles for Advanced Profile Groups

Network Authentication and Data Encryption Options

Manage Authentication Servers and Authentication Server Groups
Manage MAC Authentication and MAC Authentication Groups

Note: In this chapter and in the following chapters, access point profile
groups are referred to as just profile groups.
Profiles, security profiles, and SSIDs (that is, SSIDs with associated
security settings) are terms that are interchangeable.
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WiFi Security Profile Concepts

Profiles are sets of configurations that you can apply to an access point. The configuration
includes radio parameters, load-balancing parameters, and rate-limit parameters. Each WiFi
radio on an access point can support 8 profiles. For example, the dual-band WNDAP660
access point can support a total of 16 profiles. Therefore, in one profile group on the wireless
controller, you can configure up to 8 profiles for each radio, that is, up to 8 profiles for the 2.4
GHz radio and up to 8 profiles for the 5 GHz radio.

Setting up profiles allows you to configure the WLAN network offline. Then, when the WLAN
network is operating, you can push the configuration onto managed access points. You can
configure profiles and profile groups without taking the state of the access points into
consideration. When the access points connect to the wireless controller, the profile
configurations are pushed onto the access points.

An access point can be a member of one profile group only. If you move an access point from
one profile group to another, the access point stops serving the SSIDs in the old profile group
and starts serving the SSIDs in the new profile group.

Note: If an access point is removed from its building (someone takes it
home or it is stolen), the access point does not retain the configuration
that it received from the wireless controller. The configuration is not
stored in memory on the access point.

Depending on your network needs, you can either use the basic profile group (that is, the
basic configuration) or the advanced profile groups (that is, the advanced configuration). The
basic profile group works well for small-scale WLAN networks; advanced profile groups are
useful for larger deployments.

Note: For more information about basic and advanced profile groups, see
Basic and Advanced Setting Concepts on page 33.

Small WLAN Networks

For small WLAN networks, you can use the basic configuration with the basic profile group.
All access points belong to the same group and use the same WiFi, security, and QoS
configurations.

The basic profile group can contain up to 16 profiles for a dual-band access point, or

8 profiles for a single-band access point. Each profile provides its own SSID and can provide
its own VLAN to allow the profile to establish its own tunnel. Profiles can also share the same
VLAN.

For example, in an enterprise network in which all access points that are managed by the
wireless controller serve the same WiFi networks and support the same settings, you can
use the basic configuration.
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Large WLAN Networks

For large network deployments that consist of different sets of WLAN networks, consider
using the advanced configuration to create multiple profile groups. The access points that
belong to the same profile group use the same WiFi, security, and QoS configurations.

The wireless controller supports up to eight profile groups. Each profile group can provide its
own WiFi, security, and QoS configurations. Each profile group can contain up to 16 profiles
for a dual-band access point, or 8 profiles for a single-band access point. Using dual-band
access points, the wireless controller could support a total of 128 profiles. Each profile
provides its own SSID and can provide its own VLAN to allow the profile to establish its own
tunnel. Profiles can also share the same VLAN.

Also, in larger network deployments, you would assign guests to a separate VLAN because
guests typically access only the Internet, not the business network, and are not allowed
peer-to-peer access.

Profile Naming Conventions

You can use profile naming conventions that are based on user groups such as Marketing, or
based on VLANSs such as VLAN4Q, or you can use other naming conventions such as
CompanyName1l5.

Note: In the advanced configuration, you cannot change the names of
profile groups. However, you can change the group names of MAC
ACLs and external RADIUS servers.

Considerations Before You Configure Profiles

Before you create and configure profiles for the basic profile group or an advanced profile
group, consider the following:

e Authentication servers. If you want to use external LDAP or RADIUS authentication, or
both, first configure the authentication server settings:

- Configure basic server settings on the basic Authentication Server page (see
Configure Basic Authentication Server Settings on page 142).

- For more complex networks, configure additional RADIUS servers on the advanced
Authentication Server page (see Configure a RADIUS Authentication Server Group
on page 144).

After you configure authentication server settings, you can then assign any authentication
server to a security profile in a basic profile group or advanced profile group.
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Note: You can configure profiles to function with different authentication
servers. For example, you could set up a guest profile with no
authentication, an engineering profile that uses external RADIUS
authentication, and a marketing profile that uses external LDAP
authentication. You can also use additional external RADIUS servers
in other profiles.

e Captive portals and guest portals. If you want to use captive portals, guest portals, or
both, first configure the portals:

- Configure the basic portal on the basic Portal Settings page (see Configure a Basic
Guest Portal or Captive Portal on page 224).

- For more complex networks, configure additional portals on the advanced Captive
Portal Settings page (see Configure an Advanced Guest Portal or Captive Portal on
page 229).

After you configure portals, you can then assign any portal to a security profile in a basic
profile group or advanced profile group.

MAC authentication. If you want to use a MAC access control list (ACL) to control
access of WiFi clients, first create one or more MAC ACLs:

- Configure the basic MAC ACL on the basic MAC Authentication page (see Configure
Basic Local MAC Authentication Settings on page 146).

- For more complex networks, configure additional MAC ACLs on the advanced MAC
Authentication page (see Configure a Local MAC Authentication Group on page 149).

After you configure one or more MAC ACLs, you can then assign any MAC ACL to a
security profile in a basic profile group or advanced profile group.

* Cloning profiles. For faster setup, you can clone a profile and rename it. Cloning copies
all settings except for the name and SSID.

Basic and Advanced Security Configuration Concepts

The basic security configuration model (Configuration > Security > Basic) does not apply
strictly to the basic profile group, nor does the advanced security configuration model
(Configuration > Security > Advanced) apply strictly to advanced profile groups. The
reason is that you apply an authentication server and a MAC ACL to an individual profile and
not to a profile group.

e Basic security settings. You can apply the following security settings to any profile,
whether in the basic profile group or in an advanced profile group:
- Basic MAC authentication (the MAC ACL group that is called basic)

- Basic authentication server (the RADIUS server that is called basic-Auth or the LDAP
server that is called basic-LDAP)
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« Advanced security settings. You can apply the following security settings to any profile,
whether in the basic profile group or in an advanced profile group:

- Advanced MAC authentication (the MAC ACLs that are, by default, called Acl-1,
Acl-2, Acl-3, and so on; you can change these default names)

- Advanced authentication server (the RADIUS servers that are, by default, called
Auth-1, Auth-2, Auth-3, and so on; you can change these default names)

Manage Security Profiles for the Basic Profile Group

The basic profile group works well for small-scale WLAN networks. We recommend that you
read the information in the previous section, WiFi Security Profile Concepts, before you
configure any profiles.

Configure a Profile in the Basic Profile Group

The Edit Profile (Basic) page lets you create and configure up to eight security profiles per
WiFi radio (8 profiles for a single-band access point; 16 profiles for a dual-band access point).
Separate profiles are applied to 802.11b/bg/ng-mode and 802.11a/na/ac-mode radios.

> To add a security profile to the basic profile group and configure the security profile:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Configuration > Profile > Basic > Radio.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Wireless | Security | P | WLAN Network | Captive Portal

System

Edit Profile (Basic) @

802.11b/bg/ng B02.11afnafac

Click + to add another profile.
YLANIOD YLANZO YLAN3O + /

Profile Definition

= Load Balancing
= Rate Limit

» AP LED State
Advanced

Name VLANLOD
Wireless Network Name {SSID) VLANLO
Broadcast Wireless Network Name (SSID) ®ves ONo
Your selection from
Client Authentication the NEIwork_
Network Authentication Open System v<— AUthehtlcatlon gnu
i determines the
Data Encryption MNone e . . ]
information that is
Wireless Client Security Separation Disable v .
displayed onscreen.
¥LAN i0
Authentication Settings .
0 ® o) Select the Local radio
MAC ACL Loca External button to display the
Local MAC ACL Group | basic v Local MAC ACL
Captive Portal Fl Group menu.
Select the External
Wireless QoS radio button to display
Wi-Fi Multimedia {WMM) ® enable O disable the External Radius
WMM Powersave @ enable O disable Server menu.

CAMCEL DELETE APPLY

By default, an NG_11g-01 profile and an NG_11a-01 profile are present in the basic
profile group.

Click the tab for the radio for which you want to add a profile.
Click the + button to add the profile to the basic profile group.

ADD Profiles

Clone an existing Profile ]

Profiles WLANLO

CAMCEL ADD

To clone an existing profile, do the following:
a. Select the Clone an existing Profile check box.

The previous figure shows that you can clone an existing profile with the name
VLAN1O0.

b. Select a profile from the Profiles menu.
Click the Add button.
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The newly created profile displays onscreen, and the tab for the new profile is
automatically selected to let you configure the new profile.

Note: The authentication server settings that you specify on the
Authentication Server page affect the selections that are available
from the Network Authentication menu. For more information, see
Manage Authentication Servers and Authentication Server Groups on
page 140. If your selection from the Network Authentication menu
requires authentication, a corresponding Authentication Server field

displays.

9. Configure the settings as described in the following table.

Setting

Description

Profile Definition section

Name

Enter a unique name to identify the profile.

This value can be up to 32 alphanumeric characters. Use meaningful profile
names instead of the default names. The default profile names are Profilel,
Profile2, and so on, through Profile8.

Wireless Network Name
(SSID)

Enter a unique name for the WiFi network associated with this profile. The
length of the SSID is restricted to a maximum of 31 characters. You can you
use all characters except for the following: space, single quotation mark, and
double quotation mark.

Broadcast Wireless
Network Name

Select the Yes radio button to enable broadcast of the SSID.
This is the default setting.

Select the No radio button to disable broadcast of the SSID, in which case only
users who know the correct SSID can connect to the access point.

Client Authentication section

Note: The options that display onscreen depend on your selection from Network Authentication menu.

Network Authentication

From the menu, select the authentication type to be used.
Table 10 on page 137 lists all the authentication type options.

Data Encryption

From the menu, select the data encryption type to be used.

The options available for data encryption as well as other requirements such as
entering a key or passphrase depend on the network authentication settings.

Table 10 on page 137 lists all the data encryption options.

Wireless Client Security

From the menu, select Disable to prevent associated WiFi clients from

Separation communicating with each other, or select Enable to allow such communication.
WiFi client separation is intended for hotspots and other public access
situations.

VLAN Enter the VLAN ID to be associated with this security profile.

This VLAN ID must match the VLAN ID that is used by other network devices.
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Setting

Description

Authentication Settings section

Note: The options that display onscreen depend on the selection from Network Authentication menu.

Note: The MAC ACL
button displays only when
you select Open System,
Shared Key, WPA-PSK,
WPA2-PSK, or
WPA-PSK & WPA2-PSK
from the Network
Authentication menu.

MAC ACL

Select one of the following radio buttons:
e Local. Use local MAC authentication.

The Local MAC ACL Group menu displays so you can
select a group. For more information, see Manage MAC
Authentication and MAC Authentication Groups on
page 146.

e External. Use external MAC authentication.

The External Radius Server menu displays so you can
select a server. You can select either the basic-Auth
RADIUS server or a RADIUS server of an advanced
authentication group. You cannot use the external LDAP
server.

For information about setting up and enabling internal and
external authentication servers, see Manage Authentication
Servers and Authentication Server Groups on page 140.

Note: The MAC ACL radio buttons do not display onscreen if
the network authentication uses an external RADIUS server.
The reason for this is that you can configure either MAC
authentication with an external RADIUS server or network
authentication with an external RADIUS server, but not both.
That is, if you configure an external RADIUS server with WPA,
WPA2, or WPA & WPA2 (or you use Legacy 802.1X), you
cannot use external MAC authentication, and the MAC ACL
radio buttons do not display onscreen. You can still use internal
MAC authentication.

Note: The Captive
Portal check box displays
only when you select
Open System, Shared
Key, WPA-PSK,
WPA2-PSK, or
WPA-PSK & WPA2-PSK
from the Network
Authentication menu.

Captive Portal

Select the Captive Portal check box if you want to enable a
guest portal or captive portal.

The Captive Portal menu displays so you can select a portal.
You can select either the Basic portal or a portal from the
advanced portal group.

For information about setting up portals, see Manage Guest
Network Access Through Guest Portals and Captive Portals on
page 223.

Note: If the network authentication uses a RADIUS server,
whether it is a local server or an external server, you cannot
configure captive portal authentication. That is, if you configure
a RADIUS server with WPA, WPA2, or WPA & WPAZ2 (or if you
use legacy 802.1X), the Captive Portal check box is not shown
onscreen.
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Setting Description
R‘OIE: -It—'het' S Authentication | Select one of the following radio buttons:

uthentication Server o

Server .

buttons and menu display Local. Use the local authentlcatlor? sgrver.
only when you select WPA + External. Use an external authentication server.
with Radius, WPA2 with Select an external authentication server from the
Radius, or WPA & WPA2 Authentication Server menu.

with Radius from the
Network Authentication
menu.

Note: For information about setting up and enabling internal
and external authentication servers, see Manage Authentication
Servers and Authentication Server Groups on page 140.

Wireless QoS section

Wi-Fi Multimedia (WMM) | To enable Wi-Fi Multimedia (WMM), select the Enable radio button, which is
the default setting.

Select the Disable button to disable the feature. For more information, see
Manage Quality of Service for an Advanced Profile Group on page 207.

WMM Powersave The WMM Powersave feature saves power for battery-powered equipment by
increasing the efficiency and flexibility of data transmission.

To enable this feature, select the Enable radio button, which is the default
setting.

Note: We recommend that you do not disable the WMM Powersave feature.

10. Click the Apply button.

Your settings are saved.

Change the Settings for a Profile in the Basic Profile Group
You can change the settings for a profile in the basic profile group.

To change the settings for an existing profile:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.

3. Click the Login button.
The wireless controller's web management interface opens and displays the Summary
page.

4. Select Configuration > Profile > Basic > Radio.
The Edit Profile (Basic) page displays.

5. Click the tab for the radio for which you want to change a profile.
Click the tab for the profile that you want to change.

7. Change the settings.
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For information about how to change the settings, see Configure a Profile in the Basic
Profile Group on page 124.

8. Click the Apply button.
Your settings are saved.

Remove a Profile From the Basic Profile Group

You can remove a profile from the basic profile group.

» Toremove an existing profile:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
3. Click the Login button.
The wireless controller's web management interface opens and displays the Summary
page.
4. Select Configuration > Profile > Basic > Radio.
The Edit Profile (Basic) page displays.
Click the tab for the radio for which you want to remove a profile.
Click the tab for the profile that you want to remove.
Click the Delete button.
Confirm that you want to remove the profile.

© N o o

Manage Security Profiles for Advanced Profile Groups

Advanced profile groups are useful for larger deployments. We recommend that you read the
information in the WiFi Security Profile Concepts on page 121 before you configure any
profile groups and profiles.

Add an Advanced Profile Group

The advanced Profile Group page lets you create up to eight profile groups. For each profile
group, you can create and configure up to eight security profiles per WiFi radio (eight profiles
for a single-band access point; 16 profiles for a dual-band access point). Separate profiles
are applied to 802.11b/bg/ng-mode and 802.11a/na/ac-mode radios.

By default, all access points are assigned to the basic profile group. After you create
advanced profile groups, you can use the WLAN Network page to reassign access points to
any of these advanced profile groups (see Assign Access Points to Buildings, Floors, and
Advanced Profile Groups on page 174).
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> To add an advanced profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > Profile > Advanced > Radio.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System ! Wireless | Security Profile WLAN Network | Captive Portal

Profile Groups @

Basic s
- Click + to add another profile group.
Group-1 Group-2 Group-3 Es
» Rate Limit
» AP LED State Name E | Authentication
' Bld1_Upper_Floor 802.11b/bg/ng  WPA-PSK & WPA2-PSK

Bld1l_Lower Floor 802.11b/bafng WPA-PSK & WPAZ-PSK

Bld1_Library 802.11b/bgfng  Open System

Bldl_Upper_Floor_na 802.11a/na WPA-PSK & WPAZ-PSK

Bldi_Lower_Floor_na 202.11a/na WPA-PSK & WPAZ-PSK

CANCEL DELETE EDIT APPLY

5. To add a profile group, click the + button.

The new profile group displays on the Profile Groups page. By default, an NG_11g-x1
profile and an NG_11a-x2 profile, in which x is the group number, are present in a profile

group.

Note: By default, profile groups are named Group-1, Group-2, Group-3,
and so on. You cannot change these profile group names.

The following table describes the fields that are shown for each profile in a profile group.

Setting Description

Name The unique profile name.

Radio The WiFi radio in which the profile is operating.

Authentication The authentication setting under which the profile is operating.
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Remove an Advanced Profile Group

You can remove an advanced profile group

To remove an advanced profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

4. Select Configuration > Profile > Advanced > Radio.
The Profile Groups page displays.

5. Click the tab for the profile group that you want to remove.
6. Click the Delete button.

Note: A separate procedure to change profile groups does not exist. You
change profile groups by adding, removing, or changing profiles in the
profile group.

Configure a Profile in an Advanced Profile Group

For each profile group, the Edit Profile (Group-X, in which X is the group number) page lets
you create and configure up to 8 security profiles per WiFi radio (8 profiles for a single-band
access point; 16 profiles for a dual-band access point). Separate profiles are applied to
802.11b/bg/ng-mode and 802.11a/na/ac-mode radios.

To add a security profile to an advanced profile group and configure the security
profile:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
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Select Configuration > Profile > Advanced > Radio.
The Profile Groups page displays.

Click the Edit button.

The Edit Profile (Group-X) page displays.

Click the tab for the radio that for which you want to add a profile.
Click the + button to add the profile to the selected advanced profile group.

ADD Profiles

Clone an existing Profile [
Profiles NG_11g-31

CAMCEL ADD

To clone an existing profile, do the following:

a. Select the Clone an existing Profile check box.
b. Select a profile from the Profiles menu.

Click the Add button.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless Security | Profile | WLAN Network | Captive Portal

Basic Edit Profile (Group-3) @

802.11bfbg/ng 802.11afnafac

> Rate Limit Click + to add another profile.
» AP LED State /
| NG_1... NG_11g-33 | +

Profile Definition

Name NG_11g-33
Wireless Network Mame {SSID) MNG_11g-33
Broadcast Wireless Network Name (S5ID) ®ves OnNo

Your selection from

Client Authentication the Network

Network Authentication Open System ¥ -ag-| Authentication menu
Data Encryption None v determines the
Wireless Client Security Separation Disable s information that is
VLAN 1 displayed onscreen.

Authentication Settings
MAC ACL ® Locﬂ.| O Extsrnal Select the Local radio
button to display the

Local MAC ACL Group basic v
Captive Portal O Local MAC ACL
Group menu.
Wireless QoS Selfact the Extemal
radio button to display

Wi-Fi Multimedia (WMM) @ enable O disable he E | ek
WMM Powersave ® enable (O disable the External Radius
Server menu.
CANCEL BACK DELETE APPLY
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The newly created profile displays onscreen, and the tab for the new profile is
automatically selected to let you configure the new profile.

Note: The authentication server settings that you specify on the Authentication
Server page affect the selections that are available from the Network
Authentication menu. For more information, see Manage
Authentication Servers and Authentication Server Groups on page 140.
If your selection from the Network Authentication menu requires
authentication, a corresponding Authentication Server field displays.

10. Configure the settings as described in the following table.

Setting

Description

Profile Definition section

Name

Enter a unique name to identify the profile.

This value can be up to 32 alphanumeric characters. Use meaningful profile
names instead of the default names. The default profile names are Profilel,
Profile2, and so on, through Profile8.

Wireless Network Name
(SSID)

Enter a unique name for the WiFi network associated with this profile. The
length of the SSID is restricted to a maximum of 31 characters. You can you
use all characters except for the following: space, single quotation mark, and
double quotation mark.

Broadcast Wireless
Network Name

Select the Yes radio button to enable broadcast of the SSID.
This is the default setting.

Select the No radio button to disable broadcast of the SSID, in which case only
users who know the correct SSID can connect to the access point.

Client Authentication section

Note: The options that display onscreen depend on your selection from Network Authentication menu.

Network Authentication

From the menu, select the authentication type to be used.
Table 10 on page 137 lists all authentication types.

Data Encryption

From the menu, select the data encryption type to be used.

The options available for data encryption as well as other requirements such as
entering a key or passphrase depend on the network authentication settings.

Table 10 on page 137 lists all data encryption options.

Wireless Client Security

From the menu, select Disable to prevent associated WiFi clients from

Separation communicating with each other, or select Enable to allow such communication.
WiFi client separation is intended for hotspots and other public access
situations.

VLAN Enter the VLAN ID to be associated with this security profile.

This VLAN ID must match the VLAN ID that other network devices use.
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Setting

Description

Authentication Settings section

Note: The options that display onscreen depend on the selection from Network Authentication menu.

Note: The MAC ACL
buttons displays only when
you select Open System,
Shared Key, WPA-PSK,
WPAZ2-PSK, or
WPA-PSK & WPA2-PSK
from the Network
Authentication menu.

MAC ACL

Select one of the following radio buttons:
* Local. Use local MAC authentication.

The Local MAC ACL Group menu displays so you can
select a group. For more information, see Manage MAC
Authentication and MAC Authentication Groups on
page 146.

» External. Use external MAC authentication.

The External Radius Server menu displays so you can
select a server. You can select either the basic-Auth
RADIUS server or a RADIUS server of an advanced
authentication group. You cannot use the external LDAP
server.

For information about setting up and enabling internal and
external authentication servers, see Manage Authentication
Servers and Authentication Server Groups on page 140.

Note: The MAC ACL radio buttons do not display onscreen if
the network authentication uses an external RADIUS server.
The reason for this is that you can configure either MAC
authentication with an external RADIUS server or network
authentication with an external RADIUS server, but not both.
That is, if you configure an external RADIUS server with WPA,
WPA2, or WPA & WPA2 (or you use Legacy 802.1X), you
cannot use external MAC authentication, and the MAC ACL
radio buttons do not display onscreen. You can still use internal
MAC authentication.

Note: The Captive
Portal check box displays
only when you select
Open System, Shared
Key, WPA-PSK,
WPAZ2-PSK, or
WPA-PSK & WPA2-PSK
from the Network
Authentication menu.

Captive Portal

Select the Captive Portal check box if you want to enable a
guest portal or captive portal.

The Captive Portal menu displays so you can select a portal.
You can select either the Basic portal or a portal from the
advanced portal group.

For information about setting up portals, see Manage Guest
Network Access Through Guest Portals and Captive Portals on
page 223.

Note: If the network authentication uses a RADIUS server,
whether it is a local server or an external server, you cannot
configure captive portal authentication. That is, if you configure
a RADIUS server with WPA, WPA2, or WPA & WPA2 (or if you
use legacy 802.1X), the Captive Portal check box is not shown
onscreen.
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Setting Description

Note: The
Authentication Server

Authentication | Select one of the following radio buttons:

buttons and menu display Server » Local. Use the local authentication server.

only when you select WPA e External. Use an external authentication server.
with Radius, WPA2 with Select an external authentication server from the
Radius, or WPA & WPA2 Authentication Server menu.

with Radius from the
Network Authentication
menu.

Note: For information about setting up and enabling internal
and external authentication servers, see Manage Authentication
Servers and Authentication Server Groups on page 140.

Wireless QoS section

Wi-Fi Multimedia (WMM) | To enable Wi-Fi Multimedia (WMM), select the Enable radio button, which is
the default setting.

Select the Disable button to disable the feature. For more information, see
Manage Quality of Service for an Advanced Profile Group on page 207.

WMM Powersave The WMM Powersave feature saves power for battery-powered equipment by
increasing the efficiency and flexibility of data transmission.

To enable this feature, select the Enable radio button, which is the default
setting.

Select the Disable button to disable the feature.

11. Click the Apply button.

Your settings are saved.

Change the Settings for a Profile in an Advanced Profile Group

You can change the settings for a profile in an advanced profile group.

To change the settings for an existing profile to an advanced profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Configuration > Profile > Advanced > Radio.
The Profile Groups page displays.

5. Click the tab for the profile group for which you want to change a profile.
6. Click the Edit button.

The Edit Profile page displays.
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Click the tab for the radio for which you want to change a profile.
Click the tab for the profile that you want to change.
Change the settings.

For information about how to change the settings, see Configure a Profile in an Advanced
Profile Group on page 131.

Click the Apply button.

Your settings are saved.

Remove a Profile From an Advanced Profile Group

You can remove a profile from an advanced profile group.

To remove an existing profile from an advanced profile group:

1.

7.
8.
0.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

Select Configuration > Profile > Advanced > Radio.

The Profile Groups page displays.

Click the tab for the profile group for which you want to remove a profile.
Click the Edit button.

The Edit Profile (Group-X) page displays.

Click the tab for the radio for which you want to remove a profile.

Click the tab for the profile that you want to remove.

Click the Delete button.

10. Confirm that you want to remove the profile.
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Network Authentication and Data Encryption Options

This section describes the detailed network authentication and data encryption options that
you can select in the procedures that are described in Configure a Profile in the Basic Profile
Group on page 124 and Configure a Profile in an Advanced Profile Group on page 131.

Table 10 on page 137 shows the data encryption options based on the network
authentication that you select on the Edit Profile (Basic) or Edit Profile (Group-X) page, and
the required configuration steps to implement the selected network authentication.

Note: On the Edit Profile (Basic) or Edit Profile (Group-X) page, for any
selection from the Network Authentication menu that requires a
RADIUS server, authentication is not restricted to a RADIUS server;
you can also use an internal authentication server or an external
LDAP server.

Note: You can configure either MAC authentication with an external
RADIUS server or network authentication with an external RADIUS
server, but not both. That is, if you configure external MAC
authentication, you cannot use an external RADIUS server with WPA,
WPA2, or WPA & WPA2.

Table 10. Network authentication and data encryption settings

Network Authentication |Data Configuration Steps

Selection Encryption
Options

Open None You can use an open system without any encryption or with WEP
WEP encryption:

* No encryption. An open system without encryption is the
default setting. No further authentication and encryption
configuration is required.

«  WEP encryption. To configure an open system with WEP
encryption, see the Shared Key and WEP information further
down in this table.
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Table 10. Network authentication and data encryption settings (continued)

Network Authentication
Selection

Data
Encryption
Options

Configuration Steps

Shared Key

64-bit WEP
128-bit WEP
152-bit WEP

To configure Shared Key authentication with WEP:

1. From the Data Encryption menu, select a level of WEP
encryption:
- 64-bit WEP. Uses 40/64-bit encryption.
- 128-bit WEP. Uses 104/128-bit encryption.
- 152-bit WEP. A proprietary mode that works only with
other WiFi devices that support this mode.

2. To display the characters in the key fields, select the Show
Key check box.

Select a key radio button (Key1, Key2, Key3, or Key4).
Enter a key in the corresponding field:

- 64-bit WEP requires a key with 10 characters.
- 128-bit WEP requires a key with 26 characters.
- 152-bit WEP requires a key with 32 characters.

Note: For information about requirements for WEP keys, see
Table 15 on page 389.

Legacy 802.1x

None

To configure legacy 802.1x authentication:

1. Setup and enable an internal or external (RADIUS or LDAP)
authentication server.
For information, see Manage Authentication Servers and
Authentication Server Groups on page 140.

Select the Local or External radio button.

If you select the External radio button, select the
authentication server that you wish to use from the menu.

WPA with Radius

TKIP
TKIP + AES

To configure WPA authentication with a RADIUS server:

1. Setup and enable an internal or external (RADIUS or LDAP)
authentication server.
For information, see Manage Authentication Servers and
Authentication Server Groups on page 140.

2. From the Data Encryption menu, select the type of
encryption:
- TKIP. Supports Temporal Key Integrity Protocol (TKIP)
only.
- TKIP + AES. Supports both TKIP and Advanced
Encryption Standard (AES).

Select the Local or External radio button.

If you select the External radio button, select the
authentication server that you wish to use from the menu.
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Table 10. Network authentication and data encryption settings (continued)

Network Authentication
Selection

Data
Encryption
Options

Configuration Steps

WPA2 with Radius

AES
TKIP + AES

To configure WPA2 authentication with a RADIUS server:

1. Setup and enable an internal or external (RADIUS or LDAP)
authentication server.
For information, see Manage Authentication Servers and
Authentication Server Groups on page 140.
From the Data Encryption menu, select the type of
encryption:
- AES. Supports AES only.
- TKIP + AES. Supports both TKIP and AES.

Select the Local or External radio button.

If you select the External radio button, select the
authentication server that you wish to use from the menu.

WPA & WPA2 with Radius

Note: Use this option if
the network includes both
WPA and WPAZ clients.

TKIP + AES

To configure WPA & WPA2 authentication with a RADIUS server:

1. Setup and enable an internal or external (RADIUS or LDAP)
authentication server.
For information, see Manage Authentication Servers and
Authentication Server Groups on page 140.

Select the Local or External radio button.
If you select the External radio button, select the
authentication server that you wish to use from the menu.

Note: The Data Encryption menu displays TKIP + AES, which
is the only available option. Both TKIP and AES are supported.

WPA-PSK

TKIP
TKIP + AES

To configure WPA-PSK authentication:

1. From the Data Encryption menu, select the type of
encryption:
- TKIP. Supports TKIP only.
- TKIP + AES. Supports both TKIP and AES.

2. To display the characters in the WPA Passphrase (Network
Key) field, select the Show Passphrase check box.

3. Type a passphrase of at least eight characters in the WPA
Passphrase (Network Key) field.

Note: For information about requirements for a WPA
passphrase, see Table 15 on page 389.
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Table 10. Network authentication and data encryption settings (continued)

Network Authentication |Data Configuration Steps
Selection Encryption
Options
WPA2-PSK AES To configure WPA2-PSK authentication:
TKIP + AES 1. From the Data Encryption menu, select the type of
encryption:

- AES. Supports AES only.
- TKIP + AES. Supports both TKIP and AES.

2. To display the characters in the WPA Passphrase (Network
Key) field, select the Show Passphrase check box.

3. Type a passphrase of at least eight characters in the WPA
Passphrase (Network Key) field.

Note: For information about requirements for a WPA
passphrase, see Table 15 on page 389.

WPA-PSK & WPA2-PSK | TKIP + AES To configure WPA-PSK & WPA2-PSK authentication:

1. To display the characters in the WPA Passphrase (Network

Note: Use this option if -
Key) field, select the Show Passphrase check box.

the network includes both
WPA and WPA2 clients. 2. Type a passphrase of at least eight characters in the WPA
Passphrase (Network Key) field.

Note: The Data Encryption menu displays TKIP + AES, which
is the only available option. Both TKIP and AES are supported.

Note: For information about requirements for a WPA
passphrase, see Table 15 on page 389.

Manage Authentication Servers and Authentication
Server Groups

You can set up internal and external authentication servers and server groups that the
wireless controller can use for authentication.

Authentication Server Concepts

You can specify three types of authentication servers: internal, external RADIUS, and
external LDAP:

* Internal authentication server. The wireless controller handles authentication. If you
use this setting, set up WiFi clients on the User Management page (see Manage Users,
Accounts, and Passwords on page 236.)

* External RADIUS server. You can define a basic external RADIUS server that you would
typically use in the profiles of a basic profile group of a small-scale network. You must
specify its configuration on the basic Authentication Server page (see Configure Basic
Authentication Server Settings on page 142) so that you can select this authentication
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option during the configuration of a profile. As part of the advanced authentication server
settings, you can define multiple external RADIUS servers that you would typically use in
a more complex network with many profiles. You can then assign different RADIUS
servers to different profiles.

By default, the external RADIUS server for the basic authentication group is called
basic-Auth. You cannot change this name. By default, the external RADIUS
authentication servers for the advanced authentication groups are called Auth1 through
Auth8, and you can change these names. You can assign the basic-Auth server to an
advanced profile group, and you can assign a RADIUS server of an advanced
authentication group to the basic profile group.

See the following configuration guidelines for external RADIUS servers:

- You must add the IP address of the wireless controller as a RADIUS client to the
RADIUS server. All managed access points are then automatically known to the
RADIUS server.

- For configuration guidelines for external MAC authentication, see Guidelines for
External MAC Authentication on page 146.

- For configuration guidelines for external authentication of captive portal users, see
Manage Guest Network Access Through Guest Portals and Captive Portals on
page 223.

e External LDAP server. You can define one external LDAP server (commonly referred to
as an Active Directory [AD] server). You must specify its configuration on the basic
Authentication Server page (see Configure Basic Authentication Server Settings on
page 142) so that you can select this authentication option during the configuration of a
profile.

By default, the external LDAP server for the basic authentication group is called
basic-LDAP. You cannot change this name, and you cannot configure any LDAP servers
for the advanced authentication groups. You can assign the basic-LDAP server to both
the basic profile group and to advanced profile groups.

All three servers can be active so that the profiles that you set up can be configured to work
with different authentication servers. For example, you could set up a guest profile with no
authentication, an engineering profile that uses external RADIUS authentication, and a
marketing profile that uses external LDAP authentication.

Note: For authentication, you can configure and use a single LDAP server
only. However, you can configure and use several RADIUS servers.

The settings that you specify on the Authentication Server page affect the selections that are
available in the Network Authentication menu and the corresponding Authentication
Server field on the Edit Profile page. For information about how to configure security profiles,
see Configure a Profile in the Basic Profile Group on page 124 and Configure a Profile in an
Advanced Profile Group on page 131.
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Configure Basic Authentication Server Settings

Use the basic Authentication Server page to set up the internal authentication server, the
basic external RADIUS server (which is called Auth-basic), and the external LDAP server
(which is called Auth-LDAP). After you set up these authentication servers, you can assign
any of them to any profile, whether in the basic profile group or in an advanced profile group.

> To configure a basic authentication server:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > Security > Basic > Authentication Server.

The basic Authentication Server page displays. The following figure shows the fields for
an external LDAP server:

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile ! WLAN Network | Captive Portal

Choose Authentication Server Type

@
D (B 61D _ Authentication Server
» MAC ACL
O Externzl RADIUS Server
O Internal Authentication Server
ST @ External LDAP Server

External LDAP Server

Server IP

Server Port 389
User Base DN

Workgroup Name

Admin Domain

Domain Admin User

Domain Admin Password

5. Select the radio button that corresponds to the authentication server that you want to set up:
» External RADIUS Server
e Internal Authentication Server
* External LDAP Server

6. Configure the settings that correspond to the selected authentication server as described in
the following table.
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Setting Description
External Enable Authentication | Select the Enable Authentication check box to enable
RADIUS authentication.
Server
Enable Accounting Select the Enable Accounting check box to enable accounting.
Primary Server Do the following for each server:
. For information about
1. Spec!fy the IP address. shared secret
2. Specify the port._ requirements, see
Secondary Server The default port is 1812. Table 15 on page 389.
3. Specify the shared secret.
Reauthentication time | Specify the time (in seconds) after which reauthentication occurs
(Seconds) for all WiFi clients.
Update Global Key To enable update of the global key:
Every (Seconds) 1. Select the Update Global Key Every (Seconds) check box.
2. Specify the interval (in seconds) after which the global key is
updated for all WiFi clients.
Internal Reauthentication Time | Specify the time (in seconds) after
Authentication | (seconds) which reauthentication occurs for all | When you use the
Server WiFi clients. internal authentication
server, set up WiFi
Update Global Key To enable update of the global key: | glients on the User
Every (seconds) 1. Select the Update Global Key Management page. For
Every (Seconds) check box. information, see Manage
2. Specify the interval (in seconds) gsers, A;(écou:ts, anc;%
after which the global key is asswords on page '
updated for all WiFi clients.
External Server IP Specify the IP address of the external Active Directory (AD)
LDAP Server authentication server.
Server Port Specify the port of the external AD server.
The default port is 389.
User Base DN Specify the user base distinguished name (DN) on the AD server.
Workgroup Name Specify the workgroup name on the AD server.
Admin Domain Specify the administrative domain on the AD server.
Domain Admin User Specify the user name for the administrative domain.
Domain Admin Specify the password for the administrative domain.
Password . . .
Note: For information about password requirements, see
Table 15 on page 389.

7. Click the Apply button.

Your settings are saved.
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For information about how to add an authentication server to a security profile in the basic
profile group, see Configure a Profile in the Basic Profile Group on page 124.

For information about how to add an authentication server to a security profile in an advanced
profile group, see Configure a Profile in an Advanced Profile Group on page 131.

Configure a RADIUS Authentication Server Group

For greater security flexibility, you can create up to eight external RADIUS servers to
authenticate and account for different groups of users. After you set up these authentication
servers, you can assign any of them, including the basic RADIUS server, to any profile,
whether in the basic profile group or in an advanced profile group.

> To set up a RADIUS authentication server group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Configuration > Security > Advanced > Authentication Server.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile | WLAN Network ;| Captive Portal

Yt Authentication Server @

PP Click + to add another authentication group.

» Rogue AP Auth-1 Auth-2 Auth-3
» MAC ACL

Group Name Auth-3
Enable Authentication O
Enable Accounting (]

IP Address Port Shared Secret
Primary Server 1812 sesssssnsene
Secondary Server i | l1s12 ssssssssssss |

Reauthentication Time (Seconds) 3600
Update Global Key Every {Seconds) 3600

CAMCEL DELETE APPLY

5. Click the + button to create an additional authentication group.
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The new authentication group displays on the advanced Authentication Server page, and
the tab for the new authentication is automatically selected to let you configure the new

group.
In the Group Name field, enter a uniqgue name for the authentication group.
By default, authentication groups are named Auth-1, Auth-2, Auth-3, and so on.

Specify the tasks for the accounting group by selecting one or both of the following check
boxes:

* Enable Authentication. Enables the authentication group to authenticate users.

* Enable accounting. Enables the authentication group to perform accounting for
users sessions.

Configure the external RADIUS server for the group.

For information about setting up an external RADIUS server, see the table in the previous
section, Configure Basic Authentication Server Settings on page 142.

Click the Apply button.
Your settings are saved.

For information about how to add a RADIUS authentication group to a security profile in the
basic profile group, see Configure a Profile in the Basic Profile Group on page 124.

For information about how to add a RADIUS authentication group to a security profile in an
advanced profile group, see Configure a Profile in an Advanced Profile Group on page 131.

Remove a RADIUS Authentication Server Group

You can remove a RADIUS authentication server group.

To remove a RADIUS authentication group:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.

Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

Select Configuration > Security > Advanced > Authentication Server.

The advanced Authentication Server page displays.

Click the tab for the RADIUS authentication group that you want to remove.

Click the Delete button.
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Manage MAC Authentication and MAC Authentication
Groups

MAC authentication lets you set up an external or a local access control list (ACL) with MAC
addresses of clients to either allow or deny the network access privilege of the specified
clients with the wireless controller—-managed access point. The settings are applied only to
managed access points.

Note: The wireless controller can support an aggregate number of
4096 MAC addresses for all its local ACLs.

Guidelines for External MAC Authentication

Note the following external RADIUS server guidelines:

For each MAC authentication client, you must configure a policy on the RADIUS server.
During MAC authentication, the wireless controller sends the following information to the
RADIUS server:

- MAC address in the format Xx:XX:XX:XX:XX:XX

- User name

- Calling station ID

The wireless controller uses CHAP as the authentication protocol with the RADIUS
server.

You can configure either MAC authentication with an external RADIUS server or network
authentication with an external RADIUS server, but not both. That is, if you configure an
external RADIUS server with WPA, WPA2, or WPA & WPAZ2, you cannot use external
MAC authentication but are limited to internal MAC authentication.

Configure Basic Local MAC Authentication Settings

You would typically use the basic MAC authentication group in the profiles of a basic profile
group of a small-scale network. However, you can assign the basic MAC authentication
group to any profile, whether in the basic profile group or in an advanced profile group.

The wireless controller supports a maximum of 4,096 MAC addresses per SSID.

Note: You cannot add multicast or broadcast MAC addresses to a MAC
access control list (ACL).
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» To set up basic MAC authentication ACL:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Configuration > Security > Basic > MAC ACL.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile ! WLAN Network | Captive Portal

MAC Authentication @
* Rogue AP

Import MAC List from a file Merge v
» Authentication
Server (..‘ I ® :
o — Treat ACL as A Allow Deny
Selected Wireless Clients DELETE ADD Available Wireless Clients
MAC Address $ _ MAC Address sl
00:00:11:11:22:25 O

00:bbi14:dci22:3e
00:3d:14:dc:Zabb

o0

Note: As an option, you can import a list of MAC addresses from a file. For
more information, see Import a MAC List From a File on page 148.

5. Next to Treat ACL as, select one of the following radio buttons:

« Allow. Network access is granted to the clients for which the MAC addresses are
listed in the Selected Wireless Clients list.

« Deny. Network access is denied to the clients for which the MAC addresses are listed
in the Selected Wireless Clients list.

6. Add WiFi clients to the Selected Wireless Clients list through one of the following methods:

e The MAC address that you want to add is in Available Wireless Clients list, which
contains WiFi stations that are present in the vicinity of the access point:

a. Select the MAC address from the Available Wireless Clients list.
b. Click the Move button.
* The MAC address that you want to add is not in Available Wireless Clients list:
a. Enter the MAC address in the MAC Address field.
b. Click the Add button.
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7. Click the Apply button.

Your settings are saved.

Remove a MAC Address From a Wireless Client List

You can remove a MAC address from a wireless clients list.

» Toremove a MAC address from a wireless clients list:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
3. Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.

4. Select Configuration > Security > Basic > MAC ACL.
The basic MAC Authentication page displays.

5. In the Selected Wireless Clients list, select the check boxes that correspond to the MAC
addresses that you want to remove.

6. Click the Delete button.
7. Click the Apply button.

Your settings are saved.

For information about how to add a MAC ACL to a security profile in the basic profile group,
see Configure a Profile in the Basic Profile Group on page 124.

For information about how to add a MAC ACL to a security profile in an advanced profile
group, see Configure a Profile in an Advanced Profile Group on page 131.

Import a MAC List From a File

You can import a precompiled list of MAC addresses from a saved file. This file must be a
simple text file with one MAC address per line.

» To import a MAC list from afile:
1. Create a text file that includes a list of MAC addresses.

Each MAC address must be on a separate line with hard returns between lines as shown
in the following example:

00:00:11:11:22:29
00:00:11:11:22:28
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00:00:11:11:22:27
00:00:11:11:22:26
00:00:11:11:22:25

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Configuration > Security > Basic > MAC ACL.

The basic MAC Authentication page displays.

Click the Browse button, navigate to the file containing the list of MAC addresses, and
select it.

Make one of the following selections from the Import MAC List from a file menu:

* Merge. Merges the list of MAC addresses that you intend to import with the MAC
addresses that are already present in the Selected Wireless Clients list.

* Replace. Replaces the MAC addresses that are present in the Selected Wireless
Clients list with the MAC addresses in the file that you intend to import.

Click the Import button.

The wireless controller imports the MAC addresses that are in the text file into the Rogue
List table.

Click the Apply button.
Your settings are saved.

Configure a Local MAC Authentication Group

For greater security flexibility, you can create up to eight MAC authentication groups (MAC
ACLSs) to block or allow network access privilege of different clients. You can assign any MAC
authentication group, including the basic MAC authentication group, to any profile, whether in
the basic profile group or in an advanced profile group.

The wireless controller supports a maximum of 4,096 MAC addresses per SSID.

Note: You cannot add multicast or broadcast MAC addresses to a MAC
access control list (ACL).

Manage Security Profiles and Profile Groups

149



ProSAFE Wireless Controller

> To set up a MAC authentication group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > Security > Advanced > MAC ACL.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless Security | Profile | WLAN Network | Captive Portal

Basic MAC Authentication @)
> Rogue AP ackt [ Ack2  Aacd3  ac-4 |+ <«—— Click + to add another ACL group.
» Authentication
Sarver Group Name Acl-4
- Import MAC List from a file Merge &
(I
Treat ACL as O dllow @ Deny
Selected Wireless Clients DELETE | |_ADD Available Wireless Clients

00:ca:c3:20:34:81
00:ddic3:65:34:b3 o

00:34:c3:d5:78: 21

CAMNCEL DELETE IMPORT APPLY

5. Click the + button to create an additional ACL group.

6. The new ACL group displays on the advanced MAC Authentication page, and the tab for the
new ACL is automatically selected to let you configure the new group.

7. Inthe Group Name field, enter a unique name for the ACL group.
By default, profile groups are named Acl-1, Acl-2, Acl-3, and so on.
8. Compile the Selected Wireless Clients list.

For information about how to compile a WiFi clients list, see Configure Basic Local MAC
Authentication Settings on page 146.

9. Click the Apply button.

Your settings are saved.
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For information about how to add a MAC authentication group to a security profile in the
basic profile group, see Configure a Profile in the Basic Profile Group on page 124.

For information about how to add a MAC authentication group to a security profile in an
advanced profile group, see Configure a Profile in an Advanced Profile Group on page 131.

Remove a Local MAC Authentication Group

You can remove a local ACL group.

» Toremove alocal ACL group:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Configuration > Security > Advanced > MAC Authentication.
The advanced MAC Authentication page displays.

Click the tab for the ACL group that you want to remove.
Click the Delete button.

Select an ACL for a Profile in the Basic Profile Group

MAC authentication either allows or denies network access to clients on access point that are
managed through a select profile in the basic profile group.

» To select alocal or external MAC ACL for a profile in the basic profile group:

1.

Configure a local MAC ACL or an external MAC ACL on an external RADIUS server.

For more information about configuring a local MAC ACL, see Configure Basic Local
MAC Authentication Settings on page 146 and Configure a Local MAC Authentication
Group on page 149.

For more information about configuring an external MAC ACL, see Guidelines for
External MAC Authentication on page 146.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
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3. Enter your user name and password.

4. Click the Login button.
The wireless controller’s web management interface opens and displays the Summary
page.

5. Select Configuration > Profile > Basic > Radio.
The Edit Profile (Basic) page displays.

6. Click the tab for the radio on which the profile is configured for which you want to select a
MAC ACL.

7. Click the tab for the profile for which you want to select a MAC ACL.

On the Edit Profile page for the selected profile, next to MAC ACL, select a local or external
MAC ACL:

e Local MAC ACL:

a. Select the Local radio button.

b. From the Local MAC ACL Group menu, select a local MAC ACL.
e External MAC ACL:

a. Select the External radio button.

b. From the External Radius Server menu, select the external RADIUS server on
which the external MAC ACL is configured.

9. Click the Apply button.
Your settings are saved.

At initial client authentication, the wireless controller consults the external MAC ACL. While a
client roams, the wireless controller uses cached authentication information. After a client
disassociates from the access point and then attempts to reassociate, the wireless controller
once again consults the external MAC ACL.

Select an ACL for a Profile in an Advanced Profile Group

MAC authentication either allows or denies network access to clients on access point that are
managed through a select profile in the advanced profile group.

> To select a local or external MAC ACL for a profile in an advanced profile group:
1. Configure a local MAC ACL or an external MAC ACL on an external RADIUS server.

For more information about configuring a local MAC ACL, see Configure Basic Local
MAC Authentication Settings on page 146 and Configure a Local MAC Authentication
Group on page 149.

For more information about configuring an external MAC ACL, see Guidelines for
External MAC Authentication on page 146.

2. Open a web browser, and in the browser’s address field, type the wireless controller's IP
address.
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By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

Select Configuration > Profile > Advanced > Radio.

The Profile Groups page displays.

Click the tab for the profile group on which the profile is configured for which you want to
select a MAC ACL.

Click the Edit button.
The Edit Profile page displays.

Click the tab for the radio on which the profile is configured for which you want to select a
MAC ACL.

Click the tab for the profile for which you want to select a MAC ACL.

On the Edit Profile page for the selected profile, next to MAC ACL, select a local or external
MAC ACL:

e Local MAC ACL:

a. Select the Local radio button.

b. From the Local MAC ACL Group menu, select a local MAC ACL.
e External MAC ACL.:

a. Select the External radio button.

b. From the External Radius Server menu, select the external RADIUS server on
which the external MAC ACL is configured.

Click the Apply button.
Your settings are saved.

At initial client authentication, the wireless controller consults the external MAC ACL. While a
client roams, the wireless controller uses cached authentication information. After a client
disassociates from the access point and then attempts to reassociate, the wireless controller
once again consults the external MAC ACL.
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Discover and Manage Access
Points

This chapter includes the following sections:

Access Point Discovery Guidelines

Discover Access Points With the Discovery Wizard

Manage the Managed AP List

Assign Access Points to Buildings, Floors, and Advanced Profile Groups

IMPORTANT:

Before you use the wireless controller to discover your access
points and push the configurations to the access points, do the
following:

1. Make sure that you register a sufficient number of licenses.

2. Determine which profiles and security you require.

3. If needed, set up authentication servers and MAC authentication.

4. Complete the configuration of the profiles that you intend to use.

These steps are described in Register Your Licenses on page 110
and in Chapter 7, Manage Security Profiles and Profile Groups.
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Access Point Discovery Guidelines

You must run the Discovery Wizard for the wireless controller to discover supported
NETGEAR access points on the LAN or WAN. The wireless controller can discover access
points that are still in their factory default state and access points that are already deployed in
a standalone configuration.

Both access points in the factory default state and deployed standalone access points run
standalone firmware. For information about the minimum required standalone firmware
versions, see Supported NETGEAR Access Points on page 27.

After the access points are discovered, you can add them to the Managed AP List, enabling
the wireless controller to automatically upgrade the standalone firmware of the access points
to managed-mode firmware. You can then use the wireless controller to configure, manage,
and monitor the managed access points.

General Discovery Guidelines

An access point must run at least its initial firmware release or a newer version. For firmware
requirements, see Supported NETGEAR Access Points on page 27. No other firmware
requirements exist for the access point to function with the wireless controller.

Access points in the factory default state that are in the same Layer 2 network and are
assigned the same IP address can still be discovered. Depending on the configuration of the
DHCP server, these access points are discovered in parallel or sequentially.

Specifying an internal DHCP server on the wireless controller automatically enables DHCP
option 43 (vendor-specific information) with the IP address of the wireless controller. Whether
you must enable option 43 on an external DHCP server in a Layer 2 network depends on the
firmware version that the wireless controller is running:

* Firmware version 4.x and earlier versions. Option 43 must be enabled on an external
DHCP server in a Layer 2 network.

e Firmware version 5.x and later versions. Option 43 is not required on an external
DHCP server in a Layer 2 network.

Layer 3 Discovery Guidelines

The following are the requirements for autodiscovery of local access points across Layer 3
networks:

« Enable SNMP and SSH on all standalone access points. (This is the default setting for
access points.)

e For all access points with a static IP address, access the web management interface of
the access point and manually enter the IP address of the wireless controller in the
Controller IP field. (This requirement does not apply to Layer 2 discovery.)

e Unblock UDP port number 7890 in the firewall.

e Assign each access point a unique IP address. (This requirement does not apply to Layer
2 discovery.) If two or more access points are assigned the same IP address, only one of
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them is discovered at a time. You must add the access point to the managed list, change
its IP address, and run discovery again to discover the next access point with that IP
address.

Enable DHCP option 43 (vendor-specific information) on an external DHCP server.
Specifying an internal DHCP server on the wireless controller automatically enables
DHCP option 43 with the IP address of the wireless controller.

How you must configure DHCP option 43 depends on the type of external DHCP server:

Layer 3 switch as a DHCP server. If you use a Layer 3 switch as a DHCP server,
specify the wireless controller’s IP address in hexadecimal format to allow the access
points to receive the wireless controller’'s IP address and to allow the DHCP server to
assign IP addresses to the access points. The vendor-specific octets 02:04: must
precede the hexadecimal address.

To compose the address, start with 02:04: and then add each of the four address
octets in hexadecimal format, separated by colons. For example:

192.168.33.27 in decimal format equals c0:a8:21:1b in hexadecimal format. After
you add the vendor-specific octets, the complete address is 02:04:c0:a8:21:1b.

In a configuration with stacked wireless controllers, use the octets that are shown in
the following table.

Table 11. Vendor-specific Octets

Number of Controllers Octet
1 wireless controller 02:04
2 wireless controllers 02:08
3 wireless controllers 02:0c

In a stacked configuration, to compose the address, start with the corresponding
vendor-specific octet for the number of wireless controllers in the stack. Then add
each of the four address octets in hexadecimal format, separated by colons. For
example:

192.168.33.27 in decimal format equals c0:a8:21:1b in hexadecimal format. After
you add the vendor-specific octet for a stack with three wireless controllers, the
complete address is 02:0c:c0:a8:21:1b.

Linux-based or Windows-based DHCP server. If you use a Linux-based or
Windows-based DHCP server, configure the IP address in decimal format and
NETGEAR_WNC_AP as the vendor class identifier.
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Remote Access Point Discovery Guidelines

The following guidelines apply to the discovery of remote access points:

Enable SNMP and SSH on all standalone access points.

Unblock the following ports in the firewall at the site where the wireless controller is
located so that the remote access points can communicate with the wireless controller:

For models WC7600 and WC9500:

TCP port 22. Used by Secure Shell (SSH) and Secure Copy (SCP) for the
transfer of software images and large configuration files and for the transfer over
a tunnel.

UDP port 69. Used by TFTP for software image upgrades of standalone access
points.

UDP port 123. Used by Network Time Protocol (NTP).
UDP port 138. Used by NetBIOS to resolve names.
UDP port 161. Used by the SNMP discovery process.

UDP port 6650. Used by the control channel between the wireless controller and
the remote access point.

UDP port 7890. Used by the multicast discovery process. This port does not need
to be unblocked in a configuration in which remote access points are located
behind a NAT router.

For models WC7500 and WC7600v2:

TCP port 22. Used by Secure Shell (SSH) and Secure Copy (SCP) for the
transfer of software images and large configuration files and for the transfer over
a tunnel.

TCP port 6670. Used for communication and backward compatibility with access
points that run an older firmware release.

TCP port 6680. Used for communication and backward compatibility with access
points that run an older firmware release.

UDP port 69. Used by TFTP for software image upgrades of standalone access
points.

UDP port 123. Used by Network Time Protocol (NTP).
UDP port 138. Used by NetBIOS datagram service.
UDP port 161. Used by the SNMP discovery process.

UDP port 6650. Used by the control channel between the wireless controller and
the remote access point.

UDP port 7000. Used for Layer 3 roaming support.

UDP port 7890. Used by the multicast discovery process. This port does not need
to be unblocked in a configuration in which remote access points are located
behind a NAT router.
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« UDP port 7892. Used for access point registration with the wireless controller
after discovery.

« UDP port 7893. Used for access point registration with the wireless controller
during multicast discovery.

Enable DHCP option 43 (vendor-specific information) on the DHCP server. Specify the
wireless controller’s IP address to allow the access points to receive the wireless
controller’s IP address and the DHCP server to assign IP addresses to the access points.

The DHCP server on the wireless controller automatically enables DHCP option 43 with
its own IP address.

Convert access points behind a NAT router to managed access points and then install
them behind the NAT router.

Assign each access point an IP address. All access points that are the same model ship
with the same default IP address. Except for access points in the factory default state that
are in the same Layer 2 network at the remote site, if two or more access points are
assigned the same IP address, then only one of them is discovered at a time. You must
add the access point to the managed list, change its IP address, and then run discovery
again to discover the next access point with that IP address.

An access point must run at least its initial firmware release or a newer version. No other
firmware requirements exist for the access point to function with the wireless controller.

Tip: For management and monitoring purposes, make sure that you give
remote access points at one site the same location name and that you
create and assign meaningful building and floor names. For information
about creating building and floor names, see Manage a Building and
Floors for an RF Plan on page 56. For information about assigning
location, building, and floor names, see Change Access Point
Information on the Managed AP List on page 170.

Limitations After Discovery

The following limitations apply after remote access points are discovered:

Seamless Layer 2 roaming is supported for the clients of a remote access points, but
seamless Layer 3 roaming is not supported for the clients across remote access points.
When clients move from one IP subnet to another at the remote site, they are
disconnected from their access point and must reconnect to another access point.

If a remote access point is disconnected from the wireless controller, for example,
because the VPN connection goes down, the following occurs:

- The remote access point uses its last known configuration and functions as a
standalone access point while continuously attempting to reconnect to the wireless
controller.

- If the access point uses WPA-PSK, WPA2-PSK, or WPA-PSK & WPA2-PSK
authentication, it can continue to accept new clients. If the access point uses RADIUS
authentication with the local RADIUS server of the wireless controller instead of an
external RADIUS server, the access point can no longer accept new clients.
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- If the access point is rebooted, it loses its configuration.

After the connection with the wireless controller is reestablished, the remote access point
functions once again as a managed access point.

Discover Access Points With the Discovery Wizard

The Discovery Wizard provides two methods to find access points that are not yet on the
managed access point list. These methods are described in the following sections:

e Discover Access Points in Factory Default State and Access Points in a Layer 2 Subnet

» Discover Access Points Installed and Working in Standalone Mode in Different Layer 3
Networks

& CAUTION:

If security is not set up, or is set up incorrectly, when the wireless controller
pushes the configurations to the access points, you could accidentally
wipe out all security, leaving your entire network open to access. Be sure
that you set up security correctly (see Chapter 7, Manage Security Profiles
and Profile Groups).

Discover Access Points in Factory Default State and Access
Points in a Layer 2 Subnet

Access points in the factory default state are access points “out of the box” that were never
employed. Access points in a Layer 2 subnet are access points that are installed and
functioning in the same IP subnet as the wireless controller and that are connected to the
wireless controller through a back-end Layer 2 switch.

Note: For information about DHCP option 43, see General Discovery
Guidelines on page 155.

» To discover access points in the factory default state and access points in a Layer 2
subnet:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.
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The wireless controller’s web management interface opens and displays the Summary
page.
Select Access Point > Discovery Wizard.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Discovery

Discovery Wizard 7

Managed AP List
J Step 1 of 2 : Choose state of Access Points

In simple steps WC9500 can discover your supported Access Points in the network.
Please select the state of the Access Points

® out of Factory and L2 Subnet APs
© Installed and working in Standalone Mode

© 1 am not sure

BACK MEXT

Select the Out of Factory and L2 Subnet APs radio button.
Note: The | am not sure radio button directs you to the product documentation.

Click the Next button.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Discovery

Discovery Wizard 7

Managed AP List

Step 2 of 2 : Select Access Points to manage

L2 Subnet APs B B v
Out of Factory APs [ B
Total AP Discovered: 3 RESTART
Search

| |
WNDAP360 192.168.0.144 c4:3dic71a1106:60 Local v O
WHAP210 192.168.0.145 c0:3fi0e:7bi126:d0 Local ]
WHAPELO 152.168.0.146 cli3file: Thizd:80 Local a

BACK ADD

The wireless controller searches for NETGEAR products on the LAN based on MAC
address and identifies which products are supported access point models. Progress bars
show the progress of the discovery process.

When the discovery process is finished, the total number of access points is displayed
and the table shows the access points that were discovered. For each access point, the
table includes the model number, IP address, MAC address, and site.

To find an individual access point, enter information in the Search field.
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To make sure that all the access points are listed, review the discovery results.

The effectiveness of the discovery process depends in part on how the access points on
your LAN are set up. If each access point is configured with a unique IP address and is
running current firmware, discovery is simple.

If the discovery results are not what you expect, check the following:

e Access points that the wireless controller already manages are not in the discovery
list.

To view the Managed AP List, select Access Point > Managed AP List.
e The access points might be in a different IP network.

For information about how to discover access points in a different subnet, see
Discover Access Poaints Installed and Working in Standalone Mode in Different Layer
3 Networks on page 163.

* Access points that are in factory default mode but across a router are not detected.

For information about how to discover access points across a router, see Discover
Access Points Installed and Working in Standalone Mode in Different Layer 3
Networks on page 163.

 Make sure that a DHCP server is available in the network or on the wireless
controller.

For information about the wireless controller's DHCP server, see Manage the DHCP
Server on page 106.

* For more information, see Resolve Problems With Access Points on page 365.
To run the discovery process again, click the Restart button.

To designate an access point as a remote access point, from the Site menu, select
Remote.

By default, all discovered access points are designated as Local. The Remote and
Local designations are for organization only.

Note: The wireless controller cannot discover remote access points over a
site-to-site VPN connection or behind a remote NAT router without a
VPN connection. To use an access point as a remote access point
over a site-to-site VPN connection or behind a remote NAT router
without a VPN connection, you must preprovision the access point and
send it to the remote site for installation. For remote access points, the
maximin WAN delay period is 100 millisecond.

Either select individual access points to be added to the managed list or select all access
points to be added to the managed list:

« Select individual check boxes for discovered access points that you want to add to
the managed list.

e Select the check box in the upper right of the table heading to add all discovered
access points to the managed list.
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12. Click the Add button.

Depending on the type of access points that were discovered, a page that lets you enter
or ignore a login name and a password might display.

13. If necessary, enter the login name and password.

The Managed AP List page displays. Because this page is wide, it is shown in the
following two figures.

Access Point Configuration Maonitor Maintenance Stacking Plans Diagnostics

Discovery

Discovery Wizard Managed AP List

Search
u MAC Model Name Status I
192.168.0.145 c0:3f:0e:7b:26:d0 WHNAPZ210 netgear7B260D8 Connected

|:| 192.168.0,146 c0:3fi0e:7b:124:80 WNAP210  netgear7B2488 Connected
D 192.168.0.144 c4:3d:c7:21:06:60 WNDAP3E0 netgearAl 0668 Connected

I capablhty ¢ | 2.4ghz Mode ¢ | 5ghz Mode Select

Local basic 802.11bgn

Local  basic BGN 802.11bgn -MA- O

Local  basic ABGN 802.11bgn 202,113 O
REMOVE EDIT REFRESH

After the access points are added to the Managed AP List, the wireless controller
upgrades the firmware of the access points to the latest firmware that is loaded on the
wireless controller, and the access points become managed access points. Depending
on the number of access points that you add to the Managed AP List, this process might
take several minutes.

By default, the access point upgrade process uses multicast. If you must configure a
specific multicast IP address range for the upgrade process or disable multicast, see
Configure Multicast Firmware Upgrade for Access Points on page 278.
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If one or more access points do not transition to the Connected state (see the Status
column in the Managed AP List), see Resolve Problems With Access Points on
page 365.

For information about how to manage the Managed AP List, see Manage the Managed
AP List on page 167.

Discover Access Points Installed and Working in
Standalone Mode in Different Layer 3 Networks

Access points that are installed and working in standalone mode in different Layer 3 networks
are access points that do not function in the same subnet as the wireless controller but in
different IP ranges and that are connected to the wireless controller through a router.

Note: Make sure that DHCP option 43 (vendor-specific information) is
enabled on an external DHCP server. For more information, see
Layer 3 Discovery Guidelines on page 155.

In a large WiFi network you might need to run the Discovery Wizard several times.

> To discover access points in different Layer 3 networks:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
Select Access Point > Discovery Wizard.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Discovery

Discovery Wizard

Managed AP List n
2 S Step 1 of 3 : Choose state of Access Points

In simple steps WC9500 can discover your supported Access Points in the network.
Please select the state of the Access Points

O out of Factory and L2 Subnet APs
® Installed and working in Standalone Mode

O I am not sure

BACK MNEXT

5. Se

lect the Installed and working in Standalone Mode radio button.

Note: The | am not sure radio button directs you to the product documentation.

6. Click the Next button.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

. Managed AP List )
= = il Step 2 of 3 : Specify IP Range

covery

Discovery Wizard @

Range 1
Start IP
End IP

BACK MEXT

7. In the Range 1 section, fill in the Start IP and End IP fields.

Th

ese IP addresses specify the range in which the wireless controller must discover

access points.

8. To
a.

d.

add more IP address ranges for the wireless controller to search in, do the following:
Click the Add button.

The page adjusts to display a second set of Start IP and End IP fields.

In the Range 2 section, fill in the Start IP and End IP fields.
Click the Add button.

The page adjusts to display a third set of Start IP and End IP fields.
In the Range 3 section, fill in the Start IP and End IP fields.

9. Click the Next button.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Discovery Wizard [

Managed AP List
Step 3 of 3 : Select Access Points to manage

L3 Subnet APs v

Total AP Discovered: 3 RESTART

Search
Model
WHDAR 360 192.168.0.144 c4:3d:cT:al:06:60 Local ¥
WHAPZ10 192.168.0.146 c0:3fi0e:7b:24:80 Local v
WNAP210 192.168.0.145 cO:3fi0e: Th: 26:d0 Local

]
O
O
O

BACK ADD

The wireless controller searches for NETGEAR products on the LAN based on MAC
address and then identifies which products are supported access point models. A
progress bar show the progress of the discovery process.

When the discovery process is finished, the total number of access points is displayed
and the table shows the access points that were discovered. For each access point, the
table includes the model number, IP address, MAC address, and site.

10. To find an individual access point, enter information in the Search field.
11. To make sure that all the access points are listed, review the discovery results.

The effectiveness of the discovery process depends in part on how the access points on
your LAN are set up. If each access point is configured with a unique IP address and is
running current firmware, discovery is simple.

If the discovery results are not what you expect, check the following:

* Access points that the wireless controller already manages are not in the discovery
list.

To view the Managed AP List, select Access Point > Managed AP List.

 Make sure that a DHCP server is available in the network or on the wireless
controller.

For information about the wireless controller's DHCP server, see Manage the DHCP
Server on page 106.

e If more than one access point is assigned the same IP address, only one of them is
discovered at a time.

You must add the access point to the managed list, change its IP address, and run
discovery again to discover the next access point with that IP address.

e For more information, see Resolve Problems With Access Points on page 365.
12. To run the discovery process again, click the Restart button.
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13. To designate an access point as a remote access point, from the Site menu, select

14.

15.

16.

Remote.

By default, all discovered access points are designated as Local. The Remote and Local
designations are for organization only.

Note: The wireless controller cannot discover remote access points over a
site-to-site VPN connection or behind a remote NAT router without a
VPN connection. To use an access point as a remote access point over
a site-to-site VPN connection or behind a remote NAT router without a
VPN connection, you must preprovision the access point and send it to
the remote site for installation. For remote access points, the maximin
WAN delay period is 100 millisecond.

Either select individual access points to be added to the managed list or select all access
points to be added to the managed list:

« Select individual check boxes for discovered access points that you want to add to the
managed list.

e Select the check box in the upper right of the table heading to add all discovered
access points to the managed list.

Click the Add button.

Depending on the type of access points that were discovered, a page that lets you enter
or ignore a login name and a password might display.

If necessary, enter the login name and password.

The Managed AP List page displays. Because this page is wide, it is shown in the
following two figures.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Discovery

Discovery Wizard Managed AP List

Search

I 77 T T
192.168.0.145 c0:3f:0e:7b:26:d0 WHNAPZ10 netgear7B26D8 Connected

D 192.168.0.146 c0:3f:0e:7b:124:80 WMNAP210 netgear7B2488 Connected

|:| 192.168.0.144 c4:3d:c7:31:06:60 'WNDAP360 netgearAl0668 Connected
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ﬁ

I Capability ¢+ | 2.4ghz Mode % | 5ghz Mode :] Select
BGN -NA- ®

Local basic 802.11bagn

Local  basic BGN 802.11bgn -NA- @
Local basic ABGN 802.11bgn 802.11a O
REMOVE EDIT REFRESH

After the access points are added to the Managed AP List, the wireless controller
upgrades the firmware of the access points to the latest firmware that is loaded on the
wireless controller, and the access points become managed access points. Depending
on the number of access points that you add to the Managed AP List, this process might
take several minutes.

By default, the access point upgrade process uses multicast. If you must configure a
specific multicast IP address range for the upgrade process or disable multicast, see
Configure Multicast Firmware Upgrade for Access Points on page 278.

If one or more access points do not transition to the Connected state (see the Status
column in the Managed AP List), see Resolve Problems With Access Points on
page 365.

For information about how to manage the Managed AP List, see Manage the Managed
AP List on page 167.

Manage the Managed AP List

After you add discovered access points to the Managed AP List, you can view the status of
the access points on the list, change information for selected access point on the list, and
remove access points from the list.

View the Managed AP List

The managed AP List displays the status, IP addresses, MAC addresses, model numbers,
names, and other information for the managed access points.

> To view the status and other information for managed access points:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
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The wireless controller’s login window opens.
Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
Select Access Point > Managed AP List.

The Managed AP List page displays. Because this page is wide, it is shown in the
following two figures.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Discovery

Discovery Wizard Managed AP List

Search
I S 7 T R
192.168.0.145 c0:3f:0e:7b:26:d0 WHNAPZ10 netgear7B26D8 Connected

|:| 192.168.0.146 c0:3f:0e:7b:24:80 WNAP210  netgear7B2488 Connected
|:| 192.168.0.144 c4:3d:c7:31:06:60 WNDAP360 netgearAl0668 Connected

I (apahlllty ¢ | 2.4ghz Mode # | S5ghz Mode % Select

Local basic 802.11bagn

Local  basic BGN 802.11bgn -NA- O

Local basic ABGN 802.11bgn 802.11a O
REMOVE EDIT REFRESH

The Managed AP List page shows the following entries for each access point that you
added to the list:

Item Description

IP The IP address of the access point.
MAC The MAC address of the access point.
Model The model of the access point.
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Iltem Description
Name The name of the access point.
Status Shows one of the following states:

e Authentication in progress. This state occurs during the discovery and
upgrade process of a standalone access point when the wireless controller
logs in to the access point using the access point’s password. This state can
last several minutes.

e Firmware upgrade. This state occurs after the access point receives the
firmware file when the access point upgrades to the new firmware. This state
can last several minutes.

e AP is rebooting. This state occurs after the firmware upgrade process
completes when the access point reboots.

« Applying configurations. This state occurs after the wireless controller
upgrades the firmware on the access point when the wireless controller pushes
the WiFi configurations to the access point.

e Connecting. This state occurs when the wireless controller attempts to
establish a management connection with the access point.

Make sure that a DHCP server is enabled in the network. Otherwise, the access
point remains in the Connecting state and does not transition to the
Connected state.

e Connected. This state indicates that the firmware upgrade of the access point
was successful, the WiFi configurations were pushed to the access point, and
the access point is managed by the wireless controller.

« Not Connected. This state indicates that the wireless controller cannot
communicate with the access point at the configured IP address. The wireless
controller attempts to log in to access points each minute. If the error is
temporary, the state automatically changes to Connected. If the error is
prolonged, verify the access point’s IP address and network connectivity. For
more information, see Resolve Problems With Access Points on page 365.

Site Shows whether you designated the access point as a local or remote one:

e Local. The access point is designated as a local.

« Remote. The access point is designated as remote.

For more information about designating an access point as local or remote, see

Discover Access Points With the Discovery Wizard on page 159.

Group Name The default group is basic. For information about changing the group for an access

point, see Change Access Point Information on the Managed AP List on page 170.

Capability The WiFi modes that the access point supports.
Note: Capability information lets you determine which access points are 802.11n
mode capable but function in 802.11g mode.

2.4ghz Mode The access point’s WiFi modes that function in the 2.4 GHz band.

5ghz Mode The access point’'s WiFi modes that function in the 5 GHz band.
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Change Access Point Information on the Managed AP List

For each individual access point, you can change the general information, IP settings, and
VLAN settings, you can switch between the internal and external antenna (if the access point
supports an external antenna), and you can enter location information.

For a WAC740 access point that is on the managed list, you can also enable link aggregation
by using the following procedure. Link aggregation is required if you want to set up a link
aggregation group (LAG) connection between the WAC740 access point and a switch.

For more information about setting up a LAG connection for a WAC740 access point, see
Enable Link Aggregation on a WAC740 Access Point on page 382.

Note: Do not confuse link aggregation for a WAC740 access point with link
aggregation for a WC7600v1 or WC9500 wireless controller (see
Controller Link Aggregation Concepts on page 103), which is a
configuration between the WC7600v1 or WC9500 wireless controller
and a switch or router.

To change the information for an access point on the Managed AP List:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and Change Access Point Information on the Managed AP List on
page 170.

3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Access Point > Managed AP List.
The Managed AP List page displays.

5. Select the access point that you want to change by selecting its radio button in the Edit
column of the Managed AP List.

6. Click the Edit button.
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Monitor

Configuration

Access Point

Discovery

Discovery Wizard Edit Access Point

Access Point Info

Maintenance

Stacking Plans Diagnostics

Name netgearAd10668
Model WNDAP360
Group basic ¥
1P Settings
DHCP ® enable O disable
IP Address 192.168.0.144
Subnet Mask 255.255.255.0
Default Gateway 192.168.0.1
Primary DNS Server
Secondary DNS Server
VLAN Settings
Management YLAN 1
Untagged YLAN 1
Wireless Settings
Antenna Internal v
Plan Settings
Site Local
Building Building-1 v
Floor Floor-1 v
Location

CAMCEL BACK APPLY

Configure the settings as described in the following table.

Setting Description

Access Point Info section

Name Enter a unique value that indicates the access point name.
By default, the name is netgearxxxxxx, where xxxxxx represents the last six
hexadecimal digits of the access point's MAC address. You can change the name
to one that is meaningful to you.

Model The model of the access point.

This field is populated during the access point discovery process and cannot be
changed.
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Setting

Description

Group

The group to which the access point is assigned.

After the access point discovery process, the access point is automatically
assigned to the basic group. If you set up profile groups, you can assign the
access point to another profile group by selecting one from the menu. You can
also change the group assignment later on the WLAN Group Assignment page.
For more information, see Assign Access Points to Buildings, Floors, and
Advanced Profile Groups on page 174.

IP Settings

These fields show the IP address and other IP settings of the access point. By default, these fields are
populated during the access point discovery process. The following are the functions of the radio buttons:

DHCP client.

enable. By default, the enable radio button is selected, allowing the access point to function as a

The IP Settings fields are masked out, preventing you from changing the IP settings.

disable. Select the

disable radio button to disable the access point's DHCP client.

The IP Settings fields become available, allowing you to change the IP settings, including changes to
the access point’s IP address.

IP Address

The IP address of the access point.

Subnet Mask

The subnet mask of the access point.

Default Gateway

The default gateway of the access point.

Primary DNS Server

The primary DNS server of the access point.

Secondary DNS Server

The secondary DNS server of the access point.

VLAN Settings section

Managed VLAN

Enter a VLAN ID or leave the default ID.

By default, the management VLAN is 1. For more information about management
VLANS, see Management VLAN on page 36 and Management VLAN Concepts on
page 102.

Untagged VLAN

Enter a VLAN ID or leave the default ID.

By default, the untagged VLAN is 1 and the Untagged VLAN check box is
selected. When the wireless controller sends frames associated with the untagged
VLAN to the LAN (Ethernet) interface, those frames are untagged. When the
wireless controller receives untagged traffic from the LAN (Ethernet) interface,
those frames are assigned to the untagged VLAN.

Link Aggregation secti

on (WAC740 access point only)

Link Aggregation

You can enable link aggregation for Ethernet ports on the access point by
selecting the enable radio button. By default, the disable radio button is selected
and link aggregation is disabled.

Note: Link aggregation for access point Ethernet ports is supported only for a
WAC740 access point.
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Setting Description

Wireless Settings section

Antenna You can specify which antenna the access point uses by making a selection from
the menu:

e Internal. The access point uses its internal antenna.

e External. The access point uses its external antenna or antennas. External
antennas are optional antennas that do not come standard with an access
point.

Plan Settings section

Site Shows whether you designated the access point as a local or remote one:
e Local. The access point is designated as a local.
« Remote. The access point is designated as remote.

For more information about designating an access point as local or remote, see
Discover Access Points With the Discovery Wizard on page 159.

Building Select a building from the menu. By default, the building designation is
Building-1.

For information about how to set up a custom building, see Manage a Building and
Floors for an RF Plan on page 56.

Floor Select a floor from the menu. By default, the floor designation is Floor-1.

For information about how to set up a custom floor, see Manage a Building and
Floors for an RF Plan on page 56.

Location Enter a name that is meaningful to you.

8. Click the Apply button.
Your settings are saved.
9. Click the Back button.

The Managed AP List page displays. Changes that you made on the Edit Access Point
page are displayed in the table.

10. If the changes do not display in the table, click the REFRESH button.

Remove Access Points From the Managed AP List

To restore a managed access point to its original firmware and use it once again as a
standalone access point, remove the access point from the Managed AP List. Log in to the
access point’'s web management interface, upgrade the firmware to the standalone AP
firmware version, and reboot the access point.

» To remove an access point from the Managed AP List:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
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2. Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.

4. Select Access Point > Managed AP List.
The Managed AP List page displays.

5. Select the radio button to the right of the access point that you want to remove.
6. Select the check box to the left of the access point that you want to remove.
The Remove button becomes operational.

7. Click the Remove button.
8. Confirm the removal.

Assign Access Points to Buildings, Floors, and Advanced
Profile Groups

By default, all access points are automatically assigned to the basic profile group. However,
you can assign access points to an advanced profile group. For information about how to
create advanced profile groups, see Add an Advanced Profile Group on page 129.

By default, all access points are automatically assigned to the default building (Building-1)
and default floor (Floor-1). However, you can assign access points to a custom building,
custom floor, or both. For information about how to set up a custom building with custom
floors, see Manage a Building and Floors for an RF Plan on page 56.

You can assign multiple access points simultaneously to a particular profile group, building,
and floor.

Note: Access point profile group, profile group, and WLAN group are terms
that are interchangeable.

> To view the default assignments and assign one or more access points to a building,
floor, another profile group, or a combination of these:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.
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The wireless controller’'s web management interface opens and displays the Summary
page.

4. Select Configuration > WLAN Network.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile | WLAN Network | Captive Portal

AP Config Assignment

Search
M| Model ?j Name ‘| Building ‘| Floor ¢| Status ¢|_ Sitet_i Group N(une?_ |
| | | | | | | RS
192.168.100.178 0:91:f5:13:7e:e0 WNDAP3SO Cafe_ne2 | Building-1 Floar-1 Connacted  Local  basic
192.168.100.190 e0:91:f5:14:03:00 WNDAP350 Cafe_nol Building-1 Floar-1 Connected | Local basic
CAMCEL APPLY

The settings are described in the following table.

Setting Description

P The IP address of the access point.

MAC The MAC address of the access point.

Model The model of the access point.

Name The name that you specified for the access point.

Building The building to which the access point is assigned. For information about selecting a

building, see Step 6.
By default, the building designation is Building-1.

For information about how to set up a custom building, see Manage a Building and
Floors for an RF Plan on page 56.

Floor The floor to which the access point is assigned. For information about selecting a
floor, see Step 7.

By default, the floor designation is Floor-1.

For information about how to set up a custom floor, see Manage a Building and
Floors for an RF Plan on page 56.
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Setting

Description

Status

Shows one of the following states:

e Authentication in progress. This state occurs during the discovery and
upgrade process of a standalone access point when the wireless controller logs
in to the access point using the access point’s password. This state can last
several minutes.

e Firmware upgrade. This state occurs after the access point receives the
firmware file when the access point upgrades to the new firmware. This state
can last several minutes.

e AP is rebooting. This state occurs after the firmware upgrade process
completes when the access point reboots.

* Applying configurations. This state occurs after the wireless controller
upgrades the firmware on the access point when the wireless controller pushes
the WiFi configurations to the access point.

e Connecting. This state occurs when the wireless controller attempts to establish
a management connection with the access point.

Make sure that a DHCP server is enabled in the network. Otherwise, the access
point remains in the Connecting state and does not transition to the Connected
state.

Status
(continued)

e Connected. This state indicates that the firmware upgrade of the access point
was successful, the WiFi configurations were pushed to the access point, and
the access point is managed by the wireless controller.

* Not Connected. This state indicates that the wireless controller cannot
communicate with the access point at the configured IP address. The wireless
controller attempts to log in to access points each minute. If the error is
temporary, the state automatically changes to Connected. If the error is
prolonged, verify the access point's IP address and network connectivity. For
more information, see Resolve Problems With Access Points on page 365.

Site

Shows whether you designated the access point as a local or remote one:
e Local. The access point is designated as a local.
« Remote. The access point is designated as remote.

For more information about designating an access point as local or remote, see
Discover Access Points With the Discovery Wizard on page 159.

Group Name

The profile group to which the access point is assigned. For information about
selecting a group, see Step 8.

By default, the group designation is basic.

For information about creating profile groups and their associated security profiles,
see Manage Security Profiles for Advanced Profile Groups on page 129.

Tip: To view all

members of a profile group, sort the access points by

profile group. You do this by clicking the icon next to the Group Name
header in the table.

5. Take one of the following actions:

Assign a single access point to another group, or building, floor, or a combination of
these by selecting the check box to the right of the access point.

Assign a selection of access points to another group, building, or floor, or a
combination of these by selecting the check boxes to the right of the access points.
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» Assign all access points to another group, building, or floor, or a combination of these
by selecting the check box in the upper right of the table heading.

Select the building from the Building menu in the table heading.

Select the floor from the Floor menu in the table heading.

Select the group name from the Group Name menu in the table heading.
Click the Apply button.

Your settings are saved.

The access points are assigned to the selected group, building, and floor.
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Configure WiFi and QoS Settings

This chapter includes the following sections:

Basic and Advanced WiFi and QoS Configuration Concepts
Configure the Radio

Configure WiFi Settings

Configure Channels

Specify Radio Frequency Management

Manage AirQual for a Profile Group

Manage Quality of Service for an Advanced Profile Group
Manage Load Balancing

Manage Rate Limiting

Manage the LED Behavior
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Basic and Advanced WiFi and QoS Configuration Concepts

It is important to know how to configure your network and decide which configuration model
better fits your needs, basic or advanced. Once you follow one, it is easy to use the same
configuration model for the WiFi and Quality of Service (QoS) settings. Before you configure
the WiFi settings, read Basic and Advanced Setting Concepts on page 33.

* Basic WiFi settings. If you use the basic configuration model, the following WiFi and
QoS settings apply to all profiles in the basic profile group:
- Basic radio on/off schedule
- Basic WiFi settings for each radio in the basic profile
- Basic RF management
- Basic rate limiting for each radio in the basic profile
- Basic preferred band settings for the WNDAP620 access points

e Advanced WiFi settings. If you use the advanced configuration model, you can
configure the following WiFi and QoS settings separately for each profile group that you
created:

- Advanced radio on/off schedules for up to eight profile groups

- Advanced WiFi settings for each radio in up to eight profile groups

- Advanced QoS settings for each radio in up to eight profile groups

- Advanced RF management for up to eight profile groups

- Advanced rate limiting for each radio in up to eight profile groups

- Advanced preferred band settings for the WNDAP620 access points

e Global WiFi settings. The following WiFi and QoS settings apply to all profiles, whether
in the basic profile group or in any of the advanced profile groups:

- Basic channel allocation
- Basic load balancing for each type of access point model

Configure the Radio

Radio On/Off is a green feature that can be used during scheduled vacations or plant
shutdowns, on evenings, or on weekends.

Configure the Radio for the Basic Profile Group

> To schedule the radio for the basic profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
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2. Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Configuration > Wireless > Basic > Radio On/Off.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal
Schedule A

Current Time Fri Sep 16 14:55:40 PDT 2016
» Wireless
s Channel allocation Schedule Radio On/Off Con @ off
* RF Management Schedule at hr: 0% min:|0»
» AirQual m t w t f 5 s
Advanced Schedule On EEEE B B E

Duration hrs: 0% mins: 0%

CANCEL I  APRLY
5. Configure the settings as described in the following table.
Setting Description
Current Time This field is a nonconfigurable field that displays the current time for the wireless
controller.

Schedule Radio On/Off | You can specify either when the radio is on by selecting the On radio button or
when it is off by selecting the Off radio button.

Schedule at From the menus, specify the time (hours and minutes) when you want to turn the
radio either on or off.

Schedule On Select the check boxes for each day of the week that you want to schedule the
radio to be either on or off.

Duration From the menus, select the duration (in hours and minutes) that the radio must
be either on or off.

6. Click the Apply button.
Your settings are saved.

Configure the Radio for an Advanced Profile Group

You can schedule the radio for specific groups to match their network usage. For example,
during registration, a school could leave the radios on for the main office or administration
building, and turn off radios in buildings that contain only classrooms that are not in use.
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» To schedule the radio for an advanced profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Configuration > Wireless > Advanced > Radio On/Off.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal
Basic Schedule ®
Group-1 Group-2 Group-3
» Wireless
» QoS Settings Current Time Fri Sep 16 14:55:40 PDT 2016
i P‘_F Management Schedule Radio On/Off Oon ® off
= AirQual
) Schedule at hr:|0 s min: 0 %
m t wot f 5 [
Schedule On BEEAEA BB B A
Duration hrs : |0 % mins: |0

CANCEL APPLY

5. Click the tab for the profile group for which you want to configure the radio.
6. Configure the settings as described in the following table.

Setting Description
Current Time This field is a nonconfigurable field that displays the current time for the wireless
controller.

Schedule Radio On/Off | You can specify either when the radio is on by selecting the On radio button or
when it is off by selecting the Off radio button.

Schedule at From the menus, specify the time (hours and minutes) when you want to turn the
radio either on or off.

Schedule On Select the check boxes for each day of the week that you want to schedule the
radio to be either on or off.

Duration From the menus, select the duration (in hours and minutes) that the radio must
be either on or off.
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7. Click the Apply button.

Your settings are saved.

Configure WiFi Settings

During initial setup, you entered your country and region in the General Settings page (see
Configure the General Settings on page 100). Based on your location and environment, the
wireless controller determined the best WiFi settings for the discovered access points and
pushed these settings to your managed access points.

IMPORTANT:

Unless your network and environment require that you use other
WiFi settings, we recommend that you leave the WiFi settings as
they are.

Typically, the default WiFi settings do not need adjustment. Override the WiFi settings only if
a specific need exists, such as when the settings that a device vendor specifies are different
from the default settings. You can configure WiFi settings for the basic profile group and for
advanced profile groups (see Configure WiFi Settings for an Advanced Profile Group on
page 188).

Configure WiFi Settings for the Basic Profile Group

Two requirements exist for you to be able to configure the WiFi settings on the Basic
Wireless Settings page:

e You must disable automatic channel allocation for the radio on the Channel Allocation
page. For information about channel allocation, see Configure Channels on page 195.

e Atleast one access point must be assigned to the profile group for the radio for which you
want to configure the WiFi settings.
» To configure WiFi settings for the basic profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Configuration > Wireless > Basic > Wireless.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Profile | WLAN Network | Captive Portal

wireless | Security |

System |

» Radio On/Off

= Channel Allocation
* RF Management

Basic Wireless Settings

802.11b/bg/ng 802.11a/nafac

Turn Radio On

v

= AirQual Wireless Mode 302‘11ngE]

Advanced Data Rate Bast ]
Channel Width 20 MHz Static | =]
Guard Interval 800 nsiZl
RTS Threshold (0-2347) 2347
Beacon Interval (100-1000) 100
Aggregation Length 655355
AMPDU 9 enable disable
RIFS Transmission enable '@ disable
DTIM Interval (1-255) 3
Preamble Type 9 Auto Long
High Density Bandwidth 9 Auto High Low
Multicast/Broadcast Rate Limiting enable '@ disable
ARP Suppression @ enable disable
AP Name + | Access Point Channel | Tx Power
jonathan_AP730 1/2.412Ghz [»] Full
netgearB055ef 3/2.422Ghz |»| Full
netgear8043sf 6/2.437Ghz [=| Full

CANCEL APPLY

Click the tab for the radio for which you want to configure the WiFi settings.
Select the Turn Radio On check box.

The WiFi settings become accessible and you can configure them. If you cannot select
the Turn Radio On check box, see the requirements are the beginning of this section.

Configure the settings as described in the following table.

Setting

Description

MU MIMO

802.11na/ac only)

(WACT740 access point and

Select the MU MIMO check box to enable multi-user MIMO
(MU-MIMO).

By default, the MU MIMO check box is cleared and MU-MIMO is
disabled.

802.11ac Wave 2 supports MU-MIMO, which enables multiple users to
receive data from the access point simultaneously using the same
channel. With MU-MIMO, an access point such as the WAC740, which
is capable of 802.11ac Wave 2, can transmit to multiple clients
simultaneously using the same channel. MU-MIMO is used in the
downstream direction and requires both the access point and the WiFi
clients to be capable of 802.11ac Wave 2.
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Setting Description

Wireless Mode The selections that are available depend on the selected radio mode.
From the menu select the wireless mode:

* 802.11b/bg/ng mode:
- 802.11b.
- 802.11bg.
- 802.11ng. This is the default setting.
» 802.11a/na/ac mode:
- 802.11a.
- 802.11na.
- 802.1na/ac. This is the default setting.

Note: If you select 802.11bg or 802.11b mode, both 802.11n- and
802.11g-compliant devices can connect to the access points. However,
if you select 802.11ng mode, 802.11b-compliant devices cannot
connect.

Data Rate By default, the transmit data rate of the WiFi network is set to Best. You
cannot manually change the transmit data rate.

Note: For 802.11na and 802.11ac devices, the page shows separate
data rates with the default setting Best.

Channel Width From the menu, select the channel width:

(802.11ng and 802.11na/ac only) 20 MHz Static. This is the default setting if the selection from the
Wireless Mode menu is 802.11ng.

e 20/40 MHz Dynamic.

e 20/40/80 MHz Dynamic. This is the default setting if the selection
from the Wireless Mode menu is 802.1na/ac. This setting is an
option for 802.11na/ac devices only and does not apply to 802.11ng
devices.

A wider channel improves the performance, but some legacy devices

can operate only with a 20 MHz channel width.

Guard Interval From the menu, select a value that protects transmissions from
(802.11ng and 802.11na/ac only) |interference.

A shorter guard interval improves performance, but some legacy
devices can operate only with a long guard interval.

RTS Threshold (0-2347) Enter the size of the Request to Send (RTS) threshold packet.

The RTS threshold is related to the transmission mechanism
(CSMA/CA or CSMA/CD) for the packets. If the packet size is equal to
or less than this threshold, the data frame is transmitted immediately; if
the packet size is larger than the specified value, the transmitting
station must send an RTS threshold packet to the receiving station, and
must wait for the receiving station to return a Clear to Send (CTS)
packet before sending the actual packet data.

Beacon Interval (100-1000) Enter the time interval for each beacon transmission that allows the
access point to synchronize the WiFi network.
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Setting

Description

Aggregation Length
(802.11ng and 802.11na/ac only)

Enter the maximum length of aggregated MAC protocol data unit

(AMPDU) packets.

Larger aggregation lengths could lead to better network performance.

Aggregation is a mechanism used to achieve higher throughput.

The default setting depends on the selection from the Wireless Mode

menu:

e If the selection from the Wireless Mode menu is 802.11ng or
802.11na, the default setting is 65535.

« If the selection from the Wireless Mode menu is 802.11na/ac, the
default setting is 1048575.

AMPDU
(802.11ng and 802.11na/ac only)

Select the enable radio button to allow the aggregation of several MAC
frames into a single large frame to achieve higher throughput. Enabled
is the default setting.

Enabling AMPDU could lead to better network performance. Select the
disable radio button to disable this option.

RIFS Transmission
(802.11ng and 802.11na/ac only)

Select the enable radio button to enable the reduced interframe space
(RIFS) option to allow transmission of successive frames at different
transmit powers.

Enabling RIFS could lead to better network performance. Select the
disable radio button to disable this option. Disabled is the default
setting.

DTIM Interval (1-255)

Enter the delivery traffic indication message (DTIM) or the data beacon
rate that you want to use.

The message period of the beacon delivery traffic indication is set in
multiples of beacon intervals.

Preamble Type

Select one of the following radio buttons to specify the preamble type:

* Auto. Automatically handles both long and short preambles. A
short transmit preamble provides better performance. Auto is the
default setting.

* Long. Enables a long transmit preamble to provide a more reliable
connection or a slightly longer range.

High Density Bandwidth
(802.11ng and 802.11na/ac only)

Select the bandwidth type:

* Auto. Automatically handles both high-density bandwidth (that is,
high throughput) and low-density bandwidth (that is, extended
range) environments. Auto is the default setting.

» High. Enables a high bandwidth setting for dense environments in
which multiple clients in a relatively small space require high
bandwidth. One example of such an environment is a classroom in
which multiple students stream video on individual WiFi devices.

* Low. Enables a low bandwidth setting for sparse environments in
which multiple clients are spread out over a relatively large space
and do not require high bandwidth. One example of such an
environment is a large office floor with multiple workers who do not
all access the Internet or intranet simultaneously.
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Setting Description

Multicast/Broadcast Rate Limiting | Select the enable radio button to enable multicast and broadcast rate
limiting, which can increase bandwidth and minimize interference. To
configure the maximum packet rate, enter a packet rate in the
Multicast/Broadcast Rate Limiting Packet Count field. By default,
the wireless controller uses the following maximum packets rates:

e For the 2.4 Ghz radio, up to 63 packets per second.

* For the 5 GHz radio, up to radio 300 packets per second.

Select the disable radio button to disable multicast and broadcast rate
limiting. Disabled is the default setting.

ARP Suppression Select the enable radio button to enable Address Resolution Protocol
(ARP) suppression. ARP suppression decreases the management
traffic that the wireless controller must handle. ARP suppression is
enabled by default and applies to the wired interface only.

With ARP suppression enabled, if the IP addresses of all WiFi clients
that are associated with an access point are known, the wireless
controller handles ARP requests in the following ways:

e A packet with a known IP address is forwarded to its destination.
* A packet with an unknown IP address is dropped.

With ARP suppression enabled, if the IP address of at least one WiFi
client that is associated with an access point is not known, the wireless
controller broadcasts (that is, floods) the ARP requests into the WiFi
network.

Select the disable radio button to disable ARP suppression.

8. Click the Apply button.

Your settings are saved.

Override Channel and Transmission Power in the Basic Profile
Group

The table on the Basic Wireless Settings page shows the access points that are managed in
the profiles of the basic profile group and to which the channel allocation and basic RF
management settings apply.

After you configure the WiFi settings for the basic profile group (see Configure WiFi Settings
for the Basic Profile Group on page 182), you can change the channel, the transmission
power, or both for individual access points in the basic profile group.

For you to be able to configure these settings in the table, two requirements exist:

e Channel. To enable the Access Point Channel menu in the table, you must disable
automatic channel allocation on the Channel Allocation page (see Configure Channels on
page 195).

* Transmission power. To enable the Tx Power menu in the table, you must disable
automatic Tx power control on the basic RF Management page (see Configure Radio
Frequency Management for the Basic Profile Group on page 199).
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» To override the channel and transmission power for individual access pointsin a
security profile of the basic profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Configuration > Wireless > Basic > Wireless.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile | WLAN Network | Captive Portal

Basic Wireless Settings )

» Radio On/Off
802.11b/bg/ng 802.11a/nafac

= Channel Allocation

» RF Management Turn Radio On v
= AirQual Wireless Mode 302‘11ngE]
Advanced Data Rate Bast .
Channel Width 20 MHz Static | =]
Guard Interval 800 ngEI
RTS Threshold (0-2347) 2347
Beacon Interval (100-1000) 100
Aggregation Length 655355
AMPDU 9 enable disable
RIFS Transmission enable '@ disable
DTIM Interval (1-255) 3
Preamble Type @ Auto Long
High Density Bandwidth 9 Auto High Low
Multicast/Broadcast Rate Limiting enable '@ disable
ARP Suppression @ enable disable

Access Point Channel | Tx Power

jonathan_AP730 1/2.412Ghz [=| Full
netgear8055ef 3/2.422Ghz E] Full
netgear80438f 6/2.437Ghz [+ | Full

CANCEL APPLY

5. Click the tab for the radio for which you want to configure the WiFi settings.
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Configure the settings in the table at the bottom of the page as described in the following
table.

Setting Description
AP Name The name of the access point.
Access Point Channel Override these settings only if a specific need exists. From the menu, select a

channel and frequency for the access point to operate in.
Note: Changing a channel might temporarily affect the traffic on the access point.

Note: By default, the access point’s channel and frequency are set to the ones
that are enabled for the radio and profile group. If the channel and frequency are
not available on the access point, the channel and frequency are set to the ones
providing the highest performance. For more information, see Configure
Channels on page 195.

Tx Power From the menu, select the transmission power of the access point.

Note: By default, the access point’s transmission power is set to the
configuration that is selected on the basic RF Management page. For more
information, see Configure Radio Frequency Management for the Basic Profile
Group on page 199.

Click the Apply button.

Your settings are saved.

Configure WiFi Settings for an Advanced Profile Group

Two requirements exist for you to be able to configure the WiFi settings on the Advanced
Wireless Settings page:

You must disable automatic channel allocation for the radio on the Channel Allocation
page. For information about channel allocation, see Configure Channels on page 195.

At least one access point must be assigned to the profile group for the radio for which you
want to configure the WiFi settings.

To configure WiFi settings for an advanced profile group:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
Select Configuration > Wireless > Advanced > Wireless.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless Security | Profile | WLAN Network | Captive Portal

P Advanced Wireless Settings ()
= Radio On/Off Group-1 Group-2 Group-3 Group-4
= QoS Settings
> R Management 802.11b/bg/ng 802.11a/nafac
= AirQual )
Turn Radio On ]
Wireless Mode SOZ.angE]
Data Rate Best
Channel Width 20 MHz Static [+
Guard Interval 800 ”5‘3
RTS Threshold (0-2347) 2347
Beacon Interval (100-1000) 100
Aggregation Length 65535[= |
AMPDU @ enable disable
RIFS Transmission enable @ disable
DTIM Interval (1-255) 3
Preamble Type 9 Auto Leng
High Density Bandwidth Q9 Auto High Low
Multicast/Broadcast Rate Limiting ' enable '@ disable
ARP Suppression 9 enable disable
Weifeng_AP_720 2/2.417Ghz [+] Full
CAMCEL APPLY

Click the tab for the profile group for which you want to configure the WiFi settings.
Click the tab for the radio for which you want to configure the WiFi settings.
Select the Turn Radio On check box.

The WiFi settings become accessible and you can configure them. If you cannot select
the Turn Radio On check box, see the requirements are the beginning of this section.

Configure the settings as described in the following table.
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Setting Description

MU MIMO Select the MU MIMO check box to enable multi-user MIMO

(WACT740 access point and (MU-MIMO).

802.11na/ac only) By default, the MU MIMO check box is cleared and MU-MIMO is
disabled.

802.11ac Wave 2 supports MU-MIMO, which enables multiple users to
receive data from the access point simultaneously using the same
channel. With MU-MIMO, an access point such as the WAC740, which
is capable of 802.11ac Wave 2, can transmit to multiple clients
simultaneously using the same channel. MU-MIMO is used in the
downstream direction and requires both the access point and the WiFi
clients to be capable of 802.11ac Wave 2.

Wireless Mode The selections that are available depend on the selected radio mode.
From the menu select the wireless mode:

e 802.11b/bg/ng mode:
- 802.11b.
- 802.11bhg.
- 802.11ng. This is the default setting.
e 802.11a/na/ac mode:
- 802.1a.
- 802.11na.
- 802.1na/ac. This is the default setting.

Note: If you select 802.11bg or 802.11b mode, both 802.11n- and
802.11g-compliant devices can connect to the access points. However,
if you select 802.11ng mode, 802.11b-compliant devices cannot
connect.

Data Rate By default, the transmit data rate of the WiFi network is set to Best. You
cannot manually change the transmit data rate.

Note: For 802.11na and 802.11ac devices, the page shows separate
data rates with the default setting Best.

Channel Width From the menu, select the channel width:

(802.11ng and 802.11na/ac only) 20 MHz Static. This is the default setting if the selection from the
Wireless Mode menu is 802.11ng.

e 20/40 MHz Dynamic.

e 20/40/80 MHz Dynamic. This is the default setting if the selection
from the Wireless Mode menu is 802.1na/ac. This setting is an
option for 802.11na/ac devices only and does not apply to 802.11ng
devices.

A wider channel improves the performance, but some legacy devices

can operate only with a 20 MHz channel width.

Guard Interval From the menu, select a value that protects transmissions from
(802.11ng and 802.11na/ac only) |interference.

A shorter guard interval improves performance, but some legacy
devices can operate only with a long guard interval.
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Setting

Description

RTS Threshold (0-2347)

Enter the size of the Request to Send (RTS) threshold packet.

The RTS threshold is related to the transmission mechanism
(CSMAJ/CA or CSMA/CD) for the packets. If the packet size is equal to
or less than this threshold, the data frame is transmitted immediately; if
the packet size is larger than the specified value, the transmitting
station must send an RTS threshold packet to the receiving station, and
must wait for the receiving station to return a Clear to Send (CTS)
packet before sending the actual packet data.

Beacon Interval (100-1000)

Enter the time interval for each beacon transmission that allows the
access point to synchronize the WiFi network.

Aggregation Length
(802.11ng and 802.11na/ac only)

Enter the maximum length of aggregated MAC protocol data unit

(AMPDU) packets.

Larger aggregation lengths could lead to better network performance.

Aggregation is a mechanism used to achieve higher throughput.

The default setting depends on the selection from the Wireless Mode

menu:

e If the selection from the Wireless Mode menu is 802.11ng or
802.11na, the default setting is 65535.

* If the selection from the Wireless Mode menu is 802.11na/ac, the
default setting is 1048575.

AMPDU
(802.11ng and 802.11na/ac only)

Select the enable radio button to allow the aggregation of several MAC
frames into a single large frame to achieve higher throughput. Enabled
is the default setting.

Enabling AMPDU could lead to better network performance.
Select the disable radio button to disable this option.

RIFS Transmission
(802.11ng and 802.11na/ac only)

Select the enable radio button to enable the reduced interframe space
(RIFS) option to allow transmission of successive frames at different
transmit powers.

Enabling RIFS could lead to better network performance. Select the
disable radio button to disable this option. Disabled is the default
setting.

DTIM Interval (1-255)

Enter the delivery traffic indication message (DTIM) or the data beacon
rate that you want to use.

The message period of the beacon delivery traffic indication is set in
multiples of beacon intervals.

Preamble Type

Select one of the following radio buttons to specify the preamble type:

* Auto. Automatically handles both long and short preambles.
A short transmit preamble provides better performance. Auto is the
default setting.

* Long. Enables a long transmit preamble to provide a more reliable
connection or a slightly longer range.
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Setting

Description

High Density Bandwidth
(802.11ng and 802.11na/ac only)

Select the bandwidth type:

Auto. Automatically handles both high-density bandwidth (that is,
high throughput) and low-density bandwidth (that is, extended
range) environments. Auto is the default setting.

* High. Enables a high bandwidth setting for dense environments in
which multiple clients in a relatively small space require high
bandwidth. One example of such an environment is a classroom in
which multiple students stream video on individual WiFi devices.

* Low. Enables a low bandwidth setting for sparse environments in
which multiple clients are spread out over a relatively large space
and do not require high bandwidth. One example of such an
environment is a large office floor with multiple workers who do not
all access the Internet or intranet simultaneously.

Multicast/Broadcast Rate Limiting

Select the enable radio button to enable multicast and broadcast rate
limiting, which can increase bandwidth and minimize interference. To
configure the maximum packet rate, enter a packet rate in the
Multicast/Broadcast Rate Limiting Packet Count field. By default,
the wireless controller uses the following maximum packets rates:

* For the 2.4 Ghz radio, up to 63 packets per second.
* For the 5 GHz radio, up to radio 300 packets per second.

Select the disable radio button to disable multicast and broadcast rate
limiting. Disabled is the default setting.

ARP Suppression

Select the enable radio button to enable Address Resolution Protocol
(ARP) suppression. ARP suppression decreases the management
traffic that the wireless controller must handle. ARP suppression is
enabled by default and applies to the wired interface only.

With ARP suppression enabled, if the IP addresses of all WiFi clients
that are associated with an access point are known, the wireless
controller handles ARP requests in the following ways:

* A packet with a known IP address is forwarded to its destination.
* A packet with an unknown IP address is dropped.

With ARP suppression enabled, if the IP address of at least one WiFi
client that is associated with an access point is not known, the wireless
controller broadcasts (that is, floods) the ARP requests into the WiFi
network.

Select the disable radio button to disable ARP suppression.

9. Click the Apply button.
Your settings are saved.
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Override Channel and Transmission Power in an Advanced
Profile Group
The table on the Advanced Wireless Settings page shows the access points that are

managed in the profiles of an advanced profile group and to which the channel allocation and
advanced RF management settings apply.

After you configure the WiFi settings for an advanced profile group (see Configure WiFi
Settings for an Advanced Profile Group on page 188), you can change the channel, the
transmission power, or both for individual access points in an advanced profile group.

For you to be able to configure these settings in the table, two requirements exist:

* Channel. To enable the Access Point Channel menu in the table, you must disable
automatic channel allocation on the Channel Allocation page (see Configure Channels on
page 195).

e Transmission power. To enable the Tx Power menu in the table, you must disable
automatic Tx power control on the advanced RF Management page (see Configure
Radio Frequency Management for an Advanced Profile Group on page 200).

To override the channel and transmission power for individual access points in a
security profile of an advanced profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Configuration > Wireless > Advanced > Wireless.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal
Basic Advanced Wireless Settings @
» Radio On/Off Group-1 Group-2 Group-3 Group-4

» QoS Settings
» RF Management
» AirQual

802.11b/bg/ng 802.11a/nafac

Turn Radio On ¥

Wireless Mode Soz.ungE]

Data Rate Best

Channel Width 20 MHz Static =
Guard Interval 800 nslz

RTS Threshold (0-2347) 2347

Beacon Interval (100-1000) 100

Aggregation Length 65535E]

AMPDU @ enable disable
RIFS Transmission enable '@ disable
DTIM Interval (1-255) 3

Preamble Type 9 auto Long
High Density Bandwidth 9 Auto High Low
Multicast/Broadcast Rate Limiting ' enable '@ disable
ARP Suppression 9 enable disable

Access Point Channel

Waeifeng_AP_720 2/2.417Ghz_[+] Full |

CANCEL APPLY

Click the tab for the profile group for which you want to configure the WiFi settings.
Click the tab for the radio for which you want to configure the WiFi settings.

Configure the settings in the table at the bottom of the page as described in the following
table.

Setting Description
AP Name The name of the access point.
Access Point Channel Override these settings only if a specific need exists. From the menu, select a

channel and frequency for the access point to operate in.
Note: Changing a channel might temporarily affect the traffic on the access point.

Note: By default, the access point’s channel and frequency are set to the ones
that are enabled for the radio and profile group. If the channel and frequency are
not available on the access point, the channel and frequency are set to the ones
providing the highest performance. For more information, see Configure
Channels on page 195.
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Setting Description

Tx Power From the menu, select the transmission power of the access point.

Note: By default, the access point’s transmission power is set to the
configuration that is selected on the basic RF Management page. For more
information, see Configure Radio Frequency Management for an Advanced
Profile Group on page 200.

8. Click the Apply button.

Your settings are saved.

Configure Channels

& CAUTION:

Do not disable channel allocation unless you are debugging or an extreme
situation occurred that affects the channels.

Automatic channel allocation distributes channels across the managed access points to
reduce interference. Each wireless controller allocates channels for its managed access
points, regardless of their configured security profiles. The wireless controller detects
interference, traffic load on the access point, and neighborhood maps to determine the best
channel for an access point. The wireless controller collects this information over the
previous 24 hours and uses this information to determine the best possible channel for the
access point.

Note: The wireless controller determines available channels based on the
country or region that you specified on the General Settings page
(see Configure the General Settings on page 100).

You can configure channel allocation to allow allocation of only the specified channels when
channel allocation is scheduled to run. Channel allocation ensures that the access points use
only the channels allowed according to administration policies.

To adhere to best practices when adjusting channel allocation, we recommend the following:

» Select channels that do not overlap. For example, for 2.4 GHz, use channels 1, 6, and 11.

* Schedule channel allocation once a day at times when the fewest clients are expected to
be connected.

Channel allocation is a global feature that applies to all access points. (If you disable channel
allocation, it is globally disabled for all access points.) The allocated channels also apply to
all access points, irrespective of whether they are managed in profiles of the basic profile
group or profiles of an advanced profile group.

Configure WiFi and QoS Settings
195



ProSAFE Wireless Controller

However, you can override the general channel allocation settings for individual access
points on the Basic Wireless Settings page and on the Advanced Wireless Settings page. For
more information, see:

e Override Channel and Transmission Power in the Basic Profile Group
e Override Channel and Transmission Power in an Advanced Profile Group

» To change the channel allocation:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Configuration > Wireless > Basic > Channel Allocation.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless Security | Profile | WLAN Network | Captive Portal
B Channel Allocation @
» Radio On/Off
: Automatic channel allocation ® enable O disable
*» Wireless

» RF Management
» AirQual
- Advanced

Valid corporate channels

-]
o
-
e

11

7
E BEH B H

24 Ghz 1 4

2 3 5
B = B B EBE E

-U\

5Ghz 36 40 44 48 52 56 60 64 100 104 108 112 116 120 124
O H B FE OEHE EH B OCE BB B
128 132 136 149 153 157 161

¥ B B B B & B

Prevent channel change during

Active voice call O enable @ disable
High Traffic Load O enable @ disable

Schedule channel allocation

Run channel allocation at hr :

0w 1]
- m t w f =5 =
Run channel allocation every

CAMCEL  RUN NOW APPLY
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5. Configure the settings as described in the following table.

Setting Description
Automatic channel allocation Ensure that the enable radio button is selected during normal
operation.

Automatic channel allocation distributes channels across the
managed access points to reduce interference. To disable
automatic channel allocation, select the disable radio button.

Valid corporate channels Specify the WiFi band by selecting the 2.4 GHz or 5 GHz check box.
For each WiFi band, the following applies:

* You can remove one or more channels from the list of available
channels by clearing their check boxes. For example, you might
want to avoid interference with competing equipment such as in
a medical environment in which medical devices use a specific
channel.

*  You cannot add channels. The wireless controller determines
available channels based on the country or region that you
specified on the General Settings page (see Configure the
General Settings on page 100).

Prevent channel change during Active voice call | Select the enable radio button to prevent
channel changes during voice calls.

Select the disable radio button to allow channel
changes during voice calls. Disabled is the
default setting.

Note: If the wireless controller is
prevented from reallocating a channel
because it is in use, the wireless

controller checks again at the next

scheduled channel allocation. High Traffic Load | Select the enable radio button to prevent

channel changes during a high traffic load.
Select the disable radio button to allow channel
changes during a high traffic load. Disabled is
the default setting.

Schedule channel allocation Run channel From the menus, select the hour and minutes

allocation at when the channel allocation must run.
Note: We recommend that you

schedule channel allocation once a | Run channel Select the check boxes to specify the day or

day at times when the fewest clients | allocation every | days when the channel allocation must run.
are expected to be connected.

IMPORTANT:

Changing channels might temporarily affect traffic on the managed
access points in the network.

6. To run channel allocation immediately, click the Run Now button.

The selected channels are applied to the managed access points. This option is useful
when you add a new access point or change your network.

7. Click the Apply button.

Your settings are saved. If enabled, the channel allocation occurs according to the
configured schedule.
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Specify Radio Frequency Management

Radio frequency (RF) management lets you specify the transmission power settings, WLAN
healing settings, and band steering settings.

Radio Frequency Concepts

Radio frequency (RF) management optimizes the channel allocation for access points based
on clients, user data traffic, and the nearby RF environment of access points. The wireless
controller periodically checks the radio neighborhood maps and detects changes in the radio
neighborhood maps or loss of connectivity to the wireless controller by an access point.

WLAN healing is a special feature of RF management. When you use WLAN healing, if an
access point goes down or loses connectivity, other access points share its load to avoid a
coverage hole. In such a situation, the other access points increase their transmit power.
WLAN healing is configured per security profile group and is active among access points that
share a common security configuration.

You can configure centralized RF management for the basic profile group on the basic RF
Management page. If you use advanced profile groups, you can use the advanced RF
Management page to customize settings for each advanced profile group.

WLAN Healing Concepts

The wireless controller supports automatic WLAN healing through the following features:

* Automatic channel allocation. Enables the wireless controller to distribute an access
point channel automatically across the access points on a floor to reduce interference.
Automatic channel allocation considers interference and the traffic load on the access
point, as well as the wireless mode and bandwidth (also referred to as channel width) to
provide the best channel for the access point. For information about how to configure
automatic channel allocation, including the option to skip automatic channel allocation
during a heavy traffic load or voice activity, see Configure Channels on page 195.

* Automatic transmission power. Automatically determines the optimum transmit power
of an access point based on the coverage requirement. The access point scans its
neighborhood to determine the RF environment to minimize neighboring access point
interference, leakage across floors, and coverage holes.

When you configure WLAN healing, we recommend the following:

» Configure the WLAN self-healing wait time to a value greater than the access point reboot
time, which is usually one minute. Set an appropriate wait time to allow for fluctuations in
the power of nearby access points when access points are rebooted.

e The number of neighbors to participate in WLAN self-healing must not be large (three to
four usually suffices in most deployments). Keep the number of participants low to
prevent too many access points from increasing power for a single failed access point.
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Configure Radio Frequency Management for the Basic Profile
Group

You can configure the WiFi transmission power, WLAN healing, and band steering for the
basic profile group.
» To configure RF management for access points in the basic profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > Wireless > Basic > RF Management.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless Security | Profile | WLAN Network | Captive Portal
TX Power Settings ®
* Ra,'d'o onde Default Tx Power Half v
» Wireless ; ® O i
S CHanmelAllacation Automatic T Power Control enable ) disable
> AirQual WLAN Healing

Advanced

Maximum Neighbours to participate in Self-healing |3 v

Self healing wait Time after AP Failure{mins) 1v
Band Steering
Band Steering Status ® enable O disable

CANCEL APPLY
5. Configure the settings as described in the following table.
Setting Description
TX Power Settings
Default Tx Power Make a selection from the menu to specify how the transmission (Tx)

power is configured on the access points: Full, Half, Quarter, Eighth,
or Minimum. By default, the selection from the menu is Half.

When automatic Tx power control is enabled, the selection from the
menu is used as the initial power level for the access points.

Configure WiFi and QoS Settings
199



ProSAFE Wireless Controller

Setting

Description

Automatic Tx Power Control

Select the enable radio button to enable automatic Tx power control:

« When a client attempts to connect to an access point at low power,
the access point’s Tx power is automatically increased above the
default level.

e When coverage areas overlap, the access point's Tx power is
automatically decreased below default level.

By default, automatic Tx power control is enabled.
Select the disable radio button to disable automatic Tx power control.

WLAN Healing

Maximum Neighbors to Participate
in Self-healing

From the menu, select the maximum number of neighboring access
points that increase or decrease power to cover for a failing access
point.

Selecting 0 (zero) disables this feature. Use close neighbors, not a
distant access point, and do not use all access points. By default, the
selection from the menu is 3.

Self healing wait Time after AP
Failure

From the menu, select the number of minutes to validate (that is, wait)
before confirming a failed access point and increasing transmit power
to cover the area.

Enter a value greater than the access point reboot time, which is
usually less than one minute. By default, the selection from the menu
is 1. Entering a value greater than the access point reboot time allows
for fluctuations in the power of nearby access points when access
points are rebooted.

Band Steering

Band Steering Status

Select the enable radio button to enable band steering to the
5 GHz band for access points that support dual bands simultaneously.

If band steering is enabled, the wireless controller identifies WiFi
clients that are dual-band capable and can force them to connect to the
5 GHz band rather than 2.4 GHz band. WiFi clients that are already
connected to the 2.4 GHz band can be forced into the 5 GHz band.

In general, the 5 GHz band provides more channels, provides more
bandwidth, and causes less interference for WiFi clients. By default,
the disable radio button is selected, and band steering is disabled.

Note: Load balancing can steer clients to stronger access points. For
more information, see Manage Load Balancing on page 210.

6. Click the Apply button.

Your settings are saved.

Configure Radio Frequency Management for an Advanced

Profile Group

You can configure the WiFi transmission power, WLAN healing, and band steering for

advanced profile groups.
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» To configure RF management for access points in an advanced profile group:

1.

5.
6.

Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Configuration > Wireless > Advanced > RF Management.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal
Basic RF Management @
» Radio On/Off Group-1 Group-2  Group-3
» Wireless
» QoS Settings TX Power Settings
S Default Tx Power Half v
* AirQual

Automatic Tx Power Control & enable (O disable

WLAN Healing
Maximum Neighbours to participate in Self-healing 3 v

Self healing wait Time after AP Failure{mins) 1%

Band Steering Status
Band Steering Status ® enable O disable

CANCEL APPLY

Click the tab for the profile group for which you want to configure RF management.
Configure the settings as described in the following table.

Setting Description

TX Power Settings

Default Tx Power Make a selection from the menu to specify how the transmission (Tx)
power is configured on the access points: Full, Half, Quarter, Eighth,
or Minimum. By default, the selection from the menu is Half.

When automatic Tx power control is enabled, the selection from the
menu is used as the initial power level for the access points.
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Setting

Description

Automatic Tx Power Control

Select the enable radio button to enable automatic Tx power control:

« When a client attempts to connect to an access point at low power,
the access point’'s Tx power is automatically increased above the
default level.

e When coverage areas overlap, the access point's Tx power is
automatically decreased below default level.

By default, automatic Tx power control is enabled.
Select the disable radio button to disable automatic Tx power control.

WLAN Healing

Maximum Neighbors to Participate
in Self-healing

From the menu, select the maximum number of neighboring access
points that increase or decrease power to cover for a failing access
point.

Selecting 0 (zero) disables this feature. Use close neighbors, not a
distant access point, and do not use all access points. By default, the
selection from the menu is 3.

Self healing wait Time after AP
Failure

From the menu, select the number of minutes to validate (that is, wait)
before confirming a failed access point and increasing transmit power
to cover the area.

Enter a value greater than the access point reboot time, which is
usually less than one minute. By default, the selection from the menu
is 1. Entering a value greater than the access point reboot time allows
for fluctuations in the power of nearby access points when access
points are rebooted.

Band Steering

Band Steering Status

Select the enable radio button to enable band steering to the
5 GHz band for access points that support dual bands simultaneously.

If band steering is enabled, the wireless controller identifies WiFi
clients that are dual-band capable and can force them to connect to the
5 GHz band rather than 2.4 GHz band. WiFi clients that are already
connected to the 2.4 GHz band can be forced into the 5 GHz band.

In general, the 5 GHz band provides more channels, provides more
bandwidth, and causes less interference for WiFi clients. By default,
the disable radio button is selected, and band steering is disabled.

Note: Load balancing can steer clients to stronger access points. For
more information, see Manage Load Balancing on page 210.

7. Click the Apply button.

Your settings are saved.
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Manage AirQual for a Profile Group

AirQual, short for air quality, lets you display WiFi channel utilization levels and detect
non-WiFi interference. One access point can monitor the AirQual for a profile group.

Note: AirQual can be configured on a WAC740 access point only. However,
the WAC740 access point can monitor the WiFi channel utilization
and interference for a profile group, independent of the access point
models that serve the profile group.

AirQual Concepts

AirQual provides the following services:

e Option to display WiFi channel utilization levels. AirQual reports the utilization levels
for the 2.4 GHz and 5 GHz bands. You can monitor these levels in real time, enabling you
to see which channels are overutilized and how you can improve channel deployment.
You can also configure alerts that are raised when channel utilization increases above a
specific threshold or channel quality falls below a specific threshold.

* Non-WiFi interference detection. This feature is also referred to as channel quality. The
throughput of a WiFi network can be affected by the presence of non-WiFi interference
sources such as microwave ovens and cordless phones. AirQual can detect non-WiFi
interference and notify you through alerts. AirQual can detect up to 17 different non-WiFi
interference devices, including Bluetooth devices, microwave ovens, and analogue WiFi
cameras.

Configure AirQual for the Basic Profile Group

You can configure AirQual for the basic profile group. One WAC740 access point can
monitor the WiFi channel utilization and interference for the entire basic profile group.

> To configure AirQual for the basic profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

4. Select Configuration > Wireless > Basic > AirQual.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal
Basic AirQual %
» Radio On/off Enable/Disable v

= Wireless

Ch. 1 lity Th hold
» Channel Allocation e e

= AF Management Channel Utilization Threshold

Search
+ Advanced

¢ | Model ¢ | Name | Building + | Status #| Group Name : | Enable/Disable ¢ | Mode B

192.168.100.139  6c:0b:B4:e5:94:00  WACT40 netgearCS94AE  Building-1 Connected  basic EI‘IGNGT‘: Ded‘c&lé‘:zl

CANCEL APFLY

5. Configure the settings as described in the following table.

Setting Description

Enable/Disable Select the Enable/Disable check box to enable AirQual.
By default, the Enable/Disable check box is cleared and AirQual is
disabled.

Note: If you enable AirQual in a WiFi network that does not include
WACT740 access points, AirQual does not take effect.

Channel Quality Threshold Move the Channel Quality Threshold slider to the threshold position
or enter a number from 1 to 100 in the associated field. If the channel
quality exceeds the threshold, the wireless controller generates an
alert.

By default, the threshold position is 0, which effectively disables the
channel quality feature.

Channel Utilization Threshold Move the Channel Utilization Threshold slider to the threshold
position or enter a number from 1 to 100 in the associated field. If the
channel utilization exceeds the threshold, the wireless controller
generates an alert.

By default, the threshold position is 0, which effectively disables the
channel utilization feature.

6. In the table with WAC740 access points, select the check box for the WAC740 access point
that must monitor AirQual for the profile group.

If a WAC740 access point is not assigned to the profile group, you cannot monitor
AirQual for the profile group.

7. Make sure that the selection from the Enable/Disable menu is Enable.

This option makes it possible to change AirQual monitoring from one WAC740 access
point in the profile group to another one. That is, if more than one WAC740 access point
is assigned to the profile group, you could disable AirQual for one WAC access point and
enable it on another WAC740 access point without the need to disable the AirQual
feature entirely.

The only available selection from the Mode menu is Dedicated.
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Dedicated mode means that the WAC740 access point is dedicated to AirQual monitoring
and does not accept WiFi client associations.

Click the Apply button.
Your settings are saved.

For information about monitoring AirQual, see View AirQual for the Channels in a Profile
Group on page 346.

Configure AirQual for an Advanced Profile Group

You can configure AirQual for an advanced profile group. One WAC740 access point can
monitor the WiFi channel utilization and interference for the entire advanced profile group
that you select.

To configure AirQual for an advanced profile group:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
Select Configuration > Wireless > Advanced > AirQual.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile | WLAN Network | Captive Portal

gasic Advanced AirQual L
» Radio On/Off Group-1 | Group-2 | Group-3

» Wireless

= QoS Settings Enable/Disable

= RF Management

Channel Quality Threshold
Channel Utilization Threshold

p p [E

Search

¢ | Building # | Status % | Group Name‘;i Enable/Disable # | Mode

192,168.100.139 Ec:0bi84:c5:94:a0 WACT40 netgearC394A8  Building-1 Connected Group-1 Eﬂab|bz| Cl:dlcahed:zl

5. Click the tab for the profile group for which you want to configure AirQual.
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Configure the settings as described in the following table.

Setting Description

Enable/Disable Select the Enable/Disable check box to enable AirQual.
By default, the Enable/Disable check box is cleared and AirQual is
disabled.

Note: If you enable AirQual in a WiFi network that does not include
WACT740 access points, AirQual does not take effect.

Channel Quality Threshold Move the Channel Quality Threshold slider to the threshold position
or enter a number from 1 to 100 in the associated field. If the channel
quality exceeds the threshold, the wireless controller generates an
alert.

By default, the threshold position is 0, which effectively disables the
channel quality feature.

Channel Utilization Threshold Move the Channel Utilization Threshold slider to the threshold
position or enter a number from 1 to 100 in the associated field. If the
channel utilization exceeds the threshold, the wireless controller
generates an alert.

By default, the threshold position is 0, which effectively disables the

channel utilization feature.

In the table with WAC740 access points, select the check box for the WAC740 access point
that must monitor AirQual for the profile group.

If no WAC740 access point is assigned to the profile group, you cannot monitor AirQual
for the profile group.

Make sure that the selection from the Enable/Disable menu is Enable.

This option makes it possible to change AirQual monitoring from one WAC740 access
point in the profile group to another one. That is, if more than one WAC740 access point
is assigned to the profile group, you could disable AirQual for one WAC access point and
enable it on another WAC740 access point without the need to disable the AirQual
feature entirely.

The only available selection from the Mode menu is Dedicated.

Dedicated mode means that the WAC740 access point is dedicated to AirQual monitoring
and does not accept WiFi client associations.

Click the Apply button.
Your settings are saved.

For information about monitoring AirQual, see View AirQual for the Channels in a Profile
Group on page 346.
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Manage Quality of Service for an Advanced Profile Group

Quiality of Service (Qo0S) management lets you fine-tune priorities for different types of traffic.

Quality of Service Concepts

Quality of Service (QoS) works by default for the advanced profile groups. Change QoS only
if a specific reason exists, such as when specifications of a device vendor require you to use
different QoS settings.

Using QoS Wi-Fi MultiMedia (WMM) ensures that the applications that require better
throughput and performance are provided special qgueues with higher priority. For example,
video and audio applications are given higher priority over applications such as FTP.

WMM defines the following four queues in decreasing order of priority:

e Voice. The highest priority queue with minimum delay, which makes it ideal for
applications such as voice over IP (VoIP) and streaming media.

» Video. The second highest priority queue with low delay is given to this queue. Video
applications are routed to this queue.

e Best Effort. The medium priority queue with medium delay is given to this queue. Most
standard IP applications use this queue.

e Background. Low priority queue with high throughput. Applications, such as FTP, that
are not time-sensitive but require high throughput can use this queue.

QoS prioritization and coordination of WiFi medium access is enabled automatically. QoS
settings on the access point control downstream traffic that flows from the access point to the
client station (AP Enhanced Distributed Channel Access [EDCA] parameters) and the
upstream traffic that flows from the client station to the access point (Station EDCA
parameters).

The Advanced QoS Settings page lets you change the QoS settings per profile group and per
radio for upstream traffic flowing from the station (that is, the WiFi client) to managed access
points and the downstream traffic flowing from managed access points to the station. These
settings are applied only to managed access points that are capable of supporting these
settings.

Disabling WMM deactivates QoS control of station EDCA parameters for upstream traffic
flowing from the client station to the access point. (You can change the settings for the
station EDCA parameters, but these settings do not take effect until you enable WMM.)
However, when WMM is disabled, you can still set some parameters for downstream traffic
flowing from the access point to the client station (AP EDCA parameters), and these settings
do take effect even when WMM is disabled.
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Configure Quality of Service for a Profile Group

You can configure Quality of Service (QoS) settings for each advanced profile group.

To configure the QoS settings for a profile group:

1.

5.
6.
7.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Configuration > Wireless > Advanced > QoS.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless [ Security | Profile | WLAN Network | Captive Portal
Basic Advanced QoS Settings )
* Radio On/Off Group-1 Group-2 Group-3
* Wireless
» RF Management 802.11b/bg/ng 802.11a/nafac
= AirQual

AP EDCA parameters

Data O (Best Effort) 3

Data 1 (Background)
Data 2 (Video)
Data 3 (Voice)

cwMin Max Burst

Station EDCA parameters

Queue AIFS [ cwmin TXOP Limit
Data O (Best Effort) 0

3 15 v 1023 v
Data 1 (Background) 7 15 v 1023 w 0
Data 2 (Video) 2 7 v 15 v 3008
Data 3 (Voice) 2 3 v i v 1504
CANCEL APPLY

Click the tab for the profile group for which you want to configure the QoS settings.
Click the tab for the radio for which you want to configure the QoS settings.
Configure the settings as described in the following table.
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Setting Description

AIFS Specify a wait time (in milliseconds) for data frames. Valid values for arbitration
inter-frame space (AIFS) are 1 through 255.
The following are the default values for | The following are the default values for
the AP EDCA parameters: the Station EDCA parameters:
e Data 0 (Best Effort). 3 e Data 0 (Best Effort). 3
« Data 1 (Background). 7 « Data 1 (Background). 7
- Data 2 (Video). 1 e Data 2 (Video). 2
e Data 3 (Voice). 1 - Data 3 (Voice). 2

CwMin Specify an upper limit (in milliseconds) of a range from which the initial random
backoff wait time is determined.
Valid values for this field are 1, 3, 7, 15, 31, 63, 127, 255, 511, or 1023. The value
for the minimum contention window (CwMin) must be lower than the value for the
maximum contention window (CwMax).
The following are the default values for | The following are the default values for
the AP EDCA parameters: the Station EDCA parameters:
e Data 0 (Best Effort). 15 e Data 0 (Best Effort). 15
e Data 1 (Background). 15 e Data 1 (Background). 15
e Data 2 (Video). 7 e Data 2 (Video). 7
e Data 3 (Voice). 3 - Data 3 (Voice). 3

CwMax Specify an upper limit (in milliseconds) for the doubling of the random backoff value.
Valid values for this field are 1, 3, 7, 15, 31, 63, 127, 255, 511, or 1023. The value
for the maximum contention window (CwMax) must be higher than the value for
minimum contention window (CwMin).
The following are the default values for | The following are the default values for
the AP EDCA parameters: the Station EDCA parameters:
« Data 0 (Best Effort). 63 « Data 0 (Best Effort). 1023
» Data 1 (Background). 1023 e Data 1 (Background). 1023
e Data 2 (Video). 15 e Data 2 (Video). 15
e Data 3 (Voice). 7 - Data 3 (Voice). 7

Max Burst Specify (in milliseconds) the maximum burst length allowed for packet bursts on the

Note: AP EDCA
parameters only

WiFi network.

A packet burst is a collection of multiple frames transmitted without header
information. Valid values for maximum burst length are 0 through 8192. The
maximum burst length applies only to AP EDCA parameters.

The following are the default values for the AP EDCA parameters:

« Data 0 (Best Effort). 0
e Data 1 (Background). 0
e Data 2 (Video). 3008

- Data 3 (Voice). 1504
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Setting Description

TXOP Limit Specify the transmission opportunity (TXOP) limit.

The TXOP limit applies only to station AP EDCA parameters and specifies the

Note: Station EDCA . . . 4 ; : . L S
maximum period during which the client station client can initiate transmissions.

parameters only

The following are the default values for the Station EDCA parameters:
- Data 0 (Best Effort). 0

e Data 1 (Background). 0

e Data 2 (Video). 3008

- Data 3 (Voice). 1504

8. Click the Apply button.

Your settings are saved.

Manage Load Balancing

Load balancing lets you balance WiFi clients over the managed access points of one model,
taking the following aspects into account:

e The maximum number of clients that can connect to the access point model.
* The received signal strength indicator (RSSI) of the WiFi clients.

Load Balancing Concepts

Load balancing allows the wireless controller to distribute access point clients (the “load”)
equally among the access points that it manages. You configure load balancing per type of
access point model and per radio. By default, load balancing is disabled.

When a client discovers an access point using probe requests or sends association frames,
the access point determines whether to accept the client based on the number of clients that
are already connected, the signal strength of the clients that are already connected, and the
signal strength of the client that attempts to connect.

The wireless controller performs load balancing based on the following criteria:

*  Maximum number of clients. If more than the maximum number of clients that you allow
on a radio of an access point attempt to associate, the clients are pushed to another
access point.

If you want a good distribution of clients between the access points, set the maximum
number of clients to a low value (compared to, for example, the total number of clients in
an office or on a floor).

e Signal strength or RSSI. Signal strength determines speed. For a client that is far away
from an access point, the data rate is much lower than for a client that is in closer
proximity to the access point. The distant client requires more time to transmit or receive
data, and the delay could be too long. You can give a threshold for signal strength, which
is specified as a percentage, from 0 percent to a maximum of 75 percent.
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RSSI percentages translate into the following power levels in dBm:

e RSSIof 0% = -95 dBm (load balancing is disabled)

¢ RSSI of 25% =-81 dBm

e RSSI of 50% = -68 dBm

¢ RSSI of 75% = -55 dBm

In situations in which the throughput expectation is high, if you want only clients near an
access point to associate with the access point, set the received signal strength

indication (RSSI) to a high percentage. In situations in which the clients can be expected
to be far away or fewer access points are available, set the RSSI to a lower value.

Note: The load-balancing settings apply to all profiles, whether they are in
the basic profile group or in advanced profile groups.

Configure Load Balancing

You can configure load balancing for each model of the managed access points.

To configure load balancing for all access points of one model:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
Select Configuration > Profile > Basic > Load Balancing.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

ecurity | Profile | WLAN Network | Captive Portal

Load Balancing ¥
> Radio
WHNAPZIOWZ ~ WNDAP3S0 ~ WNAP320 WNDAP360 WHN370 WNDAP3BOR WNDAP3IGORVZ ~ WNDAPG620 WHNDAPGG60  WND930  WACT30
* Rate Limit
> AP LED State WALT20
Advanced

#| Max Client
802.11bfbalng - F (84 # -0

CAMNCEL APPLY

5. Click the tab for the access point model for which you want to configure load balancing.
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6. Configure the settings as described in the following table.

Setting Description

Max Client Drag the slider to specify or enter the maximum number of WiFi clients that can
connect to each radio of an access point at one time.

You can select a value of 64 to allow the maximum number of clients that a radio of
an access point can support.

RSSI Drag the slider to specify or enter the minimum signal quality in percentage (O to
75 percent) expected from the WiFi clients that connect to the access points.

A value of 0 means that this check is not enforced and load balancing is disabled.
RSSI percentages translate into the following power levels in dBm:

e RSSI of 0% = —-95 dBm (load balancing is disabled)

* RSSI of 25% = -81 dBm

* RSSI of 50% = —68 dBm

* RSSI of 75% = -55 dBm

7. Click the Apply button.
Your settings are saved.

If you want to configure load balancing for all access points of another model, repeat the
procedure for that model.

Manage Rate Limiting

Rate limiting lets you manage how the available bandwidth is distributed among the profiles
in a profile group on a radio of a managed access point.

Rate Limiting Concepts

The number of errors during transmission and the time that a packet spends in the
transmission queues determine the available bandwidth.

Within a profile group (including the basic profile group), you configure rate limiting separately
for each WiFi radio (2.4 GHz and 5 GHz). Within a profile group, for each WiFi radio, rate
limiting must add up to a maximum of 100 percent. (It can be less than 100 percent.)

For example, within one profile group, if four profiles use the 802.11b/bg/ng mode and two
profiles use the 802.11a/na/ac mode, you create one rate-limiting configuration for the four
profiles that use the 802.11b/bg/ng mode and another rate-limiting configuration for the two
profiles that use the 802.11a/na/ac mode. The combined percentages of the four profiles that
use the 802.11b/bg/ng mode cannot exceed 100 percent; similarly, the combined
percentages of the two profiles that use the 802.11a/na/ac mode cannot exceed 100 percent.

On each managed access point (or on each radio in a managed dual-band access point), the
available bandwidth is distributed in the specified percentages among the profiles in a profile
group. The percentage that is configured for a single profile is shared among all the clients
connected to it.
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If you do not want to configure rate limiting for a profile, configure rate limiting as

0 (zero) percent. Configuring 0 percent effectively disables rate limiting for that profile.
A setting of 0 percent can work well for profiles that are used for management,
administration, or testing.

Configure Rate Limiting for the Basic Profile Group

In the basic profile group, for each radio mode (802.11b/bg/ng mode and 802.11a/na/ac
mode), rate limiting per profile adds up to a maximum of 100 percent. (It can be less than
100 percent.)

To configure rate limiting for the basic profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Configuration > Profile > Basic > Rate Limit.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless Security | Profile | WLAN Network | Captive Portal
Rate Limit
» Radio
= Load Balancing 802.11b/bg/ng 802.11a/nafac
= AP LED State Profile Name SSID Rate Limit
Advanced VLANLO WC9500Doc e I
) VLAN20 NG_11g-02 &
VLAN30 NG_11g-03 N O

CANCEL APPLY

The page provides a tab for each WiFi radio.
5. Click the tab for the radio for which you want to configure rate limiting.
6. For each profile on a WiFi radio, specify the rate limit as a percentage.

You can drag the sliders to adjust the values in the Rate Limit fields to the right of the
sliders. Make sure that the total percentages of all profiles on one WiFi radio do not
exceed 100 percent.
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7. Click the Apply button.

Your settings are saved.

Configure Rate Limiting for an Advanced Profile Group

For each advanced profile group, and for each radio mode (802.11b/bg/ng mode and
802.11a/na/ac mode), rate limiting per profile adds up to a maximum of 100 percent. (It can
be less than 100 percent.)

> To configure rate limiting for an advanced profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
3. Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > Profile > Advanced > Rate Limit.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal
Basic Rate Limit @
» Radio Group-1 Group-2 Group-3

» AP LED State
: 802.11b/bg/ng 802.11a/nafac

Bldi_Upper_Floor  NG_11g-11 &0
Bli_Lower_Floor NG_11g-12 ——— [o
Bldi_Library NG_11g-13 = 0

CANCEL APPLY

The page provides a tab for each group. For each group, the page provides a tab for each
WiFi radio.

5. Click the tab for the profile group for which you want to configure rate limiting.
6. Click the tab for the radio for which you want to configure rate limiting.
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7. For each profile on a WiFi radio in the selected profile group, specify the rate limit as a
percentage.

You can drag the sliders to adjust the values in the Rate Limit fields to the right of the
sliders. Make sure that the total percentages of all profiles on one WiFi radio in the
selected profile group do not exceed 100 percent.

8. Click the Apply button.

Your settings are saved.

Manage the LED Behavior

Note: This feature is supported for access point models WN370, WAC720,
WAC730, and WAC740 only.

You can manage the LED behavior of WN370, WAC720, WAC730, and WAC740 access
points by enabling all LEDs (which is the default setting), by enabling the Power LED only, or
by disabling all LEDs. You can configure a different setting for each model access point that
supports management of the LED behavior.

This feature is useful if an access point is installed in a hotel guest room and you want to
make sure that guests are not disturbed by the blue light of the LEDs.

Manage the LED Behavior for the Basic Profile Group

You can manage the LED behavior of WN370, WAC720, WAC730, and WAC740 access
points that support the basic profile group.

» To manage the LED behavior of WN370, WAC720, WAC730, or WAC740 access points
that support the basic profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Configuration > Profile > Basic > AP LED State.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile | WLAN Network | Captive Portal

Choose AP LED State @

= Radio

= Load Balancing WN370 WAC740 WAC730 WAC720
= Rate Limit

AP LED State
Advanced @ Enable All LEDs

! Enable Power LED
' Disable All LEDs

CANCEL APPLY

5. Select the tab for the model access point that you want to configure.

6. Select a radio button:
* Enable all LEDs. All LEDs function normally. This is the default selection.
* Enable Power LED. Only the Power LED functions and the other LEDs are off.
» Disable All LEDs. All LEDs are off.

7. Click the Apply button.

Your settings are saved.

Manage the LED Behavior for an Advanced Profile Group

For each advanced profile group, you can manage the LED behavior of WN370, WAC720,
WAC730, and WAC740 access points that support the profile group.

To manage the LED behavior of WN370, WAC720, WAC730, or WAC740 access points
that support an advanced profile group:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > Profile > Advanced > AP LED State.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless | Security | Profile | WLAN Network | Captive Portal

Basic Choose AP LED State
» Radio Group-1 Group-2
= Rate Limit

WN370 WAC740 WAC730 WAC720

AP LED State

2  Enable All LEDs
Enable Power LED
Disable All LEDs

CANCEL APPLY

= ]

The page provides a tab for each group.

Click the tab for the profile group for which you want to manage the LED behavior.
Select the tab for the model access point that you want to configure.

Select a radio button:

e Enable all LEDs. All LEDs function normally. This is the default selection.

* Enable Power LED. Only the Power LED functions and the other LEDs are off.
e Disable All LEDs. All LEDs are off.

Click the Apply button.

Your settings are saved.
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This chapter includes the following sections:

Manage Rogue Access Points
Manage Guest Network Access Through Guest Portals and Captive Portals
Manage Users, Accounts, and Passwords
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Manage Rogue Access Points

The wireless controller can detect rogue access points in your network, you can classify the
detected rogue access points, and you can import a list of known access points.

Rogue Access Point Concepts

Rogue access point detection is disabled by default on the wireless controller. If you want to
detect rogue access points, you must enable rogue access point detection. Scanning might
affect the service availability of the access point temporarily.

An access point is defined as rogue if:

e The access point’s radio basic service set identifier (BSSID) is detected by any of the
managed access points.

e The access point transmits on the Ethernet side on the same Layer 2 as the managed
access points.

e Atleast one client is connected to the access point.
Any unmanaged access point not meeting all these conditions is classified as a neighbor.

The access points transmit broadcast frames on the Ethernet during the time access point
radios are off-channel (and scanning).

The wireless controller can detect and maintain a maximum of 512 access points, both
neighboring and rogue access points.

Note: If enabled, basic rogue AP detection and advanced rogue AP
detection apply to all profiles, whether in the basic profile group or in
any of the advanced profile groups.

Configure Basic Rogue Detection Settings

In a basic setup, you can set up one detection server. In an advanced setup you can create
multiple detection servers (for more information, see Classify Rogue Access Points on
page 220).

> To set up a server to detect rogue access points:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.
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The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Configuration > Security > Basic > Rogue AP.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security ! Profile | WLAN Network | Captive Portal
Rogue AP 7)
Rogue AP Detection ® enable O disable
» MAC ACL ) & i
Alert Severity \*) Major O Minor

» Authentication
Server

Advanced

The wireless controller can support a total of up to 512 access points from the known and
unknown lists combined.

5. Next to Rogue AP Detection, select the enable radio button.

6. Next to Alert Severity, select the severity of the alarm when a rogue access point is detected:
e Major. A major alarm is triggered.
e Minor. A minor alarm is triggered.

7. Click the Apply button.
Your settings are saved.

Because the neighboring and rogue access points are detected during off-channel scans,
it typically takes about 30 minutes after the rogue AP detection is enabled for the
neighbor and rogue access points to be detected on one channel.

Once the neighbor and rogue access points are detected, the wireless controller
populates the known list (that is, the database with known access points) and unknown
list (that is, the database with unknown access points).

Classify Rogue Access Points

You can identify what could be access points from neighboring businesses that are known.
As you identify access points, mark them as known or unknown so that the wireless controller
does not keep finding them and flagging them. Marking the access points can help you to
identify your own equipment that must be managed and the rogue access points that must be
detected. A rogue access point acquired both a WiFi and a LAN connection. A neighbor is an
access point with only a WiFi connection, not a LAN connection.

» To view and classify rogue access points:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.
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By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > Security > Advanced > Rogue AP.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless | Security | Profile | WLAN Network | Captive Portal

Basic
Rogue AP 3

» MAC ACL

;-ﬂulh!n“ﬂtlon Import Known List No file selected. O Merge @ Replace

erver
Rogue List
Search - ~ 2080/280
MAC +| SSID ¢ | Channel ¢ | Privacy ¢ | Last Beacon s Classification+ | Name + | l
84:1b:Se:Sc: 98 a0 111-620-162-2.4 11 Unsecured Fri Oct 18 22:20:09 2013 Meighbor AP Unknown |:|
Fard44:01:96:f2:80 € Zacured Fri Ock 128 22:20:109 2013  Heighbor AP Unknown "
0:46:98:38:00:b0 | 1WG103_i086_g 2 Securad Fri Ock 18 22:20:09 2013 Neighbor AP Unknown =
02:60:0f:00:00:01 NETGEAR-Guest & Unsacured FriOck 18 06:17:03 2013 MNeighbor AP Unknown D
00:00:00:00:00:01 NWTGR-ACS @ Unsacuraed  Fri Ock 18 00:07:00 2013 Neighbor AP Unknown ]
00:60:0f100:00:01  Ath5G_Q12 13 Unsecured Fri Oct 18 22:20109 2013 Heighbor AF  Unknown O
84:11b:Se:et:65:F7 we-4500v2-5G 149 Securad Fri Oct 18 22:20:09 2013 HNeighbor AP Unknown D
cdr3dicT a0 fd:fo 17€00_HeatMap_a 157 Sacurad Fri Oct 18 22:20:09 2013 Heighbor AP Unknown ]
c0:3f100:85:cd160 | 1lssued85S0_gl 11 Secured Fri Oct 18 22:20:09 2013 Neighbor 4P Unknown O
4r3dieT a0 fdifl C dl 157 Secured Fri Oct 18 22120109 2013  Heighbor AP Unknown D
1-10 of 280 | Entry Per Page | Default v PREVIOUS | |1 » of 28 | NEXT
Mowve to: KHOWHN UNEMOWN
APPLY IMPORT CAMCEL

The page displays the Rogue List, which shows all detected rogue access points with
essential information, including information about their last beacon. If the Rogue List
contains many entries that are spread out over several pages, click the Next button or the
Previous button to scroll through the Rogue List.

Note: Asan option, you canimport a list of access points from a file. For more
information, see Import a List of Known Access Points From a File on
page 222.

5. Classify the access points in the Rogue List:
a. Do one of the following:
e Select one or more check boxes that correspond to the access points.

e Select all access points in the Rogue List by selecting the check box at the top of
the table.

b. Click one of the following two buttons, both of which are located below the Rogue
List:

* Known. Moves the selected access points to the known list.
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* Unknown. Moves the selected access points to the unknown list.
For each known access point, enter a name in the Name column.
A name allows access points to be more easily identified.
Click the Apply button.

Your settings are saved.

Import a List of Known Access Points From a File

You can import a list of known access points from a saved file. Create a text file that includes
the MAC address of each access point, one MAC address per line. The wireless controller
can support a total of up to 512 access points from the known and unknown lists combined.

To import a list of known access points from a file:

1.

Create a text file that includes a list of MAC addresses for the access points. Each MAC
address must be on a separate line with hard returns between lines as shown in the
following example:

00:00:11:11:22:29
00:00:11:11:22:28
00:00:11:11:22:27
00:00:11:11:22:26
00:00:11:11:22:25

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

Select Configuration > Security > Advanced > Rogue AP.

The advanced Rogue AP page displays.

Click the Browse button, navigate to the file containing the list of known access points, and
select it.
Next to Import Known List, select one of the following radio buttons:

e Merge. Merges the list of access points that you intend to import with the access points
that are already present in the Rogue List.

* Replace. Replaces the access points that are present in the Rogue List with the
access points in the file that you intend to import.

Click the Import button.
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The wireless controller imports the MAC addresses that are in the text file into the Rogue
List table.

9. Click the Apply button.
Your settings are saved.

Manage Guest Network Access Through Guest Portals and
Captive Portals

Users with management (admin) credentials—for example, receptionists or hotel clerks—can
provision guests. Guests must provide their email address, or both a login name and
password. These latter guests are referred to as captive portal users, for which you must set
up a captive portal and captive portal user credentials.

Note: The URL for the portal is http://<IP address>/guest_access/index.php
in which <IP address> is the IP address of the wireless controller.

Portal Concepts

You can configure multiple guest portals and assign a portal to a security profile in the basic
profile group or a security profile in an advanced profile group. The wireless controller pushes
a portal configuration to the SSID of a managed access point.

The wireless controller supports two types of portal settings:

e Guest portal. Use a guest portal if all WiFi users are allowed to access the network by
supplying only their email address. You do not need to define user names and passwords
for these users.

» Captive portal. Use a captive portal if WiFi users must supply their login name and
password before being allowing access the network. You must define user names and
passwords for these users (see Manage Users, Accounts, and Passwords on page 236).
Captive portal authentication is typically used for hotspot users and paying guests such
as hotel guests who purchase access time for an Internet connection.

When you configure a captive portal, you can use either the wireless controller as a local
authentication server for the captive portal clients, or you can configure an external
RADIUS server for authentication.

You can configure the basic portal as a guest portal or a captive portal (see Configure a
Basic Guest Portal or Captive Portal on page 224) and you can configure up to eight
portals (any combination of guest portals and captive portals) as part of the advanced
portal group (see Configure an Advanced Guest Portal or Captive Portal on page 229).
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Note: If the network authentication uses an external RADIUS server, you
cannot configure captive portal authentication. That is, if you configure
an external RADIUS server with WPA, WPA2, or WPA & WPA2 (or if
you use legacy 802.1X), you cannot configure captive portal
authentication; the network authentication must be Open System,
Shared Key, WPA-PSK, WPA2-PSK, or WPA-PSK & WPA2-PSK (see
Network Authentication and Data Encryption Options on page 137).

Note these guidelines for captive portal user authentication and accounting through an
external RADIUS server:

You can use either the basic-Auth RADIUS server or a RADIUS server of an advanced
authentication group. You cannot use the external LDAP server.

The wireless controller uses CHAP or MS-CHAP as the authentication protocol with the
authentication server.

The following RADIUS authentication variables are supported on the wireless controller:
- User-Name

- User-Password

- WISPr-Session-Terminate-Time

- Session-Timeout

If you change the values for any of these variables before the WiFi client disassociates
from the access point, the new values are not updated on the wireless controller.

A managed access point can send accounting information to the external RADIUS server
because the wireless controller functions as a proxy RADIUS client for the managed
access point. The following RADIUS accounting variables are supported on the wireless
controller:

- Acct-Input-Octets

- Acct-Output-Octets

- Acct-Input-Gigawords
- Acct-Input-Gigawords

Configure a Basic Guest Portal or Captive Portal

You can configure a basic guest portal or captive portal with a local or external authentication
server.

You would typically use the basic portal in the profiles of a basic profile group of a small-scale
network. However, you can assign the basic portal to any profile, whether in the basic profile
group or in an advanced profile group.

Manage Rogue Access Points, Guest Network Access, and Users

224



ProSAFE Wireless Controller

» To configure a basic guest portal or captive portal:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Configuration > Captive Portal > Basic.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System : Wireless | Security | Profile | WLAN Network | Captive Portal
Portal Settings
Advanced Portal Type Guest @ Captive
Radius Server 9 Local Radius bas-c-AuthE‘
Redirect URL s
Max Clients Per User JE
R thentication Ti t hr: | 0|+ | mins: BOB
Background Page 9 Default Custom
Select Placement
Faghs
Ssin
sk
e
o rams
e
@ Center Bottom Top

Load Background Image (bmp,gif,jpg,png - Size Limit 5 MB) I Browse... | No file selected.

EULA @

Eula Text Required

CANCEL PREVIEW APPLY

The previous figure shows the settings for a captive portal. The settings for a guest portal
are identical, except for the RADIUS server settings, which you cannot configure for a
guest portal.
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5. Configure the settings as described in the following table.

Setting Description

Portal Settings section

Portal Type Select one of the following radio buttons:

e Guest. A guest portal with a field for entering an email address.
Guests do not need to provide a password and can get unlimited access to
the network. You do not need to configure guest accounts.

e Captive. A captive portal with a field for entering a login user name and a
field for entering a password.
If you select this option, the Radius Server radio buttons and menu display.
For information about how to configure captive portal users and accounts,
see Manage Users, Accounts, and Passwords on page 236.

Radius Server Select one of the following radio buttons:
Note: Thissettingis fora e Local. Use the local authentication s.erv.er.
captive portal only. ¢ External. Select an external authentication server from the menu.

Note: For information about setting up and enabling internal and external
authentication servers, see Manage Authentication Servers and Authentication
Server Groups on page 140.

Redirect URL To redirect traffic to a URL after successful captive authentication, select the
check box and enter the URL.

By default, traffic is not redirected.

Max Clients Per User Specify the number of clients that a single captive portal user can open with the
same the login information.

The default setting is 1. The maximum number of clients that you can select
from the menu is 5.

Reauthentication Specify the period after which a user who was idle must be reauthenticated.

Timeout The minimum period is 30 minutes. The maximum period that you can select
through the menus is 24 hours.

Select Placement Click the Center, Bottom, or Top button to specify the location of the login
prompt on the login page.
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Setting

Description

Background Page

You can either select a background image or configure a custom background
page.

To navigate to and select an image file for the background of the login page, do
the following:

1. Keep the Background Page Default radio button selected.
2. Next to Load Backgrounds Image, click the Browse button.
3. Navigate to and select an image file.

You can use a .bmp, .gif, . jpg, or .png image.
To configure a custom background page with the default login option, do the
following:

1. Select the Background Page Custom radio button.
The Login Panel radio buttons display.
2. Keep the Login Panel Default radio button selected.

The default login panel for a guest portal provides an email field and a login
button. The default login panel for a captive portal provides a user name and
password field and a login button.

3. Scroll down to the Custom Background Page section and click in anywhere
the window.

The icons display.

Custom Background Page

@ Source i@ @ Ifz‘ [ [.E_“_ _ Q_ l._’._'é E &% B I U S

x * L||M @ S © Q== 2 ¢ 4 »pa9 ¥ o

E = E || styles = || Normal = || Font - size ~|| A- BY-

body p A

4. Use the icons to compose your custom background.
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Setting

Description

Login Panel

You can either keep the default login panel or configure a custom login panel.

The default login panel for a guest portal provides an email field and a login
button. The default login panel for a captive portal provides a user name and
password field and a login button. You can customize the login panel to suit your
needs. For example, for a captive portal login panel for a hotel, you could
change the user name to a room number.

To configure a custom background page with a custom login panel, do the
following:

1. Select the Background Page Custom radio button.
The Login Panel radio buttons display.

Select the Login Panel Custom radio button.

Scroll down to the Custom Background Page section.

The icons display automatically.

Custom Background Page D)
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4. Use the icons to compose both your custom background page and login
panel.

EULA section

EULA Text Required

Select the EULA Text Required check box if you want to present the end-user
license agreement (EULA) on the guest login page or captive portal login page
so users can view the EULA before they log in. Enter the EULA text in the text
field.

6. To display the portal settings that you configured, click the Preview button.

The URL for the captive portal is http://<IP address>/guest_access/index.php, in which

<|P address> is the IP

address of the wireless controller.

The default URL for the captive portal is http://192.168.0.250/guest_access/index.php.

Click the Apply button.

Your settings are saved.
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8. Assign the captive portal or guest portal to a security profile in the basic profile group, in an
advanced profile group, or in both:

Basic profile group. Assign the captive portal or guest portal to a security profile in the

basic profile group:

a.

Select Configuration > Profile > Basic > Radio.
The Edit Profile (Basic) page displays.
Click the tab for the radio for which you want to assign the portal.

Click the tab for the profile to which you want to assign the portal.

In the Authentication Settings section of the page, select the Captive Portal
check box.

The Captive Portal check box displays only when you select Open System,
Shared Key, WPA-PSK, WPA2-PSK, or WPA-PSK & WPA2-PSK from the
Network Authentication menu.

Click the Apply button.

Your settings are saved.

Advanced profile group. Assign the captive portal or guest portal to a security profile in
an advanced profile group:

a.

Select Configuration > Profile > Advanced > Radio.
The Profile Groups page displays.

Click the tab for the profile group for which you want to assign the portal.
Click the Edit button.

The Edit Profile page displays.

d. Click the tab for the radio for which you want to assign the portal.

Click the tab for the profile to which you want to assign the portal.
In the Authentication Settings section of the page, select the Captive Portal
check box.

The Captive Portal check box displays only when you select Open System,
Shared Key, WPA-PSK, WPA2-PSK, or WPA-PSK & WPA2-PSK from the
Network Authentication menu.

. Click the Apply button.

Your settings are saved.

Configure an Advanced Guest Portal or Captive Portal

As part of the advanced portal group, you can configure up to eight portals (any combination
of guest portals and captive portals) with local or external authentication servers.

You can assign any portal, including the basic portal, to any profile, whether in the basic
profile group or in an advanced profile group.
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> To configure an advanced guest portal or captive portal:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > Captive Portal > Advanced.
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Configuration Monitor Maintenance Stacking Plans Diagnostics

System ! Wireless | Security ! Profile | WLAN Network | Captive Portal

e Captive Portal Settings @

Captive-1 Captive-2 +

Portal Settings

Name Captive-1
Portal Type 9 Guest Captive
Redirect URL [
Max Clients Per User 1E|
Reauthentication Timeout hr: | 0[=] mins:{ 30=]
Background Page 9 pefault Custom
Select Placement

v

baslie

L 2
.

9 Center Bottom Top

Load Background Image (bmp,gif,jpg,png - Size Limit 5 MB) Browse... | No file selected.

EULA
Eula Text Required

PREVIEW DELETE

The previous figure shows the settings for a captive portal. The settings for a guest portal
are identical, except for the RADIUS server settings, which you cannot configure for a
guest portal.

Click the + button to create an additional portal.

The new portal displays on the advanced Captive Portal Settings page, and the tab for
the new portal is automatically selected to let you configure the new group.

In the Name field, enter a unique name for the portal.

By default, portals are named Captive-1, Captive-2, Captive-3, and so on.
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7. Configure the settings as described in the following table.

Setting

Description

Portal Settings section

Portal Type

Select one of the following radio buttons:

e Guest. A guest portal with a field for entering an email address.
Guests do not need to provide a password and can get unlimited access to
the network. You do not need to configure guest accounts.

e Captive. A captive portal with a field for entering a login user name and a
field for entering a password.
If you select this option, the Radius Server radio buttons and menu display.
For information about how to configure captive portal users and accounts,
see Manage Users, Accounts, and Passwords on page 236.

Radius Server

Note: Thissettingisfora :

captive portal only.

Select one of the following radio buttons:
Local. Use the local authentication server.
* External. Select an external authentication server from the menu.

Note: For information about setting up and enabling internal and external
authentication servers, see Manage Authentication Servers and Authentication
Server Groups on page 140.

Redirect URL

To redirect traffic to a URL after successful captive authentication, select the
check box and enter the URL.

By default, traffic is not redirected.

Max Clients Per User

Specify the number of clients that a single captive portal user can open with the
same the login information.

The default setting is 1. The maximum number of clients that you can select
from the menu is 5.

Reauthentication
Timeout

Specify the period after which a user who was idle must be reauthenticated.

The minimum period is 30 minutes. The maximum period that you can select
through the menus is 24 hours.

Select Placement

Click the Center, Bottom, or Top button to specify the location of the login
prompt on the login page.
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Setting

Description

Background Page

You can either select a background image or configure a custom background
page.

To navigate to and select an image file for the background of the login page, do
the following:

1. Keep the Background Page Default radio button selected.
2. Next to Load Backgrounds Image, click the Browse button.
3. Navigate to and select an image file.

You can use a .bmp, .gif, . jpg, or .png image.
To configure a custom background page with the default login option, do the
following:

1. Select the Background Page Custom radio button.
The Login Panel radio buttons display.
2. Keep the Login Panel Default radio button selected.

The default login panel for a guest portal provides an email field and a login
button. The default login panel for a captive portal provides a user name and
password field and a login button.

3. Scroll down to the Custom Background Page section and click in anywhere
the window.

The icons display.

Custom Background Page
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4. Use the icons to compose your custom background.
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Setting

Description

Login Panel

You can either keep the default login panel or configure a custom login panel.

The default login panel for a guest portal provides an email field and a login
button. The default login panel for a captive portal provides a user name and
password field and a login button. You can customize the login panel to suit your
needs. For example, for a captive portal login panel for a hotel, you could
change the user name to a room number.

To configure a custom background page with a custom login panel, do the
following:

1. Select the Background Page Custom radio button.
The Login Panel radio buttons display.

Select the Login Panel Custom radio button.

Scroll down to the Custom Background Page section.

The icons display automatically.

Custom Background Page D)
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4. Use the icons to compose both your custom background page and login
panel.

EULA section

EULA Text Required

Select the EULA Text Required check box if you want to present the end-user
license agreement (EULA) on the guest login page or captive portal login page
so users can view the EULA before they log in. Enter the EULA text in the text
field.

8. To display the portal settings that you configured, click the Preview button.

The URL for the captive portal is http://<IP address>/guest_access/index.php, in which

<|P address> is the IP

address of the wireless controller.

The default URL for the captive portal is http://192.168.0.250/guest_access/index.php.

Click the Apply button.

Your settings are saved.
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10. Assign the captive portal or guest portal to a security profile in the basic profile group, in an
advanced profile group, or in both:
» Basic profile group. Assign the captive portal or guest portal to a security profile in the
basic profile group:

a.

Select Configuration > Profile > Basic > Radio.
The Edit Profile (Basic) page displays.
Click the tab for the radio for which you want to assign the portal.

Click the tab for the profile to which you want to assign the portal.

In the Authentication Settings section of the page, select the Captive Portal
check box.

The Captive Portal check box displays only when you select Open System,
Shared Key, WPA-PSK, WPA2-PSK, or WPA-PSK & WPA2-PSK from the
Network Authentication menu.

Click the Apply button.

Your settings are saved.

e Advanced profile group. Assign the captive portal or guest portal to a security profile in
an advanced profile group:

a.

Select Configuration > Profile > Advanced > Radio.
The Profile Groups page displays.

Click the tab for the profile group for which you want to assign the portal.
Click the Edit button.

The Edit Profile page displays.

d. Click the tab for the radio for which you want to assign the portal.

Click the tab for the profile to which you want to assign the portal.
In the Authentication Settings section of the page, select the Captive Portal
check box.

The Captive Portal check box displays only when you select Open System,
Shared Key, WPA-PSK, WPA2-PSK, or WPA-PSK & WPA2-PSK from the
Network Authentication menu.

. Click the Apply button.

Your settings are saved.
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Remove a Portal
You can remove a portal.

» Toremove a portal:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
3. Click the Login button.
The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > Captive Portal > Advanced.
The Captive Portal Settings page displays.

5. Click the tab for the portal.
6. Click the Delete button.

The portal is removed.

Manage Users, Accounts, and Passwords

The wireless controller supports different types of users and accounts. You can add, change,
and remove users and accounts.

User and Account Concepts

The wireless controller supports three types of users: management users, WiFi users (WiFi
clients), and captive portal users. All of these users must provide their login name and
password to be authenticated by the wireless controller’s internal authentication server and to
access the wireless controller’'s web management interface or WiFi network.

e Management users. These users are allowed access to the wireless controller's web
management interface. The wireless controller supports four types of management users:

- Administrators. Administrative users (admins) with read and write capabilities.
These users can change the configuration of the wireless controller.

- Read-only users. These users are allowed access to the wireless controller's web
management interface but can access only the Monitor main navigation tab and the
Help main navigation tab. These users cannot change the configuration of the
wireless controller.
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- Guest provisioning users. These users can configure only captive portal users, that
is, they can access only the User Management configuration menu tab under the
Maintenance main navigation tab.

- License management only users. These users can configure only licenses, that is,
they can access only the License configuration menu tab under the Maintenance
main navigation tab (for more information, see Manage Licenses on page 274).

e WiFi users. Users with credentials to access the WiFi network. These users do not need
to use the captive portal or the guest portal to access the WiFi network, nor is their
access subject to expiration.

e Captive portal users. Users with credentials to access the captive portal and who are
granted temporary access or access without expiration.

In addition to the users, you can also configure captive portal accounts that you use in
combination with captive portal users. Accounts specify the period during which WiFi access
is available and the amount that is charged for it.

Note: For information about password requirements, see Table 15 on
page 389.

Change the Password of the Default admin Account of the
Wireless Controller

We recommend that you change the password of the default administrator (admin) account
of the wireless controller to a secure password.

IMPORTANT:

The administrator password that you configure on the wireless
controller is also pushed to all managed access points. That is, if
you want to access the web management interface of a
controller-managed access point, you must use the password of
the wireless controller’'s default admin account.

> To change the password of the default admin account of the wireless controller:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.
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The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Maintenance > User Management.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts
User Management &
Management WiFi Clients Captive Portal Account Captive Portal Users
® admin Adrinistrator
O guest Read Only
O PeterBrown Guest Provisioning
O LicensefAdmin Licanse Management Only
ADD EDIT REMOVE EXPORT

The previous figure contains some account examples.

5. Select the radio button for the admin user name.
6. Click the Edit button.

Edit User
User Name admin
old Password sssnssene
User Type Administrator

New Password

Confirm New Password

CANCEL APPLY RESET

7. Inthe Old Password field, enter the current password.

8. In the New Password field, enter the new password and repeat it in the Confirm New
Password field.

9. Click the Apply button.

Your settings are saved. The password is saved and pushed to all controller-managed
access points.
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Add a Management User

You can add an administrator, a user with read-only access to the wireless controller's web
management interface, a user who can provision captive portal users only, and a user who
can manage licenses only.

» To add a management user:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Maintenance > User Management.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

er Management  Upgrade ! Licensing | Backup/Restore : Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

User Management &

Management WiFi Clients Captive Portal Account Captive Portal Users

- User Name % | User Type %
® admin Adrinistrator
O guest Read Only
O PeterBrown Guest Provizsioning
O LicenseAdmin License Management Only

ADD EDIT REMOVE EXPORT

The previous figure contains some account examples.

5. Click the Add button.

Add User

User Name

User Type [ Adrninistrator v
Password

Confirm Password

CANCEL APPLY RESET
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6. Configure the user settings as described in the following table.

Setting Description

User Name Enter a unique user name. Only alphanumerical characters and underscore
characters () are supported.

User Type From the menu, select the type of user, which determines the users’s access to the
wireless controller’'s web management interface.

e Administrator. Full access with read and write capabilities.

¢ Read Only. Read-only access that is restricted to the Monitor and Help main
navigation tabs.

e Guest Provisioning. Access that is restricted to the User Management
configuration menu tab under the Maintenance main navigation tab.

¢ License Management Only. Access that is restricted to the License
configuration menu tab under the Maintenance main navigation tab.

Password Enter a password in the Password field.
Confirm the password in the Confirm Password field.

7. Click the Apply button.

Your settings are saved. The user is added to the table on the User Management page.

Add a WiFi User

You can add a user who is allowed to access the WiFi network but who does not need to go
through the captive portal or the guest portal. (The web management interface refers to WiFi
users as WiFi clients.)

To add a WiFi user:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Maintenance > User Management.

The User Management page displays with the Management tab and associated page in
view.

5. Click the WiFi Clients tab.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts
User Management (@
Management WiFi Clients Captive Portal Account Captive Portal Users
C Tusername e
@® JohnD_415 PEAP
O Maryl_446 PEAP
ADD EDIT REMOVE EXPORT

The previous figure contains some account examples.
6. Click the Add button.

Add User

User Name
Password
Confirm Password

Authentication Type EAP v

CANCEL APPLY RESET

7. Configure the client settings as described in the following table.

Setting Description

User Name Enter a unique user name. Only alphanumerical characters and underscore
characters (_) are supported.

Password Enter a password in the Password field.
Confirm the password in the Confirm Password field.

Authentication Type |From the menu, select one of the following protocols:
* EAP. Extensible Authentication Protocol.
* PEAP. Protected EAP.

8. Click the Apply button.

Your settings are saved. The client is added to the table on the User Management page.

Add a Captive Portal Account

If you configure a captive portal (see Configure a Basic Guest Portal or Captive Portal on
page 224), you can add a captive portal account.
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Note: If you configure a guest portal, you cannot add a captive portal account.

> To add a captive portal account:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Maintenance > User Management.

The User Management page displays with the Management tab and associated page in
view.

5. Click the Captive Portal Account tab.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

Upgrade | Licensing | Backup/Restore |

User Management

Print Message

Existing Logo Image

Message Required

User Management @
Management = WiFi Clients || Captive Portal Account = Captive Portal Users
2 VIPguests 24 Hours(s) 50

HotelGuasts 12 Hours(s) £12

Load Lego For Print Message (bmp,gif,jpg,png - Size Limit 5 MB) Browse.. | No file selected.

PREVIEW

CAMCEL

APPLY

ADD EDIT

REMOVE

EXPORT
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The previous figure contains some account examples.

6. Click the Add button.

Add Account

Account Name

Amount

Currency Sign

Expiry Huurs(s)!zl

Print Message

CANCEL APPLY RESET

7. Configure the account settings as described in the following table.

Setting Description

Account Name Enter a unique account name. Only alphanumerical characters and underscore
characters () are supported.

Amount Enter the total amount that is charged for the period during which access is available.
Enter whole numbers only.

Currency Sign Enter the currency that is associated with the amount.

Expiry From the menu, select one of the following periods, and enter a valid number in the
field to the left of the menu:

e Hour(s). The expiration period is measured in one or more hours.

e Day(s). The expiration period is measured in one or more days.

*  Week(s). The expiration period is measured in one or more weeks.

e Month(s). The expiration period is measured in one or more months.

Print Message To convey a message to the captive portal user, enter a text.

8. Click the Apply button.

Your settings are saved. The account is added to the table on the User Management
page.

Add a Logo and Message on Captive Portal User Information

If you configure a captive portal (see Configure a Basic Guest Portal or Captive Portal on
page 224), you can add a logo and message that display if you print captive portal user
information.

The logo displays on all printed captive portal user information (see Add a Captive Portal User
on page 245 and Add Multiple Captive Portal Users Simultaneously on page 247). You can
specify whether the message displays on all printed captive portal user information.
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Note: If you configure a guest portal, you cannot add a logo or message.

> To add alogo and message on printed captive portal user information:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Maintenance > User Management.

The User Management page displays with the Management tab and associated page in
view.

5. Click the Captive Portal Account tab.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

Upgrade | Licensing | Backup/Restore |

User Management

Print Message

Existing Logo Image

Message Required

User Management @
Management = WiFi Clients || Captive Portal Account = Captive Portal Users
2 VIPguests 24 Hours(s) 50

HotelGuasts 12 Hours(s) £12

Load Lego For Print Message (bmp,gif,jpg,png - Size Limit 5 MB) Browse.. | No file selected.

PREVIEW

CAMCEL

APPLY

ADD EDIT

REMOVE

EXPORT
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The previous figure contains some account examples.

To load a logo that displays on the print message, click the Browse button, and follow the
directions of your browser to navigate to the logo and select it.

You can upload a logo in .bmp, .gif, . jpg, or .png format. The maximum size for the
file is 5 MB.

To specify a message, in the field below the Message Required check box, enter the
message.

To specify that the message must be printed, select the Message Required check box.
If you do not select the Message Required check box, the message is not printed.
Click the Apply button.

Your settings are saved. The uploaded logo displays to the left of the PREVIEW button.

10. To preview the logo and message, click the PREVIEW button.

User Information
User Name DUMMY
Password 300X
Validity DUMMY
Expiry DUMMY
Cost DUMMY

Welcome to the NETGEAR. site!

Add a Captive Portal User

If you configure a captive portal (see Configure a Basic Guest Portal or Captive Portal on
page 224), you can add a captive portal user.

Note: If you configure a guest portal, you cannot add a captive portal user.

> To add a captive portal user:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.
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The wireless controller’s web management interface opens and displays the Summary
page.

4. Select Maintenance > User Management.

The User Management page displays with the Management tab and associated page in
view.

5. Click the Captive Portal Users tab.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts
User Management @
Management WiFi Clients Captive Portal Account Captive Portal Users
- User Name % | Account Name % | Expiry
@ Weenson WIPguests Hever Used
O Elohson HotelGuests Hever Used
Q BHart Default 2/15/2013 at 16:30
BULK ADD ADD EDIT REMOVE EXPORT

The previous figure contains some account examples.
6. Click the Add button.

Add User

User Name
Password

GENERATE

Confirm Password

Expiry
O Account | VIPguests
O Mo Expiry
(@] Expiresin |1 % | mins
® Expires at hr:| 21 % | mins: 55+
Month: | 2 % | Date: 14 % Year: 2013 %

CAMCEL APPLY PRINT RESET

7. Configure the user settings as described in the following table.

Setting Description

User Name Enter a unique user name. Only alphanumerical characters and underscore
characters (_) are supported.
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Setting Description
Password Use one of the following methods to populate the password fields.
Method 1:

1. Enter a password in the Password field.
2. Confirm the password in the Confirm Password field.
Method 2:

Click the Generate button.
A password is generated automatically.

Expiry Select one of the following radio buttons:

e Account. Select a captive portal account from the menu. WiFi access expires
according to the expiration period that is specified for the selected account (see
Add a Captive Portal Account on page 241).

e No Expiry. WiFi access does not expire.

e Expires in. WiFi access expires in less than one hour. From the mins menu,
select in how many minutes (from 1-59) access expires.

« Expires at. WiFi access expires at a date and time that you specify by making
selections from the following menus: hr, mins, Month, Date, and Year.

8. Click the Apply button.
Your settings are saved. The user is added to the table on the User Management page.

9. To print the captive user information, click the Print button.
10. Click the Close button.

The pop-up window closes.

Add Multiple Captive Portal Users Simultaneously

If you configure a captive portal (see Configure a Basic Guest Portal or Captive Portal on
page 224), you can add multiple (up to 256) captive portal users simultaneously.

Note: If you configure a guest portal, you cannot add captive portal users.

To add a multiple captive portal users simultaneously:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
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4. Select Maintenance > User Management.

The User Management page displays with the Management tab and associated page in
view.

5. Click the Captive Portal Users tab.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts
User Management @
Management WiFi Clients Captive Portal Account Captive Portal Users
- User Name % | Account Name %+ | Expiry
@ WBenson WIPguests Hever Used
O Elohson HotelGuests Hever Used
Q BHart Default 2152013 at 16:30
BULK ADD ADD EDIT REMOVE EXPORT

The previous figure contains some account examples.

6. Click the Bulk Add button.

Add User

User Name Prefix
Start Index
End Index

Password
GENERATE

Confirm Password

Expiry
Account | Add a AccnunE]
No Expiry
Expires in 1B mins
© Expiresat hr:| 13[~] mins: sg[x]

Month: lg Date: 3!2[ Year: 2015!3

CAMNCEL APPLY PRINT RESET
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7. Configure the user settings as described in the following table.

Setting

Description

User Name Prefix

Enter a user name prefix. Only alphanumerical characters and underscore characters
(L) are supported.

Note: As an example, if you want to add 17 captive portal users for a group of
conference guests that are booked in a hotel under the name Johnson, enter
Johnson_. Then, for the start index, enter 1, and for the end index, enter 17. The
captive portal accounts are added under the names Johnson_1, Johnson-2, and so on
through Johnson_17.

Start Index

Enter the start index number.

End Index

Enter the end index number, which determines how many captive portal users are
added.

Password

Use one of the following methods to populate the password fields.
Method 1:

1. Enter a password in the Password field.

2. Confirm the password in the Confirm Password field.
Method 2:

Click the Generate button.

A password is generated automatically.

Note: All captive portal users that you are adding through this procedure must use
the same password. However, after you add the users, you can change the password
for an individual user to a unique password (see Change the Settings for a User or
Account on page 250).

Expiry

Select one of the following radio buttons:

e Account. Select a captive portal account from the menu. WiFi access expires
according to the expiration period that is specified for the selected account (see
Add a Captive Portal Account on page 241).

e No Expiry. WiFi access does not expire.

e Expires in. WiFi access expires in less than one hour. From the mins menu,
select in how many minutes (from 1-59) access expires.

« Expires at. WiFi access expires at a date and time that you specify by making
selections from the following menus: hr, mins, Month, Date, and Year.

8. Click the Apply button.

Your settings are saved. The users are added to the table on the User Management

page.

9. To print the user information, click the Print button.
10. Click the Close button.

The pop-up window closes.
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Change the Settings for a User or Account

You can change the settings for a user or an account.

» To change the settings for a user or an account:

1. Open a web browser, and in the browser’s address field, type the wireless controller's IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Maintenance > User Management.

The User Management page displays with the Management tab and associated page in
view.

5. Click one of the following tabs:
* Management
* WiFi Clients
e Captive Portal Account
e Captive Portal Users
. Select the radio button that corresponds to the user or account that you want to change.
7. Click the Edit button.
A pop-up window opens.
8. Change the user or account settings.
9. Click the Apply button.
The settings are saved in the table on the User Management page.

Remove Users or Accounts

You can change or remove one or more users or accounts. However, you cannot remove a
captive portal account with which one or more captive portal users are associated. Before
you can remove the account, you first must assign the users to another account.

» Toremove one or more users or accounts:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
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The wireless controller’s login window opens.
2. Enter your user name and password.
Click the Login button.
The wireless controller's web management interface opens and displays the Summary
page.
4. Select Maintenance > User Management.

The User Management page displays with the Management tab and associated page in
view.

5. Click one of the following tabs:
* Management
e WiFi Clients
e Captive Portal Account
e Captive Portal Users

6. Take one of the following actions:

e For management users, WiFi clients, or captive portal accounts, select the radio
button that correspond to the user or account that you want to remove.

e For captive portal users, select one or more check boxes that correspond to the users
that you want to remove.

7. Click the Remove button.
The users or accounts are removed from the table.

Export a List of Users or Accounts
You can export a list of users or account as a comma-separated values (CSV) file.

> To export alist of users or accounts:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Maintenance > User Management.

The User Management page displays with the Management tab and associated page in
view.
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Click one of the following tabs:
e Management

e WiFi Clients

e Captive Portal Account
e Captive Portal Users
Click the EXPORT button.

The selected list is opened or saved as a zipped CSV file to a location that you specify.

To complete the procedure, follow the directions of your browser.
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Maintain the Wireless Controller
and Access Points

This chapter includes the following sections:

Manage the Configuration File or Upgrade the Firmware
Reboot the Wireless Controller

Reset the Wireless Controller

Manage Extended Storage

Manage Remote Access

Specify Session Time-Outs

Save the Logs

View Alerts and Events

Manage Licenses

Reboot Access Points

Configure Multicast Firmware Upgrade for Access Points

253



ProSAFE Wireless Controller

Manage the Configuration File or Upgrade the Firmware

This section includes the following subsections:

e Back Up the Configuration File
» Restore the Configuration File
e Upgrade the Firmware

The configuration settings of the wireless controller are stored in a configuration file on the
wireless controller. This file can be saved (backed up) to a computer, retrieved (restored)
from the computer, cleared to factory default settings, and replaced by a newer version
(upgraded).

Back Up the Configuration File

Once the wireless controller is installed and works correctly, make a backup of the
configuration file to a computer. If necessary, you can later restore the wireless controller
settings from this file.

» To back up the configuration file and save a copy of the current settings:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.

4. Select Maintenance > Backup/Restore.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

Backup/Restore @

Backup

Backup a copy of the current settings to a file BACKUP

Restore

Restore saved settings from a file ho file selected,

CAMCEL APPLY

5. Click the Backup button.
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A dialog box displays, showing the file name of the backup file. The backup file is in the
following format: backup.tgz.

To save the configuration file, follow the instructions of your browser.

Restore the Configuration File

Restore only settings that were backed up from your model wireless controller. (You cannot
restore settings that were backed up from another model wireless controller.)

To restore the configuration file from a backed-up file:

1.

7.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Maintenance > Backup/Restore.
The Backup/Restore page displays.

Click the Browse button.
Navigate to the saved configuration file.

& WARNING:

When you click the Apply button to restore the configuration file, do
not try to go online, turn off the wireless controller, shut down the
computer, or do anything else to the wireless controller until the
wireless controller finishes rebooting. When the Status LED turns
green, wait a few more seconds before you do anything.

Click the Apply button.

The configuration file is loaded onto the wireless controller, and the wireless controller
reboots.

Maintain the Wireless Controller and Access Points

255



ProSAFE Wireless Controller

Upgrade the Firmware

The wireless controller provides two methods for upgrading its firmware:

e Scheduled, automatic update
e Manual update

To enable you to switch the wireless controller from one firmware version to another, the
wireless controller provides two boot partitions. You can configure the wireless controller to
download firmware from a TFTP or FTP server and upgrade the firmware on the wireless
controller when it is least disruptive. You can also download firmware manually to a computer
and upload it to the wireless controller from a local file.

Note: In some cases, such as a major firmware upgrade, you might need to
erase the configuration and manually reconfigure the wireless
controller after the firmware upgrade. To find out if you must
reconfigure the wireless controller, see the release notes for the
firmware version.

IMPORTANT:

If your wireless controller runs a 3.x or 4.x firmware version and
you want to upgrade to a 5.x version, you must upgrade the
firmware by using a TFTP or FTP server. You cannot upgrade the
firmware from a local file.

To upgrade the firmware:

1. Download the firmware from NETGEAR:

a. Visit the NETGEAR support page for the your model wireless controller at
downloads.netgear.com.

b. Download the firmware and save it on your computer or on a network server.

2. Open a web browser, and in the browser’s address field, type the wireless controller's IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

3. Enter your user name and password.
4. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
5. Select Maintenance > Upgrade > Firmware Upgrade.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management 1 censing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

Firmware Upgrade @
AP Upgrade OTrre @FTP O Local File No file selected,
Settings
Server Parameters
Server IP
File Name

User Name
Password

Boot Information

Active Partition Partition 1 {Firmware version: 3.4.1.0_1665)

Boot Partition to Upgrade @ partition 1 () Partition 2

After upgrade boot from @ partition 1 O Partition 2

Schedule

Scheduled Upgrade Status None

When to Upgrade? O Later hri 2 mins: 47 Month: | 10 Date: | 19 Year: 2013
® Now

CAMCEL APPLY

The previous figure shows the fields that display when you select the FTP radio button.
When you select the TFTP or Local File radio button, fewer fields are shown.

6. Configure the settings as described in the following table.

Setting Description

TFTP, FTP, or Local File | Select one of the following radio buttons to specify from which location the
upgrade must occur. The page adjusts to display the fields that are required for
each upgrade location.

e TFTP. Upgrade from a TFTP server. The Server IP and File Name server
parameters fields display.

* FTP. Upgrade from an FTP server. The Server IP, File Name, User Name,
and Password server parameters fields display.

» Local File. Upgrade from a local file that you downloaded. The server
parameter fields do not display, but the Browse button becomes available.
To select the firmware upgrade file from your computer, follow the
directions of your browser.

Note: If your WiFi controller runs a 3.x or 4.x firmware version and you want to
upgrade to a 5.x version, you must upgrade the firmware by using a TFTP or
FTP server. You cannot upgrade the firmware from a local file.

Server Parameters section (TFTP and FTP only)

Server IP Enter the IP address of the TFTP or FTP server.
File Name Enter the file name of the firmware.
User Name (FTP only) Enter the user name to access the FTP server.
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Setting

Description

Password (FTP only)

Enter the password to access the FTP server.

Boot Information section

Active Partition

This field is an informational field that displays the active partition and the
current firmware version.

Boot Partition to Upgrade

Select the radio button for the partition to which the new firmware must be
saved.

After upgrade boot from

Select the radio button for the partition from which the wireless controller must
reboot after the firmware is upgraded.

Schedule section

Schedule Update Status

This field is an informational field that displays when the firmware upgrade
occurs. If no update is scheduled, the field displays None.

When to Upgrade?

Select when the firmware upgrade must occur:

» Later. Make selections from the menus to specify the date and time when
the upgrade must occur.

* Now. The upgrade occurs immediately after you click the Apply button.

A WARNING:

When you click the Apply button and the Now radio button is
selected to upgrade the firmware immediately, do not try to go
online, turn off the wireless controller, shut down the computer, or
do anything else to the wireless controller until the wireless
controller finishes rebooting. When the Status LED turns green,
wait a few more seconds before you do anything.

Click the Apply button.

Unless you scheduled the firmware upgrade for a particular time, the firmware is
upgraded immediately, and the wireless controller reboots.

To verify that the wireless controller is running the latest firmware, do the following:
a. Select Monitor > Network > Controller.

The Controllers page displays.

b. Verify the firmware version in the Version column.

Note: After you upgrade the firmware, if the browser does not display the
latest features of the web management interface, clear the browser’s
cache, and refresh the page.
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Reboot the Wireless Controller

The Reboot/Reset Controllers page lets you reset the wireless controller.

» To reboot the wireless controller:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
Select Maintenance > Reboot/Reset > Controllers.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts
Reboot/Reset Controllers o)
Access Points Reset/Reboot @ reboat O reset
Reset type hard soft

CANCEL APPLY

Select the reboot radio button.
Click the Apply button.

The wireless controller reboots. The reboot process is complete after several minutes
when the Status LED on the front panel turns green.

Reset the Wireless Controller

You can perform a hard or soft reset of the wireless controller:

Hard reset. The settings of the wireless controller are restored to factory default settings.
This reset is the same as the reset that occurs when you press the Reset button on the
front panel.

Soft reset. Saves the IP and VLAN addresses and managed access point list but clears
all other settings such as profiles, profile groups, and authentication servers.

Note: Restoring the factory default settings of the wireless controller does
not restore the settings of the access points that the wireless
controller manages.
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> To reset the wireless controller:

1.

7.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

Select Maintenance > Reboot/Reset > Controllers.

The Reboot/Reset Controllers page displays.

Select the reset radio button.
Select one of the following radio buttons to specify a hard reset or soft reset:

- hard. Restores the factory default settings to the wireless controller. The factory
default settings are listed in Appendix B, Factory Default Settings, Technical
Specifications, and Passwords Requirements.

- soft. Clears all settings except for the IP and VLAN addresses and managed access
point list.

A WARNING:

If you select the hard radio button and you click the Apply button,
do not try to go online, turn off the wireless controller, shut down
the computer, or do anything else to the wireless controller until the
wireless controller finishes rebooting. When the Status LED turns
green, wait a few more seconds before you do anything.

Click the Apply button.

The configuration file is restored according to the selection that you made, and the
wireless controller reboots.

Manage Extended Storage

The Extended Storage page displays information about an optional directly attached external
storage device such as a USB memory stick or SD card, and lets you mount and dismount
the storage device. Such a device is referred to as an extended storage device. You can use
an extended storage device to store more floor heat maps and extended statistics history.
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Note: Do not reboot the wireless controller while an extended storage device
is connected. Doing so causes the wireless controller to halt in the
boot process. First, disconnect the extended storage device. Then,
reboot the wireless controller.

» To mount an extended storage device and view information about the device or to
unmount an extended storage device:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Maintenance > Extended Storage.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage

Remaote Management | Logs & Alerts

Extended Storage

Storage Details

Device Mo device ¥
Status No device connected
Vendor

Model

Total Memory (KB) o

Free Memory (KB) a

Used Memory (KB) a

REFRESH

5. Mount or unmount the extended storage device:
« To mount the extended storage device, do the following:

a. Attach the extended storage device to the USB port or SD card slot on the front
panel of the wireless controller.

Note: The SD card slot is available in only the WC7500 and WC7600v2
controllers.

b. Click the Refresh button.
c. Select the device to be mounted.
d. Click the Mount button.
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The storage details become visible on the Extended Storage page.

» To unmount the extended storage device, do the following:
a. Click the Unmount button.
b. Remove the extended storage device from the USB port.

Manage Remote Access

Enable SNMP to allow SNMP network management software, such as HP OpenView, to
monitor the wireless controller by using SNMPv1 or SNMPv2c protocol.

You can configure the wireless controller through SNMP, except for the following features:

» Guest access management
* RF management
e Stacking management

Note: The wireless controller supports SSH through the console port.
However, the console port is for debugging under guidance of
NETGEAR technical support only.

» To enable and configure SNMP:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
3. Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Maintenance > Remote Management > SNMP.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
User Management | Upgrade | Licensing | Backup/Restore | RebootfReset | Extended Storage | Re te Management | Logs & Alerts
5 SNMP @
Session Timeout SNMP
Read-Only Community Name public
Read-Write Community Name private
Trap Community Name trap

IP Address to Receive Traps
Trap Port 162
SNMP Manager IP 255,255,255.255

CAMCEL APPLY

5. Enable SNMP and configure the settings as described in the following table.

Setting Description

SNMP Select the SNMP check box to enable SNMP for the wireless controller.

Read-Only Community Name | Enter the community string that allows the SNMP manager to read the
wireless controller’s MIB objects.

The default setting is public.

Read-Write Community Name | Enter the community string that allows the SNMP manager to read and
write the wireless controller's MIB objects.

The default setting is private.

Trap Community Name Enter the community name that is associated with the IP address to
receive traps.

The default setting is trap.

IP Address to Receive Traps Enter the IP address at which the SNMP manager receives traps sent from
the wireless controller.

Trap Port Enter the port on which the SNMP manager receives traps sent from the
wireless controller.

The default setting is port 162.

SNMP Manager IP Enter the IP address of the SNMP manager.

To allow any SNMP manager to access the wireless controller, keep this
field blank.

6. Click the Apply button.

Your settings are saved.

Specify Session Time-Outs

If an HTTP session times out, the user is redirected to the login page for password
verification.
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> To specify the length of the HTTP session time-out for the wireless controller:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Maintenance > Remote Management > Session Timeout.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

SNMP Session Timeout

Timeout {minutes) 180

CAMNCEL APPLY

5. Inthe Timeout (minutes) field, specify number of minutes before an active HTTP login
session expires.

The default session time-out is 5 minutes.
6. Click the Apply button.

Your settings are saved.

Save the Logs

You can save the system logs that are collected on the wireless controller. You can also save
the logs for an individual access point.

If a problem or failure occurs, the system logs along with backed-up configuration settings
could help determine the cause.

Save the System Logs

You can save the system logs to a zipped log file on your computer.

The information that is stored in the system logs depends on the log settings. For information
about how to configure which information is recorded and stored in the logs, see Configure
the Syslog Settings for an Internal Syslog Location on page 114.
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> To save the system logs:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Maintenance > Logs & Alerts > Logs.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts
System Alerts Save Controller Logs
RF Events Save Controller Logs ¥

Load Balancing

Rate Limit Save AP Logs
Redundancy
Stacking Search

Select | Status * : | +| Model # |

Connected 10.40.0.77 00:11:22:44:55:a0 WACT30  Bruce_Gu_AF 3 days, 8 hrs, 31 mins, 13 secs

Not connected  172.24.1.116 S50:6m:03:80:5a:80 WACT30 jonathan AP730 NA

Connected 10.120.84.58 50:6a:03:80:55:¢c0 WACT20 Weifeng_AP_720 20 hrs, 22 mins, 34 secs

Connactad 172.24.1.220 S50:6a:03:80:55:e0 WAC720 netgearB055ef 3 days, 8 hrs, 31 mins, 22 secs

Mot connected | 10.120.167.27 50:6a:03:80:43:80 WACT20 netgearB0438f A

Connected 10.120.167.9 deiefi05:90:28:20 WACT30 tejaswi_Desk 3 days, 8 hrs, 31 mins, 6 secs
CANCEL SAVE

5. Select the Save Controller Logs check box.
Click the Save button.
7. Follow the directions of your browser.

The default name of the zipped log file is IP address-WC7600-Logs.tgz, in which
IP address is the IP address of the wireless controller.

Save and Clear the Logs for an Access Point

You can save the logs for a managed access point to a zipped log file on your computer.
After you save the logs, they are automatically deleted from the access point.

» To save and clear the logs for a managed access point:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
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The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
Select Maintenance > Logs & Alerts > Logs.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts
System Alerts Save Controller Logs
RF Events Save Controller Logs il

Load Balancing

Rate Limit Save AP Logs
Redundancy
Stacking Search

Select | Status ¢ | 4| Model ¢ | Name
Connected 10.40.0.77 00:11:22:44:55:a0 WACT730 Bruce_Gu_AP 2 days, B hrs, 21 mins, 13 secs

Not connected 172.24.1.116 S50:6a:03:80:5a:80 WACT30 jonathan_AP730 @ NA

Connected 10.120.84.58 50:6a:03:80:55:c0  WACT20 Weifeng_AP_720 20 hrs, 22 mins, 34 secs
Connactad 172.24.1.220 S0:5a:03:80:55:e0 WAC720 netgearB055ef 3 days, 8 hrs, 31 mins, 22 secs
Not connected 10.120.167.27 50:6a:03:80:43:80 WACT20 netgearB0438F NA

Connected 10.120.167.9 deief:09:90:28:20 WACT730  tejaswi_Desk 3 days, & hrs, 31 mins, & secs

CANCEL SAVE

To search the table with access points, in the Search field, enter the information that you are
looking for, such as an IP address or MAC address.

If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

Select the radio button that corresponds to the access point for which you want to save
the logs.

CAUTION:

After you save the logs, they are automatically deleted from the access
point.

Click the Save button.
Follow the directions of your browser.

The default name of the zipped log file is ap_logs_XX_XX_XX_XX_XX_XX.tgz, in which
XX XX XX XX_XX_XX is the MAC address of the access point.
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View Alerts and Events

The wireless controller lets you view the following alerts and events:

System alerts. System alerts such as an access point coming up or being shut down, the
wireless controller coming up or being shut down, and a firmware upgrade.

RF events. Radio frequency events such as a change of channel or a managed access
point going down.

Load balancing events. Load-balancing events such as a bad RSSI for a client, or the
violation of a load-balancing threshold.

Rate limiting events. Rate-limit events such as the violation of a rate-limit threshold.

Redundancy. Redundancy events such as the redundant wireless controller coming up
or going down, or a failover to another wireless controller.

Stacking events. Stacking events such as a slave wireless controller coming up or going
down, or two wireless controllers synchronizing.

Alerts and events indicate the alarm severity level (minor, normal, major, or critical), provide a
description, and show the date and time that the alerts or events was recorded.

View System Alerts

The wireless controller generates alerts for system events such as an access point coming
up or being shut down, the wireless controller coming up or being shut down, and a firmware
upgrade.

> To view system alerts:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP

address.
By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

4. Select Maintenance > Logs & Alerts > System Alerts.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs &
t System Alerts

RF Events

voad Balancing Search e 99/99

Rate Limit Severity # | Description #| Raised Time

Redundancy Major Access Point [NAME: natgear7B2488, 1P 192.168,0,154, MAC: cO:3fi0a:Thi24:80, MODEL: WHAP210] UP Fri Feb 15 12:31:36 2013

Stacking Major Aczezs Point [NAME: netgear7B2488, 1P: 192,165,0,154, MAC: ¢0:3i00:7b:24:80, MODEL: WHAP210] DOWH Fri Fab 15 12:30:47 2013

Loas Major Access Paint [HAME: netgear?B2488, 18: 192.168.0.151, MACT c0:3f10e:Thi24:80, MODEL: WHARZ10] UP Fri Fab 18 12:25:07 2013

. ) Majer Access Point [HAME: netgear7B2608. 1P: 192,168.0.150, MAC: ¢0:3f100: 7b:26:d0. MODEL: WHAP210] UP Fri Fab 15 12:25:0% 2013
Major Access Point [HAME: natgearAl064D, IP: 192,168,0,14%, MAC: of:3dicTrali06:60, MODEL: WHDAPISO0] UP Fri Fab 1% 12:24:%51 2013
MNormal System UP Fri Fab 1% 12:24:29 2013
Major Access Paint [NAME: netgearTB2EDE, 1Pt 192, 168.0,14%5, MAC: ¢0:3f:00:Tbi26:40, MODEL: WHAPZ10] UP Thu Fab 14 21:36:04 2013
Major Accass Point [NAME: netgear7B24828, 1P 152, 168.0, 146, MAC: c013fi00:7bi 24180, MODEL: WHAP210] UP Thu Fab 14 21:36:03 2013
Major Access Paint [NAME: netgearAl066d, IP: 192.168.0,144, MAC: o4:3d:c71a1:06:60, MODEL: WHDAPI60] UP Thu Fab 14 24:3%:4% 2013
Hormal Systam UP Thu Fab 14 21:135:26 2013
Major Accaze Point [NAME: natgear?B2608, 1P 192, 168.0,14%5, MAC: ¢0:3Fi00:7b:26:d0. MODEL: 'WHAPZ10] UP Thu Fab 14 18:25:25 2013
Major Access Point [NAME! netgear7B2488, IP1 192.168.0,146, MAC! 0131081 7b124180, MODEL: WHAPZ10] UP Thu Feb 14 18125125 2013
Major Agcass Point [NAME: notoesrAl0EES, IP: 192.065.0,144, MAC: ¢4:3d:¢7:51:06:60, MODEL: WHDAP360] UP Thu Fab 14 18:25:24 2013
Hormal Access Point [HAME: natgear7B2608, MAC: c013f10e:7bi26:d0, 1P 192,168.0.145, MODEL: WHAP210] Site:0 added to Managed List Thu Feb 14 18:24:52 2013
Mermal Agcess Point [NAME: natgear7B2488, MAC: ¢0:3f:00:7b:24:80, IP: 192.168.0.146, MODEL: WNAPZ10] Site:0 added to Managed List Thu Fab 14 18:24:33 2013
Hormal Accass Point [NAME: netgearAl 0668, MAC: o4:13dicT 1ali0&160, IP: 192,168.0.144, MODEL: WHDAP360] Site10 added to Managed List  Thu Feb 14 1812433 2013
1-16 of 99 | Entry Per Page | Default v PREVIOUS | 1% af 7 | NEXT
REFRESH ~ CLEAR AlL EXPORT

If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To display the latest alerts onscreen, click the REFRESH button.

To save the alerts to your computer, click the EXPORT button and follow the directions of
your browser.

To clear all alerts from the page and from memory, click the CLEAR ALL button.
We recommend that you save the alerts before you clear them.

View Radio Frequency Events

The wireless controller generates alerts for radio frequency (RF) events such as a change of
channel or a managed access point going down.

> To view RF events:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.
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The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Maintenance > Logs & Alerts > RF Events.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade : Licensing : Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

. System Alerts RF Events
Search
- Load Balancing
Automatic Tx Pover

» Redundancy Cormputation adjusted

Stacking Power for following AP's,

L netgear7B2608

298 Morrnal [c013f:0e: 7h: 26:d0]) Mon Feb 04 12:10:07 2013

B&-rmode Radio Power
EIGHTH. netgearfB2438
[c0:3f:0e:Tb:24:80]
B&-mode Radio Power
EIGHTH.

REFRESH = CLEAR ALL EXPORT

o

If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
« To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To display the latest events onscreen, click the REFRESH button.

To save the events to your computer, click the EXPORT button and follow the directions of
your browser.

To clear all events from the page and from memory, click the CLEAR ALL button.

N o

©

We recommend that you save the events before you clear them.

View Load-Balancing Events

The wireless controller generates alerts for load-balancing events such as a bad RSSI for a
client, or the violation of a load-balancing threshold.

> To view load-balancing events:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.
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The wireless controller’s web management interface opens and displays the Summary

page.

4. Select Maintenance > Logs & Alerts > Load Balancing.

Access Point

User Management Upgrade

Configuration Monitor

Licensing i Backup/Restore

Maintenance Stacking Diagnostics

Reboot/Reset | Extended Storage :

Remote Management

Logs & Alerts

System Alerts

RF Events
Search

-~ Rate Limit

Redundancy Normal

Stacking Mermal

Logs Nermal
Normal
Normal
Nermal
Normal
Normal
Nermal
Normal
Normal
Nerrmal

Load Balancing

Load Balancing[Bad RSS5I] Event for Client 04:12:64:81:ed:d1
Lead Balancing[Bad RSSI] Event for Client 00:16:ea:ba:cf:be
Load Balancing[Bad RSS5I] Event for Client 90:271e4:47:b2:22
Load Balancing[Bad RSSI] Event for Client 90:27:e4:47:b2:22
Load Balancing[Bad RS51] Event for Client 50:27:24:47:b2:22
Load Balancing[Bad RS51] Event for Client 90:27 1e4:47:b2:22
Load Balancing[Bad RSSI] Event for Client 90:27:e4:47:b2:22
Load Balancing[Bad RS51] Event for Client 50:27:24:47:b2:22
Load Balancing{Bad RS51] Event for Client 90:27 1e4:47:b2:22
Load Balancing[Bad RSSI] Event for Client 00:21:5¢c:03:39:0b
Load Balancing[Bad RSSI] Event for Client 00:21:5¢:03:39:0b
Load Balancing[Bad RS5I] Event for Client 00:21:5¢:03:39:0b

Raised Time

Fri Feb 15 12:31:36 2013
Fri Feb 15 12:30:47 2013
Fri Fab 15 12:25:07 2013
Fri Feb 15 12:25:05 2013
Fri Feb 15 12:24:51 2013
Fri Fab 15 12124129 2013
Thu Feb 14 21:36:04 2013
Thu Feb 14 21:36:03 2013
Thu Feb 14 21:35:14% 2013
Thu Feb 14 21:35:26 2013
Thu Feb 14 18:25:25 2013
Thu Feb 14 18:25:25 2013

REFRESH CLEAR ALL

EXPORT

5. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To display the latest events onscreen, click the REFRESH button.
7. To save the events to your computer, click the EXPORT button and follow the directions of

your browser.

8. To clear all events from the page and from memory, click the CLEAR ALL button.

We recommend that you save the events before you clear them.
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View Rate-Limit Events

The wireless controller generates alerts for rate-limit events such as the violation of a
rate-limit threshold.
> To view rate-limit events:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Maintenance > Logs & Alerts > Rate Limit.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

System Alerts Rate Limit &

RF Events
Search

Severity ¢| Description # | Raised Time B

Load Balancing

Redundancy
Stacking
Logs

REFRESH CLEAR ALL EXPORT

5. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

* To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To display the latest events onscreen, click the REFRESH button.

7. To save the events to your computer, click the EXPORT button and follow the directions of
your browser.

8. To clear all events from the page and from memory, click the CLEAR ALL button.

We recommend that you save the events before you clear them.
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View Redundancy Events

The wireless controller generates alerts for redundancy events such as the redundant
wireless controller coming up or going down, or a failover to another wireless controller.
To view redundancy events:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Maintenance > Logs & Alerts > Redundancy.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

System Alerts Redundancy
RF Events Search
Load Balancing 7
Severity + | Description +| Raised Time
Rate Limit Ly = |
Major Sending Config Bulk Sync Response Thu Dec 18 13:40:23 2014
Major Config Bulk Sync Requasted Thu Dec 18 13:40:20 2014
Stacking
Major Switching to Active State Thu Dec 18 13:40:11 2014

Logs

REFRESH = CLEAR ALL EXPORT

=

5. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

6. To display the latest events onscreen, click the REFRESH button.

7. To save the events to your computer, click the EXPORT button and follow the directions of
your browser.

8. To clear all events from the page and from memory, click the CLEAR ALL button.

We recommend that you save the events before you clear them.
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View Stacking Events

The wireless controller generates alerts for stacking events such as a slave wireless
controller coming up or going down, or two wireless controllers synchronizing.
To view stacking events:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Maintenance > Logs & Alerts > Stacking.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

System Alerts Stacking @

RF Events
) Search
Load Balancing

Rate Limit | Severity ¢ | Description ¢ | Raised Time ____ <]

Redundancy Major Peer 192.168.0.7 is DOWN | Sat Oct 19 01:00:58 2013
Major Peer 152,168.0.7 is UP Fri Oct 18 23110140 2013

Logs Major Peer 192.168.0.7 is DOWN Fri Oct 18 23:08:33 2013
e Peer 192.168.0.7 is UP Fri Oct 18 06124118 2013

Major Peer 192.168.0.7 is DOWN Fri Oct 18 06:22:21 2013

Major Peer 152,168.0.7 is UP Fri Oct 18 06121:26 2013

REFRESH CLEAR ALL EXPORT

5. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

» To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

6. To display the latest events onscreen, click the REFRESH button.

7. To save the events to your computer, click the EXPORT button and follow the directions of
your browsetr.

8. To clear all events from the page and from memory, click the CLEAR ALL button.
We recommend that you save the events before you clear them.
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Manage Licenses

The License page allows you to import, register, and view the licenses that you require for
your network. For more information about licenses, see Licenses on page 17.

The License page provides four tabs:

Inventory. Provides an overview of your licenses. For information, see View Your
Licenses on page 274.

Server Settings. Allows you to configure the server settings to import your licenses. For
information, see Configure the License Server Settings on page 110.

Registration. Allows you to register your licenses. For information, see Register Your
Licenses With the License Server on page 111.

Advanced. Lets you retrieve your licenses. This page displays relevant information only if
you receive a replacement unit from NETGEAR and install the unit. Under normal
circumstances, you do not need this page. For information, see Retrieve Your Licenses
on page 276.

View Your Licenses

When your licenses are installed and registered, you can view them on the Inventory page.

» To view your licenses:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Maintenance > Licensing.

Click the Inventory tab.
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Access Point Configuration Maonitor Maintenance Stacking Plans Diagnostics
User Management | Upgrade | Licensing | Backup/Restor Reboot/Reset | Extended Storage ! Remote Management | Logs & Alerts
License Settings @
Inventory Server Settings Registration Advanced
Summary
Total AP License 200
Nmode License Status Preinstalled
Used License Count 138
Available License Count B2
Key Details
[y <[y Types | Key Statuse]
NG2F06-50D6-C765-D487-30AC-AA43-2067-B63A-850D8 S0-AP Registered
NGZF0&-3850-F39F-9D9C-2766-BRET7-CBDE-5806-BDF9 S0-AP Registered
MEZFO4-950C-FO10-A130-8710-1552-2520-8707-0333 10-AP Registerad
NG2F04-1D30-7951-99DE-D18C-FOEA-B269-636B-582C 10-AP Registerad
MEZFO4-4BC5-5B12-3DEE-AATE-4BBF-EGZF-CE12-DESS 10-AP Registerad
NG2F04-3639-1888-D2D3-6F7A-90F6-0AES-BF21-5FES 10-AP Registered
MGZFO4-423CI-ERER-24A5-F750-0CIE-3DFI-269A-453F 10-AP Registerad
NGZFO6-ATZ9-CABB-1AE4-C195-90BF-CASA-T346-0EDE S0-AP Registerad
REFRESH
The following table describes the fields of the page.
Setting Description
Summary section
Total AP License The number of access points that your licenses support.
Nmode License Status Availability of the 802.11n mode license. (This license is available by default,
indicated by either Preinstalled or Available.)
Used License Count The number of access points that are used from the total number that your

licenses support.

Available License Count The number of access points that are still available from the total number that
your licenses support.

Key Details section

Key The value of the key that unlocks the license.

Key Type The type of the key that determines the number of access points that are
supported and the mode that is supported.

Key Status The status of the key (Registering key with server or Registered).

6. To refresh your license information onscreen, click the REFRESH button.
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Retrieve Your Licenses

If NETGEAR exchanged your wireless controller for another one, your licenses no longer
display on the Inventory and Registration pages. You must retrieve your licenses from the
license update server.

To retrieve licenses after you receive a replacement unit from NETGEAR:

1.
2.

Make sure that the wireless controller is connected to the Internet.
Make sure that the DNS servers are configured correctly.

For information about configuring DNS servers, see Manage the IP, VLAN, and Link
Aggregation Settings on page 102.

Open a web browser, and in the browser’s address field, type the wireless controller's IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Maintenance > Licensing.

Click the Advanced tab.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

License Settings 3

Inventory Server Settings Registration Advanced

key + | key Type %+ | Key Status

REPLACE

8. Click the Replace button.

The wireless controller connects to the license update server and retrieves your licenses.
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Reboot Access Points

Under normal circumstances, you do not need to reboot an access point. If a problem occurs
with an access point, you can reboot it to see if this resolves the problem.

To reboot an access point:
1.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
Select Maintenance > Reboot/Reset > Access Points.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade | Licensing | Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

. Controllers Reboot Access Points @
Search
P # | MAC # | Name # | Building # | Floor+ | Location
192,168.0,158  c0:3f10e:7b:26:d0  netgesr7B26D8  Building-1  Floor-1 Cornected [ ]
192,168.0.154  c0:3f:10e:7b:24:80 netgear7B2488 Building-1 Floor-1 Connected D
192,168.0,152 c4:3d:c7:21:06:60 netgeardl0868 | Building-1 Floor-1 Conneced D

CANCEL REBOOT

To find the access point that you want to reboot, in the Search field, enter the IP address,
MAC address, model, or name of the access point, or enter other information to narrow
down the information that is displayed in the table.

The table displays only the access point or access points that match the information that
you entered in the Search field.
Take one of the following actions:

e Select a single access point by selecting the check box to the right of the access
point.

* Make a selection of access points by selecting the check boxes to the right of the
access points.

e Select all access points by selecting the check box in the upper right of the table
heading.

Click the Reboot button.

The selected access point or access points are rebooted.
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Configure Multicast Firmware Upgrade for Access Points

When you add access points to the managed list (see Chapter 8, Discover and Manage
Access Points), the wireless controller upgrades the firmware of the access points to the
latest firmware that is loaded on the wireless controller. By default, this firmware upgrade
process uses multicast, which allows all access points to be upgraded simultaneously. If you
prefer, you can disable multicast and let the wireless controller use unicast for the firmware
upgrade process (see Disable Multicast Firmware Upgrade on page 279). Also, if the
multicast firmware upgrade process fails three times, the wireless controller automatically
switches to the unicast firmware upgrade process.

With the default multicast firmware upgrade process, the wireless controller distributes
multicast IP addresses to the access points, enabling them to join the multicast group and to
receive the firmware upgrade.

Change the Multicast Firmware Upgrade Settings

By default, the wireless controller uses IP range 239.255.0.0-239.255.0.255 for the multicast
firmware upgrade process. If your network requires that the wireless controller uses a
different multicast IP range, you can configure the IP range on the AP Upgrade Settings
page.

> To configure another multicast IP address range and port for the firmware upgrade
process:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

4. Select Maintenance > Upgrade > AP Upgrade Settings.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management | Upgrade | Licensing ! Backup/Restore | Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

. Firmware AP Upgrade Settings @
Upgrade
" Enable MultiCast
Start IP 239 [[255 || 0O 40
End IP 239 |[255 |0 | 255
Port Number 69

CANCEL APPLY

5. Configure the settings as described in the following table.
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Setting Description

Start IP Enter the start IP address of the multicast range that the wireless controller must use.
End IP Enter the end IP address of the multicast range that the wireless controller must use.

Port Number Enter the port number that the wireless controller must use. The default number is 69.

6. Click the Apply button.
Your settings are saved.

Disable Multicast Firmware Upgrade

There might be network configurations in which you cannot use multicast. If you disable
multicast on the AP Upgrade Setting page, the firmware upgrade process uses unicast,
which is a slower process because the firmware upgrade is applied to groups of access
points instead of simultaneously to all access points. The time that the unicast firmware

upgrade process takes depends on the network load and on the type of Ethernet interface to

which the wireless controller is connected.

To disable multicast firmware upgrade for access points:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP

address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Maintenance > Upgrade > AP Upgrade Settings.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

User Management : Upgrade | Licensing | Backup/Restore ! Reboot/Reset | Extended Storage | Remote Management | Logs & Alerts

Eirmsiare AP Upgrade Settings

Upgrade
Enable MultiCast
Start IP 239 || 255 |0 L0
End IP 239 |[255 |0 | 295
Port Number 69

CAMCEL APPLY

5. Clear the Enable Multicast check box.
This check box is selected by default.
6. Click the Apply button.
Your settings are saved.
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Manage Stacking and Redundancy 1 2

This chapter includes the following sections:

e Stacking Concepts

e Configure a Stack of Wireless Controllers

* Remove a Wireless Controller From a Stack

» Select Which Wireless Controller in a Stack to Configure
* Manage Redundancy for a Single Controller

* Manage a Redundancy Group With N:1 Redundancy

* Replace a Redundant Controller

* Remove a Redundancy Group

Note: Model WC7500 does not support stacking and redundancy.

Note: Master and slave refers to the relationship between controllers in a
stack. Primary and redundant (or primary and secondary) refers to
the relationship between controllers in a redundant configuration.
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Stacking Concepts

The wireless controller supports stacking of up to three units for management of up to
150 access points (models WC7600 and WC7600v2) or 600 access points (model WC9500)
through purchased licensing (see Licenses on page 17).

In a stack, one wireless controller functions as the master controller, and the other two
wireless controllers function as slave controllers.

The following figure shows a stacked configuration with WC9500 wireless controllers in which
you can manage up to 600 access points:

Slave controller Slave controller
200 AP license 200 AP license

— -~ Master controller

ﬁﬁﬁ 200 AP license

Figure 17. WC9500 stacking configuration

The wireless controllers that you intend to make members of the stack must be connected
over a wired connection. A switch or router can be located between the wireless controllers
that are part of a stack.

The following procedure described the high-level configuration steps to set up a stack.

» To set up a stack:

1. Configure the master controller, including the system settings, profiles, security settings,
and WiFi settings.

2. On each slave controller, configure the system settings only.
On the master controller, enable stacking and add all slave controllers to the stack.
4. On the master controller, synchronize the configurations to the slave controllers.
The profiles, security settings, WiFi settings, administrative user name and password,

and firmware image of the master controller are synchronized to the slave controllers.
The managed AP list of the master controller is not synchronized.

5. On each slave controller, run the Discovery Wizard to discover the access points that the
slave controller must manage and add them to the managed AP list for the slave controller.
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After you configure the stack, you can change profiles, security settings, and WiFi settings on
the master controller, synchronize these changes with the slave controllers, and let the slave
controllers push the changes to the individual access points that they manage. For ease of
management, you can configure location-based profiles on the master controller and assign
a location to each slave controller.

Stacking allows WiFi clients to roam from an access point that is managed by one of the
controllers in the stacking group to any access point managed by the other controllers in the
same stacking group.

The master and slave controllers in a stack support the following capacities:

e Master controller. You can perform the following tasks:
- Manage the slave controllers
- Perform RF planning for the slave controllers

- Configure the entire network, including access point discovery and license
reinforcement

- Monitor the entire network
» Slave controller. You can perform the following tasks:
- Configure the subnetwork
- Monitor the subnetwork
- Upgrade the firmware image on the slave controller only
- Perform access point discovery for the subnetwork
- Reinforce licenses for the subnetwork

Note: A single WC9500 wireless controller that does not function in a stack
can manage up to 300 access point; a single WC9500 wireless
controller in a stack can manage up to 200 access points.

If a WC9500 wireless controller does not function in a stack and
manages more than 200 access points and you add the WC9500
wireless controller to a stack, all access points are removed from its
managed list. The access points are removed because of the
reduction in maximum capacity from 300 to 200 access points.

You must let the WC9500 wireless controllers in the stack rediscover
the access points and add them to the managed lists of several
WC9500 wireless controllers in the stack.
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Configure a Stack of Wireless Controllers

A stack can consist of up to three wireless controllers, one of which is the master controller
and two of which are slave controllers.

The following procedure assumes that you already configured the system settings, profiles,
security settings, and WiFi settings on the master controller, and that you already configured
the system settings on the slave controller.

> To create a stack by adding a slave controller to a wireless controller that functions as
the master controller:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Stacking.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Configuration

Stacking 3

-m Controller IP # | Local IP %+ | MasterIP =

L Master 172.16.152.30 172.16.192.30 172.16.192.30

ADD DELETE

APPLY SYNC CAMCEL

The Stacking table shows the master wireless controller with its IP addresses.
5. Click the Add button.
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Access Point Configuration Monitor Maintenance Plans Diagnostics

Stacking i)

Role # | Controller IP¢| Local IP %+ | MasterIP =

(=] Master 172.1

ADD DELETE ADD Settings
Controller IP
Redundancy UserName admin
Password

Enable Redundancy

CAMCEL ADD

APPLY SYNC CANCEL

6. Configure the settings for the slave controller as described in the following table.

Setting Description

Controller IP Enter the IP address of the slave controller. This is the address that you use to log in
to the slave controller's web management interface.

UserName The user name is a nonconfigurable field that displays the user name with which you
log in to the web management interface of the slave controller. By default, the user
name is admin.

Password Enter the password with which you log in to the web management interface of the
slave controller. If you did not yet personalize the password, enter password for the
password.

7. Click the Add button.

The wireless controller is added to the Stacking table but the local IP address for the
slave controller is not yet shown.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Configuration

Stacking @
-m Controller IP# | Local IP #| MasterIP +
Master 172.16.192.30 172.16.192.30 172.16.192.20
@ Slave 172.16.192.31 172.16.192.30
ADD DELETE
Redundancy

Enable Redundancy

APPLY SYNC CAMNCEL

Click the Apply button.

Your settings are saved. After the configuration of the master controller synchronizes with
the slave controller, the stack is established.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Configuration

Stacking @

| | Role | Controller 1P | Local 1P < | Master1p <

@ Master 172.16.192.30 172.16.192.30 172.16.152.30
Slave 172.16.192.31 172.16.192.31  172.16.192.30

ADD DELETE

Redundancy

Enable Redundancy

APPLY SYMNC CANCEL
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The Stacking table shows the following fields:

Setting Description

Role The role or function that the wireless controller provides in the stack: either Master or
Slave.

Controller IP The IP address of the wireless controller. In a stacking configuration, the controller IP

address is identical to the local IP address.

Local IP The local IP address of the wireless controller in the stacking group. This IP address
remains constant. The role of the wireless controller (that is, master or slave) does not
affect the local IP address.

Master IP The IP address of the master in the stack.

9. To add another wireless controller, repeat Step 5 through Step 8.

10. To synchronize the profiles, captive portals, and user management settings of the master
controller to a slave controller in the stack, do the following:

a. Inthe Stacking table, select the radio button for the slave controller that you want to
synchronize.

b. Click the Sync button.
Confirm that you want to allow the slave controller to reboot.

After synchronization, the slave controller reboots.
11. Select Monitor > Network > Summary.

The Summary page displays for the network.

Note: The web management interface displays an additional Network menu
tab with the network Summary page in view. The network Summary
page displays information about the stacking configuration.

12. Click the REFRESH button.

The Summary page displays the new stacking information.

Note: On a slave controller in the stack, if you add the master controller as a
stack member, the slave controller becomes the new master controller,
and the original master controller becomes the new slave controller. For
information about selecting which controller to configure, see Select
Which Wireless Controller in a Stack to Configure on page 288.
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Remove a Wireless Controller From a Stack

You can remove a wireless controller from a stack.

» Toremove a wireless controller from a stack:

1.

5.

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
Select Stacking.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Configuration

Stacking @

| Role ¢ | Controller 1P+ | Local 1P ¢| Master1p ¢

@ Master 172.16.192.30 172.16.192.30 172.16.192.30

) slave 172.16.192.31 172.16.192.31  172.16.192.30

ADD DELETE

Redundancy

Enable Redundancy

APPLY SYNC CANCEL

In the Stacking table, select the radio button for the slave controller that you want to remove.
Note: You cannot remove the master controller.

Click the Delete button.
The slave controller is removed from the stack.
Click the Apply button.

Your settings are saved. The master controller and former slave controllers reboot.
Depending on the number of controllers in the stack, the stack is either decreased in size
and now consists of two instead of thee controllers, or removed entirely.
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Select Which Wireless Controller in a Stack to Configure

After you add one or more wireless controllers to the stack, most pages of the web management
interface display a controller selection menu at the top. This menu lets you select the wireless
controller that you want to configure.

172.16.192.31 | 172.16.192.32 | - |

Figure 18. Controller selection menu with three wireless controllers in stack

In the previous figure, Self indicates the wireless controller that you are configuring through the
web management interface. Self is shown in orange font. The two IP addresses (172.16.192.31
and 172.16.192.32) indicate the other wireless controllers in the stack. These IP addresses are
shown in white font. A selected controller is shown in orange font. Other controllers in the stack
that are not selected are shown in white font.

The following procedure is an example of how to select a wireless controller in a stack to
configure the basic radio on/off settings. After you select a wireless controller to configure,
this selection carries through to other pages of the web management interface until you select
to configure another wireless controller in the stack.

> To select a wireless controller for configuration in a stack with two controllers:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Configuration > Wireless > Basic > Radio On/Off.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | W S5 Security | Profile | WLAN Network | Captive Portal
D
= Wireless Schedule
» Channel Allocation -
Current Time Fri Jan 30 12:42:23 PST 2015
» RF Management
» Preferred Band Schedule Radio On/Off On 9 off
Advanced Schedule at hr:|o |E| min : OE
m t wot f 5 s
Schedule On A A  F F F
Duration hrs : UE mins : U'Z‘
CANCEL APPLY
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The controller selection menu shows Self in orange font as the wireless controller that
you are accessing through the web management interface.

In the controller selection menu, next to Self, click the + button.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless Security | Profile | WLAN Network | Captive Portal

172.16.192.31 | - |

* Wireless Schedule
» Channel Allocation

Current Time Fri Jan 30 12:42:23 PST 2015
= RF Management
» Preferred Band Schedule Radio On/Off On @ off
Advanced Schedule at hr:lo |Z| min : OEI

m t w ot F s s
Schedule On . Ll -

Duration hrs : 0'3 mins : 0=3

CANCEL APPLY

The IP address of the other wireless controller in the stack displays in white font in the
controller selection menu.

In the controller selection menu, click 172.16.192.31, which is the IP address of the other
wireless controller in the stack.

The web management interface accesses the other wireless controller in the stack.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless Security | Profile | WLAN Network | Captive Portal

172.16.192.31

* Wireless Schedule @
» Channel Allocation

Current Time Fri Jan 30 12:44:37 PST 2015
» RF Management
» Preferred Band Schedule Radio On/Off on @ Off
- Advanced Schedule at hr : DE] min : | 0 g
m t w t f s s
Schedule On T 1 1
Duration hrs: | 0 IE‘ mins : 0[2‘

CANCEL APPLY

The controller selection menu shows the IP address of the other wireless controller in the
stack in orange font on the left. Self is no longer shown.

Note: If you select another page in the web management interface, the
controller selection menu continues to shows the IP address of the
other wireless controller as the one being configured.
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7. To change back to the original wireless controller, in the controller selection menu next to the
IP address (172.16.192.31), click the + button.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

System | Wireless Security | Profile | WLAN Network | Captive Portal

= Wireless Schedule
» Channel Allocation :
Current Time Fri Jan 30 12:45:15 PST 2015
» RF Management
» Preferred Band Schedule Radio On/Off - On @ Off
- Advanced Schedule at hr: 0 |Z| min : OB

m t w t f s =
Schedule On q )

Duration hrs : Djzl mins : DEl

CAMCEL APPLY

In the controller selection menu, Self displays in white font to the left of the IP address of
the other wireless controller in the stack.

8. In the controller selection menu, click Self.

The web management interface accesses the original wireless controller in the stack.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
System | Wireless Security | Profile | WLAN Network | Captive Portal
(Emm >
» Wireless Schedule
» Channel Allocation
Current Time Fri Jan 30 12:42:23 PST 2015

» RF Management

» Preferred Band Schedule Radio On/Off Cn @ off

Advanced Schedule at hr:|0 |E| min : OE

m t wot f 5 s
Schedule On T T

Duration hrs : 03 mins : 03

The controller selection menu once again shows Self in orange font. The IP address of
the other wireless controller in the stack is no longer shown.
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Manage Redundancy for a Single Controller

The wireless controller supports 1:1 redundancy with failover. Redundancy is implemented
through the use of the Virtual Router Redundancy Protocol (VRRP).

For information about N:1 redundancy, see Manage a Redundancy Group With N:1
Redundancy on page 297.

VRRP Redundancy Concepts

You can configure two controllers to form a redundancy group. You then designate one
controller in the redundancy group as the primary controller (the master) and the other
wireless controller as the redundant controller (the secondary controller). If the primary
controller fails or is disconnected from the network, an automatic failover to the redundant
controller occurs. The redundant controller then takes over all functions of the primary
controller.

Note: When a redundancy failover occurs, WiFi clients might experience a
service interruption of a few seconds.

Requirements and Restrictions for 1:1 Redundancy

These are the requirements and restrictions for a single controller with redundancy to
function correctly:

e The primary controller and redundant controller must be in the same management VLAN
and IP subnet.

« The VRRP ID for the relationship between the primary controller and redundant controller
must be unique and also different from any other VRRP IDs that might be used for other
purposes in the network.

e The primary controller and redundant controller must run the same firmware version. If
the firmware versions do not match, redundancy does not work.

* The licenses on the redundant controller must match those on the primary controller. If
the licenses do not match, redundancy does not work.

* The primary controller and redundant controller must be assigned the same controller IP
address at which they provide the service, but each controller is assigned its own unique
local IP address.
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Example of a 1:1 Redundancy Configuration
The following figure shows a configuration with a primary controller and a redundant
controller before a failover occurs.

1:1 Redundancy
Before failover

Primary controller

Controller IP 172.16.192.30
Local IP  172.16.192.34 %, AP Cloud

Master IP 172.16.182.30

Redundant controller
Local IP  172.16.192.33

Figure 19. Primary and redundant controllers before a failover

The following figure shows the settings on the Stacking/Redundancy page before a failover
occurs.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Configuration

Stacking

| | Role 2| Controller 1P :| Local IP +| Master IP #
@ Master 172.16.192.30 172.16.192.34 172.16.152.30
ADD DELETE

Redundancy

Enable Redundancy 7]
Secondary IP 172.16.192.33

Controller Role # | Controller IP # | VRRP ID[1-255] # | Local IP &

Master 172.16.152.30 123 172.16.192.34

APPLY REPLACE SYNC CAMNCEL

Figure 20. Stacking/Redundancy page before a failover
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The following figure shows a configuration with a primary controller and a redundant
controller after a failover occurred in which the primary controller went down and the
redundant controller became the active controller.

1:1 Redundancy
After failover

Down
Local IP 172.16.192.34

|

VRRP ID 123

Active controller
Controller IP 172.16.192.30 AP Cloud
Local IP 172.16.192.33
Master IP  172.16.192.30

Figure 21. Primary and redundant controllers after a failover

Configure a Single Controller With Redundancy

To enable 1:1 redundancy, configure the secondary IP address (that is, the IP address for the
redundant controller), the VRPP ID for the connection between the primary and the
redundant controller, and the local IP address for the primary controller. Both controllers
require matching licenses. If licenses do not match, redundancy cannot be established. For
additional requirements, see Requirements and Restrictions for 1:1 Redundancy on

page 291.

» To configure a single controller with redundancy:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Stacking.
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The Stacking/Redundancy page displays.
5. Select the Enable Redundancy check box.

The Redundancy page expands to display the Redundancy table and the Secondary
Controller Information pop-up window opens.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Configuration

Stacking @
Controller IP = | Local IP + | Master IP
o Master 172.16.192.30
e = Secondary Controller Information
Controller IP
UserName admin
Redundancy
Password
Enable Redundancy
Secondary IP CAMCEL APPLY
Controller Role + | Controller IH
Master 172.16.192.30

APPLY SYNC CANCEL

6. Configure the settings for the redundant controller (that is, the secondary controller) as
described in the following table.

Setting Description

Controller IP Enter the IP address of the redundant controller. This is the address that you use to
log in to the redundant controller’'s web management interface.

UserName The user name is a nonconfigurable field that displays the user name with which you
log in to the web management interface of the redundant controller. By default, the
user name is admin.

Password Enter the password with which you log in to the web management interface of the

redundant controller. If you did not yet personalize the password, enter password for
the password.

7. Click the Apply button.

Your settings are saved. The Secondary IP field displays the IP address of the redundant
controller (that is, the secondary controller).
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Stacking @
Role #| Controller 1P 4| Local 1P ¢ | Master 1P ®
o Master 172.16.192.30 172.16.192.30 172.16.192.30
ADD DELETE
Redundancy

Enable Redundancy ]

Secondary IP 172.16.192.33
Controller Role # | Controller IP ¢ | VRRP ID[1-255] + | Local IP &
Master 172.16.192.30

APPLY SYNC CANCEL

8. Configure the VRRP ID and local IP address of the primary controller (that is, the master) as
described in the following table.

These settings are required so that the primary controller and redundant controller can
establish a redundancy group.

The following table also includes descriptions of the nonconfigurable fields.

Setting Description

Controller Role This is a nonconfigurable field that shows that the role of the primary controller.
In a 1:1 redundancy configuration, by default, the role is master.

Controller IP This is a nonconfigurable field that shows the IP address of the primary
controller. This IP address is the address that you use to log in to the primary
controller’'s web management interface.

Note: The controller IP address of the primary controller (the master) is also the
master IP address.

VRRP ID [1-255] For the primary controller, enter a number from 1 through 255 as the VRRP ID.
This number must be unique and not assigned to any other device in the
network.

Local IP For the primary controller, enter a local IP address. If a failover occurs, this IP

address remains assigned to the primary controller and does not transfer to the
redundant controller to let you identify the primary controller before and after
the failover. You must enter an IP address that is not assigned to any other
device.
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WARNING:

Enabling redundancy causes the redundancy process on the
primary wireless controller to restart, which might temporarily
affects traffic on the managed access points in the network.

9. Click the Apply button.

Your settings are saved. After the configuration of the primary controller synchronizes
with the redundant controller, redundancy goes into effect.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Configuration

Stacking

| | Role 2| controller 1P : | Local IP 2| Master 1P )
o Master 172.16.192.30 172.16.192.34 172.16.192.20

ADD DELETE
Redundancy

Enable Redundancy v

Secondary IP 172.16.192.33
Controller Role # | Controller IP # | VRRP ID[1-255] % | Local IP S
Master 172.16.152.30 123 172.16.192.34

APPLY REPLACE SYMNC CAMNCEL

10. Select Monitor > Controller > Summary.
The Summary page displays for the controller.

11. Click the REFRESH button.
The Summary page displays the new redundancy information.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Controller | WLAN | Clients

Network Status 2 Controller Info Redundancy Status

Controller Mode
Redundancy State Active
Secondary Status
Sync Status In Sync
Primary IP Address 172.16.192.34

Usage Total | Alarms Firmware Version 5.0.0.26

Access Point Device "up | Down | Critical | Major Serial Number JEM134SWFO007

Clients Accass Points O o o [} Controller Uptime 2 hours, 33 mins, 8 secs
- Neighboring et o A A A Last Reboot Thu Jan 29 14:37:22 201F

Clients Last Configuration Change Thu Jan 29 17:09:26 201
Neighbor AP

Primary

Reachable

Wireless Clients 3 Last Channel Allocation  NA Secondary IP Address  172.16.192.33
Frofiles oo ' Last Admin Login HA Virtual 1P 172.16.192.30
ier lesee Open WEP | wea WPAZ
Captive Portal ki L = i
Users
s Most Active APs ) Maost Active Clients 7 Most Active SSIDs i

Name C Clients MAC SSID Usage(KBytes) SSID Clients

REFRESH

Manage a Redundancy Group With N:1 Redundancy

The wireless controller supports N:1 redundancy with failover. Redundancy is implemented
through the use of the Virtual Router Redundancy Protocol (VRRP).

For information about 1:1 redundancy, see Manage Redundancy for a Single Controller on
page 291.

VRRP N:1 Redundancy Concepts

With N:1 redundancy, you can add one redundant controller for up to three controllers, that is,
a redundancy group can consist of four controllers, one of which is a redundant controller.

The controllers that are served by the redundant controller must function in a stack in which
one controller is the master and the other controllers are the slaves. However, in relation to
the redundant controller (also referred to as the secondary controller), both the master and
the slaves function as primary controllers because the redundant controller can take over for
the master or for any of the slaves.

In an N:1 redundancy group with three primary controllers and one redundant controller, you
could consider the redundant controller to consist of three virtual controllers, each of which
maintains a redundancy relationship with a primary controller. You need a unique VRRP ID
for each relationship.

Each controller in the redundancy group is assigned a unique controller IP address and a
unique local IP address. Local addresses remain constant so that a controller can always be
identified before and after a failover. If a primary controller fails or is disconnected from the
network, an automatic failover to the redundant controller occurs. The redundant controller
then takes ownership of the controller IP address of the primary controller and takes over all
functions of the primary controller.

After a failover occurs, redundancy no longer exists for the other primary controllers in the
redundancy group.
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When the primary controller that went down and for which the redundant controller took over
comes back up and is stable, a switchback occurs automatically, in which case ownership of
the controller IP address is returned to the primary controller that came back up. The
redundant controller reassumes its passive position, and redundancy is once again available
for all primary controllers in the redundancy group.

Note: When a redundancy failover occurs, WiFi clients might experience a
service interruption of a few seconds.

Requirements and Restrictions for N:1 Redundancy
These are the requirements and restrictions for N:1 redundancy to function correctly:

e All controllers in a redundancy group must be in the same management VLAN and IP
subnet.

e The primary controllers must be stacked.

« If three or four controllers are in the same redundancy group, you must configure one
controller as the redundant controller and all other controllers as primary controllers.

e All controllers in the redundancy group must run the same firmware version. If the
firmware versions do not match, redundancy does not work.

e The licenses on the redundant controller must match those on the primary controller that
supports the largest number of licenses. For example, in a redundancy group with two
primary controllers, if one primary controller supports a license for 10 access points and
the other primary controller supports a license for 50 access points, the redundant
controller must support a license for 50 access points. If the licenses do not match,
redundancy does not work.

e For the relationship of each primary controller with the redundant controller, you must
configure a unique VRRP ID that is also different from any other VRRP IDs that might be
used for other purposes in the network. You also must configure a unique local controller
IP address for each controller in the redundancy group.

e When a failover occurs and the redundant controller takes over for a primary controller,
redundancy is no longer available for the other primary controllers in the redundancy

group.

Example of an N:1 Redundancy Configuration

The following figure shows an N:1 configuration with three stacked controllers and one
redundant controller before a failover occurs.
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N:1 Redundancy
Before failover

Primary controllers

AP Cloud 1 AP Cloud 2 AP Cloud 3
Master controller Slave controller Slave controller
Controller IP 172.16.192.30 Controller IP 172.16.192.31 Controller IP 172.16.192.32
Local IP 172.16.192.34 Local IP 172.16.192.35 Local IP 172.16.192.36

Master IP  172.16.192.30 Master [P 172.16.192.30 Master IP  172.16.192.30

i
1
1
1
1
VRRP ID 123 VRRP ID 124 VRRP ID 125
1
1

I o o o o o o

Redundant controller
Local IP 172.16.192.33

Figure 22. Primary and redundant controllers in an N:1 configuration before a failover

The following figure shows the N:1 settings on the Redundancy page before a failover
occurs.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
Configuration
Stacking @
o Master 172.16.192.30 172.16.192.34 172.16.192.30
Slave 172.16.192.31 172.16.192.35 172.16.192.30
Slave 172.16.192.32 172.16.192.36 172.16.192.30
ADD DELETE
Redundancy
Enable Redundancy ]
Secondary IP 172.16.192.33
Controller Role # | Controller IP | VRRP ID[1-255] % | Local 1P &
Master 172.16.192.30 123 172.16.192.34
Slave 172.16.192.31 124 172.16.192.35
Slave 172.16.192.32 125 172.16.192.36
‘ m »
APPLY REPLACE SYNC CAMCEL

Figure 23. Redundancy page for an N:1 configuration before a failover
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The following figure shows an N:1 configuration with three primary controllers and one
redundant controller after a failover occurs:

N:1 Redundancy
After failover

Primary controllers '

AP Cloud 2 AP Cloud 3
Down Slave controller Slave controller
— Local IP 172.16.192.34 Controller IP 172.16.192.31 Controller IP 172.16.192.32
Cocal IP 172.16.192.35 Local IP 172.16.192.36

Master IP 172.16.192.30 Master IP 172.16.192.30

o=

VRRP ID 123 VRRP ID 124 VRRP ID 125
1 1 1
1 o e 1

hemccm———— =

Master controller
Controller IP 172.16.192.30
Local IP  172.16.192.33 AP Cloud 1
Master IP  172.16.192.30

Figure 24. Primary and redundant controllers in an N:1 configuration after a failover

Configure a Redundancy Group With N:1 Redundancy

To enable N:1 redundancy, configure the redundancy settings on the primary controllers (the
master and one or two slaves) and on the redundant controller (the secondary controller) that
serves all primary controllers. All controllers require matching licenses. If licenses do not
match, redundancy cannot be established. For additional requirements, see Requirements
and Restrictions for N:1 Redundancy on page 298.

An N:1 redundancy group includes two or three primary controllers that usually operate as a
stack:

* To configure redundancy for a stack of two controllers, you need three controllers: Two
primary controllers (one master and one slave) and one redundant controller that serves
both primary controllers.

e To configure redundancy for a stack of three controllers, you need four controllers: Three
primary controllers (one master and two slaves) and one redundant controller that serves
the three primary controllers.

For information about configuring a stack of controllers, see Configure a Stack of Wireless
Controllers on page 283.
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» To configure N:1 redundancy for a stack of three controllers:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP

address.

ProSAFE Wireless Controller

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.

2. Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary

page.
4. Select Stacking.

Access Point Configuration

Stacking

@ Master
Slave

Slave

ADD

Redundancy

Monitor

Maintenance Plans

Role ¢ | Controller 1P % | Local IP 2 m

172.16.192.30 172.16.192.30 | 172.16.192.30

172.16.192.31 172.16.192.31  172.16.192.30

172.16.192.32 172.16.192.32 | 172.16.192.30

DELETE

Enable Redundancy

APPLY

SYMC

CAMNCEL

The page displays the stacking configuration.

5. Select the Enable Redundancy check box.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Configuration

Stacking 7
-m Controller IP %+ | Local IP % | Master IP %
L Master 1 2.30
Slave 1 - 2.30
Secondary Controller Information
Slave 1 2.30

Controller IP
ADD DELETE UserName admin
Password

Redundancy = T

Enable Redundancy
Secondary IP

Controller Role¢| Controller IP ¢+ | VRRP ID[1-255] # | Local IP &

Master 172.16.192.30
Slave 172.16.192.31
Slave 172.16.192.32

APPLY SYNC CAMNCEL

6. Configure the settings for the redundant controller (that is, the secondary controller) as

described in the following table.

Setting Description

Controller IP Enter the IP address of the redundant controller. This is the address that you use to
log in to the redundant controller’'s web management interface.

UserName The user name is a nonconfigurable field that displays the user name with which you
log in to the web management interface of the redundant controller. By default, the
user name is admin.

Password Enter the password with which you log in to the web management interface of the
redundant controller. If you did not yet personalize the password, enter password for
the password.

7. Click the Apply button.

Your settings are saved. The Secondary IP field displays the IP address of the redundant
controller (that is, the secondary controller).
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Access Point Configuration

Monitor Maintenance Plans Diagnostics

Stacking

-m Controller IP #| Local IP + | Master IP %

a Mastar 172.16.192.30 172.16.192.30 172.16.192.30
Slave 172.16.192.31 172.16.192.31 172.16.192.30
Slave 172.16.192.32 172.16.192.32 172.16.152.30
ADD DELETE
Redundancy
Enable Redundancy il
Secondary IP 172.16.152.33

Controller Role ¢ | Controller IP ¢ | VRRP ID[1-255] ¢ | Local IP &

Master
Slave

Slave

172.16.192.30
172.16.192.31
172.16.192.32

APPLY SYMC CAMCEL

8. Configure the VRRP ID and local IP address of all primary controllers (that is, the master
and the slaves) as described in the following table.

These settings are required so that the primary controllers and redundant controller can
establish a redundancy group.

The following table also includes descriptions of the nonconfigurable fields.

Setting

Description

Controller Role

This is a nonconfigurable field that shows that the role of the primary controller.
The role is either master (for the master in the stack) or slave (for the slaves in
the stack).

Controller IP

This is a nonconfigurable field that shows the IP address of the primary
controller. This IP address is the address that you use to log in to the primary
controller’s (master’s or slave’s) web management interface and was
established when you configured the stack (see Configure a Stack of Wireless
Controllers on page 283).

Note: The controller IP address of the master in the stack is also the master IP
address for the redundancy configuration.

VRRP ID [1-255]

For each primary controller, enter a number from 1 through 255 as the VRRP
ID. For each primary controller, this number must be unique and not assigned
to any other device in the network.

Local IP

the failover. For each primary controller, you must enter an IP address that is

For each primary controller, enter a local IP address. If a failover occurs, this IP
address remains assigned to the primary controller and does not transfer to the
redundant controller to let you identify the primary controller before and after

not assigned to any other device.
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WARNING:

Enabling redundancy causes the redundancy process on the
primary wireless controller to restart, which might temporarily
affects traffic on the managed access points in the network.

Click the Apply button.

Your settings are saved. After the configuration of the primary controller that functions as
the master in the stack synchronizes with the redundant controller, redundancy goes into

effect.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Configuration

Stacking 6
Q Master 172.16.192.30 172.16.192.34 172.16.192.30
Slave 172.16.192.31 172.16.192.35 172.16.192.30
Slave 172.16.192.32 172.16.192.36 172.16.192.30
ADD DELETE
Redundancy
Enable Redundancy vl
Secondary IP 172.16.192.33
Controller Role ¢ | Controller IP ¢ | VRRP ID[1-255] % | Local 1P &
Master 172.16.192.30 123 172.16.192.34
Slave 172.16.192.31 124 172.16.192.35
Slave 172.16.192.32 125 172.16.192.36
“« n »
APPLY REPLACE SYNC CANCEL

10. Select Monitor > Controller > Summary.

The Summary page displays for the controller.

11. Click the REFRESH button.

The Summary page displays the new redundancy information.

Maintenance Stacking Plans Diagnostics

Point Configuration Monitor

r | WLAN | Clients

Emn -

Usage

Network Status 7 Controller Info Redundancy Status
Access Point
Clients Total Alarms Firmware Version 5.0.0.26 Controller Mode Primary
Meighboring Device Up i Down | Critical | Major Serial Number 3EM1345WFO007 Redundancy State Active
Clients Access Points | 0 o o o Controller Uptime 2 hours, 51 mins, 11 se Secondary Status Reachable
Neighbor AP Cliants ° HA A A Last Reboot Thu Jan 29 14:37:22 2015 Sync Status in Sync
Profiles Last Configuration Change Thu Jan 20 17:28:17 201 Primary 1P Address 172.16.192.38
DHCP Lease Wireless Clients i Last Channel Allocation NA Secondary IP Address  172.16.152.33
Captive Portal z : = Last Admin Login NA Virtual 1P 172.16.192.30
T Open WEP | wea WPA2

o 0 o ]
Most Active APs @ Most Active Clients 3

Name Model MAC | Clients MAC =0 Usage(KBytes) [sso [ clients |

REFRESH
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Replace a Redundant Controller

After you configure redundancy, you can replace the redundant controller with another one.
Even if you change only the password of the redundant controller, use the replace tool.
> To replace aredundant controller:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Stacking.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Configuration

Stacking 7
- Role #| Controller IP %| Local IP %+ | Master IP %
Cl Master 172.16.192.30 172.16.192.34 172.16,192.30
ADD DELETE
Redundancy
Enable Redundancy [
Secondary IP 172.16.192.31
Controller Role # | Controller IP ¢+ | VRRP ID[1-255] % | Local IP =
Master 172.16.192.30 123 172.16.192.34
4 m b
APPLY REPLACE SYNC CAMCEL
o

5. Click the Replace button.
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Access Point Configuration Monitor Maintenance Plans Diagnostics

Stacking T
[ Thole < Controler p <] ocal < Moster P ]
o Master 172.16.192.30
ADD DELETE Replacing Controller Information
Local IP
Redundancy UserName admin
Password
Enable Redundancy
Secondary IP CANCEL APPLY
Controller Role ¢ | Controller 1P %
Master 172.16.192.30

APPLY REPLACE SYNC CANCEL

6. Configure the settings as described in the following table.

Setting Description

Controller IP Enter the IP address of the redundant controller. This is the address that you use to
log in to the redundant controller’s web management interface.

UserName The user name is a nonconfigurable field that displays the user name with which you
log in to the web management interface of the redundant controller. By default, the
user name is admin.

Password Enter the password with which you log in to the web management interface of the
redundant controller. If you did not yet personalize the password, enter password for
the password.

7. Click the Apply button.

Your settings are saved. The Secondary IP field displays the IP address of the redundant
controller (that is, the secondary controller).

Remove a Redundancy Group

You can remove an existing redundancy group. In a 1:1 redundancy group, the primary
controller is returned to a standalone configuration without redundancy. In a N:1 redundancy
group, the primary controllers are returned to a stacked configuration without redundancy.

After you remove a redundant controller, reset the redundant controller to its factory default
configuration before you use the controller in another configuration.
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» Toremove aredundancy group:

1.

Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
Select Stacking.

Access Point Configuration Monitor Maintenance Plans Diagnostics

Stacking @

| | Role ¢ Controller 1P ¢ | Local TP + | master 1P ®
o Master 172.16.192.30 172.16.192.34 172.16.192.30

ADD DELETE
Redundancy

Enable Redundancy El

Secondary IP 172.16.192.33
Controller Role + | Controller IP +| VRRP ID[1-255] % | Local IP =
Master 172.16.192.30 123 172.16.192.34

APPLY REPLACE SYMNC CAMNCEL

Clear the Enable Redundancy check box.
Click the Apply button.

Your settings are saved. Each controller in the redundancy group reboots. Redundancy is
no longer provided.
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Monitor the WiFi Network
and Its Components

This chapter includes the following sections:

e Monitor the Network

* Monitor the Wireless Controller

* Monitor the SSIDs on the Wireless Controller
e Monitor Local Clients in the Network

Note: The information that is shown in the figures in this chapter is not
always consistent. That is, the information in one figure might be for a
different network configuration than the information in another figure.
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Monitor the Network

Note: The Network configuration menu tab displays under the Monitor
main navigation menu tab only if you configured stacking. If you did
not configure stacking, see Monitor the Wireless Controller on
page 324.

Note: Monitoring the network does not apply to the WC7500. For this model,
see Monitor the Wireless Controller on page 324.

You can view a summary of the status of all wireless controllers in the network and their
components and view individual components:

* Summary. See View the Network Summary Page.

e Controllers. View the Wireless Controllers in the Network.

e Access Points. See View the Access Points in the Network.
e Clients. See View the Clients in the Network.

* Profiles. See View the Profiles in the Network.

View the Network Summary Page

The wireless controller Summary page provides the status of the controller stack, the network
status, and an overview of the rogue access points.

If you configured stacking and log in to the web management interface, the network

Summary page displays. However, if you did not configure stacking, the wireless controller

Summary page displays (see View the Wireless Controller Summary Page on page 324).
> To view the network Summary page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Monitor > Network > Summary.
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Access Point

Controller

Metwork |

Configuration

Monitor Maintenance Stacking Plans Diagnostics

Controller

Access Point
. Clients

Profiles

WLAN ! Clients
Stacking/Redundancy Status @
Service IP % | Local Device IP Controller Status %
Master 192,168.0.8 192.168.0.8 uUp
Slave-1 192,168.0.7 192.168.0.7 Up
Network Status @ Rogue Access Points 5,
Controller IP | Status | Access Points | Clients Rogue AP current a
] Up l Down | Critical. | T Rogue AP count 24hrs 0
152.168.0.8
192.168.0.7 Up ] o ] ] 0
Total ] 0 ] 0 16

REFRESH

The following table describes the fields of the Stacking/Redundancy Status table, the
Network Status table, and the Rogue Access Points section of the page.

Item

Description

Stacking/Redundancy Status

Role The role of the wireless controller in a stacking configuration (Master or
Slave).
Service IP The service IP address of the wireless controller. In a stacking configuration,

the service IP address is identical to the local IP address.

Local Device IP

The local IP address of the wireless controller in the stacking group. This IP
address remains constant. The role of the wireless controller (that is, master
or slave) does not affect the local IP address.

Controller Status

The state of the wireless controller in the stack (Up or Down).

Network Status

Controller IP

The IP address of each wireless controller in the network.

Status

The status of each wireless controller in the network (Up or Down).

Monitor the WiFi Network and Its Components
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Iltem Description
Access Up The number of access points that a wireless controller manages and that are
Points running correctly.

This number is shown for each wireless controller in the stack and for all
wireless controllers together.

Down The number of access points that a wireless controller manages but cannot
ping.

This number is shown for each wireless controller in the stack and for all
wireless controllers together.

Critical The number of access points that a wireless controller manages and can ping,
but either cannot log in to or for which the wireless controller detected that the
access points are different from the ones that were configured.

This number is shown for each wireless controller in the stack and for all
wireless controllers together.

Major The number of access points that a wireless controller manages but for which
the wireless controller detected that the configuration differs from the one that
is in its own configuration. This situation can occur if an access point runs
outdated firmware or the wireless controller changed the configuration while
the access point was down or offline.

This number is shown for each wireless controller in the stack and for all
wireless controllers together.

Clients The number of WiFi clients that each wireless controller in the stack manages,
and the total number of WiFi clients that all wireless controllers in the stack
manage.

Rogue Access Points

Rogue AP current The total number of unique rogue and unmanaged neighboring access points
that are detected in the network.

Rogue AP count 24hrs The total number of unique rogue and unmanaged neighboring access points
that were detected over the last 24 hours in the network.

5. To sort the Stacking/Redundancy Status table, click the double triangle icon or single
triangle icon at the top right of a column.

6. To display the latest information onscreen, click the REFRESH button.

View the Wireless Controllers in the Network

You can monitor the stacking configuration of the wireless controllers in the network.

> To view the network Controllers page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
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3. Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Monitor > Network > Controller.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Metwork | Controller | WLAN | Clients

Summary Controllers @
Controller IP # | Name #| Location# Typec: Version #| Status$ Config Status ¢| Config Sync Time
Access Point 192.166.0.8 we2DCE21 Master  3.4.1.0_1665 Up NA ot
Clients
profil 192.168.0.7 woABCBE4 Slave 3.4.1.0_1665 Up UPDATE SUCCESSFUL Mon Oct 21 23:57:18 2013
rofiles

REFRESH

The following table explains the fields of the Controllers table on the network Controllers
page.

Item Description

Controller IP The IP address of the wireless controller.

Name The name of the wireless controller (see Configure the General Settings on
page 100).

Location The location of the wireless controller (see Configure the General Settings on
page 100).

Type The function of the wireless controller in a stack (either Master or Slave).

Version The firmware version that the wireless controller is running.

Status The stacking status of the wireless controller (for example, Up or

Unreachable).

Config Status The firmware configuration status of the wireless controller (for example,
Update Successful).

Note: This field applies only for a wireless controller that functions as a slave.

Config Sync Time The time that the wireless controller synchronized its firmware.

Note: This field applies only for a wireless controller that functions as a slave.

5. To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

6. To display the latest information onscreen, click the REFRESH button.
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View the Access Points in the Network

You can monitor all managed access points in the network and see which wireless controller
manages a particular access point.
» To view the network Access Point page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Monitor > Network > Access Point.

The Access Point page displays. Because this page is a wide page, it is shown in the
following two figures.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Metwork | Controller | WLAN | Clients

Access Point

Summary
Controller
Search ||
Clients Status ¢ | Name MAC $| IP ¢ | Controller IP %
Profiles ® healthy netgearlAFC48  WNDAP3S0  e0:91:f5:0a:fcid40 192,168.0.109 192.168.0.8

healthy netgear8330D8  WHNAP210w2 2c:b0:5d:83:30:d0 192.168.0.110 192.168.0.8
healthy netgear8859ES WHNDAP3E0D 2¢:b0:5d:88:59:e0 192,168.0.104 192,168.0.8
healthy netgear91B4ES  WHNAP320 74:44:01:91:b4:e0 192,168.0,108 192,168.0.8
healthy netgearSDFASS WHNDAPEAD 24:1b:5e:5d:fa: 90 192,168.0.101 192.168.0.8
heaslthy netgearSCSBC8 WNDAP620  84:1b:Se:SciSbic0  192,168.0,103 192.,168.0.8
healthy 3ntgralFADS WHNDAP360 c4:3dic7ia0:fa:00 192,168.0,107 192.,168.0.8
healthy netgearAl0548  WHNDAP360 c4:3dic7:a1:05:40 192,168.0,102 192,168.0.8

o/fe] ¢ [¢] ¢ [¢] &
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Local
Local
Local
Local
Local
Local
Local

Local

Building-1
Building-1
Building-1
Building-1
Building-1
Building-1
Building-1

Building-1

Buildingc| Floor

Floor-1
Floor-1
Floor-1
Floar-1
Floar-1
Floar-1
Floar-1

Floar-1

12 days, 22 hrs, 6 mins, 40 secs
13 days, 21 hrs, 54 mins, 27 secs
13 days, 22 hrs, 7 mins, 26 secs
132 days, 21 hrs, 54 rins, 8 secs
12 days, 22 hrs, & mins, 14 secs
13 days, 21 hrs, 37 mins, 16 secs
4 days, 2 hrs, 37 mins, 10 secs

4 days, 2 hre, 37 mins, 9 secs

REFRESH DETAILS EXPORT

The following table describes the fields of the Access Point page.

Item Description

Select The radio button that lets you select the access point.

Status The status of the access point (healthy or down).

Name The name of the access point (see Change Access Point Information on the
Managed AP List on page 170).

Model The model of the access point.

MAC The MAC address of the access point.

IP The IP address of the access point.

Controller IP The IP address of the wireless controller that manages the access point.

Site Shows whether you designated the access point as a local or remote one:
e Local. The access point is designated as a local.
* Remote. The access point is designated as remote.
For more information about designating an access point as local or remote, see
Discover Access Points With the Discovery Wizard on page 159.

Building The building to which you assigned the access point (see Change Access Point
Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

Floor The floor to which you assigned the access point (see Change Access Point
Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

Location The location of the access point (see Change Access Point Information on the

Managed AP List on page 170).
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Iltem Description

2.4/5 GHz Channel The active 2.4 GHz or 5 GHz channel on the access point. This information can
change after initial configuration of the access point because of automatic
channel allocation.

The color coding specifies the channel utilization on each radio and means the
following:

e Green. 0—40 percent utilization.

o Light green. 41-60 percent utilization.

* Orange. 61-80 percent utilization.

* Red. 81-100 percent utilization.

* NA. The radio does not support the band.

Uptime The period since the access point was last restarted.

5. To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

6. To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

7. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

« To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

8. To display the latest information onscreen, click the REFRESH button.
9. To export the table, do the following:

a. Click the EXPORT button.

b. To save the file, follow the directions of your browser.
10. To display details about an access point, do the following:

a. Select the radio button that corresponds to the access point for which you want to see
the details.

b. Click the Details button.

The AP Details pop-up window opens. Because this window is tall and you must scroll
through it, the window is shown in the following two figures.
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AP Details
Access Point Details
AP Info D
Access Point Name netgearAl0668
Model WNDAP3ED
Group Group-3
IP Address 192.165.0.156
Ethernet MAC Address c4:3d:c7: a1 :06:60
AP Site Local
Configured 2.4 GHz Channel 1/ 2412Ghz
Current Operating 2.4 GHz Channel 1/2412Ghz
Configured 5 GHz Channel 36/ 5.180Ghz
Current Operating 5 GHz Channel 36/ 5.180Ghz
Load Balancing Max Clients {(802.11b/bg/ng) 50
Load Balancing Signal Quality (802.11b/bg/ng) &0
Load Balancing Max Clients (802.11a/na) 40
Load Balancing Signal Quality (802.11a/na) 45
Profile Info o)
v
OK
AP Details
Profile Info 3 A
802.11b/bafng NG_11g-31 Cpen 1
202.11b/balng NG_11g-33 Opan 1
202.113/na NG_11a-31 Spen 1
Client Info 0}
Rogue AP Info
Type * | Reported ¢ | In Same Channel | In Interfering Channel ¢
Statistics o)
m Unicast Packets Received ¢+ | Broadcast Packets Received
Wired Ethernat 1943 1455
Wireless 11bg 0 o
Wireless 11a 0 Q
< > v
OK

The following table describes the fields of the AP Details pop-up window.
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Iltem

Description

AP Info

This information is self-explanatory.

Profile Info

For each security profile that is configured on the selected access point, the following information

displays:

Type The type of profile (802.11b/bg/ng or 802.11a/na/ac).

SSID The WiFi network SSID for the security profile.

Security The security mode (Open, WEP, WPA, WPA2, or WPA/WPAZ2) for the
security profile.

VLAN The VLAN ID or VLAN name for the security profile.

Client Info

The information that displays depends on the type and security of the connection between the client

and the access point.

For each WiFi client that is connected to the selected access point, some or all of the following

information displays:

MAC The MAC address of the WiFi client.

IP The IP address of the client.

Channel The channel that the WiFi client is using to connect to the access point.

SSID The WiFi network SSID that the WiFi client is using to connect to the access
point.

Security The security mode that the WiFi client is using to connect to the access

point (Open, WEP, WPA, WPA2, or WPA/WPA2).

Rogue AP Info

For all rogue and unmanaged neighboring access points combined that the selected managed access
point detected, the following information displays:

Type The type of profile that the rogue access point is using to connect to the
access point (802.11b/bg/ng or 802.11a/na/ac).
Reported The total number of detected rogue access points in the wireless mode.

In Same Channel

The total number of detected rogue access points in the same channel.

In Interfering Channel

The total number of detected rogue access points in the interfering channel.

Statistics

For each type of usage (Wired Ethernet, Wireless 11ng, Wireless 11bg, Wireless 11b,
Wireless 1lac, Wireless 11na, Wireless 11a, or a combination), statistics about transmitted and
received packets and bytes display for the selected access point. The actual statistics are

self-explanatory.

Note: To see all fields of the table on the AP Details page, scroll to the right.
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11. Click the OK button.
The AP Details pop-up window closes, and the network Access Point page displays
again.

View the Clients in the Network

You can view all clients that are connected to managed access points and see which wireless
controller manages a particular access point.
> To view the Clients page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Monitor > Network > Clients.

The Clients page displays. Because this page is a wide page, it is shown in the following
two figures.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

i Controller | WLAN | Clients

Summary Clients

Controller

Access Point Search []

¢| Location ¢ | AP-Name ¢ AP MAC

Profiles ® 00:11:22:33:02:01  192.168.0.50 netgear8859E8  192,168.0.104 2C:B0:5D:88:5%:E0
O 00:11:22:133:02:02 192.168.0.51 netgear88S9E8  192,168.0,104 2C:B0:SD88:159:E0
O 00:11:22:132:02:03  192,168.0.52 netgearS8S9E8  192,168.0,104  2C:B0:50:28:59:E0
O 00:11:22:33:02:04 192,168.0,53 netgear8859E8  192,168.0,104 2C:B0:5D1898:5%:E0
O 00:11122:133:02:05  192,168.0.54 netgear88S9E8  192,168.0,104  2C:B0:50:88159:1E0
O 00:11:22:33:02:06  192.169.0.55 netgear88S9E8  192,168.0,104 2C:B0:5D:198:5%:E0
O 00:11:22:132:02:07  192.168.0.56 netgear859E8  192,168.0,104  2C:B0:5D:28:59:E0
Q 00:11122:33:02:08  192.168.0.57 netgear8859E8  192,168.0.104 2C:B0:5D188159:1E0
(@) 00:11:22:33:02:09  192,168.0,58 netgear88S9E8  192,168.0,104  2C:B0:5D:88:59:E0
@) 00:11122:33:02:0A  192.168.0,59 netgear8859E8  192,168.0,104 2C:iB0:5D198:5%:E0
© 00:11:22133:02:08  192.168.0.60 netgear8859E8  192,168.0,104  2C:B0:5D:88:5%:E0
O 00:11122133:02:0C 192,168.0,61 netgear8@S9E8  192,168.0,104 2C:BO:SD188159:E0
9] 00:11:22:32:02:0D  192,168.0,62 netgear88S9ES  192,168.0,104 2C:B0:50188:15%E0
@ 00:11:22:33:02:0E  192.168.0.63 netgear8859E8  192,168.0.104 2C:B0:5D:188:5%:E0
O 00:11:22:33:02:0F  192,168.0.64 netgear88S9E8  192,168,0,104  2C:B0:5D:88159:E0
O 00:11:22:33:02:10  192.168.0.65 netgear8859E8  192,168.0,104 2C:B0:50:198:15%:E0
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802.11g 157 -44 Building-1 Floor-1 WCIS00Doc | Open 192,168.0.8 2z days, 16 hrs, 20 mins, 1 secs

£02.11g 157 =44 Building-1 Floor-1 WCIS00Doe  Open 192.168.0.8 2 days, 16 hrs, 20 mins, 0 secs

802.11g 157 =44 Building-1  Fleer-1 = WC9S00Dec  Open 192.168.0.8 2 days, 16 hrs, 20 mins, 0 secs

g§02.11g 157 -44 Building-1 Floor-1 = WC9500Doc  Cpen 192.168.0.8 2 days, 16 hrs, 20 mins, 0 secs

802.11g 157 -43 Building-1 Floor-1 WC2S00Doc | Open 192.168.0.8 2 days, 16 hrs, 19 mins, 58 secs
S02.119 157 -43 Building-1 Floor-1 WEoS00Doe | Open 192.168.0.8 2 days, 16 hrs, 12 mins, 58 secs
802.11g 157 =43 Building-1 Floor-1 WCSS00Dos | Open 192.168.0.8 2 days, 1€ hre, 19 mins, 58 secs
802.11g 157 -43 Building-1 Floor-1  WC9500Doc  Open 192.168.0.8 2 days, 16 hrs, 19 mins, 55 secs
802.11g 157 -43 Building-1 Floor-1 | WC9500Doc = Cpen 192.168.0.8 2 days, 16 hrs, 19 mins, 57 secs
B02.11g 157 =47 Building-1  Floor-1  WC9500Doc  Open 192,168.0.8 2 days, 16 hrs, 19 mins, 56 secs
802.11g 157 -44 Building-1 Floor-1 WCSS00Doe | Open 192,168.0.8 z days, 16 hrs, 19 mins, 56 secs
e02.11g 157 ~4q Building-1 Floor-1 WC9S00Dos  Open 192,168.0.8 2 days, 16 hrs, 19 mins, 55 secs
802.11g 157 -d4 Building-1 Floor-1 WCI500Doc | Open 192.168.0.8 2 days, 16 hrs, 19 mins, 55 secs
g802.11g 157 =45 Building=1  Floor-1  WC9500Doc  Open 192,168.0.8 2 days, 16 hrs, 19 mins, 55 secs
802.11g 157 -44 Building-1 Floor-1 WC9S00Doe | COpen 192,168.0.8 2 days, 16 hrs, 19 mins, 54 secs
§02.11qg 157 -43 Building-1 Floor-1  WC$500Doc Cpen 192.168.0.8 z days, 16 hrs, 19 mins, 54 secs

REFRESH LOCATE DETAILS EXPORT

The following table describes the fields of the Clients page.

Iltem Description
Select The radio button that lets you select the client.
MAC The MAC address of the WiFi client.
IP The IP address of the WiFi client.
Note the following:
» If clients and the access point to which they are connected are in the same
VLAN, all receive an IP address from the same DHCP server.
» If clients and the access point to which they are connected are not in the
same VLAN, you must provide a DHCP server for the client VLAN.
» If clients are not connected to any DHCP server, IP addresses in the
169.254.x.x. range are assigned automatically.
Location The location of the access point (see Change Access Point Information on the
Managed AP List on page 170) to which the WiFi client is connected.
AP-Name The name of the access point (see Change Access Point Information on the
Managed AP List on page 170) to which the WiFi client is connected.
AP-IP The IP address of the access point to which the WiFi client is connected.
AP-MAC The MAC address of the access point to which the WiFi client is connected.
Client Type The wireless mode that the WiFi client is using to connect to the access point

(802.11ng, 802.11bhg, 802.11b, 802.11ac, 802.11na, or 802.11a).

Usage (KBytes)

The traffic usage of the WiFi client in KB.
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Item Description
RSSI The received signal strength indicator (RSSI) of the WiFi client.
Building The building to which you assigned the access point (see Change Access Point

Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

Floor The floor to which you assigned the access point (see Change Access Point
Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

SSID The WiFi network SSID that the WiFi client is using to connect to the access
point.
Security The security mode (Open, WEP, WPA, WPA2, or WPA/WPA?2) that the WiFi

client is using to connect to the access point.

Controller IP The IP address of the wireless controller that manages the access point to which
the WiFi client is connected.

Uptime The period that the client is connected to the wireless controller.

To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

* To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To display the latest information onscreen, click the REFRESH button.
To locate a client on a deployed floor plan, do the following:
a. Select the radio button that corresponds to the client that you want to locate.
b. Click the Locate button.
The selected client displays on the floor plan and is indicated by a red icon.

| ___— Client

— Access point
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c. To display details about the client, point to the client.
A pop-up window opens and displays details about the client.
d. To close the floor plan, click the Back button.
The Clients page displays again.
10. To export the table, do the following:
a. Click the EXPORT button.
b. To save the file, follow the directions of your browser.

11. To display details about a client, do the following:

a. Select the radio button that corresponds to the clients for which you want to see the
details.

b. Click the Details button.

Client Details
MALC 20:D6:07:2C: 70 7E
Access Point netgear7B260D3E
BSSID CO:3F:0E: 7B 26:00
SSID WLANLD
Frequency 2412000 GHz
Auth open
Client Type 802.119g
Cipher none
AID 1
RSSI -35
Tx Power 14 dbm
Tx Rate 54.00Mbps
Tx Bytes o
Rx Rate 1.00Mbps
Rx Bytes 2328
T Packets o
Rx Packets 23
Ok

The following table describes the fields of the Client Details pop-up window.

Iltem Description

MAC The MAC address of the WiFi client.

Access Point The name of the access point to which the WiFi client is connected.

BSSID The MAC address of the access point’s radio to which the WiFi client is
connected.

SSID The WiFi network SSID that the WiFi client is using to connect to the access
point.

Frequency The channel frequency that the WiFi client is using to connect to the access
point.
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Item

Description

Auth

The security mode that the WiFi client is using to connect to the access
point (Open, WEP, WPA, WPA2, or WPA/WPA?2).

Client Type

The wireless mode that the WiFi client is using to connect to the access
point (802.11ng, 802.11bg, 802.11b, 802.11ac, 802.11na, or 802.11a).

Cipher

The type of encryption that the WiFi client is using (None, WEP, AES, TKIP,
or TKIP + AES).

AID

The association ID of the client.

RSSI

The received signal strength indicator (RSSI) of the WiFi client.

Tx Power

The transmit power of the WiFi client.

Tx Rate

The transmit rate in Mbps of the WiFi client.

Tx Bytes

The number of bytes that the WiFi client transmitted.

Rx Rate

The receive rate in Mbps of the WiFi client.

Rx Bytes

The number of bytes that the WiFi client received.

Tx Packets

The number of packets that the WiFi client transmitted.

Rx Packets

The number of packets that the WiFi client received.

12. Click the OK button.

The Client Details pop-up window closes, and the Clients page displays again.

View the Profiles in the Network

You can view all security profiles on the managed access points and see which wireless
controller manages a particular access point.

» To view the network Profiles page:

1. Open a web browser, and in the browser’s address field, type the wireless controller's IP

address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.

2. Enter your user name and password.

Click the Login button.

The wireless controller's web management interface opens and displays the Summary

page.

4. Select Monitor > Network > Profiles.
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Access Point

Metwork | Controller

Configuration

Monitor Maintenance Stacking Plans Diagnostics

Summary
Controller
Access Point

Clients

WLAN | Clients
Profiles
Search
¢ | Profile Name ¢ | Security ¢ | Radio Mode ¢ | Status+ | No.of APs# | No.of Clients 2 | Group Name ¢ | Controller 1P
WCIS000oc | VLANLOD Span 802.11b/baing  Active s o basic 192,162.0.2
NG_11g-02  VLANZO Cpen 802.11b/bafng  Active 5 o basic 192,168.0.8
NG_119-03 VLANZO Cpen 802.11b/baing  Active 3 o basic 152.168.0.8
WC9S00Doc  NG_1la-01 Cpen 802.11aina Ackive 3 o basic 192.168.0.8
NG_1ig-11  Bldi_Upper_Floor Open 302.1ib/baing  Adive 3 [ Group-1 192,162.0.2
NG_11g-12  Bli_Lower_Floor Cpen 802.11b/bafng  Adive 3 o Graup-1 192.168.0.8
NG_11g9-13 Bld1_Library Open 802.11b/bging  Active 3 -] Group-1 192.168.0.8
NG_11a-11 NG_1la-11 Cpan 802.11afna Activa 3 o Sroup-1 192,18.0.2
NG_11g-21 | NG_11g-21 Cpen 802.11b/baing = Inactive 0 o Group-2 192,168.0.8
NG_11a-21 HG_11a-21 Open 802.11a/na Inactive o o Group-2 192,168.0.8
NG_11g-31 WNG_11g-31 Open 802.11b/baing  Inactive -] o Growp-3 1%2.168.0.8
NG_112-31 NG_11a-31 Cpan 802.11afna Inactive o o Group-3 192.168.0.8
NG_115-32 | NG_11a-32 Open 802.115/na Insctive 0 [ Group-3 192,168.0.8
WC95000oc  NG_11g-01 Cpen 802.11b/bging  Inactive o o basic 192,168.0.7
WC95000oc  NG_1l1a-01 Cpan 802.11a'na Inactive ] ] basic 192.162.0.7
NG_11g-11 NG 11g-11 Cpen 802.11b/bafng  Inactive 0 o Group-1 192,168.0.7
1-16 of 22 | Entry Per Page | Default v PREVIOUS | 1% of 2 | NEXT
REFRESH EXPORT

The following table describes the fields of the Profiles page.

Iltem Description

SSID The WiFi network SSID for the security profile.

Profile Name The name of the security profile.

Security The security mode (Open, WEP, WPA, WPA2, or WPA/WPA?2) for the security
profile.

Radio Mode The wireless mode for the security profile (802.11b/bg/ng or 802.11a/na/ac).

Status The status of the security profile (Active or Inactive).

No.of APs The number of access points that are attached to the security profile.

No.of Clients The number of clients that are attached (through the access points) to the
security profile.

Group Name The name of the group of which the security profile is a member.

Controller IP The IP address of the wireless controller that manages the access point on
which the profile is configured.

To sort the table, click the double triangle icon or single triangle icon at the top right of a

column.

To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.
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If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To display the latest information onscreen, click the REFRESH button.
To export the table, do the following:

a. Click the EXPORT button.

b. To save the file, follow the directions of your browser.

Monitor the Wireless Controller

You can view a summary of the status of a wireless controller and its components and view
individual components:

Summary. See View the Wireless Controller Summary Page.

Usage. See View Wireless Controller Usage.

Access Points. See View Access Points That the Wireless Controller Manages.
Clients. See View Clients on Access Points That the Wireless Controller Manages.

Neighboring Clients. See View Neighboring Clients That the Wireless Controller
Detects.

Neighboring APs. See View Neighboring Access Points That the Wireless Controller
Does Not Manage.

Profiles. See View Security Profiles That the Wireless Controller Manages.
DHCP Lease. See View DHCP Leases That Are Provided by the Wireless Controller.

Captive Portal Users. See View Captive Portal Users on Access Points That the
Wireless Controller Manages.

Guest Email List. See View the Guest Email Address Database for Access Points That
the Wireless Controller Manages.

AirQual. See View AirQual for the Channels in a Profile Group.

View the Wireless Controller Summary Page

You can view an overview of the activity on the wireless controller.

When you log in to the web management interface, the wireless controller Summary page
displays. However, if you configured stacking, the network Summary page displays (see View
the Network Summary Page on page 309).
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> To view the wireless controller Summary page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Monitor > Controller > Summary.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Controller | WLAN | Clients

MNetwork Status ) Wireless Clients ¥ Controller Info
Usage Total | alarms Open | WEP | WPA | wpa2 Firmware Version 6.5.0.16
Pccessibolut Device Up Down | Critical Major 17 o o o Serial Number 3EM13450F000A
z":“.:: | Access Pointe | 2 o ° o Controller Uptime 3 mins, & secs
eighboring P
A At = ity = Last Reboot Sat Sep 17 08:55:32 2016
Neighbor AP Last Configuration Change  Sat Sep 17 08:57:16 2016
Profiles Last Channel Allocation  Wed Aug 31 13:52:37 2016
DHCP Lease Last Admin Login Sat Sep 17 08:57:56 2016
ﬁ:::‘:‘ Portal Most Active APs 7 Most Active Clients 7 Most Active SSIDs 3
AirQual Name Madel MAC Clients MAC | SSID | Usage(KBytes) 551D Clients
netgearSEETAS  WHDAPISD  20:4eiTFiSéieTia0 8 Bock 17
di98:29:40 9
REFRESH

The following table describes the fields of the Network Status, Wireless Clients, Most
Active APs, Most Active Clients, and Most Active SSIDs tables of the page. The
Controller Info section is self-explanatory.

Note: If you configure redundant controllers, the page also displays
information about the status of the redundancy configuration. This
information is self-explanatory.

Iltem Description

Network Status

Total Up The total number of managed devices that are running correctly.
Down The total number of managed devices that cannot be pinged.
Alarms Critical The wireless controller can ping these managed devices, but either cannot log in or

detected that these devices are different from the ones that were configured.

Major The number of managed devices for which the configuration differs from the one
that is set on the wireless controller. This situation occurs most likely because the
device runs outdated firmware or the wireless controller changed the configuration
while the device was down or offline.
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Item Description

Wireless Clients

Open The number of WiFi clients that are connected to managed access points using
security profiles configured with open mode.

WEP The number of WiFi clients that are connected to managed access points using
security profiles configured with WEP.

WPA The number of WiFi clients that are connected to managed access points using
security profiles configured with WPA.

WPA2 The number of WiFi clients that are connected to managed access points using
security profiles configured with WPA2.

Most Active APs
For the most active access points, the following information displays:

Name The name of the access point (see Change Access Point Information on the
Managed AP List on page 170).

Model The model of the access point.
MAC The MAC address of the access point.
Clients The number of clients that are associated with the access point.

Most Active Clients
For the most active clients, the following information displays:

MAC The MAC address of the WiFi client.
SSID The WiFi network SSID that the WiFi client is using to connect to the access point.
Usage (KBytes) The traffic usage of the WiFi client in KB.

Most Active SSIDs
For the most active SSIDs, the following information displays:

SSID The name of the WiFi network SSID.

Clients The number of clients that are using the SSID.

5. To sort a table, click the double triangle icon or single triangle icon at the top right of a
column.

6. To display the latest information onscreen, click the REFRESH button.
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View Wireless Controller Usage

The page displays graphics that show the access point usage, SSID usage, and number of
clients on the wireless controller.

Note: The Java plug-in is required to display the graphics.

> To view the Usage page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Monitor > Controller > Usage.

Access Point Configuration Maintenance Stacking Diagnostics Plans Diagnostics
Summary Controller Usage
Access Point AP Usage SSID Usage
Neighbaring
Clients - = -
Heighbor AP o
Profiles o ~
DHCP Lease € 3om g
Captive Portal
Users 20,000 &
Guest Emall List 4 ]
AirQual )
) L il Al A 1 &P -
S ERLLL SRS
P & & & o
- & & & o e
& o8 o & o 2
° ° SSID Name
AP Mac
Number of Clients
[ Totdl 2.4 Gu A5 Ew
&
g
-
]
1
z
40K D 08 X = 05 1 110 12:00 1:00 0 400 s 0
Time
REIRESH
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Data for the 2.4 GHz network (for the combined 802.11b, 802.11bg, and 802.11ng
modes) is shown in purple; data for the 5 GHz network (for the combined 802.11a,
802.11na, and 802.11ac modes) is shown in green. The page shows the following graphs:

e AP Usage. Displays the 2.4 GHz and 5 GHz traffic usage in MB for access points.
e SSID Usage. Displays the 2.4 GHz and 5 GHz traffic usage in MB for SSIDs.

*  Number of Clients. Displays the total number of clients, number of clients in the
2.4 GHz network, and number of clients in the 5 GHz network over a period.

5. To display the latest information onscreen, click the REFRESH button.

View Access Points That the Wireless Controller Manages
You can monitor all access points that the wireless controller manages.

> To view the Access Point page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
3. Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Monitor > Controller > Access Point.

The Access Point page displays. Because this page is a wide page, it is shown in the
following two figures.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Controller | WLAN | Clients

Access Point

Summary
Usage

Search
Neighboring healthy netgear?BQéDB WNAPZ10 c0:3f:0e:7b:26:d0  192,168.0.157 Local
Clients O healthy  netgear7B2488 WNAP210  c0:3f:0e:7b:24:80 192.168.0.155 Local
helghbor AR O healthy netgearAl0668  WNDAP360 c4:3d:c7:al:06:60 192,168.0,156 Local
Profiles
DHCP Lease

Captive Portal
Users

Guest Email List
AirQual
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basic
basic

Group-3

I Group :I Building =

Building-1
Building-1

Building-1

Floor# | Location+ | 2.4/5 GHz Channel:
& IEE

Floor-1

7 mins, 7 secs
Floor-1 - — 7 mins, 7 secs
Floor-1 _f - & rnins, 57 secs

REFRESH DETAILS EXPORT

The following table describes the fields of the Access Point page.

Iltem Description

Select The radio button that lets you select the access point.

Status The status of the access point (healthy or down).

Name The name of the access point (see Change Access Point Information on the
Managed AP List on page 170).

Model The model of the access point.

MAC The MAC address of the access point.

IP The IP address of the access point.

Site Shows whether you designated the access point as a local or remote one:
e Local. The access point is designated as a local.
« Remote. The access point is designated as remote.
For more information about designating an access point as local or remote, see
Discover Access Points With the Discovery Wizard on page 159.

Group The profile group to which the access point is assigned (see Assign Access
Points to Buildings, Floors, and Advanced Profile Groups on page 174).

Building The building to which you assigned the access point (see Change Access Point
Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

Floor The floor to which you assigned the access point (see Change Access Point
Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

Location The location of the access point (see Change Access Point Information on the

Managed AP List on page 170).
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Item Description

2.4/5 GHz Channel The active 2.4 GHz or 5 GHz channel on the access point. This information can
change after initial configuration of the access point because of automatic
channel allocation.

The color coding specifies the channel utilization on each radio and means the
following:

e Green. 0-40 percent utilization.

e Light green. 41-60 percent utilization.

e Orange. 61-80 percent utilization.

* Red. 81-100 percent utilization.

*« NA. The radio does not support the band.

Uptime The period since the access point was last restarted.

5. To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

6. To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

7. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

* To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

8. To display the latest information onscreen, click the REFRESH button.
9. To export the table, do the following:

a. Click the EXPORT button.

b. To save the file, follow the directions of your browser.
10. To display details about an access point, do the following:

a. Select the radio button that corresponds to the access point for which you want to see
the detalils.

b. Click the Details button.

The AP Details pop-up window opens. Because this window is tall and you must scroll
through it, the window is shown in the following two figures.
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AP Details

Access Point Details

AP Info

Access Point Name

Model

Group

IP Address

Ethernet MAC Address

AP Site

Configured 2.4 GHz Channel

Current Operating 2.4 GHz Channel
Configured 5 GHz Channel

Current Operating 5 GHz Channel

Load Balancing Max Clients {802.11b/bg/ng)
Load Balancing Signal Quality (802.11b/bg/ng}
Load Balancing Max Clients (802.11a/na)
Load Balancing Signal Quality (802.11a/na)

Profile Info

netgearAl0868
WHDAP3ED
Group-3
192,165.0.156
o4:3d:27:a1:06:60
Local
1/2412Ghz
1/2412Ghz
36 / 5.180Ghz
36 / 5.180Ghz
50

60

40

45

Channel

[inc_—+[w ]

Rogue AP Info

Statistics

Unicast Packets Received #

Device

AP Details
Profile Info
Type | S5ID
202.11b/bafng MG_11g-31 Open
202.11b/balng NG_11g=33 Opan
#02.11a'na M&_1la-31 Open
Client Info

Wired Etharnat = 1943
Wireless 11bg 0O a
Wireless 11a [} o

o

: 4
1
1

Security &

Type =| Reported #| In Same Channel ¢ | In Interfering Channel #

Broadcast Packets Received

The following table describes the fields of the AP Details pop-up window.

Item

Description

AP Info

This information is self-explanatory.
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Item Description

Profile Info

For each security profile that is configured on the selected access point, the following information

displays:

Type The type of profile (802.11b/bg/ng or 802.11a/na/ac).

SSID The WiFi network SSID for the security profile.

Security The security mode (Open, WEP, WPA, WPA2, or WPA/WPAZ2) for the
security profile.

VLAN The VLAN ID or VLAN name for the security profile.

Client Info

The information that displays depends on the type and security of the connection between the client
and the access point.

For each WiFi client that is connected to the selected access point, some or all of the following
information displays:

MAC The MAC address of the WiFi client.

IP The IP address of the client.

Channel The channel that the WiFi client is using to connect to the access point.

SSID The WiFi network SSID that the WiFi client is using to connect to the access
point.

Security The security mode that the WiFi client is using to connect to the access

point (Open, WEP, WPA, WPA2, or WPA/WPA?2).

Rogue AP Info

For all rogue and unmanaged neighboring access points combined that the selected managed access
point detected, the following information displays:

Type The type of profile that the rogue access point is using to connect to the
access point (802.11b/bg/ng or 802.11a/na/ac).
Reported The total number of detected rogue access points in the wireless mode.

In Same Channel

The total number of detected rogue access points in the same channel.

In Interfering Channel

The total number of detected rogue access points in the interfering channel.

Statistics

self-explanatory.

For each type of usage (Wired Ethernet, Wireless 11ng, Wireless 11bg, Wireless 11b,
Wireless 1lac, Wireless 11na, Wireless 1l1a, or a combination), statistics about transmitted and
received packets and bytes display for the selected access point. The actual statistics are

Note: To see all fields of the table on the AP Details page, scroll to the right.

11. Click the OK button.

The AP Details pop-up window closes, and the Access Point page displays again.
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View Clients on Access Points That the Wireless Controller
Manages

You can view all clients that are connected to access points that the wireless controller
manages.
» To view the Clients page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Monitor > Controller > Clients.

The Clients page displays. Because this page is a wide page, it is shown in the following

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
Network | Controller | WLAN : Clients
Summary Clients
Usage s h
earc
Access Point
| MAC # | Location ¢ | AP-Name ¢ | AP-IP ¢ | AP MAC + |
Neighboring ® 00:11:22:33:02/01  192.168.0.50 netgear8859E8  192,168.0.104  2C1B0:5D:188:59:E0
Clients O 00111:22:33:02:02 192,168.0,51 netgearS§59ES  192,168.0.104 2CiB0:SD:188:59:E0
Neighbor AP
= &) 00:11:22:33:02103  192.168.0,52 netgear8859ES  192,168,0.104 2C:B0:SD:88:S9:E0
Profiles
O 00:11:22133:102:04  192,168.0.53 netgear8859ES  192,168.0.104 2C:B0:5D:188:55:E0
DHCP Lease
= O 00:11:22:33:02:05  192.168.0,54 netgear8859ES  192,168,0.104 2C:B0:SD:88:S9:E0
Captive Portal
Users ®) 00:11:22133:02:06  192,168.0.55 netgear8859E8  192,168.0.104 2C1B0:5D:188:59:E0
Guest Email List O 00:11:22:33:02:07 192.168.0.56 netgear8859E8  192,168.0.104 2C:B0:SD:88:59:E0
AirQual @) 00:11:22133102:08  192,168.0.57 netgear8855E8  1592,168.0.104 2C:B0:5D:88:59:E0
O 00:11:22133:102/109  192,168.0,58 netgeargS59E9  192,168,0,104  2C1B0:5D:188:52:E0
O 00:11:22133102:04 192,168.0,59 netgear8859E8  192,168,0.104 2C1B0:5D188;59:E0
@) 00:11:22133:102/108 | 192.168.0,60 netgear8859E8  192,168,0,104  2C:B0:SD:18859:E0
@ 00:11:22133102:0C  192,168.0.61 netgearB859E8 | 192,168.0.104  2C:B0:5D188:59:E0
O 00:11:22:133:10210D | 192.168,0.62 netgear8eS9ES  192,168,0,104  2C:1B0:50:188:59:E0
@ 00:11:22133:02;0E  192.168.0,63 netgear8859E9  192,168.0.104  2C1B0:5D:188:59:E0
O 00:11:22:33:102:0F  192.168.0.64 netgearS$59E8  192,168,0,104  2C:B0:5D:198;59:E0
@) 00:11:22:33:02;10 192,168.0.65 netgear8859E8  192,168.0.104 2C:B0:5D:88:59:E0
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@
oo ansoren s auiane s oore soin L seeniulupine
202.119 Building-1 Flaar-1 WC950000e  OPEN 2 days, 17 hrs, 55 mins, 10 secs
802.11g 161 =49 Building-1 Floor-1 WC9S00Doc OPEN 2 days, 17 hrs, 55 mins, 9 secs
802,119 161 =49 Building-1 Floar-1 WC9500Doe  OPEN 2 days, 17 hrs, 55 mins, 9 secs
802,119 161 -49 Building-1 Floor-1  WC9500Doc  OPEN 2 days, 17 hrs, 55 mins, 9 secs
a02.11g 161 -51 Building-1  Floor-1  WC9500Doc  OPEN 2 days, 17 hrs, 55 mins, 7 secs
202.11g 161 -49 Building-1  Floor-1  WC9500Doc  OPEM 2 days, 17 hrs; 55 mins, 7 secs
202.11g 161 -50 Building-1  Floor-1  WC9500Doc | OPEM 2 days, 17 hrs, 55 mins, 7 secs
202.11g 161 -49 Building-1 Flaor-1 WCA50000c  OPEM 2 days, 17 hre, 55 mins, 7 sacs
202,119 161 =49 Building-1 Floor-1 WC95S000Doc  QPEM 2 days, 17 hrs, 55 mins, 6 secs
802,119 161 =49 Building=1 Floor-1 WCaS00Doc  OPEM 2 days, 17 hrs, 55 mins, 5 secs
802.11g 161 -50 Building-1 Floor-1  WC9500Doc | OFEN 2 days, 17 hrs, 55 mins, 5§ secs
202,119 161 -49 Building-1 Floor-1  WC9500Doc  OPEN 2 days, 17 hrs, 55 mins, 4 secs
202.11g 161 -49 Building-1  Floor-1  WC9500Doc  OPEM 2 days, 17 hrs, 55 mins, 4 secs
2802.11g 161 -49 Building-1 Floor-1  WC9500Doc  OPEN 2 days, 17 hrs, 55 mins, 4 secs
202.11g 161 -50 Building-1  Flaor-1  WC9500Doc  OPEN 2 days, 17 hrs, 55 mins, 3 secs
202.11q 161 =50 Building-1 Flaor-1 WC9S000oc OPEN 2 days, 17 hrs, 55 mins. 3 secs
REFRESH LOCATE DETAILS EXPORT

The following table describes the fields of the Clients page.

Item Description
Select The radio button that lets you select the client.
MAC The MAC address of the WiFi client.
IP The IP address of the WiFi client.
Note the following:
e If clients and the access point to which they are connected are in the same
VLAN, all receive an IP address from the same DHCP server.
e If clients and the access point to which they are connected are not in the
same VLAN, you must provide a DHCP server for the client VLAN.
e If clients are not connected to any DHCP server, IP addresses in the
169.254.x.x. range are assigned automatically.
Location The location of the access point (see Change Access Point Information on the
Managed AP List on page 170) to which the WiFi client is connected.
AP-Name The name of the access point (see Change Access Point Information on the
Managed AP List on page 170) to which the WiFi client is connected.
AP-IP The IP address of the access point to which the WiFi client is connected.
AP-MAC The MAC address of the access point to which the WiFi client is connected.
Client Type The wireless mode that the WiFi client is using to connect to the access point
(802.11ng, 802.11bg, 802.11b, 802.11ac, 802.11na, or 802.11a).
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Iltem Description

Usage (KBytes) The traffic usage of the WiFi client in KB.

RSSI The received signal strength indicator (RSSI) of the WiFi client.

Building The building to which you assigned the access point (see Change Access Point

Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

Floor The floor to which you assigned the access point (see Change Access Point
Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

SSID The WiFi network SSID that the WiFi client is using to connect to the access
point.
Security The security mode (Open, WEP, WPA, WPA2, or WPA/WPA?2) that the WiFi

client is using to connect to the access point.

Uptime The period that the client is connected to the wireless controller.

To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To display the latest information onscreen, click the REFRESH button.
To locate a client on a deployed floor plan, do the following:
a. Select the radio button that corresponds to the client that you want to locate.
b. Click the Locate button.
The selected client displays on the floor plan and is indicated by a red icon.

| ___—— Client

A in
— ccess point

c. To display details about the client, point to the client.

Monitor the WiFi Network and Its Components
335



ProSAFE Wireless Controller

A pop-up window opens and displays details about the client.
d. To close the floor plan, click the Back button.
The Clients page displays again.
10. To export the table, do the following:
a. Click the EXPORT button.
b. To save the file, follow the directions of your browser.

11. To display details about a client, do the following:

a. Select the radio button that corresponds to the clients for which you want to see the
details.

b. Click the Details button.

Client Details
MAC 20:D6:07:2C:70:7E
Access Point netgear7B 2608
BSSID CO:3F:0E: 78:26:00
SSID VLANLD
Frequency 2.412000 GHz
Auth open
Client Type 802.11g
Cipher nane
AID 1
RSS1 -35
Tx Power 14 dbm
T Rate 54.00Mbps
Tx Bytes o
R+ Rate 1.00Mbps
Rx Bytes 2326
Tu Packets o
Rx Packets 23
oK

The following table describes the fields of the Client Details pop-up window.

Item Description

MAC The MAC address of the WiFi client.

Access Point The name of the access point to which the WiFi client is connected.

BSSID The MAC address of the access point’s radio to which the WiFi client is
connected.

SSID The WiFi network SSID that the WiFi client is using to connect to the access
point.

Frequency The channel frequency that the WiFi client is using to connect to the access
point.
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Iltem Description

Auth The security mode that the WiFi client is using to connect to the access
point (Open, WEP, WPA, WPA2, or WPA/WPA?2).

Client Type The wireless mode that the WiFi client is using to connect to the access
point (802.11ng, 802.11bg, 802.11b, 802.11ac, 802.11na, or 802.11a).

Cipher The type of encryption that the WiFi client is using (None, WEP, AES, TKIP,
or TKIP + AES).

AID The association ID of the client.

RSSI The received signal strength indicator (RSSI) of the WiFi client.

Tx Power The transmit power of the WiFi client.

Tx Rate The transmit rate in Mbps of the WiFi client.

Tx Bytes The number of bytes that the WiFi client transmitted.

Rx Rate The receive rate in Mbps of the WiFi client.

Rx Bytes The number of bytes that the WiFi client received.

Tx Packets The number of packets that the WiFi client transmitted.

Rx Packets The number of packets that the WiFi client received.

12. Click the OK button.
The Client Details pop-up window closes, and the Clients page displays again.

View Neighboring Clients That the Wireless Controller Detects

You can monitor clients that the wireless controller detects and that are attached to known or
rogue access points.
> To view the Neighboring Clients page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Monitor > Controller > Neighboring Clients.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Controller | WLAN | Clients

Neighboring Clients @

Summary

L nas Search

Access Point

Clients Locate ___[mAac___________ ¢|RSSL___ ¢ Rogue ¢
9a:f4:76:15:63:e5 -87 No
40:0e:85:0b:26:5¢ -85 Mo

Neighbor AP @0:91:f5:0a:2b:30 -85 Ne

Profiles ad4:4e:31:1b:78:dc -87 No

DHCP Lease d8:bb:2c:2c:ab:92 -85 Mo

Captive Portal
Users

Guest Email List
AirQual

dei9b:9e:3cibd:1f
52:e3:10:10:08:67
8c:29:37:12:ce:79

ce:3a:61:35:74:ec

Mo
Mo
No

No

80:88:b4:06:8c:58 -85 No
9e:3e:92:2b:12:14a -85 No
e2:a4:b6:28:07:58 -B6 No
40:0e:85:16:f0:66 -86 No
f8:27:93:3c:45:38 -86 No
€0:91:f5:02:fb:50 -20 No
cc:32:61:13:83:1a -84 No

1-16 of 119 | Entry Per Page | Default{~| PREVIOUS | | 1[~] of 8 | NEXT

REFRESH EXPORT

The following table describes the fields of the Neighboring Clients page.

Item Description

Location This radio button is nonfunctional.

MAC The MAC address of the neighboring client.

RSSI The received signal strength indicator (RSSI) of the neighboring client.
Rogue Shows whether or not (Yes or No) the neighboring client is connected to a

rogue access point.

To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

* To move to the next page, click the Next button.
« To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To display the latest information onscreen, click the REFRESH button.
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9. To export the table, do the following:
a. Click the EXPORT button.
b. To save the file, follow the directions of your browser.

View Neighboring Access Points That the Wireless Controller
Does Not Manage

You can monitor the access points that the wireless controller detects but does not manage.

> To view the Rogue AP page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Monitor > Controller > Neighbor AP.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

ontroller | WLAN | Clients

e Neighbor/Rogue AP i
Usage Search
Access Point
e ¢ | Channel = | Privacy | Last Beacon *| % | Classification ¢ | Name =
Nejﬂ'lbl‘lﬂnﬂ ° bO:7F:b9:cbichich NETGEAR_11AC 149 Secured Sat Sep 17 2016 -] AR
Clients b0:7fib9ichicbich | NETGEAR_11H 5 Secured Sat Sep 17 2016 AP
+ N 04:81:51ichichich  IcabergsPower 44 Securad Sat Sep 17 10:06:55 2016  Neighbor AP Unknown
. Profiles . 04:a1:51ichicbich | SurferDude 44 Secured Sat Sep 17 2016 ap
DHCP Lease 04:a1:51:chicbich  IcabergsPower 1 Securad Sat Sep 17 10:06:55 2016 ighbor AP Unk
Captive Portal 04:a1:511chicbich | SurferDude 1 Secured Sat Sep 17 2018 AR
Users b8:Ze:591chicbich 149 Secured Sat Sep 17 10:06:55 2016 Neighbor AP Unknown
e el 60:33:4bicbicbich  SimplePrazancalistwork SGHz 145 Secured | SatSep 17 2018 ar
ﬂi?ﬂual £0:23:4bicbicbich SimplePresenceNetwork & Secured Sat Sep 17 10:06:55 201& Neighbor AP Unknown
@0:91:fSichichich  RMCS FARMS 1 Unsecured  Fri Sep 16 15:52:17 2016 Neighbor AP Unknown
REFRESH EXPORT

The following table describes the fields of the Rogue AP page.

Item Description

Select The radio button that lets you select the access point.

MAC The MAC address of the rogue access point.

SSID The WiFi network SSID that the rogue access point is using.
Channel The channel that the access point is using.
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Item Description

Privacy The security of the access point (Secured or Unsecured).

Last Beacon The last beacon that the access point transmitted.

Type The category that the access point belongs to (Neighbor AP or Rogue AP).
Classification The status of the access point (Known or Unknown).

Name The name of the access point, if a name is assigned.

5. To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

6. To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

7. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All

8. To display the latest information onscreen, click the REFRESH button.
9. To export the table, do the following:

a. Click the EXPORT button.

b. To save the file, follow the directions of your browser.

View Security Profiles That the Wireless Controller Manages

You can monitor all security profiles on the access points that the wireless controller
manages.

> To view the Profiles page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Monitor > Controller > Profiles.
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Access Point ( iguratior Monitor Maintenance Stacking Plans Diagnostics
Controller | WLAM | Clients
Summary Profiles el
Usage
Access Point Sedrch =
Clients SSID  #| Profile Name | Security + | Radio Mode ¢ | Status ¢ | No.of APs# | No.of Clients ¢
Meighboring VLANLO WLANLO Cpen 802.11b/bafng  Active 2 1z basic
c"_‘"“ VLANZO VLANZO Open 802.11b/bafng  Active 2 1 basic
Netghbur S VLANZO WLANZO Cpen g02.11b/balng  Active 2 2 basic
DHCP Lease NG 11a-01 HE 11a-01 Qpan 202.11a/na Active o [ basic
Captive Portal NG_1ig-11  Bldi_Upper_Floor Wpa/Wpa2z 802.11b/bging Inactive 0 o Group-1
Users NG_11g-12 Bld1_Lower Floor Wpa/Wwpaz 802.11b/bafng  Inactive L] o Group-1
- Guest Email List NG_11g-13  Bld1_Library Open 802.11b/bafng  Inactive O L] Group-1
AirQual NG_11a-11 Bldl_Upper_Floor_na ‘Wpa/Wpa2 802.11a/na Inactive O ] Group-1
NG_11a-12 Bldl_Lower_Floor_na Wpa/Wpa2 802.11afna Inactive 0O o Group-1
NG _11g-21 NG _11g-21 Open 802.11bfbafng  Inactive o 0 Group-2
NG_11a-21 NG_11a-21 Cpen 202.11a/na Inactive o o Group-2
HG_11g-31 NG 11g-31 Cpen 802,11bfbafng  Active 2l ak Group-3
MG_119-33 NG_11g9-33 Cpen 802.11b/bafng  Active 1 o Group-3
NG_11a-31 NG_11a-31 Open 802.11ana Active 1 ik Group-3
REFRESH EXPORT
The following table describes the fields of the Profiles page.
Iltem Description
SSID The WiFi network SSID for the security profile.
Profile Name The name of the security profile.
Security The security mode (Open, WEP, WPA, WPA2, or WPA/WPA?2) for the security
profile.
Radio Mode The wireless mode for the security profile (802.11b/bg/ng or 802.11a/na/ac).
Status The status of the security profile (Active or Inactive).
No.of APs The number of access points that are attached to the security profile.
No.of Clients The number of clients that are attached (through the access points) to the
security profile.
Group Name The name of the group of which the security profile is a member.

To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

« To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.
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8. To display the latest information onscreen, click the REFRESH button.

9. To export the table, do the following:

a. Click the EXPORT button.
b. To save the file, follow the directions of your browser.

View DHCP Leases That Are Provided by the Wireless

Controller

You can view the current DHCP clients that were allocated IP addresses by the DHCP server
on the wireless controller.

» To view the DHCP Leases page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP

address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.

2. Enter your user name and password.

3. Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary

page.

4. Select Monitor > Controller > DHCP Lease.

Access Point

Controller | WLAN { Clients

Configuration Monitor Maintenance Stacking Plans Diagnostics

Summary
Usage

- Access Point
Clients

Neighboring
Clients

Neighbor AP
Profiles

Captive Portal
Users

Guest Email List
AirQual

DHCP Leases

Search

Host Name % 4| End Time % | End Date &

netgear7B2488  192,168.0.155

VostrolS00 192.168.0.148
netgearfl0668  192,168.0.158
netgear7B26D8 192,168.0.159

unknown 192.168.0.133

MAC % | VLAN %
14:38:31 2013/02/17  c0:3fi0e:7b:24:80  Management
13:48:31 2013/02/17 00:le:4c:67:33:b2  Management
14:41:20 2013/02/17  c4:3dic7:ali06:60 Management
14:37:53 2013/02/17 c0:3f:0e:7bi26:d0 Management
14:20:40 201370217 e0:46:93:47:1c2:13 Managemant

REFRESH EXPORT
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The following table describes the fields of the DHCP Leases page.

Item Description

Host Name The host name of the DHCP client.

IP The IP address that is allocated to the DHCP client.

End Time The DHCP lease end time for the DHCP client.

End Date The DHCP lease end date for the DHCP client.

MAC The MAC address of the DHCP client.

VLAN The VLAN name or number that the DHCP server and DHCP client are using to
connect.

5. To sort the table, click the double triangle icon or single triangle icon at the top right of a

column.

6. To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

7. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

» To move to the next page, click the Next button.

e To move to the previous page, click the Previous button.

» To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

8. To display the latest information onscreen, click the REFRESH button.
9. To export the table, do the following, do the following:

a. Click the EXPORT button.

b. To save the file, follow the directions of your browser.

View Captive Portal Users on Access Points That the
Wireless Controller Manages

You can view the current guests and users that are logged in to a captive portal on the
access points that the wireless controller manages.

> To view the Captive Portal Users page:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP

address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.
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The wireless controller’s web management interface opens and displays the Summary
page.

4. Select Monitor > Controller > Captive Portal Users.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Controller | WLAN | Clients

Captive Portal Users @
Summary =

I=r Search

Access Point

. User Name % | Account Name % MAC %+ | Login Time %+ | Expiry Time 4+
en

. . Weenson VIPguests 192,168,1,107  O0MED:0D:2Z:00:A0  Sat Feb 16 15:14:22 2013 Sun Feb 17 15:14:22 2013
Neighboring
clients EHart Default 192,168,1,104 00:E0:15:00:00:A0  Sat Feb 16 15:15:57 2013 Mon Feb 18 08:20:00 2013
Neighbor AP

Profiles
DHCP Lease

Guest Email List
AirQual

REFRESH CLEAR ALL EXPORT

The following table describes the fields of the Captive Portal Users page.

Item Description

User Name The login name of the user.

Account Name The account name, if any, that is associated with the user.

P The IP address of the user.

MAC The MAC address of the device with which the user is logged in.
Login Time The time that the user logged in.

Expiry Time The time when the login access expires.

5. To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

6. To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

7. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

8. To display the latest information onscreen, click the REFRESH button.
9. To clear all information from the page and from memory, click the CLEAR ALL button.

We recommend that you save the information before you clear the information.
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10. To export the table, do the following:
a. Click the EXPORT button.
b. To save the file, follow the directions of your browser.

View the Guest Email Address Database for Access Points That
the Wireless Controller Manages

You can view the email addresses of users who are or were logged in through a guest portal.
The email address database can contain a maximum of 12,000 entries.
> To view the guest email address database:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
3. Click the Login button.

The wireless controller’s web management interface opens and displays the Summary
page.
4. Select Monitor > Controller > Guest Email List.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Controller | WLAN | Clients

e Captive Portal Emall History G

e Search EE—— 13661366

. Clients Emall Address ¢ | Login Time &

Neighboring bagavathe Gomal com Mon Sep 01 00:40:28 2015

:1:::0‘_ - fagsta Gplaycs com Tue Sep 02 01:4128 2015

. Profiles square_sohaZi(Photmad com Wed Sep 03 03:11:00 2015

. DHCP Lease Cs_dukerexu(photmad com Thu Sep 04 00:04:28 2015

+ Captive Portal Zeamhas@hotmad com Fa Sep 05 00:41:00 2015

teers rde_82Qhotmal com Sun Sep 06 10:4128 2015

R trngesgsmet s Mon Sep 07 10:41:28 2015
remuspar (Byahoo com Tue Sep 08 20:41:08 2015
masash90 Fhotmal com Wed Sep 09 12:41:28 2015
24p (g de Thu Sep 10 00:41:28 2015
dmsarasn hotmad comden_see (ive dic Fn Sep 11 00:31:28 2015
skapgprova (fhotmad com Sal Sep 12 05:41:28 2015
tussytusuyPhotmal com Mon Sep 1301:31:28 2015
nancyceo @hotmal com Mon Sep 01 00:40:28 2015
Destpunfier Tyahoo com Tue Sep 0201:41:28 2015
blal_mapc @hotmail com Wed Sep 03 03:11:00 2015
el_tury_v@hotmal com Thu Sep 04 00:04:28 2015

REFRESH | CLEARALL | EXPORT
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The table shows the user email addresses and the date and time that the user logged in.

5. To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

6. To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

7. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

8. To display the latest information onscreen, click the REFRESH button.
9. To clear all information from the page and from memory, click the CLEAR ALL button.

We recommend that you save the information before you clear the information.

10. To export the table, do the following:
a. Click the EXPORT button.

E-Bae@HEse '>H X002 D P 8- BE QT FindTex 7
[ [Liberation Sans ~| [10 | | &4 A E M1 RE Do = m N [E R E - f
Bl v| fu B = [Iuginﬁtime
| A [ B c | o | E | F 5
| Tluser login_time £
2 |bagavathe@gmail.com Mon Sep 01 00:40.28 2015 |
fragsta@playcs.com Tue Sep 02 01:41:28 %015 |
square_softazk@hotmail.com Wed Sep 03 03:11:00°2015 |
cs_dukerex: olmail.cor Thu Sep 04 00:04:28 2015 |
zerathas @hotmail.com Fri Sep 05 00:41:00 2015 |
riddle_82@hotmail.com Sun Sep 06 10:41:28 2015 |
finnigisli@simnet is Mon Sep 07 10:41:28 2015 |
remuspwI@yahoo.com Tue Sep 08 20:41:08 2015
masashi990@hotmail.com ‘Wed Sep 09 12:41:28 2015
z4p@gmx.de Thu Sep 10 00:41:28 2015 |
dimisarasin@hotmail.comden_seje@live.dk Fri Sep 11 00:31:28 2015 |
skajagprova@hotmail,com Satl Sep 12 05:41:28 2015 |
lusuytusuy@hotmail.com Mon Sep 13 01:31:28 2015 |
nancyceo@hotmail,com Mon Sep 01 00:40:28 2015 |
bestpurifier@yahoa.com Tue Sep 02 01:41:28 2015 |
bilal_majic@hotmail.com Wed Sep 03 03:11:00 2015 |

b. To save the file, follow the directions of your browser.

View AirQual for the Channels in a Profile Group

If you enabled AirQual for a profile group (see Manage AirQual for a Profile Group on
page 203), you can monitor the WiFi channel utilization and interference for a profile group.

To view the WiFi channel utilization and interference for a profile group for which
AirQual is enabled or to clear the WiFi channel utilization and interference information:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
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The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
Select Monitor > Controller > AirQual.

Channel Utilization
usage
Access Point
Clients
Meighbaring
Clients
Mobkghbar AP
Proliles
DHCP Loase

Captive Portal
Users

Guest Email List

8 | 192.168.100.139

62108184 1E3154100

AlrQual Logs

Search

sormal FUS% Coodless Phone or Meadset Spectral Interference Map

PSS Coodlass Bhocs of Masdiat
i3S Coedlan:

LA ASE

Sl LLASET YL 3 Bhane o Haadiet

Moamal
1:6 of 21 | Entry Per Page | Defavi ]

13 Sat 37 Aug 2014 13:22:34

BZ 3436 T8 % 10,50 12 53 Sab 37 Aug 301613432131 FHIS Covdlens Phone of Headiet

PREVIOUS | | 1[=] of 4 | REXT

Uiz ation ()

The AP List includes the WAC740 access points for which AirQual is enabled. (In the
previous figure, AirQual is enabled for a single WAC740 access point only.)

If the AP List includes more than one WAC740 access point, select the radio button for a
WACT740 access point.

The page adjust to display the utilization, interference, and logs for the Wifi network of the
profile group that the WAC740 access point monitors.

On the right side of the page, the Channel Utilization graphic illustrates the percentage of
utilization for each individual channel in both radio bands of the WiFi network and the
Spectral Interference Map graphic illustrates the percentage of non-WLAN interference
for each individual channel of both radio bands in the WiFi network.

The following table describes the fields of the AirQual Logs table.

Field Description

Severity The severity of the interference (Normal or Major).

Description The description of the interference event and the impacted channel or channels.
Raised TIme The time at which the interference was detected.

Interference Type

The type alert (for example, quality is below threshold) or type of interference (for
example, FHSS Cordless Phone or Handset, or Microwave Oven).

6. To sort the table, click the double triangle icon or single triangle icon at the top right of a

column.

Monitor the WiFi Network and Its Components
347



10.

ProSAFE Wireless Controller

To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

» To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To display the latest information onscreen, click the REFRESH button.
To clear all information from the page and from memory, click the CLEAR ALL button.

Monitor the SSIDs on the Wireless Controller

You can monitor all access points that function in an SSID.

> To
1.

monitor an active SSID in the network:

Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

Select Monitor > WLAN.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Controller | WLAN | Clients

SSID Mapping @

Active SSID present Select an SSID v

DETAILS EXPORT

From the Active SSID present menu, select an SSID.

The Active SSID table for the selected SSID displays. Because this page is a wide page,
it is shown in the following two figures.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Controller | WLAN | Clients

SSID Mapping

Active SSID present

Active SSID - VLAN3O

Search
ac el ¢
netgear7B2608 healthy  c0:3fi0e:7b:26:d0  192,168.0,159
O netgear7B2488 healthy  c0:3fi0e:7b:24:80 192.168.0.155

YLAN3OD v

I Model Building # 2.4 GHz Channel # | 5 GHz Channel

WNAPZ210  Building-1 Floor-1 1/ 2.412Ghz 1 hrs, 58 mins, 5 secs

WHNAP210 | Building-1 Floor-1 1/ 2.412Ghz NA 1 hrs, 58 mins, 6 secs

DETAILS EXPORT

The following table describes the fields of the SSID Mapping page.

Iltem Description
Select The radio button that lets you select the access point.
Name The name of the access point (see Change Access Point Information on the

Managed AP List on page 170).

Location The location of the access point (see Change Access Point Information on the
Managed AP List on page 170).

Status The status of the access point (healthy or down).
MAC The MAC address of the access point.

IP The IP address of the access point.

Model The model of the access point.
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Item Description

Building The building to which you assigned the access point (see Change Access Point
Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

Floor The floor to which you assigned the access point (see Change Access Point
Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

2.4 GHz Channel The configured 2.4 GHz channel on the access point. This information can
change after initial configuration of the access point because of automatic
channel allocation.

5 GHz Channel The configured 5 GHz channel on the access point. This information can change
after initial configuration of the access point because of automatic channel
allocation.

Uptime The period since the access point was last restarted.

6. To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

7. To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

8. If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

9. To export the table, do the following:

a. Click the EXPORT button.

b. To save the file, follow the directions of your browser.
10. To display details about an access point, do the following:

a. Select the radio button that corresponds to the access point for which you want to see
the details.

b. Click the Details button.

The AP Details pop-up window opens. Because this window is tall and you must scroll
through it, the window is shown in the following two figures.

Monitor the WiFi Network and Its Components

350



ProSAFE Wireless Controller

AP Details

Access Point Details

AP Info

Access Point Name
Madel

Group

1P Address

Ethernet MAC Address
AP Site

Configured 2.4 GHz Channel

Current Operating 2.4 GHz Channel

Load Balancing Max Clients (802.11b/bg/ng)

Load Balancing Signal Quality {(802.11bfbg/ng)

Profile Info

netgear7B26038
WHAPZ10

basic
192.168.0,159
c0:3f:0e:7b:26:d0
Local
1/2412Ghz
1/2412Ghz

40

202.11b/bafng VLANLOD 10

§02.11b/balna VLANZO 1

202.11b/bafng VLAN3O 1
AP Details

AT AL G TRy P T

anz.11b/balng WLANZO Cpen i

802,11bfbg/ng WLANZO Cpen 3

Client Info

MAC | 1P 4

Rogue AP Info

Channel

#| Security

Statistics

Device ¢
‘Wired Ethernet = 7520

Wiraless 11bg 716

In Same Channel 3%

Unicast Packets Received ¢

In Interfering Channel

Broadcast Packets Received
5923

415
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The following table describes the fields of the AP Details pop-up window.

Item

Description

AP Info

This information is self-explanatory.

information displays:

Profile Info

For each security profile that is configured on the selected access point, the following information

displays:

Type The type of profile (802.11b/bg/ng or 802.11a/na/ac).

SSID The WiFi network SSID for the security profile.

Security The security mode (Open, WEP, WPA, WPA2, or WPA/WPA?2) for the
security profile.

VLAN The VLAN ID or VLAN name for the security profile.

Client Info

The information that displays depends on the type and security of the connection between the client
and the access point.

For each WiFi client that is connected to the selected access point, some or all of the following

MAC The MAC address of the WiFi client.

IP The IP address of the client.

Channel The channel that the WiFi client is using to connect to the access point.

SSID The WiFi network SSID that the WiFi client is using to connect to the access
point.

Security The security mode that the WiFi client is using to connect to the access

point (Open, WEP, WPA, WPA2, or WPA/WPA?2).

Rogue AP Info

For all rogue and unmanaged neighboring access points combined that the selected managed access
point detected, the following information displays:

Type The type of profile that the rogue access point is using to connect to the
access point (802.11b/bg/ng or 802.11a/na/ac).
Reported The total number of detected rogue access points in the wireless mode.

In Same Channel

The total number of detected rogue access points in the same channel.
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Iltem Description
In Interfering Channel The total number of detected rogue access points in the interfering channel.
Statistics

For each type of usage (Wired Ethernet, Wireless 11ng, Wireless 11bg, Wireless 11b,
Wireless 1lac, Wireless 11na, Wireless 11a, or a combination), statistics about transmitted and
received packets and bytes display for the selected access point. The actual statistics are
self-explanatory.

Note: To see all fields of the table on the AP Details page, scroll to the right.

11. Click the OK button.
The AP Details pop-up window closes, and the SSID Mapping page displays again.

Monitor Local Clients in the Network

You can monitor the clients that were accepted into the WiFi network, the clients that were
denied access to the WiFi network, and the clients that are roaming in the network:

e Accepted clients. See Monitor Accepted Clients.
e Blacklisted clients. See Monitor Blacklisted Clients.

Monitor Accepted Clients

You can monitor all clients that were accepted into the network by all wireless controllers in the
network.
> To view the accepted clients in the network:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
2. Enter your user name and password.
3. Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Monitor > Clients > Local Client List.

The Clients page displays. Because this page is a wide page, it is shown in the following
two figures.
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Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Network | Controller | WLAN :

Clients
Blacklisted
clients Search
[Seloct | mac = [1p <] Locotion=| Ap-Name | Ap-ip | ApMAC |

00:11:22:33102:101  192,168.0,50 netgear8BS9EE  192,168,0.104  2C:BO:5D/88159:E0
C) 00:111122138102102 192,168.0,51 netgear88S9ES  192,168.0,104 2C!B015D 88159 1ED
O 00:11:22:33102:03  192,168.0,52 netgear8859E8  192,168,0.104 | 2C:B0:50188:59:E0
O 00:11;22:38102104 192,168.0,58 netgear8859ES  192,168,0,104  2CiB0:5D 88:591E0
@ 00:11:22:33102105  192,168.0,54 netgearB859E8  192,168,0.104 | 2C:B0:5D188:59:E0
@) 00:11:22:38102106 192,168.0.55 netgear88S9ES  192,168.0.104  2C:B0:5D188:59:1E0
@ 00:11:22:33102/07  192,168.0,56 netgear8859ES  192,168,0.104 | 2C:B015DI88:59:E0
O 00:11:22:33102:08 192.168.0.57 netgear8859E8  192.168.0.104 2C:B0:5D188:59:E0
@] 00:11:22:33102/09 192,168.0,58 netgearS859E8  192,168,0.104 2CiBO:5D881591E0
O 00:11112213310210A 192,168.0,59 netgear8E59ES  192,168,0.104 2CIB0:15DI881591ED
O 00:11:22:33102/08  192,168.0,60 netgearS§59ES  192,168,0.104  2CiB0;50188:59:E0
O 00:11;22:38102:0C 192,168.0,61 netgearB859ES  192,168.0,104 2CiB0:5D198:591E0
O 00:11:22:33102/0D  192,168.0,62 netgear3659E8  192,168,0,104  2CiB0I15DI88:159:E0
@) 00:11:22:33102/10E  192,168.0.63 netgear8859ES  192,168.0.104 2C:B0:5D 88:59:E0
O 00:11:22:33:02:0F  192.168.0,64 netgear8859E8  192,168,0.104 | 2C:B0:5D188:59:E0
@) 00:11:22:33102:10 192,168.0.65 netgear8859E8  192.168.0.104 2C:B0:5D188:59:E0

@
et Type + | uzage(aytes) | Rssi+] uiding 2| Fioor> | sSp | Security= vptime 2|
202,119 161 =49 Building-1 Flaor-1 WC9500Doc  OPEM 2 days, 17 hrs, 55 mins, 10 secs
802.11q 161 =449 Building=1 Floor-1 WCaS00Doc OPEM 2 days, 17 hre, 55 mins, 9 secs
802.11¢g 161 -49 Building-1 Floor-1  WC9500Doc  OPEN 2 days, 17 hrs, 55 mins, 9 secs
802,119 161 -49 Building-1 Floor-1  WC9500Doc OPEN 2 days, 17 hrs, 55 mins, 9 secs
202.11g iel -51 Building-1 Flaor-1 WC9500Doo OPEN 2 days, 17 hrs, 55 mins, 7 secs
202,119 161 -49 Building-1 Floor-1 WCA500Doc OPEM 2 days, 17 hrs, 55 mins, 7 secs
802.11g 161 -50 Building-1 Flaar-1 WC9500Doc  OPEN 2 days, 17 hrs, 55 mins, 7 secs
202.11g 161 -49 Building-1 Flaor-1 WC9500Doc OPEM 2 days, 17 hrs, 55 mins. 7 secs
202,119 161 =44 Building=-1 Floor-1 WC9S000oe  OPEN 2 days, 17 hrs, 55 mins, & secs
802,119 161 -49 Building-1 Floor-1  WC9500Doc OPEN 2 days, 17 hrs, 55 mins, 5 secs
802,119 161 -50 Building-1 Floor-1  WC9500Doc  OPEN 2 days, 17 hrs, 55 mins, 5§ secs
202,119 161 -49 Building-1 Floor-1  WC9500Doc  OPEM 2 days, 17 hrs, 55 mins, 4 secs
202.11g 1el -49 Building-1 Floor-1 WC9500Doc  OPEM 2 days, 17 hrs, 55 mins, 4 secs
802.11g 161 -49 Building-1  Floor-1  WC950000c  OPEN 2 days, 17 hrs, 55 mins, 4 sacs
202,119 161 -50 Building-1 Floor-1 WCA5000oc OPEM 2 days, 17 hrs, 55 mins. 3 secs
202,119 161 =50 Building-1 Floor-1 WC95000oc  OPEM 2 days, 17 hrs, 55 mins, 2 secs
REFRESH LOCATE DETAILS EXPORT

Note: The Network configuration menu tab displays under the Monitor main
navigation menu tab only if you configured stacking.
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The following table describes the fields of the Clients table on the Local Client List page.

Item Description

Select The radio button that lets you select the client.

MAC The MAC address of the WiFi client.

P The IP address of the WiFi client.

Location The location of the access point (see Change Access Point Information on the
Managed AP List on page 170) to which the WiFi client is connected.

AP-Name The name of the access point (see Change Access Point Information on the
Managed AP List on page 170) to which the WiFi client is connected.

AP-IP The IP address of the access point to which the WiFi client is connected.

AP MAC The MAC address of the access point to which the WiFi client is connected.

Client Type The wireless mode that the WiFi client is using to connect to the access point

(802.11ng, 802.11bg, 802.11b, 802.11ac, 802.11na, or 802.11a).

Usage (KBytes)

The traffic usage of the WiFi client in KB.

RSSI The received signal strength indicator (RSSI) of the WiFi client.

Building The building to which you assigned the access point (see Change Access Point
Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

Floor The floor to which you assigned the access point (see Change Access Point
Information on the Managed AP List on page 170 or Assign Access Points to
Buildings, Floors, and Advanced Profile Groups on page 174).

SSID The WiFi network SSID that the WiFi client is using to connect to the access
point.

Security The security mode (Open, WEP, WPA, WPA2, or WPA/WPA?2) that the WiFi
client is using to connect to the access point.

Uptime The period that the client is connected to the wireless controller.

To sort the table, click the double triangle icon or single triangle icon at the top right of a

column.

To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

* To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

e To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To display the latest information onscreen, click the REFRESH button.
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9. To locate a client on a deployed floor plan, do the following:
a. Select the radio button that corresponds to the client that you want to locate.
b. Click the Locate button.
The selected client displays on the floor plan and is indicated by a red icon.

NR.T | Am A Ly

| ___—— Client

| — Access point

c. To display details about the client, point to the client.
A pop-up window opens and displays details about the client.
d. To close the floor plan, click the Back button.
The Local Client List page displays again.
10. To export the table, do the following:
a. Click the EXPORT button.
b. To save the file, follow the directions of your browser.
11. To display details about a client, do the following:

a. Select the radio button that corresponds to the clients for which you want to see the
details.

b. Click the Details button.

Client Details
MAC 20:D6:07:2C 70 7E
Access Point nietgeard10668
BSSID C4;30:CFIAL:I06:62
SSID MG_11g-33
Frequency 2412000 GHz
Auth apen
Client Type &0z2.11b
Cipher none
AID 3
RSSI -39
Tx Power 10 dbm
Tx Rate 11,00Mbps
Tx Bytes 728
Rx Rate 1.00Mbps
Rx Bytes 1928
Tx Packets 3
Ru Packets 30
Ok
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The following table describes the fields of the Client Details pop-up window.

Item Description

MAC The MAC address of the WiFi client.

Access Point The name of the access point to which the WiFi client is connected.

BSSID The MAC address of the access point’s radio to which the WiFi client is
connected.

SSID The WiFi network SSID that the WiFi client is using to connect to the access
point.

Frequency The channel frequency that the WiFi client is using to connect to the access
point.

Auth The security mode that the WiFi client is using to connect to the access
point (Open, WEP, WPA, WPA2, or WPA/WPA?2).

Client Type The wireless mode that the WiFi client is using to connect to the access
point (802.11ng, 802.11bg, 802.11b, 802.11ac, 802.11na, or 802.11a).

Cipher The type of encryption that the WiFi client is using (None, WEP, AES, TKIP,
or TKIP + AES).

AID The association ID of the client.

RSSI The received signal strength indicator (RSSI) of the WiFi client.

Tx Power The transmit power of the WiFi client.

Tx Rate The transmit rate in Mbps of the WiFi client.

Tx Bytes The number of bytes that the WiFi client transmitted.

Rx Rate The receive rate in Mbps of the WiFi client.

Rx Bytes The number of bytes that the WiFi client received.

Tx packets The number of packets that the WiFi client transmitted.

Rx Packets The number of packets that the WiFi client received.

12. Click the OK button.

The Client Details pop-up window closes, and the Local Client List page displays again.

Monitor Blacklisted Clients

You can monitor all clients that were denied access to the network by all wireless controllers in

the network.

Note: Monitoring of blacklisted clients is supported on models WC7600 and
WC9500 but not on models WC7500 and WC7600v2.
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The wireless controller places the following types of clients on the black list:

Clients for which an authentication failure occurred because they are included in a MAC
ACL that denies them access.

Clients for which an authentication failure occurred, for example, because an incorrect
password was entered or a RADIUS server denied them access.

If the client connects with the correct authentication information, the client is cleared from
the black list after 10 seconds.

Clients that attempt to connect to an access point for which load balancing is enabled and
that reached its maximum number of devices allowed per radio.

Clients that attempt to connect to an access point for which load balancing is enabled and
that reached its RSSI threshold.

Note: If a client continues to attempt to connect to an access point with a weak
signal (that is, with a weak RSSI), the client is allowed to connect while
remaining on the black list. In such a situation, we recommend that you
investigate the coverage and other environmental factors in the area in
which the client and access point are located.

Blacklisted clients are allowed to attempt to connect again 10 seconds after their previous
attempt. If the reason that a client is blacklisted is addressed, for example, the security key is
corrected, the client is allowed to connect and (in most cases) removed from the black list.

> To view the blacklisted clients in the network:

1. Open a web browser, and in the browser’s address field, type the wireless controller’'s IP

address.
By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

Enter your user name and password.
Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.

4. Select Monitor > Clients > Blacklisted Clients.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Network | Controller | WLAN | Clients

Local Client List Blacklisted Clients

#| AP-Name = | AP-IP + % $ Last Seen
00100  Authentication Failed | ap1-8b2d80  192.188.0.30  verWave_g 49 2 Mon Sep 20 17:55:125 2010

Failed pl-8b2d 192.168.0.30 veriWave g 49 3 Mon Sep 20 18:02:25 2010

100 | Authentication Falled | api-8b2d480 152.168.0.30 verWave_g 49 2 Mon Sep 20 18102110 2010

LOCATE EXPORT

Note: The Network configuration menu tab displays under the Monitor main
navigation menu tab only if you configured stacking.
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The following table describes the fields of the Blacklisted Clients table on the Blacklisted
Clients page.

Item Description

Select The radio button that lets you select the client.

MAC The MAC address of the WiFi client.

TYPE The reason why the WiFi client was denied access.

AP-Name The name of the access point (see Change Access Point Information on the

Managed AP List on page 170) to which the WiFi client was denied access.

AP-IP The IP address of the access point to which the WiFi client was denied access.
SSID The WiFi network SSID to which the WiFi client attempted to connect.

RSSI The received signal strength indicator (RSSI) of the WiFi client.

Count The number of times that the WiFi client attempted to connect.

Last Seen The last time that the WiFi client attempted to connect.

To sort the table, click the double triangle icon or single triangle icon at the top right of a
column.

To search the table, in the Search field, enter the information that you are looking for, such
as an IP address or MAC address.

If the table contains many entries, navigate through the table by using the following buttons
and menu that display at the bottom of the table:

» To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

» To change the number of entries onscreen, from the Entry Per Page menu, select
20, or 40, or 60, and so on, or All.

To locate a blacklisted client on a deployed floor plan, do the following:

a. Select the radio button that corresponds to the blacklisted client that you want to
locate.

b. Click the Locate button.

The selected blacklisted client displays on the floor plan and is indicated by a red
icon.

c. To display details about the blacklisted client, point to the client.
A pop-up window opens and displays details about the client.

d. To close the floor plan, click the Back button.
The Blacklisted Client page displays again.

To export the table, do the following:
a. Click the EXPORT button.
b. To save the file, follow the directions of your browser.
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Troubleshooting and Diagnostics

This chapter includes the following sections:

Troubleshoot Basic Functioning

Troubleshoot the Web Management Interface
Troubleshoot a TCP/IP Network Using the Ping Utility
Use the Reset Button to Restore Default Settings
Resolve Problems With Date and Time

Resolve Network Problems

Resolve Problems With Access Points

Use the Diagnostic Tools on the Wireless Controller
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Troubleshoot Basic Functioning

After you turn on power to the wireless controller, verify that the following sequence of events
ocCurs:

1. When power is first applied, verify that the Power LED is lit green and that the Status
LED is lit yellow.

2. After approximately two minutes, verify the following:
a. The Status LED is lit green.
b. The left Ethernet port LED is lit for any local port that is connected.

If the port’s left LED is lit, a link is established to the connected device. If the port is
connected to a 1000 Mbps device, verify that the port's right LED is green. If the port
functions at 100 Mbps, the right LED is yellow. If the port functions at 10 Mbps, the right
LED is off.

If any of these conditions do not occur, see to the appropriate following section.

Power LED Is Not Lit

If the Power and other LEDs are off when your wireless controller is turned on, make sure
that the power cord is correctly connected to your wireless controller and that the power
supply adapter is correctly connected to a functioning power outlet.

If the error persists, a hardware problem might exist. Contact NETGEAR technical support.

Status LED Never Turns Off

When the wireless controller is powered on, the Status LED is lit yellow for approximately
two minutes and then turns green when the wireless controller completes its initialization. If
the Status LED remains yellow, a fault occurred within the wireless controller.

If the Status LED is yellow more than several minutes after power-up, try the following:

e Turn off the power, and turn it on again to see if the wireless controller recovers.

» Reset the wireless controller’s configuration to factory default settings. Doing so sets the
wireless controller’s IP address to 192.168.0.250. For more information, see Reboot the
Wireless Controller on page 259.

If the error persists, a hardware problem might exist. Contact NETGEAR technical support.

Ethernet Port LEDs Are Not Lit

If the Ethernet LEDs do not light when the Ethernet connection is made, check the following:

 Make sure that the Ethernet cable connections are secure at the wireless controller and
at the hub, switch, or router.
* Make sure that power is turned on to the connected hub, switch, or router.

* Be sure that you are using the correct cables.
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Troubleshoot the Web Management Interface

If you are unable to access the wireless controller's web management interface from a
computer on your local network, try to isolate the problem. You can most likely solve the
problem by following the suggestions that are described in the following sections.

Check the Ethernet Cabling

Check the Ethernet connection between the computer and the wireless controller as
described in the previous section (see Ethernet Port LEDs Are Not Lit).

Check the IP Address Configuration

Make sure that your computer’s IP address is on the same subnet as the wireless controller.
If you are using the recommended addressing scheme, make sure that your computer is
assigned a static IP address of 192.168.0.210 and a subnet of 255.255.255.0.

Note: If your computer’s IP address is shown as 169.254.x.x:
Windows and Mac operating systems generate and assign an IP
address if the computer cannot reach a DHCP server. These
autogenerated addresses are in the range of 169.254.x.x. If your IP
address is in this range, check the connection from the computer to
the wireless controller and reboot your computer.

If the wireless controller’'s IP address changed and you do not know the current IP address,
reset the wireless controller’'s configuration to factory default settings. The factory default IP
address of the wireless controller is 192.168.0.250. For more information, see Reboot the
Wireless Controller on page 259.

If you do not want to revert to the factory default settings and lose your configuration settings,
you could use one of the following methods to discover the IP address of the wireless
controller:

* Reboot the wireless controller and use a sniffer to capture packets sent during the reboot.
Look at the ARP packets to locate the wireless controller's LAN interface address.

* Run an IP scanner application in your network to discover the IP address of the wireless
controller.

» Connect a serial cable between a computer and the wireless controller, and use the
ifconfig command to discover the IP address of the wireless controller.
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Check the Internet Browser

If the Ethernet cabling and IP address configuration are fine, the Internet browser might
prevent you from accessing the web management interface. Check the following:

* Make sure that you are using the http://address login rather than the https://address login.

* Make sure that Java, JavaScript, or ActiveX is enabled in your browser. If you are using
Internet Explorer, click the Refresh button to be sure that the Java applet is loaded.

» Try quitting the browser and launching it again.

* Make sure that you are using the correct login information. The factory default login name
is admin, and the password is password. Make sure that Caps Lock is off when entering
this information.

If the wireless controller does not save changes that you make in the web management
interface, check the following:

* When entering configuration settings, be sure to click the Apply button before moving to
another tab or page, or your changes are lost.

e Click the Refresh or Reload button in the web browser. It is possible that the changes
occurred but that the old settings remain in the web browser’s cache.

After you upgrade the firmware, if the browser does not display the latest features of the web
management interface, clear the browser’s cache, and refresh the page.

Troubleshoot a TCP/IP Network Using the Ping Utility

Most TCP/IP terminal devices and routers contain a ping utility that sends an echo request
packet to the designated device. The device then responds with an echo reply. You can
troubleshoot a TCP/IP network by using the ping utility in your computer.

You can ping the wireless controller from your computer to verify that the LAN path to your
wireless controller is set up correctly.
> To ping the wireless controller from a computer running Windows:

1. From the Windows toolbar, click the Start button, and select Run.

2. In the field provided, type ping followed by the IP address of the wireless controller, as in
this example:

ping 192.168.0.250
3. Click the OK button.
A message like the following one displays:
Pinging <IP address> with 32 bytes of data
If the path is working, you see this message:

Reply from < IP address >: bytes=32 time=NN ms TTL=xxx
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If the path is not working, you see this message:
Request timed out
If the path is not functioning correctly, one of the following problems might be occurring:
e Wrong physical connections

Make sure that the Ethernet LEDs are lit. If they are off, follow the instructions in Ethernet
Port LEDs Are Not Lit on page 361.

* Wrong network configuration

- Verify that the Ethernet card driver software and TCP/IP software are both installed
and configured on your computer.

- Verify that the IP address for your wireless controller and your computer are correct
and that the addresses are on the same subnet.

Use the Reset Button to Restore Default Settings

If you can access the wireless controller, you can use the Reboot/Reset Controllers page (the
path is Maintenance > Backup/Restore) to perform a soft or hard reset (see Reboot the
Wireless Controller on page 259).

If you can no longer access the wireless controller, press the Reset button on the front panel
to restore the factory default settings.

> To clear all data and restore the factory default values:
1. Press and hold the Reset button for about eight seconds until the Status LED turns on
and begins to blink.

2. Release the Reset button. The reboot process is complete after several minutes when the
Status LED on the front panel goes off.

Note: After restoring the factory default configuration, the wireless
controller’s default LAN IP address is 192.168.0.250, the default login
user name is admin, and the default login password is password.

Resolve Problems With Date and Time

The Time Settings page displays the current date and time of day (see Manage the Time
Settings on page 101). The wireless controller uses the Network Time Protocol (NTP) to
obtain the current time from one of several network time servers on the Internet. Each entry
in the log is stamped with the date and time of day.

When the date shown is January 1, 2000, the wireless controller did not yet successfully
reach a network time server. Verify that the wireless controller can reach the Internet. After
you configure the wireless controller, wait at least five minutes and check the date and time

again.
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Resolve Network Problems

If a network loop occurs, make sure that you did not connect a GBIC and the Ethernet port on
the wireless controller (or two GBICs on the wireless controller) to the same network switch.
Make only a single connection from a wireless controller to a network switch.

Resolve Problems With Access Points

If you encounter access point discovery or connection problems, the information in this
section might help you to resolve these problems.

Resolve Discovery Problems

If the wireless controller does not discover any or all access points, check the configuration of
the wireless controller and access points.

For all access points, check the following:

Make sure that the wireless controller is connected to the LAN (see Ethernet Port LEDs
Are Not Lit on page 361).

Make sure that you enter the correct IP range if the access points function in different
VLANSs, are behind an IP subnet, or are already installed and working in standalone mode
(see Access Point Discovery Guidelines on page 155).

Make sure that the access points run at least their initial firmware release or a newer
version. For firmware requirements, see Supported NETGEAR Access Points on
page 27.

For local access points that are installed across a Layer 3 network, check the following:

Enable SNMP and SSH on all standalone access points. (This is the default setting for
access points.)

Unblock UDP port number 7890 in the firewall.

Assign each access point a unique IP address. (This requirement does not apply to
access points in the factory default state that are in the same Layer 2 network.) If two or
more access points are assigned the same IP address, only one of them is discovered at
a time. You must add the access point to the managed list, change its IP address, and
run discovery again to discover the next access point with that IP address.

Enable DHCP option 43 (vendor-specific information) on an external DHCP server.
Specifying an internal DHCP server on the wireless controller automatically enables
DHCP option 43 with the IP address of the wireless controller.

For more information, see Access Point Discovery Guidelines on page 155.
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Resolve Connection Problems

If the Power LED of an access point blinks amber, the access point lost its connection to the
wireless controller. In this situation, check the network connectivity between the access point
and the wireless controller.

When an access point is converted from standalone AP mode to managed AP mode, its
static IP address is changed to an IP address that a DHCP server issues, either a DHCP
server in the network or a DHCP server that is configured on the wireless controller. This
change occurs to ensure that each managed access point is assigned a unique IP address.

If the network does not include a DHCP server or if the access point cannot reach the DHCP
server, the access point remains in the Connecting state, attempting to obtain an IP address.
If the network does not include a DHCP server, configure one on the wireless controller (see
Manage the DHCP Server on page 106). When a DHCP server becomes available, the
access point can transition from the Connecting state to the Connected state.

If you assign a static IP address to the wireless controller and then use the web management
interface of a discovered access point to configure a static IP address for the access point
and enter the wireless controller’s static IP address, the access point attempts to reach the
wireless controller only at the provided static IP address. If the IP address of the wireless
controller changes, the access point can no longer reach the wireless controller. In such a
situation, reset the access point to factory default settings. Doing so removes the static IP
address of the wireless controller from the access point configuration.

Network Performance and Rogue Access Point Detection

When rogue access point detection is enabled, access points intermittently go off channel for
short periods, which can affect network performance. The default rogue access point
detection interval is 30 minutes. This interval is not configurable.

Use the Diagnostic Tools on the Wireless Controller

As part of the diagnostic functions on the wireless controller, you can ping a managed access
point from the wireless controller and trace its route from the wireless controller. You can also
remotely view the console debug logs of a managed access point and capture its WiFi
packets in the network.

The following sections describe the diagnostic functions:
e Ping an Access Point on page 367
e Trace a Route to an Access Point on page 368

* View the Console Debug Logs of an Access Point on page 369
* Capture WiFi Packets on page 371
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Ping an Access Point

You can ping an access point to see if the wireless controller can reach the access point.

> To ping an access point:

1.

4.

5.

Open a web browser, and in the browser’s address field, type the wireless controller’'s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.
Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
Select Diagnostics > Tools > Ping.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Tools | Technical Support

Ping @
Trace Route Ping Count 10
AP Console Logs Access Point netgear140308 [=]
Packet Capture 1P Address 192.168.100.191

Ping Result @

64 bytes from 192.168.100.191: icmp seq=3 ttl=64 time=0.283 ms -
64 bytes from 1592.168.100.191: icmp seq=4 ttl=64 time=0.242 ms
64 byctes from 152.168.100.191: icrp seqew5 tcl=64 cimewD.261 ms
64 bytes from 192.168.100.191: imp:seqﬂs ttl=64 time=0.271 m=
64 bytes from 192.168.100.191: icmp segq=7 ttl=64 time=0.300 ms
64 bytes from 1592.168.100.191: icmp seq=8 ttl=64 time=0.275 ms
64 byres from 192.168.100.191: icwp seqwd tciméd timem0.290 ms 2
64 bytes from 182.168.100.191: icmp_ seq=10 ttl=64 time=),286 m=

——— 192.168.100.191 ping scaciscics ——
10 packets transmitted, 10 received, 0% packet loss, time 3001ms
rtt min/avg/max/mdev = 0,242/8.650/84.004/25.118 ms

CANCEL

L]
O

P START

In the Ping Count field, enter the number of ping packets to be sent.
The default number is 10.
From the Access Point menu, select the access point to be pinged.

After you make your selection, the IP address of the access point displays in the IP
Address field.

Click the Start button.

The results are shown in the Ping Result field.
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Trace a Route to an Access Point

You can trace a route to verify the route from the wireless controller to an access point.

» To trace aroute to an access point:

1. Open a web browser, and in the browser’s address field, type the wireless controller's IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.
4. Select Diagnostics > Tools > Trace Route.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics
Tools | Technical Support
Ping TraceRoute ]
Access Point netgearC5%4A8 E|
AP Console Logs Host IP Address / Name 192.168.100.139

Packet Capture
TraceRoute Result 7

traceroute to 192.168.100.139 (192.168.100.139), 30 hops max, 46 by
1 192.168.100.139 (192.168.100.139) 0.237 ms 0.107 m= 0.094 m=s

CANCEL STOE. START

5. From the Access Point menu, select the access point for which you want to trace the route.

After you make your selection, the IP address of the access point displays in the IP
Address field.

6. Click the Start button.

The results are shown in the TraceRoute Result field.
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View the Console Debug Logs of an Access Point

Note: On the wireless controller, you can view console debug logs for the
WNDAP660, WAC720, WAC730, and WAC740 access points only.

The console debug logs that you can download by connecting a device with a serial cable to
an access point’s console point can be very useful for troubleshooting or debugging a WLAN
network. However, it might not always be possible to physically connect to an access point.

The wireless controller provides the option to remotely capture the access point’s console
debug logs without physically connecting to the access point and send the console debug
logs over the network to a syslog server or generic UDP server.

Note: This option does not provide access to the serial port over the
network. The option only collects the console debug logs without
physically connecting to the access point.

> To remotely collect and view the console debug logs of an access point:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.

The wireless controller’s login window opens.
2. Enter your user name and password.

Click the Login button.

The wireless controller’'s web management interface opens and displays the Summary
page.
4. Select Diagnhostics > Tools > AP Console Logs.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Tools | Technical Support

Ping AP Console Logs

Trace Route

Enable Console Logs ¥
Server IP Address 0.0.0.0
- Packet Capture
Server Port Number 514
Server / L3 Switch MAC 00:00:00:00:00:00
Log Level WARNING (5)  [~]

+| Group Name =

6c:0b:84:c5:94:a0 192.168.100.139 WACT40 netgearCIS4A8 Connected Group-1
50:62:03:80:58:60 192.168.100.135 WAC720 netgear80586F Connected basic

CANCEL APPLY
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5. Configure the settings as described in the following table.

6.

Setting

Description

Enable Console Logs

Enable the console log settings by selecting the Enable Console Logs check
box.

By default, the console log settings are disabled.

Server IP Address

Enter the IP address of the syslog server or UDP server.

Note: If you use a syslog server on the network, the number of the logs that are
sent to the syslog server might increase considerably.

Server Port Number

Enter the port number of the syslog server or UDP server.
The default port number is the syslog server port 514.

Server / L3 Switch MAC

Enter the MAC address of the UDP server or Layer 3 gateway behind which the
UDP server is located:

e If you use a UDP server, enter the MAC address of the UDP server. This
MAC address is required to enable the access point to send messages to
the UDP server.

» If the UDP server is in another subnet (that is, the UDP server is located
behind a Layer 3 gateway), enter the MAC address of the gateway instead
of the MAC address of the UDP server.

Log Level

From the Log Level menu, select one of the following levels:

« EMERGENCY (1). Emergency messages. Sent when the system is
unstable.

* ALERT (2). Alert messages. Sent when action must be taken immediately.
e CRITICAL (3). Critical messages. Sent when a critical condition occurs.
« ERROR (4). Error messages. Sent when an error condition occurs.

*  WARNING (5). Warning messages. Sent when a warning condition occurs.

* NOTICE (6). Notification messages. Sent when a normal but significant
condition occurs.

* INFORMATION (7). Informational messages.
- DEBUG (8). Debug messages.

Note: If you select EMERGENCY (1), only emergency messages are sent. For
each lower level, the messages of the levels that are higher than the selected
level are also sent. For example, if you select CRITICAL (3), critical messages,
alert messages, and emergency messages are sent. If you select DEBUG (8),
all messages from emergency messages to debug messages are sent.
Selecting DEBUG (8) generates a very large number of messages.

In the table with access points, select one or more check boxes for access points for which
you want to collect debug logs.

You can select only access point that are in the Connected state. The table can display
WNDAP660, WAC720, WAC730, and WAC740 access points only.

Click the Apply button.

Your settings are saved. The selected access points start generating and sending debug
logs over the network to the syslog or UDP server. (If a device is connected to the
console port of an access point, the access point also starts sending debug logs over the

console port.)
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Capture WiFi Packets

You can use the wireless controller packet capture utility to capture WiFi packets in a
network. This capability can be useful for analyzing a WiFi deployment, monitoring a WiFi
network, debugging protocols, determining WiFi network bottlenecks, and, in general,
troubleshooting any irregularities in a WiFi network.

The packet capture utility captures all packets of an access point in the network, irrespective
of their final destinations, and collects the packets in a file. You can specify whether that file
is saved to the access point logs (local capture, see Save and Clear the Logs for an Access
Point on page 265) or to a TFTP server (remote capture).

With local capture, a single file that is limited to a size of 40 MB is saved to the access point
logs. Even if you do not stop the capturing process during local capture, only a single file is
saved. With remote capture, multiple files, each limited to a size of 40 MB, can be saved to a
TFTP server until you stop the capturing process.

Note: Packet capturing is available for the WAC720, WAC730, and WAC740
access points only.

> To collect an access point’s WiFi packets in the network:

1. Open a web browser, and in the browser’s address field, type the wireless controller’s IP
address.

By default, the IP address is 192.168.0.250.
The wireless controller’s login window opens.

2. Enter your user name and password.
Click the Login button.

The wireless controller's web management interface opens and displays the Summary
page.

4. Select Diaghostics > Tools > Packet Capture.

Access Point Configuration Monitor Maintenance Stacking Plans Diagnostics

Tools | Technical Support

Ping Packet Capture
Trace Route
AP Console Logs Cnptitre Bencon
Capture Probe 1
MAC Address Filter 00:00:00:00:00:00
Save Location @ |ocal Capture [Max 40MB] Remote Capture
Band 2.4GHE ¥

Search

¢ | Model = | Name ¢ | Status * | Group Name ¢ | Capture Status ¢ | |
6c:0b:84:c5:94:a0  192.168.100.139 WACT40 netgearC594A8  Connected Group-1 Stopped
50:6a:03:80:58:60 192.168.100,135 WAC720 netgearBOSS6F Connected basic Stopped
CAMCEL START STOP
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Configure the settings as described in the following table.

Setting Description

Capture Beacon Select the Capture Beacon check box to enable capturing of beacon frames.

If the check box is cleared (which is the default), beacon frames are ignored
during the packet capture process.

Capture Probe Select the Capture Probe check box to enable capturing of probe requests
and responses.

If the check box is cleared (which is the default), probe requests and responses
are ignored during the packet capture process.

Client Mac Address If you want to capture packets that are destined for a particular client, enter the
MAC address of the client.

By default, the MAC address is 00:00:00:00:00:00, which specifies that packets
are not filtered for any MAC address during the packet capture process.

Save Location Select one of the following radio buttons to specify where the captured packets

must be saved:

» Local Capture [Max 40MB]. After the file size reaches its maximum limit
of 40 MB, regardless of whether you click the Stop button, the file is saved
to the access point logs from where you can download it (see Save and
Clear the Logs for an Access Point on page 265).

* Remote Capture. When you click the Stop button, the file or files are
saved to the TFTP server. With remote capture, multiple files, each limited
to a size of 40 MB, can be saved to a TFTP server until you stop the
capturing process.

Band From the Band menu, select 2.4GHz or 5GHz to specify the radio band on
which packet must be captured.

In the table with access points, select the check box for the access point for which you want
to capture WiFi packets.

You can select only access point that are in the Connected state. The table can display
WAC720, WAC730, and WAC740 access points only.

Click the Start button.

In the table with access points, the Capture Status field for the selected access point
states Running and includes the radio band for which packets are captured.

IMPORTANT:

After starting the capture process, you must manually stop the
process.

When you want to stop the capturing process, do the following:
a. Select the check box again for the same access point.
b. Click the Stop button.

In the table with access points, the Capture Status field for the selected access point
shows Stopped.
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9. If you specified that the file with captured packets must be saved to the access point logs,
do the following to retrieve and view the content of the file:

a.
b.

Select Maintenance > Logs & Alerts > Logs.

If the table contains many entries, navigate through the table by using the following
buttons and menu that display at the bottom of the table:

e To move to the next page, click the Next button.
e To move to the previous page, click the Previous button.

» To change the number of entries onscreen, from the Entry Per Page menu,
select 20, or 40, or 60, and so on, or All.

Select the radio button that corresponds to the access point for which you want to
save (that is, download) the logs.

Click the Save button.
Follow the directions of your browser.
Unzip the logs.

The file with captured packets is a . pcap file in the following format:
AP_<mac_addr>_<2_.4GHz/5GHz>_<time_stamp>.pcap
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Controller-Managed Access Points

Standalone access points provide a full web management interface. Access points that are
controlled by a wireless controller provide a limited web management interface. This appendix
describes the limited web management interface and includes the following sections:

Overview

Change IP Address and VLAN Settings on a Controller-Managed Access Point
Reenable the DHCP Client on a Controller-Managed Access Point

Upgrade or Change Firmware on a Controller-Managed Access Point

Save and View the Logs on a Controller-Managed Access Point

Enable Link Aggregation on a WAC740 Access Point

Change the Password on an Access Point

Convert an Access Point From Controller-Managed to Standalone
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Overview

Except for the WAC740 and WN370 access points, all access points can function in either
standalone mode or controller-managed mode.

Standalone mode. When an access point functions in standalone mode, the access
point’s provides a full web management interface that allows you to configure and
manage all features that the access point supports. For more information about
standalone mode, see the user manual for your access point. (Because the WAC740 and
WN370 access points do not function in standalone mode, NETGEAR does not provide
user manuals for these models.)

Controller-managed mode. When an access point functions in controller-managed
mode, the access point provides a limited web management interface that allows you to
manage the following features only:

- DHCP client

- Access point IP address settings

- Wireless controller IP address

- Management VLAN

- Firmware

- Password

- Link aggregation (WAC740 access point only)

In addition, you can view the logs on the controller-managed access point. You can
convert a controller-managed access point to standalone mode by loading a standalone

firmware version on the controller-managed access point (this does not apply to the
WAC740 and RN370 access points).

The following sections describe the tasks that you can perform through the limited web
management interface of a controller-managed access point:

Change IP Address and VLAN Settings on a Controller-Managed Access Point on
page 376

Reenable the DHCP Client on a Controller-Managed Access Point on page 377
Upgrade or Change Firmware on a Controller-Managed Access Point on page 378
Change the Password on an Access Point on page 383

Save and View the Logs on a Controller-Managed Access Point on page 381
Enable Link Aggregation on a WAC740 Access Point on page 382

Convert an Access Point From Controller-Managed to Standalone on page 385

Controller-Managed Access Points
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Change IP Address and VLAN Settings on a
Controller-Managed Access Point

By default, a controller-managed access point functions as a DHCP client. The only reason to
manually change the IP address settings on a controller-managed access point is that you
must assign a static IP address to the access point.

Make sure that the new IP address is in the same Layer 2 or Layer 3 network as the wireless
controller, otherwise the wireless controller cannot reach the access point after you change
the IP address.

If you configure a static IP address for the access point, you must also specify the IP address
of the wireless controller.

You can also change the VLAN settings. However, if you change the VLAN, make sure that
you configure the correct management VLAN ID and state whether it is tagged or untagged,
otherwise the wireless controller cannot reach the access point after you change the VLAN

settings.

» To change the IP address settings or VLAN settings on a controller-managed access
point:
1. Find the IP address of the access point on your network.
For more information, see Manage the Managed AP List on page 167.
2. In the address bar, enter the IP address of the access point.
A login window displays.
3. Enter the user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

The Network Settings page displays. (The full path is Configuration > System >
Network Settings.)

Controller-Managed Access Points
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Configuration

System | Upgrade | Password | Logs

Network Settings

IP Settings @
DHCP Client @ enable ! disable
IP Address 192.168.100.135
IP Subnet Mask 255.255.255.0

Default Gateway 192.168.100.1
Primary DNS Server [
Secondary DNS Server

Controller Settings @

Controller IP - (Discovered IP) |192.168.100.250

Vlan Settings @
Management VLAN [ 1
[¥] untagged VLAN [1
CANCEL APPLY

4. In the IP Settings section, select the DHCP client disable radio button.

The fields become available. By default, the DHCP client enable radio button is selected
and the access point functions as a DHCP client.

5. In the IP Settings sections, configure the IP address information for the access point in the
network.

6. In the Controller Settings section, configure the IP address for the wireless controller in the
network.

7. If you need to change the management VLAN settings, do so in the Vlan Settings section.

By default, VLAN 1 is the management VLAN and it is untagged, that is, the Untagged
VLAN check box is selected and the Untagged VLAN field also states VLAN ID 1. You
can specify a different VLAN ID for the management VLAN and the tagged or untagged
VLAN.

8. Click the Apply button.

You changes are saved. You must let the wireless controller rediscover the access point
in the network (see Discover Access Points With the Discovery Wizard on page 159).

Reenable the DHCP Client on a Controller-Managed
Access Point
By default, a controller-managed access point functions as a DHCP client. If you disabled the

DHCP client, for example, because the access point required a static IP address setting, you
can reenable the DHCP client and allow the DHCP server in your network to assign an IP
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address to the access point. For information about the requirements of a DHCP server that
enable a wireless controller to discover access points in a network, see Access Point
Discovery Guidelines on page 155.
> To reenable the DHCP client on a controller-managed access point:
1. Find the IP address of the access point on your network.
For more information, see Manage the Managed AP List on page 167.
2. In the address bar, enter the IP address of the access point.
A login window displays.
3. Enter the user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

The Network Settings page displays. (The full path is Configuration > System >
Network Settings.)

4. In the IP Settings section, select the DHCP client enable radio button.
The fields become masked out.

5. Click the Apply button.

You changes are saved. The DHCP server assigns and IP address to the access point
and you must let the wireless controller rediscover the access point in the network (see
Discover Access Points With the Discovery Wizard on page 159).

Upgrade or Change Firmware on a Controller-Managed
Access Point

In most situations, the wireless controller automatically upgrades the firmware on a
controller-managed access point. Situations exist in which you must manually upgrade or
change the firmware on a controller-managed access point. One such situation is when you
want to change a controller-managed access point to a standalone firmware version and use
the access point in standalone mode.

» To upgrade or change the firmware on a controller-managed access point:

1. Download the desired software file from the NETGEAR website and save it to a
computer that is connected to the same network as the controller-managed access
point.

2. If necessary, unzip the new software file.
If available, read the release notes before upgrading the software.
4. Find the IP address of the access point on your network.

For more information, see Manage the Managed AP List on page 167.
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5. In the address bar, enter the IP address of the access point.
A login window displays.
6. Enter the user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

7. Select Configuration > Upgrade > Firmware Upgrade.

Configuration

System | Upgrade | Password | Logs
- Upgrade
Upgrade
Current build version 6.5.0.16_g3c5d253
Select upgrade file @ No file selected.

The page states the current firmware version that is running on the access point.
8. Click the Browse button and locate and select the firmware version on your computer.
The firmware file is usually a .tar file but could also be a different type of file.

9. Click the Apply button.

During the upgrade process, the access point automatically restarts. The upgrade
process typically takes several minutes.

When the upgrade is complete, the access point might still be controller-managed, the
wireless controller might not be able to connect to the access point, or the access point
might run a standalone firmware version.

10. Verify that the new firmware is installed by performing one of the following procedures:
* The access point is still controller-managed. Do the following:
a. Log back in to the access point at the same IP address that you used in Step 5.
b. Select Configuration > Upgrade > Firmware Upgrade.

The Upgrade page displays. The page states the current firmware version that is
running on the access point.

« The wireless controller cannot connect to the access point or the access point
runs a standalone firmware version. Do the following:

a. Log back in to the access point at the same IP address that you used in Step 5.
b. Select Configuration > Upgrade > Firmware Upgrade.

The Upgrade page displays. The page states the current firmware version that is
running on the access point.

Controller-Managed Access Points

379



C.

ProSAFE Wireless Controller

Reconfigure the static IP address setting and the VLAN settings or reenable the
DHCP client.

For more information, see Change IP Address and VLAN Settings on a
Controller-Managed Access Point on page 376 and Reenable the DHCP Client on
a Controller-Managed Access Point on page 377.

If you cannot connect to the access point, its IP address might be the factory default
IP address.

The access point’s IP address is reset to the factory default IP address. Do the
following:

a. Determine the factory default IP address for the model access point.

Access Point Model |Factory Default IP Address
WAC740 192.168.0.160
WAC730 192.168.0.100
WAC720 192.168.0.100
WN370 192.168.0.160
WND930 192.168.0.100
WNDAP660 192.168.0.100
WNDAP620 192.168.0.100
WNDAP380R Not applicable?l
WNDAP360 192.168.0.100
WNDAP350 192.168.0.237
WNAP320 192.168.0.100
WNAP210v2 192.168.0.236

1. The WNDAP380R does not provide a web
management interface and a default IP address.
The WNDAP380R can be managed only by a
wireless controller in a network with a DHCP server.

Configure a computer with a static IP address in the same subnet as the factory
default IP address of your model access point and a subnet mask of
255.255.255.0.

Use an Ethernet cable to connect the computer to the access point.

Log back in to the access point using the factory default IP address of your
model access point.

Enter the user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Select Configuration > Upgrade > Firmware Upgrade.
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The Upgrade page displays. The page states the current firmware version that is
running on the access point.

Reconfigure the static IP address setting and the VLAN settings or reenable the
DHCP client.

For more information, see Change IP Address and VLAN Settings on a
Controller-Managed Access Point on page 376 and Reenable the DHCP Client on
a Controller-Managed Access Point on page 377.

Save and View the Logs on a Controller-Managed Access

Point

You can save and view the logs on a controller-managed access point. For some access
point models, you can also view the console debug logs (see View the Console Debug Logs
of an Access Point on page 369).

> To save and view the logs on a controller-managed access point:

1.

Find the IP address of the access point on your network.

For more information, see Manage the Managed AP List on page 167.
In the address bar, enter the IP address of the access point.

A login window displays.

Enter the user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Select Configuration > Logs > AP Logs.

Configuration

System | Upgrade | Password | Logs

AP Logs

AP Logs

Save a copy of the AP logs to a file SAVE

Click the SAVE button.
Follow the directions of your browser.
Unzip the logs.

The file with logs is a . tar file in the following format: aplogs_<mac_addr>.tar
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Enable Link Aggregation on a WAC740 Access Point

Setting up a static link aggregation group (LAG) connection between a WAC740 access
point, a switch, and a wireless controller involves the following steps:

1. Connect both LAN Ethernet ports on a WAC740 access point to a switch.

For more information, see the ProSAFE Dual Band Wireless AC Access Point Model
WAC740 Hardware Installation Guide, which you can download by visiting
downloadcenter.netgear.com.

2. Configure link aggregation on the switch.

For more information, see the documentation for your switch. If you use a NETGEAR
M4200 ProSAFE Managed Switch, see the M4200 and M4300 Series ProSAFE
Managed Switches Web Management User Manual, which you can download by visiting
downloadcenter.netgear.com.

Note: The overall link aggregation throughput is 2 x 1 Gbps (2 Gbps). If,
however, one of two LAN connections fails between a WAC740 access
point and a switch with Static Lag configured on both, the redundancy
protocol prevails and the link throughput drops to 1 Gbps.

3. Configure link aggregation for the WAC740 access point on the wireless controller.

For more information, see Change Access Point Information on the Managed AP List on
page 170.

4. Enable link aggregation on the WAC740 access point itself.

For more information, see the following procedure.

Note: The WAC740 access point supports a manual static LAG only. The
access point does not support IEEE 802.3ad Link Aggregation or Link
Aggregation Control Protocol (LACP) groups.

» To enable link aggregation on a controller-managed WAC740 access point:
1. Find the IP address of the access point on your network.
For more information, see Manage the Managed AP List on page 167.
2. In the address bar, enter the IP address of the access point.
A login window displays.
3. Enter the user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.
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The Network Settings page displays. (The full path is Configuration > System >
Network Settings.)

Configuration

System | Upgrade | Password | Logs

Network Settings

IP Settings
DHCP Client ® enable 7 disable
IP Address 192.168.100.139
IP Subnet Mask |255.255.255.0
Default Gateway [192.168.100.1

Primary DNS Server
Secondary DNS Server

Controller Settings

Controller IP - (Discovered IP) | 192.168.100.250

Vlan Settings ©)
Management VLAN 1
¥ untagged vLAN 1
Link Aggregation @
Link Aggregation enable 9 disable
CANCEL APPLY

4. In the Link Aggregation section, select the enable radio button.

By default, the disable radio button is selected.

5. Click the Apply button.

You changes are saved.

Change the Password on an Access Point

Do not change the password on a controller-managed access point. The admin password of
the wireless controller is pushed to all access points that the wireless controller manages.
(For information about changing the admin password of the wireless controller, see Change
the Password of the Default admin Account of the Wireless Controller on page 237).

If you do change the password on a controller-managed access point, the change is
automatically reversed when the access point synchronizes with the wireless controller and
the password of the wireless controller is pushed to the access point.

In some situations when the access point is not managed by a wireless controller but does
not function in standalone more either, you might want to change the password. For example,
when the access point is not managed by a wireless controller and you do not want anyone
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to log into the access point to load a standalone firmware image or change the configuration,
you can change the password to block access.

To change the password on an access point that is no longer managed by a wireless
controller but does not function in standalone mode either:

1.

In the address bar, enter the IP address of the access point.

If you did not write down the IP address of the access point when it was still
controller-managed, you might need to reset the access point to factory default settings
and access the access point at its default IP address. For a list of default IP addresses,
see the table in Upgrade or Change Firmware on a Controller-Managed Access Point on
page 378.

A login window displays.
Enter the user name and password.

The user name is admin. The password is the password of the wireless controller at the
time that the access point was still controller-managed. The user name and password are
case-sensitive.

If you reset the access point to factory default settings, the default password is
password.

Select Configuration > Password > Password.

Configuration

System | Upgrade | Password | Logs

Change Password

Change Password

User Name admin
Current Password oy
New Password

Retype New Password

If the Current Password field does not state the hidden current password, enter it.

In the New Password field, enter a new password and repeat it in the Retype New
Password field.

Click the Apply button.

You changes are saved.
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Convert an Access Point From Controller-Managed to
Standalone

Note: You cannot convert a WAC740 or RN370 access point to a
standalone access point. The WAC740 and WN370 access points are
intended to function as controller-managed access points only.

» To change a controller-managed access point to a standalone firmware version and
use the access point in standalone mode, do the following:

1. Remove the access point from the Managed AP List (see Remove Access Points From
the Managed AP List on page 173.)

2. Log in to the access point’s limited web management interface, upgrade the firmware to the
standalone AP firmware version, (see Upgrade or Change Firmware on a
Controller-Managed Access Point on page 378), and reboot the access point as a
standalone access point.

Controller-Managed Access Points

385



Factory Default Settings, Technical
Specifications, and Passwords Requirements

This appendix includes the following sections:

* Factory Default Settings

e Technical Specifications Models WC7500 and WC7600v2
e Technical Specifications Models WC7600 and WC9500

e Password Requirements
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Factory Default Settings

You can restore the wireless controller to its factory default settings on the Reboot/Reset
Controllers page (see Reboot the Wireless Controller on page 259) or by using the Reset

button on the front panel (s

ee Use the Reset Button to Restore Default Settings on

page 364). The wireless controller returns to the factory configuration settings that are shown

in the following table.

Table 12. Factory default settings for the wireless controller

Feature Default Setting
Login User login URL http:192.168.0.250
User name (case-sensitive) admin

Login password (case-sensitive) | password
LAN LAN IP 192.168.0.250

Subnet mask

255.255.255.0

Default gateway

192.168.0.1

DHCP server pools

None

Time zone

USA Pacific Standard Time (PST)

saving time

Time zone adjusted for daylight Enabled

SNMP

Enabled

Technical Specifications Models WC7500 and WC7600v2

The following table lists the technical and physical specifications for models WC7500 and

WC7600v2.

Table 13. Technical and physical specifications models WC7500 and WC7600v2

Feature

Default Setting

Electrical specifications

e 100-240V, 3A, 50-60 Hz AC input
e Typical power consumption 12 W

Dimensions (W x H x D) cm

44 cm x 4.5 cm x 26.3 cm (Fits in a 1U rack)

Dimensions (W x H x D) in.

17.3in. x 1.7 in. x 10.3 in. (Fits in a 1U rack)

Weight

7.9kg (3.6 Ib)

Operating temperatures

0° to 45°C (32° to 113°F)

Operating humidity

10% minimum to 90% maximum relative humidity
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Table 13. Technical and physical specifications models WC7500 and WC7600v2 (continued)

Feature Default Setting

Storage temperatures —20° to 70°C (—4° to 158°F)

Storage humidity 5% minimum to 95% maximum relative humidity, noncondensing
Safety and EMI UL, FCC, CE, RCM, CCC, VCCI, KCC, BIS

Environmental WEEE, RoHS, REACH

For a list of all features and capabilities of the wireless controller, see the datasheet:

e For the WC7500, visit netgear.com/support/product/\WWC7500.
e For the WC7600v2, visit netgear.com/support/product/WWC7600v2.

Technical Specifications Models WC7600 and WC9500

The following table lists the technical and physical specifications for models WC7600 and
WC9500.

Table 14. Technical and physical specifications models WC7600 and WC9500

Feature Default Setting

Electrical specifications e 100-240V, 5A, 47-63 Hz AC input
e Typical power consumption 82.3 W

Dimensions (W x H x D) cm 43 cm x 4.3 cm x 44 cm (Fits in a 1U rack)

Dimensions (W x H x D) in. 16.92in. x 1.7 in. x 17.32 in. (Fits in a 1U rack)

Weight * With one power supply: 6.32 kg (13.94 Ib)
« With an optional second power supply: 7.57 kg (16.68 Ib)
Operating temperatures 0° to 45°C (32° to 113°F)
Operating humidity 10% minimum to 90% maximum relative humidity
Storage temperatures —20° to 70°C (—4° to 158°F)
Storage humidity 5% minimum to 95% maximum relative humidity, noncondensing
Safety and EMI UL, FCC, CE, RCM, CCC, VCCI, KCC, BIS
Environmental WEEE, RoHS, REACH

For a list of all features and capabilities of the wireless controller, see the datasheet:

e For the WC7600, visit netgear.com/support/product/WC7600v1.
e For the WC9500, visit netgear.com/support/product/\WC9500.
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Password Requirements

Note: We recommend that you change the administrator password of the
wireless controller to a secure password (see Change the Password
of the Default admin Account of the Wireless Controller on page 237).
The administrator password that you configure on the wireless
controller is also pushed to all managed access points.

The following table lists the password requirements.

Table 15. Password requirements

Web Management Interface Path User Type Restrictions Section in
or This Manual
Data Encryption Allowed Length
Characters
Select Maintenance > User e Administrator Alphanumericsand |Up to 31
Management. « Read Only special characters
1
* Guest Provisioning (see footnote )
e License
Management Only See Manage
Users,
1. Select Maintenance > User Captive portal user Alphanumericsand |Up to 31 |Accounts, and
Management. special characters Passwords on
2. Click the Captive Portal Users tab. page 236.
1. Select Maintenance > User WiFi user Alphanumerics Upto 31
Management. only
2. Click the WiFi Clients tab.
Basic profile: Shared Key | 64-bit WEP Hexadecimal 10 fixed
1. Select Configuration > 128-bit WEP Hexadecimal 26 fixed
Profile > Basic >
Radio. 152-bit WEP Hexadecimal 32 fixed
Select a profile. ] See Manage
i WPA-PSK | TKIP Alphanumericsand |Up to 63 | security
3. Make a selection from ; .
the Network special characters, Profiles for
e Networ TKIP +AES excluding quotes i
Authentication menu. 94 ::I:eﬁasg
WPA2-PSK |AES rotie Sroup
on page 124.
TKIP + AES
WPA-PSK | TKIP + AES
&
WPA2-PSK
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Table 15. Password requirements (continued)

Web Management Interface Path User Type Restrictions Section in
or This Manual
Data Encryption Allowed Length
Characters
Advanced profile: Shared Key | 64-bit WEP Hexadecimal 10 fixed
L Sele_ct Configuration > 128-bit WEP Hexadecimal 26 fixed
Profile > Advanced >
Radio. 152-bit WEP Hexadecimal 32 fixed
See Manage
2. Select a group. ] S .
_ _ WPA-PSK | TKIP Alphanumericsand | Up to 63 | S€curity
3. Click Edit. special characters, Profiles for
4. Select a profile. TKIP + AES excluding quotes édvfe_llnced
) rofile
5. Make a selection from  |\wpa2-PSK |AES Groups on
the Net\{vorl_< page 129.
Authentication menu. TKIP + AES
WPA-PSK | TKIP + AES
&
WPA2-PSK
Select Configuration > External Shared Secret Alphanumericsand | Up to 127 | S€€ Manage
Security > Authentication | RADIUS special characters Authentication
Server. Server Servers and
Authentication
External Domain Admin User Alphanumericsand |Upto 32 | Server
LDAP special characters Groups on
Server page 140.

1. If your admin password contains special characters (for example, P, !, @, #, $, %, or ) and you upgrade the
firmware from version 4.x to version 5.x, you first must change the password to one with alphanumeric characters
only (for example, password4285) before you upgrade the firmware. Make sure that you back up the configuration
before you upgrade the firmware. After you successfully upgrade the firmware to version 5.x, you can change the

password back to your original password with special characters.
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Numerics IP subnet 159, 161
known and unknown 221
1to 1 redundancy 291-296 limited management web interface 374
2.4 GHz and 5 GHz channels 197 local 155, 166, 169
802.11 wireless modes 184, 190 managed status 169
802.1Q VLAN header 36, 103 models, supported 27
password, changing 237
A pinging 367
rebooting 277
AC power supply remote 161, 166, 169
WC7500 and WC7600v2 21 RF planning, adding and managing 76
WC7600 and WC9500 24 rogue
access denied, clients 359 detecting and managing 219
access point logs, saving and clearing 265 viewing in the network 311
access point profile groups viewing on the managed access point 317, 332,
adding advanced groups 129 352
assigning access points to 174 viewing on the wireless controller 339
basic and advanced, described 34 standalone mode
channels and transmission power, overriding 186, autodiscovery 164
193 described 375
profiles, adding and configuring 124, 131 returning to 173, 385
QoS, configuring 207 supported models 27
radio, turning on and off 179 tracing a route 368
rate limiting, configuring 212 troubleshooting 365
RF management, configuring 198 Tx power
wireless settings, configuring 182 automatically controlling 200, 202
access points manually controlling 188, 195
adding 162, 166 overriding 186, 193
antennas, configuring 173 viewing
autodiscovery 154 on the wireless controller 314, 329
channel allocation security profiles 317, 332, 352
automatic 195—197 statistics 317, 332, 353
manual 188, 194 VLAN settings 172
collecting console debug logs 369 access, remote 262
collecting WiFi packets 371 accounts, captive portal 236
controller-managed mode, described 375 active SSIDs, viewing 349
DHCP client, disabling 172 active voice calls, preventing channel allocation 197

discovery 155 Address Resolution Protocol (ARP) suppression 186,
dual-band 30, 34, 121, 212 192

factory default IP addresses 380
factory default state, autodiscovery 159
firmware, minimum version 27

floor and building settings 173

IP addresses 172

admin password, changing 237
Advanced Encryption Standard (AES) 138
advanced profile groups

adding groups 129
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assigning access points to 174
channels and transmission power, overriding 193
described 34
LED behavior, configuring 216
profiles, adding and configuring 131
QoS, configuring 207
radio, turning on and off 180
rate limiting, configuring 214
RF management, configuring 200
wireless settings, configuring 188
advanced settings, described 33, 121
AES (Advanced Encryption Standard) 138
aggregated MAC protocol data unit (AMPDU) 185, 191
aggregation length 185, 191
aggregation links
WAC740 access point 170, 382
WC7600v1 and WC9500 controller 103
AIFS (arbitration inter-frame space) 209
AirQual
configuring 203—206
monitoring 346
alarms
settings 118
viewing in the network 311
viewing on the wireless controller 325
alerts, viewing and saving 267
AMPDU (aggregated MAC protocol data unit) 185, 191
antennas
RF planning, adding and managing 79
specifying internal or external 173
supported models 30
application requirements, RF planning 53
arbitration inter-frame space (AIFS) 209
architecture, advanced profile group 35
ARP (Address Resolution Protocol) suppression 186, 192
authentication
certificates 113
external
MAC authentication 127, 134, 146
RADIUS and LDAP servers 138, 140—143, 226,
232
internal 143
methods supported 38
servers 140
auto planning advisor, RF planning 70
autodiscovery, access points 154

automatic channel allocation and transmission power,
WLAN healing 198

back panel components
WC7500 and WC7600v2 21
WC7600 and WC9500 23
background QoS queue 207
backing up the configuration 254
band steering 200, 202
bandwidth, low and high density 185, 192
basic profile group
assigning access points to 174
channels and transmission power, overriding 186
described 34
LED behavior, configuring 215
profiles, adding and configuring 124
radio, scheduling 179
rate limiting, configuring 213
RF management, configuring 199
wireless settings, configuring 182
basic service set identifier (BSSID) 219
basic settings, described 33, 121
beacon interval 184, 191
best effort QoS queue 207
blacklisted clients, viewing in the network 359
bottom label
WC7500 and WC7600v2 21
WC7600 and WC9500 24
broadcast rate limiting 186, 192
broadcasting SSID 126, 133
browsers
requirements, RF planning 53
supported 92
troubleshooting 363
BSSID (basic service set identifier) 219
buildings, RF planning 56

C

cabling, troubleshooting 361
calls, preventing channel allocation 197
captive portal
accounts and users, adding 241—249
accounts and users, viewing 343
configuring 223—236
enabling 134
guest email address database, viewing 345
users, adding multiple simultaneously 247
certificates, authentication 113
channel allocation
automatic 195—197
manual 188, 194
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channel width 184, 190
classify rogue access points 220
client separation 126, 133
client VLANs 37, 42
clients, DHCP 172
clients, viewing
accepted in the network 355
blacklisted in the network 359
neighboring in the network 338
on the access point 317, 332, 352
on the wireless controller 319, 326, 334
clients, wireless, maximum number 210
color coding, channels 315, 330
community names, SNMP 263
compliance, regulatory
WC7500 and WC7600v2 388
WC7600 and WC9500 388
configuration file, restoring 255
configuration roadmaps 94—98
configuration, backing up and restoring 254—255
connection problems, troubleshooting 366
connectivity test 36
console debug logs, collecting 369
console port
WC7500 and WC7600v2 20
WC7600 and WC9500 23
contents, package 19
controller models 12
controller password, changing 237
controller selection, stacking 288
controller-managed mode, access points, described 375
corporate channels 197
counter
WC7500 and WC7600v2 20
WC7600 and WC9500 23
country and region of operation 101
customer information, licenses 112

CwMin and CwMax (minimum or maximum contention
window) 209

D

data encryption
configuring 126, 133
supported methods 38
data rate 184, 190
date, troubleshooting 364
default profile group. See basic profile group.
default settings 387
default settings, resetting

WC7500 and WC7600v2 20, 259
WC7600 and WC9500 23, 259

delivery traffic indication message (DTIM) interval 185,
191

denied access, clients 359
detecting rogue access points 219
DHCP client, access points 172
DHCP leases, viewing 343
DHCP option 43 156, 365
DHCP server
described 37
settings 107
diagnostic tools 366
digital counter
WC7500 and WC7600v2 20
WC7600 and WC9500 23
dimensions
WC7500 and WC7600v2 387
WC7600 and WC9500 388
discovering access points 155
discovery problems, troubleshooting 365
DNS servers 105

DTIM (delivery traffic indication message) interval 185,
191

dual-band access points 30, 34, 121, 212

E

EAP (Extensible Authentication Protocol) 241
electrical specifications
WC7500 and WC7600v2 387
WC7600 and WC9500 388
email address database, viewing 345
email notification server 119
encryption, methods supported 38
end-user license agreement (EULA) 228, 234
Ethernet port
WC7500 and WC7600v2 20
WC7600 and WC9500 23
Ethernet port LEDs
described 26
troubleshooting 361
EULA (end-user license agreement) 228, 234
Extensible Authentication Protocol (EAP) 241
external antennas 173
external authentication
MAC authentication 127, 134, 146
RADIUS and LDAP servers 138, 140—143, 226, 232
external storage 260
external syslog server 116
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F

factory default IP addresses, access points 380
factory default settings, wireless controller 387
factory default state, access point autodiscovery 159
failover, redundancy 291, 297
Fan LED, described 25
fans
WC7500 and WC7600v2 21
WC7600 and WC9500 24
features, overview 14—17
firmware
minimum version for access points 27
multicast, using for access point upgrade 278
upgrading, wireless controller 256
version, viewing 312
floors, RF planning
adding 56
heat map, deployed floor plan 88
scaling 60
FTP server, firmware upgrade 257

G

GBICs (gigabit interface converters) 23
guard interval 184, 190

guest email address database, viewing 345
guest portal, configuring 223—236

GUI, troubleshooting 362

H

hard reset 259, 364
healing, WLAN 198
heat maps, deployed floor plan 88
high density bandwidth 185, 192
high traffic load, preventing channel allocation 197
hotspot users 223
humidity
WC7500 and WC7600v2 387
WC7600 and WC9500 388

interference sources 36
interference, non-WiFi 203
internal antennas 173

internal authentication server 143
internal RADIUS server 140
internal syslog server 114
inventory, licenses 274

inventory, RF planning 84
IP addresses
access points 172
DHCP server assignment 108
license server 111
local address
redundancy setting 295, 303
stacking setting 286
master controller, stacking 286
multicast range 279
primary controller, redundancy 295, 303
secondary controller, redundancy 294, 302
slave controller, stacking 284
SNMP manager 263
syslog server 117
TFTP and FTP servers 257
wireless controller 105
IP settings
access points 172
wireless controller 105
IP subnets
access points 159, 161
LAN 105
troubleshooting 365

K

keys, licenses 113, 275
known rogue access points 221

L

label, bottom

WC7500 and WC7600v2 21

WC7600 and WC9500 24
LAG (link aggregation group)

WAC740 access point 170

WC7600v1 and WC9500 controller 105
LAN path, troubleshooting 363
LAN port

WC7500 and WC7600v2 20

WC7600 and WC9500 23
LAN port LEDs

described 26

troubleshooting 361
Layer 2 subnet, access point autodiscovery 159
Layer 3 access point autodiscovery 155, 163
LDAP server 138, 141—143, 226, 232
LEDs

startup procedure 92

troubleshooting 361
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legacy 802.1x authentication 138
levels, logging 115, 117
licenses
managing 274—276
number and types required 17
redundancy group, matching 291, 298
registering 110—113
limited web management interface, access points 374
link aggregation
WAC740 access point 170, 382
WC7600v1 and WC9500 controller 103
link aggregation group (LAG)
WAC740 access point 170
WC7600v1 and WC9500 controller 105
load balancing 210
load balancing logs, viewing and saving 269
local access points 155, 166, 169
local IP address
redundancy settings 295, 303
stacking settings 286
location, placement wireless controller 98
logs
saving 264
low density bandwidth 185, 192

M

MAC authentication 146

MAC authentication groups 149
managed AP list 167

managed status, access points 169
management users, adding 239
management VLANs 36, 42, 102
master controller, stacking 282, 286
maximum burst length 209

maximum number, wireless clients 210
memory partition 258

minimum and maximum contention window (CwMin or
CwMax) 209

models
access points supported 27
antennas supported 30
wireless controllers 12
multicast rate limiting 186, 192
multicast, firmware upgrade process 278
MU-MIMO (multi-user MIMO) 183, 190

N

N to 1 redundancy 297—304

neighboring clients, viewing 338

network authentication 126, 133

network performance, troubleshooting 366
network status, viewing summary 310

noncoverage zone, RF planning 61

notification server, emails 119

NTP (Network Time Protocol), client and server 102

(o)

obstacles, RF planning 62
obstruction areas, RF planning 65
option 43, DHCP 155

P

package contents 19
partition, memory 258
password requirements 389
password, changing default admin 237
passwords
restoring default 364
users 236
physical specifications 387—388
pinging, access points 367
planning, system 36
PoE (Power over Ethernet), access points 30
port requirements, RF planning 53
portals, configuring 223—236
ports and slots
WC7500 and WC7600v2 19
WC7600 and WC9500 22
Power LED
described 25
troubleshooting 361
power level, transmission 101
power supply
WC7500 and WC7600v2 21
WC7600 and WC9500 24
preamble type 185, 191
preventing channel allocation 197
primary controller, redundancy 295, 303
product label
WC7500 and WC7600v2 21
WC7600 and WC9500 24
profile groups. See
access point profile groups.
advanced profile groups.
basic profile group.
profiles. See security profiles.
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Q

QoS (quality of service) 207

R

rack-mounting 98
radio band steering 200, 202
radio frequency (RF)
logs, viewing and saving 268
management 198
obstructions 36
planning 52
radio, turning on and off 179
RADIUS authentication server groups 144
RADIUS servers 138, 140—143, 226, 232
rate limit logs, viewing and saving 271
rate limiting 212
rebooting
access points 277
wireless controller 259, 364

received signal strength indication (RSSI), load balancing
210

redirecting traffic, captive portals 226
reduced interframe space (RIFS) transmission 185, 191
redundancy logs, viewing 272
redundancy status, viewing 310
redundancy, managing 291—307
redundant controller 294, 302
registering licenses 110—113
registration keys, licenses 113, 275
regulatory compliance

WC7500 and WC7600v2 388

WC7600 and WC9500 388
remote access 262
remote access points 161, 166, 169
reports, RF planning 87
requirements

1 to 1 redundancy 291

N to 1 redundancy 298
requirements Layer 3 autodiscovery 155
Reset button

WC7500 and WC7600v2 20

WC7600 and WC9500 23
resetting

factory defaults 20, 23, 259, 364

passwords 364

wireless controller 259
restoring the configuration file 255
RF (radio frequency)

logs, viewing and saving 268

management 198
obstructions 36
planning 52
RF planning
access points, adding and managing 76
antennas, adding and managing 79
overview and requirements 53
RIFS (reduced interframe space) transmission 185, 191
roadmaps for configuration 94—98
rogue access points
detecting and managing 219
viewing
in the network 311
on the managed access point 317, 332, 352
on the wireless controller 326, 339

RSSI (received signal strength indication), load balancing
210

RTS threshold 184, 191

S

scalability and features, wireless controller models 13
scaling, floors 60
scheduling

channel allocation 197

firmware updates, wireless controller 258

radio 179
SD card slot, WC7500 and WC7600v2 20
second power supply, WC7600 and WC9500 24
secondary controller, redundancy 294, 302
security profiles

configuring

advanced profile groups 131
basic profile group 124

managing 121

viewing on the access point 317, 332, 352

viewing on the wireless controller 323, 341
self, controller selection 288
self-healing 200, 202
server, licenses 110
service set ID (SSID) 126, 133
session time-out 263
SFP slot LEDs, WC7600 and WC9500, described 26
SFP slots, WC7600 and WC9500 23
shared key requirements (RADIUS) 389
signal quality 74
signal strength 210
slave controller, stacking 282, 284
slots and ports

WC7500 and WC7600v2 19
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WC7600 and WC9500 22 troubleshooting 364
sniffer 362 TKIP (Temporal Key Integrity Protocol) 138
SNMP, enabling 262 tracing a route 368
soft reset 259 traffic redirecting, captive portals 226
software transmission opportunity (TXOP) limit 210
minimum version for access points 27 transmission power
multicast, using for access point upgrade 278 automatically controlling 200, 202
upgrading, wireless controller 256 country specification 101
version, viewing 312 manually controlling 188, 195
spectrum analysis 36 overriding 186, 193
SSID (service set ID or wireless network name) 126, 133 trap port, SNMP 263
Stack Master LED, described 26 trial license 17
stacking logs, viewing 273 troubleshooting
stacking status, viewing 310 access points 365
stacking, managing 281—290 basic functioning 361

standalone mode, access points 375 collecting console debug logs 369
autodiscovery 164 collecting WiFi packets 371

returning to 173, 385 configuration settings, using sniffer 362
connection problems 366

date 364

diagnostic tools 366

discovery problems 365

standby link, aggregation 105
Status LED
described 25
troubleshooting 361

. . GUI 362
steering, radio anzds 200, 202 LAN path 363
storage, external 260 LEDs 361

subnet masks
access point 172
DHCP server 108

network performance 366
pinging access points 367
resetting factory default settings 364

wireless controller 105 TCP/IP network 363
support, NETGEAR 17 time and time zone 364
suppression, ARP 186, 192 tracing an access point route 368
syslog server web management interface 362
external 116 Tx power
internal 114 automatically controlling 200, 202
system alerts, viewing and saving 267 country specification 101
system logs, saving 264 manually controlling 188, 195
system planning 36 overriding 186, 193
TXOP (transmission opportunity) limit 210
T
tagged VLANs 103 u
TCP/IP network, troubleshooting 363 unicast, firmware upgrade process 278
technical specifications 387—388 unknown rogue access points 221
technical support 2 untagged VLANs 103, 172
temperatures upgrading firmware, wireless controller 256
WC7500 and WC7600v2 387 URL redirecting, captive portals 226
WC7600 and WC9500 388 USB port
Temporal Key Integrity Protocol (TKIP) 138 WC7500 and WC7600v2 20
TFTP server, firmware upgrade 257 WC7600 and WC9500 23
time and time zone users, managing 236
configuring 102 utilization, WiFi channels 203
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\'

VAR information, licenses 112
video QoS queue 207
Virtual Router Redundancy Protocol (VRRP) 291, 297
VLANs
clients 37, 42
DHCP server 107
management 36, 42, 102
security profiles 126, 133
settings, access points 172
untagged 103, 172
voice calls, preventing channel allocation 197
voice QoS queue 207
VRRP (Virtual Router Redundancy Protocol) 291, 297
VRRP ID 295, 303

w

web management interface, troubleshooting 362
weight
WC7500 and WC7600v2 387
WC7600 and WC9500 388
WEP encryption 138
WEP key requirements 389
WiFi auto planning advisor 70
WiFi channels, utilization 203
WiFi coverage zone, RF planning 61
WiFi coverage, RF planning 83
WiFi inventory, RF planning 84
WiFi packets, collecting 371
WiFi users, adding 240
WINS servers 105
wired connection, stacking 281
wireless bands
usage, viewing 327
wireless blacklisted clients, viewing 359
wireless client separation 126, 133
wireless clients, maximum number 210
wireless clients, viewing
accepted in the network 355
blacklisted in the network 359
neighboring in the network 338
on the access point 317, 332, 352
on the wireless controller 319, 326, 334
wireless controller models 12
wireless controller password, changing 237
wireless controller, viewing
active SSIDs 349
captive portal accounts and users 343

DHCP leases 343
guest email address database 345
in the network 312
managed access points 328
managed clients 333
neighboring access points 339
neighboring clients 337
profiles 340
summary 324
usage 327
wireless modes 184, 190
wireless network name (SSID) 126, 133
wireless settings 178
wizard, access point discovery 155
WLAN group assignment 174
WLAN healing 198
WMM (Wi-Fi multimedia) 207
WNAP and WNDAP access points 27
WPA and WPA2 authentication 138—140
WPA passphrase requirements 389
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